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User Manual 

Read this manual before using this product.  Failure to follow the 

instructions and safety precautions in this manual can result in serious 

injury.  Keep this manual in a safe location for future reference. 

Copyright  2017 by SKF USA Inc. 

All rights reserved. 
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extracts) unless prior written permission is granted. Every care has been taken to ensure the accuracy of 

the information contained in this publication but no liability can be accepted for any loss or damage whether 

direct, indirect or consequential arising out of the use of the information contained herein. SKF reserves the 
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Product Support – Contact Information 

 

Product Support – To request a Return Authorization, Product Calibration or a Product Support Plan, use 

the web page links for direct contact and support.   

 

Product Sales - For information on purchasing condition monitoring products, services or customer 

support, contact your local SKF sales office. 

 

General Product Information 

 

For general product information (i.e., product data sheet, accessories catalog, etc.), visit the Condition 

Monitoring Products page on SKF.com and select the appropriate product link. 

 

Technical Support Group 

 

Discuss/review issues of specific interest with maintenance and reliability specialists from around the world 

at the SKF Knowledge Centre. 

 

For technical support on issues like troubleshooting product installation, troubleshooting product 

performance, etc., use our technical support web page to contact one of our Technical Support Groups. 

 

Product Registration 

 

Please take a moment to register your product at www.skf.com/cm/register to receive exclusive benefits 

offered only to our registered customers, including receiving technical support, tracking your proof of 

ownership, and staying informed about upgrades and special offers.  (Please visit our website for more 

details on these benefits.) 

 

Tell us how we’re doing! 

 

It’s important that you’re satisfied with the quality of our product user manuals.  We appreciate your 

feedback; if you have comments or suggestions for improvement, please tell us how we’re doing! 
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End-User License Agreement 

 

THIS END-USER LICENSE AGREEMENT (this 

“Agreement”) is entered into by and between 

SKF USA Inc. and/or SKF Condition Monitoring 

Center AB (hereinafter referred to collectively as 

the “Licensor”) and any person or business that 

executes this Agreement by clicking the “I agree” 

icon at the end of this Agreement or by 

accessing, using, or installing the Software 

(“Licensee” or “You”).  Licensor and Licensee 

shall be referred to collectively in this 

Agreement as the Parties. 

 

BY CLICKING THE ACCEPTANCE BUTTON OR 

ACCESSING, USING, OR INSTALLING THE 

SOFTWARE, OR ANY PART THEREOF, YOU 

EXPRESSLY AGREE TO BE BOUND BY ALL OF 

THE TERMS OF THIS AGREEMENT.  IF YOU 

DO NOT AGREE TO ALL OF THE TERMS OF 

THIS AGREEMENT, THE BUTTON INDICATING 

NON-ACCEPTANCE MUST BE SELECTED, 

AND YOU MAY NOT ACCESS, USE, OR 

INSTALL ANY PART OF THE SOFTWARE. 

 

1. DEFINITIONS 

 

(a) Derivative Works.  The Term 

“Derivative Works” shall have the 

same meaning as set forth in the U.S. 

Copyright Act, as amended from time 

to time, in title 17 of the United States 

Code. 

 

(b) Effective Date.  The term “Effective 

Date” shall mean the date on which 

Licensee assents to the terms of this 

Agreement by clicking the “I agree” 

button at the bottom of this 

Agreement. 

 

(c) Intellectual Property Rights.  The 

term Intellectual Property Rights shall 

mean all rights arising or protectable 

under the copyright, trademark, 

patent, or trade secrets laws of the 

United States or any other nation, 

including all rights associated with the 

protection of computer programs 

and/or source code. 

(d) Person.  The term “Person” shall 

mean an individual, a partnership, a 

company, a corporation, an 

association, a joint stock company, a 

trust, a joint venture, an 

unincorporated organization, or a 

governmental entity (or any 

department, agency, or political 

subdivision thereof). 

 

(e) Software.  The term “Software” shall 

mean the software application entitled 

Software for Wireless Monitoring 

System V/T, SKF @ptitude Analyst, 

SKF @ptitude Inspector, SKF @ptitude 

Observer, SKF @ptitude Decision 

Support or any other software within 

the SKF @ptitude family suite, which 

is an application developed, owned, 

marketed, and licensed by Licensor.  

The term Software shall include the 

object code of Software for Wireless 

Monitoring System V/T, SKF @ptitude 

Analyst, SKF @ptitude Inspector, SKF 

@ptitude Observer, SKF @ptitude 

Decision Support or any other object 

code within the SKF @ptitude family 

suite and any and all user manuals, or 

other technical documentation, 

authored by Licensor in connection 

with Software for Wireless Monitoring 

System V/T, SKF @ptitude Analyst, 

SKF @ptitude Inspector, SKF @ptitude 

Observer, SKF @ptitude Decision 

Support or any other software within 

the SKF @ptitude family.  The term 

“Software” includes any corrections, 

bug fixes, enhancements, releases, 

updates, upgrades, or other 

modifications, including custom 

modifications, to Software for 

Wireless Monitoring System V/T, SKF 

@ptitude Analyst, SKF @ptitude 

Inspector, SKF @ptitude Observer, 

SKF @ptitude Decision Support or any 

other software within the SKF 

@ptitude family suite and any and all 

user manuals.  The term Software 

also includes any supplemental, add-

on, or plug-in software code provided 



to Licensee in the course of receiving 

Product Support Plan services from 

Licensor.  The term Software shall not 

be construed to include the source 

code for Software for Wireless 

Monitoring System V/T, SKF @ptitude 

Analyst, SKF @ptitude Inspector, SKF 

@ptitude Observer, SKF @ptitude 

Decision Support or any other 

software within the SKF @ptitude 

family suite. 

 

2. LICENSE 

 

(a)  Grant of License.  Licensor grants 

Licensee, pursuant to the terms and 

conditions of this Agreement, a non-

exclusive, non-transferable, and 

revocable license to use the Software 

in strict accordance with the terms 

and conditions of this Agreement, 

including any concurrent use, network 

or other limitations set forth in 

subsection (b) below.  All rights not 

specifically granted by Licensor under 

this Agreement are retained by 

Licensor and withheld from Licensee. 

 

(b) Installation and Use Rights.  

Licensee shall use the Software only 

on its internal computer equipment, 

whether such equipment is owned, 

leased, or rented, at the Licensee’s 

principal business office.  The 

following paragraphs govern your 

installation and use rights with regard 

to the Software, depending on the 

type of license you have obtained from 

Licensor. 

 

(i) If you obtained a stand-alone 

license of the Software, you 

may install one (1) copy of the 

Software on one (1) computer 

residing in your principal 

business office. 

 

(ii) If you obtained a network 

license of the Software, you 

may install one (1) copy of the 

Software on as many 

networked clients 

(workstations) as authorized 

by your network license, as set 

forth more particularly in the 

applicable purchase order or 

other ordering documents 

memorializing your license 

acquisition; provided, however, 

that all network clients 

(workstations) are connected 

to a single licensed database 

residing in your principal 

business office. 

 

(iii) If you obtained a network 

license of the Software, you 

may connect to multiple 

licensed databases, you may 

install the database-dedicated 

clients up to the total number 

of networked clients acquired 

by you under the applicable 

purchase order or other 

ordering documents 

memorializing your license 

acquisition. 

 

(c) Other Conditions of Use.  Licensor 

understands and agrees that the 

Software works in conjunction and is 

compatible with database software 

licensed to you by Microsoft or 

Oracle.  Upon installation of the 

Software, the Software may detect 

an installed database software 

application from Oracle or Microsoft, 

and if so, the Software will be fully 

installed.  If no installed database 

software application from Oracle or 

Microsoft is detected, the Software 

will not install until such time as 

Licensee installs a valid and Software 

compatible copy of an Oracle 

database or a Microsoft SQL Server 

database and consents to the license 

terms of such database software 

application.  If Licensee does not 

agree to the terms of the the Oracle 

database license or the Microsoft 



SQL Server license, or if the Licensee 

fails to install such database 

software, the Software will not work.  

Licensee is responsible for 

maintaining a valid database license 

in accordance with the Oracle or 

Microsoft license agreement (which 

ever is applicable) at all times. 

 

(d) Restrictions on Use.  Licensee may 

use the Software only for its internal 

business purposes and on the 

identified equipment on which the 

Software was first installed or for 

which it is otherwise licensed; 

provided, however, that Licensee 

may temporarily use the Software on 

a back-up system in the event that 

the primary licensed system is 

inoperative or test system not used 

for production but solely for the 

purposes of testing the Software.  

Licensee may not use the Software 

for any other purpose.  Licensee shall 

not: 

 

(i)  permit any parent, 

subsidiaries, affiliated entities 

or third parties to use the 

Software; 

 

(ii) use the Software in the 

operation of a service bureau; 

 

(iii) allow access to the Software 

through any workstations 

located outside of Licensee’s 

principal business offices; 

 

(iv) rent, resell, lease, timeshare 

or lend the Software to any 

Person; 

 

(v) sublicense, assign, or transfer 

the Software or this license for 

the Software to any Person; 

 

(vi) reproduce, distribute, or 

publicly display the Software; 

 

(vii) make the Software accessible 

to any Person by any means, 

including posting on a web site 

or through other distribution 

mechanisms over the Internet; 

 

(viii) reverse assemble, 

disassemble, reverse engineer, 

reverse compile, decompile, or 

otherwise translate the 

Software or prepare 

Derivative Works based on the 

Software; 

 

(ix) place, reproduce, or make 

available the Software on 

Licensee’s computer network 

if Licensee is only authorized 

by this Agreement to operate 

the Software on a single 

workstation; 

 

(x) exceed at any given point in 

time the total number of 

network clients authorized by 

the applicable purchase order 

or ordering document to use 

or access the Software; 

 

(xi) edit or modify the Software 

except as expressly authorized 

by Licensor, including altering, 

deleting, or obscuring any 

proprietary rights notices 

embedded in or affixed to the 

Software; 

 

(xii) use the Software in any 

manner that disparages 

Licensor, Microsoft, or Oracle, 

or use the Software in a way 

that infringes the Intellectual 

Property Rights of the 

foregoing parties; or 

 

(xiii) use the Software in a manner 

that violates any federal, state, 

or local law, rule or regulation, 

or use the Software to violate 

the rights of any third party, or 



use the Software to promote 

pornography, hatred, or 

racism. 

 

(e) Copies.  Licensee, solely to enable it 

to use the Software, may make one 

archival copy of the Software’s 

computer program, provided that the 

copy shall include Licensor’s copyright 

and any other proprietary notices.  

The Software delivered by Licensor to 

Licensee and the archival copy shall 

be stored at Licensee’s principal 

business office.  If you purchased a 

network license of the Software, you 

may install one additional copy of the 

Software on your network for the 

limited purpose of testing the 

Software’s operation.  Except for the 

limited reproduction rights set forth in 

this paragraph, Licensee shall have no 

other right to copy, in whole or in part, 

the Software.  Any copy of the 

Software made by Licensee is the 

exclusive property of Licensor. 

 

(f) Modifications.  Licensee agrees that 

only Licensor shall have the right to 

alter, maintain, enhance or otherwise 

modify the Software. 

 

(g) Protection of Software.  Licensee 

agrees that it will take action by 

instruction, written agreement, or 

otherwise as appropriate with any 

person permitted access to the 

Software to enable Licensee to comply 

with its obligations hereunder.  

Licensee shall maintain records of the 

number and location of all copies of 

Software.  Licensee shall not provide, 

permit access to or use of, or 

otherwise make available any 

Software in any form without 

Licensor’s prior written agreement, 

except to Licensee’s employees for 

purposes specifically authorized by 

this Agreement.  Licensee 

understands and agrees that the 

source code for the Software is a 

valuable copyright and contains 

valuable trade secrets of Licensor.  

Licensee agrees not to discover or 

attempt to discover, or assist or 

permit any Person to discover or 

attempt to discover, by any means 

whatsoever the source code of the 

Software. 

 

(h) Licensor’s Audit Rights.  Licensor 

shall possess the right to audit 

Licensee’s use of the Software to 

determine compliance with this 

Agreement (hereinafter referred to as 

“Licensor’s Audit Rights”).  Licensor’s 

Audit Rights shall be exercised in 

accordance with the following 

paragraphs: 

 

(i) Notice of Audit.  Licensor 

shall provide Licensee with at 

least five (5) calendar days 

advance written notice of its 

intent to exercise the 

Licensor’s Audit Rights. 

 

(ii) Conduct of Audit.  The audit 

conducted by Licensor shall 

consist of a physical review of 

the computer hardware, 

software, and middleware 

operated by Licensee at its 

principal business office and 

any other office for which 

Licensor, in its sole and 

arbitrary discretion, deems an 

audit appropriate.  Licensee 

shall provide Licensor with 

unrestricted access to its 

computer hardware, software, 

and middleware in connection 

with any audit conducted by 

Licensor. 

 

(iii) Costs of Audit.  If Licensor’s 

audit uncovers a violation of 

this Agreement by Licensee, 

Licensee shall pay all costs 

and expenses incurred by 

Licensor in exercising the 



Licensor Audit Rights, 

including, without limitation, 

all attorneys’ fees and agent 

fees incurred by Licensor.  If 

Licensor concludes that no 

violation of this License 

Agreement has occurred, 

Licensor shall bear all costs 

and expenses incurred in 

exercising the Licensor Audit 

Rights.  If Licensee obstructs, 

restricts, or otherwise 

prevents Licensor from 

conducting a full and 

unrestricted audit, Licensee 

shall bear all costs and 

expenses, including attorneys’ 

fees, incurred by Licensor in 

enforcing this Section 2(h) 

before any court or judicial 

tribunal. 

 

(iv) Frequency of Audits.  

Licensor’s Audit Rights shall be 

exercised no more than two 

(2) times in any one calendar 

year.  

 

(i) Validity of Intellectual Property 

Rights.  In any action, dispute, 

controversy, or lawsuit arising out of 

or related to this Agreement, Licensee 

shall not contest the validity of 

Licensor’s Intellectual Property Rights 

related to the Software.  Licensee 

hereby agrees that it has had an 

opportunity to investigate the validity 

of Licensor’s Intellectual Property 

Rights, and acknowledges that 

Licensor’s Intellectual Property Rights 

related to the Software are valid and 

enforceable. 

 

(j) Material Terms and Conditions.  

Licensee specifically agrees that each 

of the terms and conditions of this 

Section 2 are material and that failure 

of Licensee to comply with these 

terms and conditions shall constitute 

sufficient cause for Licensor to 

terminate this Agreement and the 

license granted hereunder 

immediately and without an 

opportunity to cure.  This subsection 

2(j) shall not be construed to preclude, 

or in any way effect, a finding of 

materiality with respect to any other 

provision of this Agreement. 

 

3.   LICENSE FEE 

The applicable licensee fees will be set forth 

in the quote issued to Licensee by Licensor 

or otherwise established in the applicable 

purchase order or other ordering 

documents memorializing your license 

acquisition. 

 

4.   OWNERSHIP 

 

(a) Title.  Licensee understands and 

agrees that Licensor owns all 

Intellectual Property Rights related to 

the Software, including custom 

modifications to the Software, 

whether made by Licensor or any 

third party.  Licensee agrees that this 

Agreement effects a license, not a 

sale, of the Software and that the first 

sale doctrine, as codified in 17 U.S.C. 

§ 109, does not apply to the 

transaction effected by this 

Agreement. 

 

(b) Transfers.  Under no circumstances 

shall Licensee sell, license, sublicense, 

publish, display, distribute, assign, or 

otherwise transfer (hereinafter 

referred to collectively as a “Transfer”) 

to a third party the Software or any 

copy thereof, in whole or in part, 

without Licensor’s prior written 

consent.  Any Transfer effected in 

violation of this Section 4(b) shall be 

void ab initio and of no force or effect. 

 

5. MAINTENANCE AND SUPPORT 

Licensor may provide you with support 

services related to the Software called 

Product Support Plan (“PSP”) services.  Use 

of PSP is governed by the policies and 



programs described in the PSP literature or 

other material from Licensor’s Product 

Support Department (hereinafter referred 

to as the “PSP Policies”) that may be 

updated by Licensor from time to time. If 

you select and pay for PSP, the PSP 

Policies shall be specifically incorporated 

into this Agreement by this reference.  

Licensee acknowledges that Licensor may 

use any technical information provided by 

Licensee in the course of receiving PSP 

services for Licensor’s business purposes, 

including for product support and 

development.  Licensor will not utilize such 

technical information in a manner that 

identifies Licensee. 

 

6. CONFIDENTIAL INFORMATION 

Licensee agrees that the Software contains 

proprietary information, including trade 

secrets, know-how and confidential 

information (hereinafter referred to 

collectively as the “Confidential 

Information”), that is the exclusive property 

of Licensor.  During the period this 

Agreement is in effect and at all times after 

its termination, Licensee and its employees 

and agents shall maintain the confidentiality 

of the Confidential Information and shall not 

sell, license, publish, display, distribute, 

disclose or otherwise make available the 

Confidential Information to any Person nor 

use the Confidential Information except as 

authorized by this Agreement.  Licensee 

shall not disclose the Confidential 

Information concerning the Software, 

including any flow charts, logic diagrams, 

user manuals and screens, to persons not 

an employee of Licensee without the prior 

written consent of Licensor. 

 

7.   LIMITED WARRANTIES 

 

(a) Licensor warrants that the Software 

will perform substantially in 

accordance with its documentation for 

a period of 180 days from the date of 

shipment of the Software; provided, 

however, that the foregoing warranty 

only applies if: (i) Licensee makes 

Licensor aware of any defect with the 

Software within seven (7) days after 

the occurrence of the defect; (ii) 

Licensee has paid all amounts due 

under this Agreement; and (iii) 

Licensee has not breached any 

provision of this Agreement.  The 

foregoing warranty does not apply in 

the event that: (i) the Software and 

documentation have been subject to 

misuse, neglect, alteration, 

modification, customization, improper 

installation, and/or unauthorized 

repair; (ii) the Software or any 

associated software or equipment 

have not been properly maintained in 

accordance with applicable 

specifications and industry standards 

or have been maintained in unsuitable 

environmental conditions; or (iii) 

Licensee has used the Software in 

conjunction with other equipment, 

hardware, software, or other 

technology that created an adverse 

impact on the operation, functioning, 

or performance of the Software. 

 

(b) EXCEPT AS SET FORTH IN THIS 

SECTION 7 AND TO THE EXTENT 

PERMITTED BY APPLICABLE LAW, 

ALL EXPRESS AND/OR IMPLIED 

WARRANTIES OR CONDITIONS, 

INCLUDING BUT NOT LIMITED TO 

IMPLIED WARRANTIES OR 

CONDITIONS OF MERCHANTABILITY, 

MERCHANTABILITY OF A COMPUTER 

PROGRAM, INFORMATIONAL 

CONTENT, SYSTEM INTEGRATION, 

FITNESS FOR A PARTICULAR 

PURPOSE, AND NON-

INFRINGEMENT, ARE HEREBY 

DISCLAIMED AND EXCLUDED BY 

LICENSOR. 

 

(c) The remedies set forth in this Section 

7 are the exclusive remedies available 

to Licensee for any problem in the 

performance of the Software. 

 



8.   LIMITATIONS ON LIABILITY 

 

(a) Limitations and Exclusions.  IN NO 

EVENT WILL LICENSOR BE LIABLE 

TO LICENSEE FOR ANY DIRECT, 

INDIRECT, INCIDENTAL, 

CONSEQUENTIAL, PUNITIVE OR 

OTHER SPECIAL DAMAGES, LOST 

PROFITS, OR LOSS OF INFORMATION 

SUFFERED BY LICENSEE ARISING 

OUT OF OR RELATED TO THIS 

AGREEMENT OR THE USE OF THE 

SOFTWARE, FOR ALL CAUSES OF 

ACTION OF ANY KIND (INCLUDING 

TORT, CONTRACT, NEGLIGENCE, 

STRICT LIABILITY, BREACH OF 

WARRANTY OR CONDITION, AND 

STATUTORY) EVEN IF LICENSOR HAS 

BEEN ADVISED OF THE POSSIBILITY 

OF SUCH DAMAGES.  THE 

PRECEDING EXCLUSION AND 

DISCLAIMER OF DAMAGES SHALL 

APPLY TO ALL CLAIMS MADE BY 

LICENSEE RELATED TO OR ARISING 

OUT OF LICENSEE’s USE OF THE 

SOFTWARE, INCLUDING, BUT NOT 

LIMITED TO, CLAIMS ALLEGING THAT 

THE SOFTWARE, OR ANY 

COMPONENT THEREOF, FAILED OF 

ITS ESSENTIAL PURPOSE OR FAILED 

IN SOME OTHER RESPECT. 

 

(b) Acknowledgment.  Licensee agrees 

that the limitations of liability and 

disclaimers of warranty set forth in 

this Agreement will apply regardless 

of whether Licensor has tendered 

delivery of the Software or Licensee 

has accepted the Software.  Licensee 

acknowledges that Licensor has set its 

prices and entered into this 

Agreement in reliance on the 

disclaimers of warranty and the 

limitations and exclusions of liability 

set forth in this Agreement and that 

the same form an essential basis of 

the bargain between the Parties. 

 

9.   TERM AND TERMINATION 

 

(a) Term.  This Agreement shall 

commence on the Effective Date and 

shall continue in existence until it is 

terminated in accordance with Section 

9(b) below. 

 

(b) Termination.  Licensor may 

terminate this Agreement and the 

license conveyed hereunder in the 

event that Licensee breaches any 

provision, term, condition, or 

limitation set forth in this Agreement, 

including but not limited to the license 

restrictions set forth in Section 2(d) of 

this Agreement. 

 

(c) Effect of Termination.  Within ten 

(10) days after termination of this 

Agreement and the license granted 

hereunder, Licensee shall return to 

Licensor, at Licensee’s expense, the 

Software and all copies thereof, and 

deliver to Licensor a certification, in 

writing signed by an officer of 

Licensee, that all copies of the 

Software have been returned to 

Licensor and that Licensee has 

discontinued its use of the Software. 

 

10. ASSIGNMENT 

 Licensee shall not assign or otherwise 

transfer the Software or this Agreement to 

anyone, including any parent, subsidiaries, 

affiliated entities or third Parties, or as 

part of the sale of any portion of its 

business, or pursuant to any merger, 

consolidation or reorganization, without 

Licensor’s prior written consent.  Any 

assignment or transfer effected in violation 

of this Section 10 shall be void ab initio 

and of no force or effect. 

 

11. FORCE MAJEURE 

 Neither party shall be in default or 

otherwise liable for any delay in or failure 

of its performance under this Agreement if 

such delay or failure arises by any reason 

beyond its reasonable control, including 



any act of God, any acts of the common 

enemy, the elements, earthquakes, floods, 

fires, epidemics, riots, failures or delay in 

transportation or  communications; 

provided, however, that lack of funds shall 

not be deemed to be a reason beyond a 

party’s reasonable control.  The Parties 

will promptly inform and consult with each 

other as to any of the above causes that in 

their judgment may or could be the cause 

of a delay in the performance of this 

Agreement. 

 

12. NOTICES 

 All notices under this Agreement are to be 

delivered by depositing the notice in the 

mail, using registered mail, return receipt 

requested, to the party’s last known 

principal business address or to any other 

address as the party may designate by 

providing notice.  The notice shall be 

deemed delivered four (4) days after the 

notice’s deposit in the mail, if such notice 

has been sent by registered mail. 

 

13. CHOICE OF LAW 

 This Agreement (including all Exhibits), 

including its formation, execution, 

interpretation, and performance, and the 

rights and obligations of the Parties 

hereunder, shall be governed by and 

construed in accordance with the laws of 

the Commonwealth of Pennsylvania, 

without regard to any conflicts of law (or 

choice of law) principles thereof. 

 

14. CONSENT TO JURISDICTION 

 In the event that either party initiates 

litigation relating to or arising out of this 

Agreement, Licensor and Licensee 

irrevocably submit to the exclusive 

jurisdiction of the state or federal court in 

or for Philadelphia, Pennsylvania for the 

purposes of any suit, action or other 

proceeding relating to arising out of this 

Agreement or any transaction 

contemplated hereby or thereby (“Legal 

Proceedings”).  Licensee further agree that 

service of any process, summons, notice, 

or document by U.S. registered mail to 

such Party’s respective address shall be 

effective service of process for any Legal 

Proceeding.  Licensor and Licensee 

irrevocably and unconditionally waive any 

objection to personal jurisdiction and/or 

the laying of venue of any Legal 

Proceeding in the state or federal court in 

or for Philadelphia, Pennsylvania, and 

hereby further irrevocably and 

unconditionally agree not to plead, argue, 

or claim in any such court that any Legal 

Proceeding brought in any such court has 

been brought in an inconvenient forum 

and otherwise waive any and all objections 

to the forum. 

 

15. EXPORT CONTROLS 

 Licensee shall not export or reexport, 

directly or indirectly, the Software without 

complying with the export controls 

imposed by the United States Export 

Administration Act of 1979, as amended 

(or any future U.S. export control 

legislation) and the regulations 

promulgated thereunder.  

 

16. GOVERNMENT END USERS 

 If Licensee is acquiring the Software for or 

on behalf of a subdivision of the U.S. 

federal government, this Section 16 shall 

apply.  The Software was developed 

completely at private expense, is existing 

computer software, is a trade secret for all 

purposes of the Freedom of Information 

Act, is “restricted computer software” and 

in all respects proprietary data belonging 

solely to Licensor, and all rights are 

reserved under the copyright laws of the 

United States.  Use, duplication, or 

disclosure by the Government is subject to 

restricted rights as set forth in 

subparagraphs (a) through (d) of the 

Commercial Computer Software Restricted 

Rights clause at FAR 52.227-19, or for 

DoD units, the restrictions as set forth in 

subparagraph (c)(1)(ii) of the Rights in 

Technical Data and Computer Software 

clause at DFARS 252.227-7013. 

 



17. TRADEMARKS 

 Licensee agrees that SKF @ptitude 

Analyst, SKF @ptitude Inspector, SKF 

@ptitude Observer, SKF @ptitude Decision 

Support or any other software within the 

SKF @ptitude family suite and the trade 

dress, logos and other designations of 

source used by Licensor to identify the 

Software are trademarks or registered 

trademarks of Licensor.  Licensee shall not 

use Licensor’s trademarks or service 

marks without the prior written consent of 

Licensor.  If the Software contains any 

active links to web sites, you agree to 

maintain such active links and not redirect 

or modify them. 

 

18. GENERAL PROVISIONS 

 

(a)  Complete Agreement.  The Parties 

agree that this Agreement is the 

complete and exclusive statement of 

the agreement between the Parties, 

which supersedes and merges all 

prior proposals, understandings and 

all other agreements, oral or written, 

between the Parties relating to the 

use of the Software. 

 

(b) Amendment.  This Agreement may 

not be modified, altered or amended 

except by written instrument duly 

executed by both Parties.  Any 

purchase orders or other ordering 

documents issued to Licensee by 

Licensor shall not have the effect of 

amending or modifying this 

Agreement, and shall only serve to 

memorialize the number of licenses 

or products ordered by Licensee.  In 

the event of a conflict between the 

PSP Policies and this Agreement, the 

terms of this Agreement shall 

control. 

 

(c) Waiver.  The waiver or failure of 

either party to exercise in any respect 

any right provided for in this 

Agreement shall not be deemed a 

waiver of any further right under this 

Agreement. 

 

(d) Severability.  If any provision of this 

Agreement is invalid, illegal or 

unenforceable under any applicable 

statute or rule of law, it is to that 

extent to be deemed omitted.  The 

remainder of the Agreement shall be 

valid and enforceable to the 

maximum extent possible. 

 

(e) Read and Understood.  Each party 

acknowledges that it has read and 

understands this Agreement and 

agrees to be bound by its terms. 

 

(f) Limitations Period.  No action 

arising under, or related to, this 

Agreement, may be brought by 

either party against the other more 

than two (2) years after the cause of 

action accrues, unless the cause of 

action involves death or personal 

injury. 

 

(g) Attorneys’ Fees.  In the event any 

litigation is brought by either party in 

connection with this Agreement, the 

prevailing party in such litigation will 

be entitled to recover from the other 

party all the costs, reasonable 

attorneys’ fees, and other expenses 

incurred by such prevailing party in 

the litigation. 

 

(h) Authorized Representative.  The 

person installing or using the 

Software on behalf of Licensee 

represents and warrants that he or 

she is legally authorized to bind 

Licensee and commit Licensee to the 

terms of this Agreement. 

 

(i) Injunctive Relief.  Licensee agrees 

that Licensor may suffer irreparable 

harm as a result of a violation of 

Sections 2, 4, 6, 10, 15, and 17 of 

this Agreement and that monetary 

damages in such event would be 



substantial and inadequate to 

compensate Licensor.  Consequently, 

Licensor shall be entitled to seek and 

obtain, in addition to such other 

monetary relief as may be 

recoverable at law or in equity, such 

injunctive other equitable relief as 

may be necessary to restrain any 

threatened, continuing, or further 

breach by Licensee without showing 

or proving actual damages sustained 

by Licensor and without posting a 

bond. 

 

CM-F0176 (Revision F, January 2011) 
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Introduction to SKF @ptitude Analyst and SKF Multilog 

On-line Systems 

About This Manual 

The SKF @ptitude Analyst and SKF Multilog On-line Systems manual describes the 

operation of online and protection systems supported in @ptitude Analyst.  In these 

pages you will find information on the operation of the: 

 Multilog Wireless Monitoring System (WMx) 

 Multilog IMx Monitoring System (IMx) 

 Multilog DMx Machine Monitoring System (DMx) 

and their @ptitude Analyst for Multilog On-line Systems features.   

 For the purposes of this documentation, all supported online 

systems are included in the Multilog On-line Systems category. 

Since all On-line features work in conjunction with standard @ptitude Analyst 

operations, you should be familiar with @ptitude Analyst and its sections before using 

@ptitude Analyst software. 

The @ptitude Analyst and Multilog On-line Systems manual is organized as follows: 

Chapter 1, Introduction - Introduces manual conventions and overviews the @ptitude 

Analyst Software and the On-line Systems. 

Chapter 2, Setting Up Your WMx Device – Describes how to manage your WMx 

devices in @ptitude Analyst.   

Chapter 3, Working With Your @ptitude Analyst Hierarchy – Describes in detail how 

to organize your machinery measurement POINTs into @ptitude Analyst hierarchies, 

SETs, machines, and POINTs.  Also details how to establish @ptitude Analyst’s many 

alarm criteria.  Describes Hierarchy editing procedures using @ptitude Analyst’s 

Templates, Modify by Attribute feature, and Filters. 

Chapter 4, Data Collection ROUTEs and Other Data Transfer 

Operations - Describes how to create @ptitude Analyst measurement collection 

ROUTEs, how to download ROUTEs to the data collection devices, how to upload 

measurements from the data collection devices, and how to manually enter data into 

the @ptitude Analyst Hierarchy. 

Chapter 5, Displaying Graphic Plots - Describes methods for displaying collected 

machinery measurements in graphic plot format, and describes in detail @ptitude 

Analyst’s menu options for manipulating graphic plots to obtain useful analysis data. 

Chapter 6, Generating and Printing SKF @ptitude Analyst Reports - Describes in 

detail how to create report templates and how to generate and print @ptitude Analyst 

reports. 
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Chapter 7, Multilog DMx Machine Monitoring Module - Provides an overview of 

@ptitude Analyst configuration for DMx Machine Monitoring System 

Chapter 8, Transient Data Analysis - Describes setup and collection methods for run-

up and coast-down data. 

Appendix A, SKF @ptitude Analyst Toolbars - Offers an overview of @ptitude 

Analyst’s toolbars and details the custom toolbar creation procedure. 

Appendix B, Event Log Redirection - Describes Event Log redirection codes and 

terminology. 

Appendix C, Data Collection Gating – Describes the data collection gating methods for 

the online systems. 

Technical Support  

If you have questions regarding the installation or operation of SKF @ptitude Analyst, 

please visit the self-help portal before contacting the help desk to see if the answer is 

already published:  . 

Technical Support Self-help Portal: www.skf.com/cm/tsg  

If further assistance is needed, please submit a support request by clicking on the 

SUPPORT tab and one of our support engineers will contact you shortly.  

The technical support team can be reached during normal business hours (7:00 a.m. to 

4:00 p.m. local time) by phone, e-mail, or live chat:  

 Customers in Europe, Middle East and Africa:  

Phone: +46 31 337 6500  

E-Mail: TSG-EMEA@skf.com  

Chat: www.skf.com/cm/tsg  

 Customers in all other locations:  

Phone: 1-858-496-3627 or toll-free (USA) 1-800-523-7514  

E-Mail: TSG-Americas@skf.com   

Chat: www.skf.com/cm/tsg  

Note: Standard technical support will be provided at no cost on products or software 

covered under an SKF Product Support Plan (PSP), whenever applicable.  Many SKF 

Machine Health products include limited technical support for the first 180 days after 

purchase.  Support obtained after 180 days or without PSP coverage will be Support 

obtained after 180 days or without PSP coverage will be subject to a per-incident fee. 

Contact the technical support team for more information.  

Definition of On-line Systems 

Throughout this @ptitude Analyst manual, SKF's Multilog IMx Monitoring System, 

Multilog WMx Monitoring System, and Multilog DMx Monitoring System are referred to 

as SKF's On-line Systems. 

http://www.skf.com/cm/tsg
mailto:TSG-EMEA@skf.com
http://www.skf.com/cm/tsg
mailto:TSG-Americas@skf.com
http://www.skf.com/cm/tsg
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References specific to the IMx Machine Monitoring System use the term IMx.  

References specific to the WMx Machine Monitoring System use the term WMx.  

References specific to the DMx Machine Monitoring System use the term DMx. 

References that apply to the WMx, IMx, and DMx systems use the general term “on-line 

device.” 

Each of these systems is discussed in detail later in this introduction chapter. 

What is the SKF @ptitude Analyst and On-line Systems System? 

An SKF @ptitude Analyst and On-line Systems System consists of the following 

components: 

1. A WMx, IMx, or DMx 

2. @ptitude IMx Service, @ptitude WMx Service, or @ptitude Analyst Monitor (for 

DMx) 

3. A host computer with: 

- an Ethernet connection (for IMx or DMx) or wireless network access (for WMx) 

- the appropriate Windows OS drivers 

- @ptitude Analyst 

Communications 

An Ethernet (TCP / IP) connection allows you to create a network consisting of several 

PCs and IMxs / DMxs. The Ethernet connection type is only available for use with IMxs 

or DMxs. 

 A single PC running the @ptitude IMx Service can communicate with the IMxs and 

with several additional PCs running @ptitude Analyst software via the Ethernet 

connection. 

 A single PC running the @ptitude Analyst Monitor application can communicate 

with the DMxs and with several additional PCs running @ptitude Analyst software 

via the Ethernet connection. 

 A DMx does not natively talk Ethernet and must therefore rely on 

a 9420 B&B Ethernet Gateway to convert from RS485 to 

Ethernet. 

The online devices behave like any other peripherals on the intranet (for instance, a 

laser printer).   

For detailed communication protocol installation information, refer to your on-line 

device’s installation manual. 
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The Host Computer 

The host computer has Microsoft Windows 7, 8.1 or 10, an Intel 2.0 GHz, 32 or 64-bit, 

or better processor,  with 6 or more GB of RAM, and a 30 Gbyte hard disk (minimum 10 

Gbyte); and enough free disk space to store your @ptitude Analyst for On-line Systems 

measurement Hierarchy (whose size depends on the number of monitored 

measurement POINTs).  Together, the host computer and @ptitude Analyst software 

perform Hierarchy management, trending, display, and reporting functions for the On-

line System. 

For further details, refer to the SKF @ptitude Analyst Installation Manual (P/N 

32312400). 

SKF @ptitude Analyst Software 

The easy-to-use @ptitude Analyst software works with DADs (Data Acquisition Devices) 

to assist machinery maintenance personnel in managing and analyzing their collected 

data.  @ptitude Analyst automatically uploads measurement data from DADs and 

performs the tedious clerical work required in sorting, storing, and pre-analyzing 

measurement data.  Use @ptitude Analyst to easily configure measurement POINTs (a 

machinery location at which measurement data is collected), for downloading 

measurement POINT setups to DADs, for Hierarchy manipulation of collected data, and 

to graphically display and generate reports on collected measurement data. 

Exception Reports - @ptitude Analyst automatically compares current measurement 

values to past measurement values, and to pre-defined alarm values to detect changes 

from normal machinery conditions.  Using hierarchy list alarm status indicators and 

detailed printed reports, @ptitude Analyst alerts maintenance personnel to alarm 

conditions (exceptions from normal conditions). 

Analysis - @ptitude Analyst displays and prints various plots and reports for analyzing 

machinery condition. 



 Introduction to SKF @ptitude Analyst and SKF Multilog On-line Systems 

 SKF @ptitude Analyst Software 

SKF @ptitude Analyst and SKF Multilog On-line Systems 1 - 5 

User Manual 

 

Figure 1 - 1. 

Two Graphic Displays of an @ptitude Analyst Measurement. 

Trend plots, FFT spectra (including waterfall and palogram plots), time waveforms, 

polar vector plots, and other plot types are easily displayed to help determine if 

machinery condition changes are occurring, and if so, to help with analyzing the cause 

of machinery condition changes. 

For the easiest and most effective use of the On-line System, you should: 

Use @ptitude Analyst to: 

 Organize your hierarchy into SETs and machines. 

 Add measurement POINTs to these Hierarchy machines, configuring each POINT's 

measurement and alarm settings as it is created. 

 Download the measurement POINTs to the On-line System.  

Use the On-line System to: 

 Collect measurement data and detect alarms. 

Use @ptitude Analyst to: 

 Upload the collected data to @ptitude Analyst software. 

 Run alarm detection features to quickly scan for abnormal machine conditions. 

 Generate plots and reports to analyze, trend, report, and store measurement data. 
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The IMx System 

Together with SKF @ptitude Analyst software, the SKF Multilog On-line System IMx 

provides a complete on-line system for early fault detection and prevention, automatic 

advice for correcting existing or impending conditions, and advanced condition-based 

maintenance to improve reliability, availability, and performance.  @ptitude Analyst 

supports five IMx units: the IMx-8, IMx-M, IMx-P, IMx-S, and IMx-T.  

The IMx-8 

The IMx-8 is a cost effective 8 channel condition monitoring device which offers an 

optimized size when less than 16 channels are required. The IMx-8 is certified for wind 

power and marine industry environments, but can also be used across multiple 

segments. The device comes as a DIN rail mounted unit or inside an IP65 box.  

The IMx-8 is key component and flexible on-line condition monitoring system tool for 

rotating machinery applications, such as turbines, motors, pumps, fans, gearboxes, etc. 

This enables acquired data trending and analysis, ensuring early identification of 

potential defects and the subsequent prevention of catastrophic machine failures. 

The IMx-8 has eight analogue inputs with input range of ±25 V. All channels are 

referenced to chassis/enclosure ground (all channels grounds are connected). The 

analogue input supports 2-wire ICP-type sensors (for example, accelerometers) with its 

internal power supply. The analogue input can also interface other 2-wire voltage 

output sensors with external power supply. Other types of sensors can be interfaced 

using external adapters. 

The IMx-8 has two digital inputs. These digital inputs can interface with most standard 

types of digital inputs/sensors. The digital input can interface with 2- or 3-wired speed 

sensors and/or CMCP 2505 (Eddy probe converters). All channels are referenced to 

chassis/enclosure ground. 

The IMx-8 connects only with firmware v6.0 or later.  

SKF also provides the SKF Multilog IMx Manager app for iOS and Android. The app 

provides features to manage and configure the IMx system and to visualize 

measurement data. The SKF Multilog IMx Manager connects to the IMx-8 device via 

Bluetooth.  

The IMx-M 

The SKF Multilog On-line System IMx-M is a powerful, cost effective solution for a 

variety of machinery monitoring applications.  Together, with SKF @ptitude Analyst, the 

IMx-M can provide a complete system for initiation of machinery shutdown, early fault 

detection, and diagnosis.  In addition, the SKF Multilog On-line IMx-M system provides 

automated advice for correcting existing or impending conditions which can affect 

machine reliability, availability, and performance.  Each SKF Multilog IMx-M is equipped 

with four cards: up to 64 analog inputs (dynamic and static), 32 digital / speed inputs, 

and 96 relay outputs.   
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The IMx-P 

The SKF Multilog On-line System IMx-P is portable and battery powered with a battery 

life of approximately four hours in continuous operation (mains powered).  The 16 

analog signal inputs are configurable for a wide variety of sensors.  Signals such as 

acceleration, velocity, and displacement or other parameters are easily adopted.  In 

addition to the analog channels, eight digital channels may be used for measuring 

speed, trigger, or digital status (for example, indicating when a measurement can take 

place).   

The SKF Multilog IMx-P can be used as a trouble-shooting device or as part of a 

condition monitoring system with several units together in a network. The system can 

also run in an existing LAN together with other computers, printers, servers, etc., or 

over the internet.  The unit’s unique built-in “hardware auto-diagnosis system” 

continuously checks all sensors, cabling and electronics for any faults, signal 

interruption, or power failure. Any malfunction triggers an alarm. If the main voltage 

fails or for some reason is disconnected, the battery power automatically takes over. In 

the case of system power failure, the system will automatically restart when the power 

returns. 

The IMx-S 

SKF Multilog On-line System IMx-S is a key component in an advanced condition 

monitoring system.  It is a robust measurement unit designed for tough industrial 

environments.  Each SKF Multilog IMx-S is equipped with 16 analog signal inputs and 

the SKF Multilog IMx-S 32 with 32 analogue signal inputs.  The dynamic signal inputs 

are configurable for a variety of sensors.  Signals such as acceleration, velocity and 

displacement or other parameters are easily adopted.  Each input can be configured for 

standard accelerometers, proximity probes, 4–20 mA or ±25 V.  

In addition to the analogue channels, 8 digital channels on the SKF Multilog IMx-S 16 

and 16 digital channels on the SKF Multilog IMx-S 32 may be used for measuring 

speed, trigger or digital status (e.g., indicating when a measurement can take place). 

Several measurement points may be attached to one channel and both AC and DC 

measurements can be measured on the same channel.  Individual conditions for 

warning and alarm may be set for each point.  Warning and alarm levels may be 

controlled by machine speed or load.   

The SKF Multilog IMx-S works as a machine condition monitoring system with several 

other units together in a network with SKF @ptitude Analyst.  The system can run in an 

existing LAN together with other computers, printers, servers, etc., or over the Internet.  

The unit’s unique built-in hardware auto-diagnosis system continuously checks all 

sensors, cabling and electronics for any faults, signal interruption, or power failure and 

any malfunctions triggers an alarm. In the case of system power failure, the system will 

automatically restart when the power returns. 

The IMx-T 

SKF Multilog On-line System IMx-T is a key component in an advanced condition 

monitoring system.  Designed to fit into a 19” rack enclosure, the Multilog IMx-T is 

equipped with 16-64 analogue signal inputs.  The dynamic signal inputs are 

configurable for a wide variety of sensors.  Signals such as acceleration, velocity and 
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displacement or other parameters are easily adopted.  Each input can be configured for 

ICP (accelerometers), 4-20 mA or ± 25 V.  

In addition to the analogue channels, 8-32 digital channels may be used for measuring 

speed, trigger or digital status (e.g., indicating when a measurement can take place).  

Several measurement points may be attached to one channel and both AC and DC 

measurements can be measured on the same channel.  Individual conditions for 

warning and alarm may be set for each point.  Warning and alarm levels may be 

controlled by machine speed or load.   

The Multilog IMx-T works as a machine condition monitoring system with several other 

units together in a network with SKF @ptitude Analyst.  The system can also run in an 

existing LAN together with other computers, printers, servers, etc., or over the Internet.  

The unit’s unique built-in hardware auto-diagnosis system continuously checks all 

sensors, cabling and electronics for any faults, signal interruption, or power failure.  Any 

malfunction triggers an alarm. In the case of system power failure, the system will 

automatically restart when the power returns. 

 

Figure 1 - 2. 

Example of a Condition Monitoring System. 

In the figure above, IMx units are connected using @ptitude LAN to @ptitude IMx 

Service.  @ptitude IMx Service is also connected to a LAN network.  Several @ptitude 

Analyst clients may be connected to this network.  It is also possible to connect different 

types of on-line devices in the same network, for example an IMx and WMx. 
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To set up your IMx system for data collection: 

 Install the IMx hardware.  Reference your IMx Hardware User Manual for details. 

 Identify the computer to run the SKF @ptitude IMx Service.  You will need this 

information for the following step. 

 Run SKF IMx Configurator.  Identify the IP addresses for the IMx and the computer 

running IMx Service.  You may need to contact your IT administrator to obtain IP 

address information. 

 Reference the SKF IMx Configurator manual for details. 

 Run the SKF @ptitude Analyst Configuration Tool to add an IMx Service to the 

system.  This step is necessary for setting up IMx devices in @ptitude Analyst.  You 

may add multiple services on the same computer.   

 Reference the SKF @ptitude Analyst Configuration Tool manual 

for details. 

 In @ptitude Analyst, set up your IMx devices, channels, and POINTs.  Create 

measurement ROUTEs and download measurement data to the IMx.  

Transaction Service 

SKF Transaction Service is a support application that runs in the “background.”  It is 

responsible for processing data received from the IMx, handling communication 

between @ptitude Analyst and IMx Service, and deleting POINTs on the IMx. SKF 

Transaction Service can also handle communication between @ptitude Analyst and 

@ptitude Analyst Monitor in an IMx system where data coming from the IMx is archived. 

IMx Service  

SKF Multilog IMx Service is also a support application that runs in the “background,” 

similar to @ptitude Analyst Monitor for the DMx.   

Each IMx Service communicates with a set of IMxs.  It is responsible for communicating 

with IMx devices, for processing data from IMxs and storing the data to the database.  

IMx Service uses the Transaction Service to report status information to @ptitude 

Analyst.   

The WMx System 

Together with SKF @ptitude Analyst software, the SKF Multilog On-line System WMx 

provides a complete on-line system for early fault detection and prevention, automatic 

advice for correcting existing or impending conditions, and advanced condition-based 

maintenance to improve reliability, availability, and performance.   

The WMx unit is a compact, eight-channel, temporarily / permanently mounted, battery 

powered on-line data acquisition unit that communicates using your existing wireless 

network.  It is ideal for monitoring machines in areas that are inaccessible, difficult or 

dangerous to reach, or where it would be expensive or hazardous to install cables. 
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Figure 1 - 3. 

WMx Network Overview. 

To set up your WMx system for data collection: 

 Install the WMx hardware.  Reference your WMx Hardware User Manual 

(PN 32343900) for details. 

 Identify the computer to run the SKF @ptitude WMx Service.  You will need this 

information for the following step. 

 Connect the WMx to the host computer using the supplied USB cable, and run the 

SKF Wireless Configuration Utility from the SKF @ptitude Analyst DVD’s Tools / 

WMx folder to set up the network configuration.  Reference your WMx Hardware 

User Manual for details. 

 You may download the Wireless Configuration Utility from the 

SKF website.  Select SKF Multilog WMx Series. 

 (Windows XP users only) The WMx USB device drivers are 

automatically installed when you install the WMx Configuration 

Utility or SKF @ptitude Analyst.  For proper USB driver 

installation, you must connect and power on the WMx device 

before installing the software.  When the Windows XP Found 

New Hardware Wizard displays, click Cancel and proceed with 

the software installation. If the WMx device is not available at the 

time of software installation, you must reinstall the device drivers 

when you first connect and power on the WMx.  When the 

Windows XP Found New Hardware Wizard displays, proceed 

through the wizard to reinstall the drivers from SKF @ptitude 

Analyst DVD’s Tools / WMx / WMx USB Drivers folder. 

 Run the SKF @ptitude Analyst Configuration Tool to add a WMx Service to the 

system.  This step is necessary for setting up WMx devices in @ptitude Analyst.  

You may only add one service on a computer.   

 Reference the SKF @ptitude Analyst Installation manual (PN 

32312400) for details. 

http://www.skf.com/group/products/condition-monitoring/condition-monitoring-product-support/condition-monitoring-product-downloads/skf-multilog-wmx-series/index.html
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 In @ptitude Analyst, set up your WMx devices, channels, and POINTs.  

Transaction Service 

SKF Transaction Service is a support application that runs in the “background.” It is 

responsible for processing data received from the WMx, handling communication 

between @ptitude Analyst and WMx Service, and deleting POINTs on the WMx. SKF 

Transaction Service can also handle communication between @ptitude Analyst and 

@ptitude Analyst Monitor in a WMx system where data coming from the WMx is 

archived. 

WMx Service  

SKF Multilog WMx Service is also a support application that runs in the “background,” 

similar to @ptitude Analyst Monitor for the DMx.   

Each WMx Service communicates with a set of WMxs.  It is responsible for 

communicating with WMx devices, for processing data from WMxs and storing the data 

to the database.  WMx Service uses the Transaction Service to report status information 

to @ptitude Analyst. 

 





 

SKF @ptitude Analyst and SKF Multilog On-line Systems 2 - 1 

User Manual 

2 

Setting Up Your WMx Device  

Management of your WMx devices takes place from the View menu’s WMx Device 

screen. 

Overview 

The WMx Device screen displays all WMx devices currently connected to @ptitude 

Analyst, and allows you to edit WMx device settings and channel settings.   

 To configure a new device’s network connection settings, use the 

@ptitude Analyst Configuration Tool’s WMx Service screen.   

To open the WMx Device screen: 

 Click the View menu’s WMx Device… option.  The WMx Device screen displays.   

The WMx Device screen is divided into two panes.  The left pane is set up in a 

hierarchical structure, displaying each device, and each device’s assigned channels, 

diagnostic POINTs, and Unassigned POINTs.  The right pane displays information for the 

item that is selected in the left pane.  Each hierarchy level is detailed in the sections that 

follow. 

 

Figure 2 - 1. 

The WMx Device Screen. 
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Fields include: 

Select items to view – Displays each connected WMx and its assigned channels and 

POINTs in a hierarchical structure.  Click an item to display its information in the right 

panel. 

Filter – Select None, By bad channel, or By name from the Filter drop-down list to 

filter the items that display in the left pane. 

None – All items display in the standard hierarchical structure. 

By bad channel – Only those channels which have collected BOV out of range 

data display in the left pane. 

By name – Enter the name of the item(s) you wish to display in the left pane. 

Refresh – Click to refresh the view. 

Print – Click to print a summary of the right panel view. 

Edit – Click to display the Device Properties screen and modify device and channel 

settings. 

Add – Click to display the Device Properties screen and add a new WMx device to 

@ptitude Analyst.   

 Adding a device allows you to set up and assign POINTs to the 

device before it is online.  The device must still be registered 

through the WMx Service before it can communicate with the 

@ptitude Analyst software. 

Remove – Click to remove the selected device.  When you remove a device from 

@ptitude Analyst, the device is automatically powered down.  Select Yes or No when 

prompted to continue with the removal. 

 When you remove a device from @ptitude Analyst, you should 

physically disconnect the device.  Otherwise, the next time you 

connect to the WMx Service, the device will reappear in @ptitude 

Analyst. 

Disable – Click to disable data collection for the selected device.  You are prompted to 

power down the device.  Select Yes, No, or Cancel. 

Yes – Disable and power down the device. 

No – Disable data collection only. 

Cancel – Abort disabling the device. 

Close – Click to exit the WMx Device screen. 
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WMx Devices Levels Overview 

When the WMx Devices level is selected in the left pane, the right pane displays three 

tabs – WMx Devices, Battery Status, and Network. 

 

Figure 2 - 2. 

The WMx Device Screen’s WMx Devices Tab. 

WMx Devices Tab 

The WMx Devices tab displays a list of WMxs currently connected to @ptitude Analyst.  

The name of the device, MAC address, device type (WMx / WVT), device IP address, last 

wakeup time, and next scheduled wakeup time display.  You may edit currently 

connected devices, remove / disable currently connected devices, or add a new device to 

@ptitude Analyst. 

To edit a device: 

 Select a device from the Devices list. 

 Click the Edit button.  The Device Properties screen displays. 

 Click the Device Setup and Channels tabs and edit as necessary. 

 Reference the Device Properties section later in this chapter for 

details. 
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To add a new WMx device: 

 Click the Add button.  The Device Properties screen displays. 

 Click the Device Setup or Channels tabs and edit as necessary. 

 Reference the Device Properties section later in this chapter for 

details. 

To remove a device: 

 Select a device from the Devices list. 

 Click the Remove button.  A message displays, informing you that the device is 

automatically powered down upon removal.   

 

Figure 2 - 3. 

Continue with removal prompt. 

 Click Yes or No when prompted to continue with the removal. 

To disable a device: 

 Select a device from the Devices list. 

 Click the Disable button.  A message displays, asking if you wish to power down the 

device.   

 

Figure 2 - 4. 

Continue with disable prompt. 

 Click Yes or No when prompted to continue with the disable. 
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Battery Status Tab 

The Battery Status tab displays the battery / power status for each connected WMx 

device. 

 

Figure 2 - 5. 

The WMx Device Screen’s Battery Status Tab. 

To edit a device’s battery information: 

 Select a device from the Devices list. 

 Click the Edit button.  The Device Properties screen displays. 

 Click the Device Setup tabs and edit the Battery information area as necessary. 

 Reference the Device Properties section later in this chapter for 

details. 
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Network Tab 

The Network tab displays the network connection and diagnostic information for each 

connected device. 

 

Figure 2 - 6. 

The WMx Device Screen’s Network Tab. 

 WMx network information is read-only in @ptitude Analyst’s WMx 

Device screen.  To modify your network settings reference the 

SKF @ptitude Analyst Installation Manual for details. 

To view more network information details: 

 Select a device from the Devices list. 

 Click the Edit button.  The Device Properties screen displays. 

 Click the Network Info tab. 

 Reference the Device Properties section later in this chapter for 

details. 
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Device Level 

When you select a device from the left pane, the right pane displays two tabs – Device 

Info and Channels. 

 

Figure 2 - 7. 

The WMx Device Screen’s Device Info Tab. 

Device Info Tab 

The Device Info tab displays a summary of the selected device’s settings, wakeup, 

battery, network, and diagnostic information. 

To edit the selected device’s settings: 

 Click the Edit button.  The Device Properties screen displays. 

 Click the Device Setup tab and edit as necessary. 

 Reference the Device Properties section later in this chapter for 

details. 
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Channels Tab 

The Channels tab displays a summary of the channels assigned to the selected device. 

 

Figure 2 - 8. 

The WMx Device Screen’s Channels Tab. 

To edit the selected device’s channels: 

 Select a device from the Devices list. 

 Click the Edit button.  The Device Properties screen displays. 

 Click the Channels tab and edit as necessary. 

 Reference the Device Properties section later in this chapter for 

details. 
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Channels Level 

When you select the Channels hierarchy item or a specific channel in the left pane, the 

right pane displays a summary of the channel settings.   

Channels Tab 

If you select the Channels hierarchy item, the Channels tab displays.  Reference the 

Device Level / Channels Tab section above for details. 

Channel Info Tab 

If you select a specific channel hierarchy item, the Channel Info tab displays a summary 

of the selected channels information.   

 

Figure 2 - 9. 

The WMx Device Screen’s Channel Info Tab. 

 The Channel Info tab is a read-only tab and the Edit button is 

not available.  To modify the selected channels settings, reference 

the Device Level / Channels Tab section above. 
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Device Diagnostic POINTs Level 

Device Diagnostic POINTs are used to trend the WMx battery status and wireless 

connection performance parameters.  The diagnostic POINTs assigned to the device 

display below the Device Diagnostic POINTs hierarchy item. 

 Diagnostic POINTs are created and assigned to a WMx device 

using the Insert menu’s Insert POINT option.  Reference Chapter 

3, Working With Your SKF @ptitude Analyst Hierarchy for 

details on inserting new POINTs.  

 

Figure 2 - 10. 

The WMx Device Screen’s Device Diagnostic POINT’s POINT Info Tab. 

 For the battery diagnostic POINT level alarm, there are many 

factors that affect battery life.  Two main influential factors are 

how long the WMx has to stay on to collect a set of 

measurements, and how often the measurements are collected.  

Both vary from site to site.  To determine a baseline, it is 

recommended that you set up a typical route and run the WMx 

with your typical collection schedule until the batteries are 

completely depleted.  Then use the trended battery level to set up 

your site specific alert and danger alarm levels.  When the battery 

is below critical level (which may be above 0% battery level), no 

more measurements will be collected and a “battery level below 

critical” message is entered in the @ptitude Analyst Event Log.  

Depending on the WMx device wakeup settings, the system 

continues to periodically log new battery critical messages into the 
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Event Log if the battery level remains below critical. Reference the 

Battery Life Estimation and Optimization section in your WMx 

Hardware User Manual for more details. 

 For the wireless link, signal, and noise POINT level alarms, you 

must first establish baseline readings for a working Wi-Fi 

connection, and then adjust the alert and danger alarm threshold 

levels.  

POINT Info Tab 

When you select a diagnostic POINT the POINT Info tab displays, allowing you to view 

details and edit settings for the selected diagnostic POINT. 

To edit a diagnostic POINT’s settings: 

 Select the diagnostic POINT you wish to modify. 

 Click the Edit button.  The selected diagnostic POINT’s POINT Properties screen 

displays.   

 Make any necessary changes to the POINT’s settings.  Reference Chapter 3, 

Working With Your SKF @ptitude Analyst Hierarchy for details on the POINT 

Properties screen. 

 Click OK when you are finished editing the diagnostic POINT’s settings. 

To locate the diagnostic POINT in the @ptitude Analyst Hierarchy: 

 Select the diagnostic POINT you wish to locate. 

 Click the To Hierarchy button.  The WMx Device screen closes and the diagnostic 

POINT is highlighted in the @ptitude Analyst Hierarchy. 

Diagnostic POINT Overview 

Four diagnostic POINT types are available for trending battery level and wireless 

network parameters: 

Battery Level 

Wireless Link 

Wireless Signal 

Wireless Noise 

Battery Level - Trends the remaining battery life in % for lower out-of-window alarm 

thresholds. 

There are many factors that affect battery life.  Two of them are, how long the WMx has 

to stay on collecting the measurements, and how often the measurements are 

collected.  Both vary from site to site. To determine a baseline, it is recommended that 

you set up a typical route and run the WMx with your typical collection schedule until 

the batteries are completely depleted.  Then use the trended battery level to set up your 

site specific alert and danger alarm levels. 

When the battery is below critical level (which may be above 0% battery level), no more 

measurement will be collected and a “battery level below critical” message is entered in 

the @ptitude Analyst event log. 
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Wireless Link – Percentage that trends the Wi-Fi overall link quality with lower out-of-

window alarm thresholds.  Higher percentages indicate stronger links. 

Wireless Signal - Trends the Wi-Fi signal level in dBm with lower out-of-window 

alarm thresholds. 

Wireless Noise - Trends the noise level in dBm with upper out-of-window alarm 

thresholds. 

 Although the diagnostic POINTs are created under the channel 

node in the hierarchy, they are system parameters.  Only one of 

each POINT type is needed for each WMx.   

 You must first establish baseline readings for a working Wi-Fi 

connection, and then adjust the alert and danger alarm threshold 

levels.  

For your reference, the following table describes wireless parameters in a typical office 

environment with reliable connections. 

 

Distance from axis point Link quality Signal level - dBm Noise level - dBm 

10 m (30 ft) 60 -50 -85 

13 m (40 ft) 45 -60 -85 

30 m (100 ft) 25 -70 -85 
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Unassigned POINTs Level 

Unassigned POINTs are POINTs that have been assigned to device but not to one of 

the device’s channels. 

 

Figure 2 - 11. 

The WMx Device Screen’s Unassigned POINT’s POINT Info Tab. 

POINT Info Tab 

When you select an UnassignedPOINT the POINT Info tab displays, allowing you to view 

edit settings for the selected unassigned POINT.  For example, you may wish to assign 

channels to the unassigned POINT from this screen. 

To edit an unassigned POINT’s settings: 

 Select the unassigned POINT you wish to modify. 

 Click the Edit button.  The selected unassigned POINT’s POINT Properties screen 

displays.   

 Make any necessary changes to the POINT’s settings.  Reference Chapter 3, 

Working With Your SKF @ptitude Analyst Hierarchy for details on the POINT 

Properties screen. 

 Click OK when you are finished editing the unassigned POINT’s settings. 
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To locate the unassigned POINT in the @ptitude Analyst Hierarchy: 

 Select the unassigned POINT you wish to locate. 

 Click the To Hierarchy button.  The WMx Device screen closes and the unassigned 

POINT is highlighted in the @ptitude Analyst Hierarchy. 

Device Properties 

The Device Properties screen allows you modify the selected device’s settings, view the 

device’s network information, and modify its channel settings. 

To open the Device Properties screen, click the Edit button from the WMx Device 

screen. 

 

Figure 2 - 12. 

The Device Properties Screen’s Device Setup Tab. 

Depending on the level from which the Device Properties screen is launched, up to three 

tabs display – Device Setup, Network Info, and Channels. 
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Device Setup tab 

The Device Setup tab allows you to edit the WMx device’s settings. 

Fields include: 

Device Information area 

MAC address – Enter the MAC address of the physical device.  The MAC address can be 

found on the device’s packaging. 

No MAC address – Enable if you do not yet have the MAC address.  This would allow 

the user to create a new device, channel configuration, and POINT assignments.     

Swap button – Click to replace the selected device with a new device, but still retain the 

channel configuration and POINT assignments for both devices, without the user having 

to recreate the channel configuration / POINT assignments for the new device.  The 

Swap Device dialog displays a list of devices available for swapping.  Select the new 

device and click OK.   

 Devices can not be downgraded.  For example, you cannot swap 

device channel configuration and POINT assignments from a 

device with 16 MB of memory to a device with 8 MB of memory; 

also you cannot swap device channel configuration and POINT 

assignments from a WMx to a WVT. 

Device name – Enter a unique name to identify the device. 

Device Type – Displays the device type (WMx or WVT).  This field is only editable for 

new devices. 

Service Name – Select the WMx Service name that the device uses to connect to 

@ptitude Analyst from the drop-down list.   

Memory Size – Displays the device’s memory size.  This field is only editable for new 

devices. 

Location – Enter the physical location of the device.  

Update PCB: (read-only) – Displays the device’s PCB information. 

 

SKF Part No. PCB Memory 

size 

Features 

CMWA WVT ICON0603 8 MB Obsolete, limited functionality 

CMWA 7810  0703E  8 MB Full functionality with original 

resolution for the enveloped 

measurements 

CMWA 7810  0703E 16 MB Expanded memory, full 

functionality, improved enveloped 

POINT resolution. 

 Reference the WMx POINTs’ End Frequency and Lines Validation 

for 8 MB WMx devices and enveloped POINTs and 16 MB WMx 

devices and enveloped POINTs tables in Chapter 3 - Working With 

Your SKF @ptitude Analyst Hierarchy / Setup Tab – WMx POINTs 

section. 
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Firmware version – (read-only) Displays the device’s current WMx firmware version. 

Protocol version – (read-only) Displays the device’s current protocol version. 

Time zone – Select the time zone of the device’s physical location from the drop-down 

list. 

Wakeup Information area 

Timeout – Specify how long the WMx should remain idle while waiting for commands 

from the WMx Communication Service before going back to sleep. 

Timout enabled – Disable if you do not wish to use the network timeout. 

Wakeup interval – Specify the amount of time between wakeups.   

 At wakeup, the unit has a limit on the time that it remains 

powered up if it is unable to make contact with the network.  This 

reduces battery drain when, for example, the network is 

temporarily down.  If the unit wakes up and is unable to establish 

communication with its network it attempts to retry to connect.  

Reference the Retry Strategy section later in this chapter for 

details. 

Wakeup enabled – Allows you to switch between WakeUp Mode and Contintuous mode. 

 Check this box to enable WakeUp Mode.   

WakeUp Mode is when the WMx automatically takes measurements on a specified 

schedule.  The wakeup schedule is set using the Wakeup Interval and Wakeup Sync 

Time fields on the Device Setup tab.  This tells the unit at what time it should take data 

for the first time followed by the interval at which repetitive data collection should occur.  

 Unchecked to enable Continuous Mode.   

In Continuous Mode, the device does not follow a wakeup schedule.  If the device’s ON / 

OFF button is switched to OFF, it will not wakeup until the device is switched ON again 

by pressing the ON / OFF button on the device.  

The WMx can also power down automatically in Continuous Mode if the WMx loses 

connection with the host computer and no command has been received from the host 

computer within the timeout period specified in the Timeout field described above.  If 

this happens, you must press the ON / OFF button to manually restart the device. 

Wakeup sync time – It is possible to synchronize the wake-up to a particular time 

using these fields.  For example, if Wakeup sync time is set to a time of 15:00, Wakeup 

interval is set to two hours, and the time now is 17:00, then the unit will wake up at 

17:15 (13:15, 15:15, 17:15, etc.) and every two hours thereafter.  This value is used 

the first time you use the WMx. 

 For systems with a large number of WMxs, it is helpful to stagger 

the synchronization of each unit by at least two minutes.  This 

prevents all of the units from waking up together and all trying to 

connect to the host computer simultaneously, causing potential 

memory issues.  Battery life is optimized if WMxs do not need to 

wait to be serviced by the host.   

Last wakeup time – Displays the date and time of the last wakeup. 
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Next wakeup time – Displays the time of the next scheduled wakeup. 

Power down between measurements – This mode is the only mode available when 

the WMx is battery powered, in order to conserve battery power.  It is also available 

when the WMx is externally powered.  The WMx powers down between measurements; 

therefore, any schedule changes are not effective until the next scheduled wake up 

time.  When the unit is switched off, a real-time clock remains running that is used to 

power the unit up at pre-determined intervals. 

Remain on between measurements - This mode is available only when the WMx is 

externally powered.  After the WMx has completed taking measurements, it stays on 

and waits for the next scheduled interval to take the next round of measurements.  It 

continues to listen between measurements, and immediately acts on any received 

commands.  The WMx is more responsive to schedule changes in this mode.  This is the 

recommended mode for an externally powered WMx. 

Battery Information area 

Battery alarm level – Specify a low battery life percentage to trigger a low battery 

event in the Event Log.  For example, if set to 20%, when the remaining battery life 

reaches 20%, an event is initiated. 

Battery level – (read-only) Displays the percentage of remaining battery run-time. 

External power – (read-only)  Displays Yes if powered by external power or No if 

powered by battery. 

 Click OK to apply any changes and return to the WMx Device screen. 
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Network Info tab 

The Network Info tab displays the device’s network connection information and 

network diagnostic information.   

 The information on this screen is read-only.  To make changes to 

the network information, reference the SKF @ptitude Analyst 

Installation Manual for details. 

 

Figure 2 - 13. 

The Device Properties Screen’s Network Info Tab. 

Fields include: 

Network information area 

Host IP – Displays the host computer’s IP address. 

Host Port – Displays the host computer’s host port. 

DHCP enable – Displays Yes or No, dependin on if the device is using a dynamic IP 

address. 

Gateway IP – Displays the device’s gateway IP address. 



 Setting Up Your WMx Device 

 Device Properties 

SKF @ptitude Analyst and SKF Multilog On-line Systems 2 - 19 

User Manual 

Device IP – Displays the device’s IP address. 

Subnet – Displays the device’s subnet mask address. 

Wireless mode – Displays the type of wireless network being used (Ad-hoc for peer-to-

peer or Structured Network if an access point is used). 

Wireless channels – Displays the wireless channel being used. 

SSID – Displays the wireless network name. 

Encryption type – Displays the encryption type (Disabled (None), WEP 64 bit, WEP 128 

bit, WPA-PSK (TKIP/AES), WPA2-PSK (TKIP/AES).   

Wireless card – Displays the model name of the wireless card. 

Diagnostic information area (read-only) 

Link quality – Displays the current quality of the link to the network (0 to 100 %). 

Noise level – Displays the current noise level (0 to -255 dBm).  The lower the number, 

the lower the noise is; therefore, the closer to zero, the higher the noise level is. 

Wi-Fi signal level – Displays the current Wireless Network signal quality (0 to -255 

dBm).  The closer to zero, the stronger the received signal is.  The lower the number, 

the weaker the received signal is. 

Last updated – Displays a date/time stamp of the device’s last wakeup. 

 Click OK to apply any changes and return to the WMx Device screen. 
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Channels tab 

The Channels tab allows you to view and edit the device’s channel settings. 

 

Figure 2 - 14. 

The Device Properties Screen’s Channels Tab. 

Fields include: 

Units system – Select the system units (English or Metric) to use on this tab. 

Channels – Displays a list of the channels assigned to the device.  The name, status 

(enabled / disabled), sensor type, sensitivity, units, and BOV (bias output voltage) status 

display for each channel. 

Properties area – When a channel is selected in the Channels list, the channel 

properties display for editing purposes.  Edit the following fields to make changes to a 

channel’s settings: 

Channel enabled – Click the Channel Enabled checkbox to enable a channel 

on the WMx.  If the channel is disabled, the WMx skips the POINTs assigned to 

that channel during data collection. 

Channel name – Assign the channel a unique name. 
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Sensor type – Specify the type of sensor used by the selected channel 

(Accelerometer, Displacement Probe, Velocity Sensor, DC, and Tach). 

Sensitivity - Enter a value for the sensitivity of the sensor to be used in 

making the measurement. 

Check sensor ok status - Click to enable this option.  When enabled, @ptitude 

Analyst will check the sensor status, and will display the sensor status in 

Device status and Online Data View dialogs.  If data is outside specified range, 

the WMx does not collect the data. 

Lower BOV – Type in the BOV upper limit value. 

Upper BOV – Type in the BOV lower limit value. 

Offset - Enter a value in milivolts to offset the zero point of the measurement.  

Click the Autoset button to adjust the sensitivity and offset calculation using 

the Offset Calculator.  The Offset Calculator allows you to set the sensitivity 

and offset values for scaling the WMx process input from channels 5 to 8 using 

two signal levels and their corresponding engineering units.  

The calculator uses simple algebra to calculate the Sensitivity (slope) and the 

Offset (Y-intercept of a linear sensor curve).   

POINT1 / POINT2 – Enter the Engineering Unit (X) from the sensor (i.e., °C, 

°F, etc.) and the corresponding Signal level (Y) in mV for both points from a 

sensor curve (X1, Y1 / X2, Y2).  The calculator uses the following equation: 

Sensitivity = (Y2 - Y1) / (X2 - X1) 

Offset = Y1 - X1 * sensitivity 

For example, MSS2100T temperature range is from 2 to 120 °C and 

10 mV / °C in the 0-3 VDC range: 

For setting up the input temperature in °C, 

(POINT1) at signal = 20 mV, the temperature = 2 °C 

(POINT2) at signal = 1200 mV, the temperature = 120 °C 

 

Figure 2 - 15. 

The Offset Calculator Dialog in °C. 
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Sensitivity = (1200 – 20) / (120 – 2) = 10 mV / °C 

Offset = 20 mV – 2 °C * 10 mV / °C = 0 mV 

For setting up the input temperature in degF, 

(POINT1) at signal = 20 mV, the temperature = 35.6 °F 

(POINT2) at signal = 1200 mV, the temperature = 248 °F 

 

Figure 2 - 16. 

The Offset Calculator Dialog in °F. 

Sensitivity = ( 1200 – 20 ) / (248 – 35.6 ) = 5.56 mV / °C 

Offset = 20 mV – 35.6 °C * 5.56 mV / °C = -177.9 mV 

 Click OK to accept the calculated values and return to the Channels tab.  The 

Sensitivity and Offset fields automatically update to reflect the calculated values. 

Range – Select 0-3 V, 0-10 V, or 4-20 mA input range from the drop down 

list.  Input range must match the hardware’s range jumper setting.   

 For details on jumper settings, reference the SKF Multilog On-line 

System WMx CMWA 7810 User Manual’s Jumper Summary 

section in Chapter 2. 

Sensor notes – Type in any additional information you would like to store with 

the selected sensor settings.   

To edit channel properties:  

 Select the channel you wish to edit from the Channels list.   

 In the Properties area, edit channel name, enable / disable the channel, and edit 

the sensor information.   

 When you start to edit a field in the Properties area, the 

Channels list turns gray, allowing you to only make changes to 

the selected channel.  Also, the Save and Undo buttons become 

available. 

 To cancel changes to the selected channel, click Undo.   
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 When you have finished editing the channel properties, click Save to save your 

changes. 

 Use the Copy / Paste function to copy the selected channel’s properties and paste 

to another channel.  To copy channel properties to multiple channels, select the 

Number checkbox of each channel, then click Paste.  

 Click OK to apply any changes and return to the WMx Device screen. 

SKF Multilog WMx Retry Strategies Summary 

Mode Power Up or Wakeup Communication Interrupted  

(Lost connection) For example, lost PC 

or Lost Access Point or WMx service 

stopped 

Power Down 

Between 

Measurements 

The only mode 

available for battery 

powered devices; it 

is also available for 

externally powered 

devices. 

The SKF Multilog WMx tries to 

connect to the WMx Service for 

40 seconds, then powers down for 

up to 3 minutes (see Note 1 

below for next retry time 

calculation).  It then wakes up to 

retry for another 40 seconds.  If 

no connection is established, it will 

shut down until the next 

scheduled wakeup time and 

repeat the cycle until connection is 

established. 

SKF Multilog WMx idles, at a maximum, 

until the network timer times out (see 

Note 2 below).  It shuts down for 3 

minutes, and then starts the power up or 

wakeup process described in the adjacent 

left column. 

Remain On 

Between 

Measurements 

(or Continuous) 

This mode is 

available only for 

externally powered 

devices. 

 

After being manually switched on, 

the SKF Multilog WMx continues 

to try to connect to the WMx 

Service.  It resets after the 

network timer times out (see Note 

2 below) and continues to retry 

after a reset.  It repeats the cycle 

until connection is established. 

SKF Multilog WMx idles, at a maximum, 

until the network timer times out (see 

Note 2 below) and resets.  After the reset, 

it starts the power up or wakeup process 

described in the adjacent left column.  

Note 1: The next retry time is calculated by rounding up to the minute, then adding two 

minutes. 

Note 2: Configure the network timeout in SKF @ptitude Analyst’s WMx Devices > 

Network tab… Device Properties / Device Setup tab.  Refer to the SKF @ptitude 

Analyst and SKF Multilog On-Line Systems User Manual (P/N 32296700) for details. 

Normally, the device will apply the retry strategy as soon as it detects the network 

communication is lost. However, when the device is waiting for a command and does 

not detect the network communication loss, then the device will apply the retry strategy 

when the network timeout expires. 
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SKF Multilog WMx in “Power Down Between Measurements” Mode 

Wakeup 

This example shows the execution of the new retry strategy using an SKF Multilog WMx 

scheduled to wake up at 15 minute intervals.  The SKF Multilog WMx woke up at 

14:45:10 and tried to connect.  It tried for 40 seconds and then shut down at 14:45:53.  

To calculate the next retry time, it rounded up the current time to 14:46, and added 

two minutes to 14:48.  At 14:48:10, it woke up to retry.  After trying for 40 seconds, it 

shut down at 14:48:53.  The next wakeup time is 14:45 + 15 minutes equaling 15:00 

hours.  The Log record for this example is shown below. 

 

Figure 2 - 17. 

Log Showing the SKF Multilog WMx Scheduled to Wakeup at 15 Minute Intervals. 

Interrupted Communication 

In the example below, the Timeout was set at five minutes, and the Wakeup interval 

was set at 15 minutes.  The SKF Multilog WMx was connected and communicating, but 

was interrupted at 10:20:20.  Because it did not detect the connection loss,  the timeout 

expired five minutes later, at 10:25:34, and it shut down.  Before it shut down, it 

calculated the next retry time according to Note 1 (rounded up the current time to the 

next minute and added two minutes) as 10:28.  It woke up at 10:28:11 to retry for 40 
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seconds and finally shut down again at 10:28:52, with the next wakeup time scheduled 

for 10:30.  The Log record for this example is shown below. 

 

Figure 2 - 18. 

Log Showing the Response to Interrupted Communication. 

SKF Multilog WMx in “Remain on between Measurements” Mode 

In the “Remain On Between Measurements” or “Continuous” mode, the WMx Service 

sends a probe command every minute to refresh the network timer function. 

Manually Powered Up 

In this example, the SKF Multilog WMx’s Timeout was set at five minutes.  After it was 

manually powered up, the SKF Multilog WMx was unable to connect to the WMx 

Service.  It continued to try, and reset five minutes later at 16:36:32.  After the reset, it 

continued to try to connect.  The Log record for this example is shown below.   
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Figure 2 - 19. 

Log Showing a WMX in Remain on Between Measurements Mode – Manually Powered Up. 

Interrupted Communication 

In the event the network is disconnected, the SKF Multilog WMx will reset after the 

timeout expires and then try to reconnect. 

In the example below, the Timeout was set at five minutes.  The SKF Multilog WMx 

completed a scheduled measurement at 15:00:05 and then went into idle status.  The 

WMx Service sent a probe command every minute to keep the timer function from 

resetting.  There was a network issue at 15:08:07.  As a result, the SKF Multilog WMx 

no longer received the probe command.  After five minutes (when the timeout expired), 

the SKF Multilog WMx reset at 15:13:21.  After the reset, the unit continued to try to 

connect.  The Log record for this example is shown below.   
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Figure 2 - 20. 

Log Showing the Response to Interrupted Communication. 

WMx Service Memory Watch  

The Memory Watch function allows the WMx Service to periodically monitor the amount 

of physical and virtual memory being used by the server, and refreshes the service 

whenever memory consumption exceeds a specified threshold.   

To configure the Memory Watch function’s wakeup period: 

 Open the skfWMxService.exe.config file located in the C:\Program Files\SKF-

RS\SKF @ptitude Analyst folder. 
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Figure  2 - 21. 

The skfWMxService.exe.config Configuration File. 

 Scroll down to locate the WmxService_default section. 

 Edit the value fields for the following keys to configure the Memory Watch settings: 

Do not edit any other value fields in the skfWMxService.exe.config configuration file 

than the fields specified below.  

MemoryWatchDelaySec – Specify how often the Memory Watch function checks the 

server’s memory consumption.  Default is 900 seconds (15 minutes). 

MaxPhysicalMemoryMB – Specify the maximum limit of physical memory in 

megabytes.  A setting of zero seconds means monitoring is not enabled.  Default is zero. 

MaxVirtualMemoryMB – Specify the maximum limit of virtual memory in megabytes.  

A setting of zero seconds means monitoring is not enabled.  Default is zero. 

 In order to trigger the Memory Watch function to refresh the 

service, the MaxPhysicalMemoryMB and MaxVirtualMemoryMB 

must be set to a value greater than zero.  When either value is set 

to zero, monitoring is disabled. 

 Click File / Save and close the configuration file. 
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Working With Your SKF @ptitude Analyst Hierarchy  

Selecting which of your machinery requires monitoring, what measurements to perform 

on the selected machinery, and how often to perform these measurements requires a 

careful study of the needs of the plant.   

Creating a Paper Copy Hierarchy 

It is advisable to create a paper copy Hierarchy before creating your @ptitude Analyst 

Hierarchy.  This paper copy Hierarchy of your machinery measurement POINTs should 

be organized in hierarchical format by machines and POINTs for each machine. 

HIERARCHY 

POWER GENERATION 

GAS TURBINE 

GT INLT 1HV 

GT INLT 1VV 

GT INLT 1XV 

GT INLT 2HV 

GT INLT 2VV 

GT INLT 2X 

MAIN PUMP 

WATER TREATMENT 

For each Hierarchy, use an outline format to create your Hierarchy’s organizational 

hierarchy, with measurement POINTs branching from machines, which branch from 

SETs. 

Take time to organize your paper copy Hierarchy thoroughly.  A complete and organized 

paper copy Hierarchy makes building your @ptitude Analyst Hierarchy much easier.  

When naming POINTs, it is helpful to keep machine names and POINT identifiers in 

columns (as exampled above). 

 If you have several machines with the same title (for example, 

GAS TURBINE), use an alpha or numeric prefix or suffix to 

uniquely identify one machine only (for example, GAS TURBINE 

INLT). 

About POINT Names 

In the @ptitude Analyst system, each measurement must be identified by a descriptive 

name.  This can be accomplished by adding a suffix to each equipment name to denote 

the specific location, measurement orientation, and type of measurement.  
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Suffixes such as AHV, 1VD, and so on, can be used to identify specific MCD Probe 

vibration measurements, with letters denoting which end of the machine (A, B, 1, 2, 

etc.), direction (H - horizontal, V - vertical, or A - axial), and type of measurement 

(V - velocity, D - displacement, etc.). 

 In a hierarchy list, POINTs branching from the same machine 

must have unique names.  However, POINTs branching from 

different machines may share the same name.  Also, each 

machine must have a unique name.  If you try to create a 

machine with the same name as another in the hierarchy list, SKF 

@ptitude Analyst automatically adds a numeric suffix to the 

machine’s name.  The same holds true for POINTs branching 

from the same machine.  For example, if you have a machine 

named Pump and try to name another machine with the same 

name, @ptitude Analyst adds a suffix, and the new machine is 

named Pump.1. 

Overview 

In @ptitude Analyst, you create a Hierarchy that organizes your monitored machinery 

measurements into a hierarchy structure consisting of Groups (which consist of 

organizational SETs, machines, or custom groups) and measurement POINTs. 

Each @ptitude Analyst hierarchy displays in the Hierarchy window in which its hierarchy 

items list.  Multiple databases display in the same Hierarchy window, and only one 

Hierarchy window may be open at a time. 

When building your Hierarchy, you insert hierarchy Groups, which you identify as either 

a Machine hierarchy item or an organizational SET hierarchy item, or a custom Group 

Type you create. 

IMPORTANT 

All hierarchy lists must contain Machine hierarchy items from which measurement 

POINTs branch.  Measurement POINTs cannot branch from a SET hierarchy item or 

the root node.  They must branch from a “Machine” hierarchy item. 

After creating your paper copy hierarchy, your next task is to use your paper copy 

hierarchy to input your organizational hierarchy into @ptitude Analyst to build your 

@ptitude Analyst hierarchy.  This chapter walks you through the usual @ptitude Analyst 

steps for creating a new hierarchy.  These steps are: 

 Create one or more new hierarchies. 

 Create each hierarchy’s organizational SETs (optional) and Machines. 

 Add measurement POINTs to their appropriate machine, configuring 

each POINT as it is created. 

The general steps required to create a new hierarchical structure are listed below.  

Refer to the indicated dialogs and topics for more information on specific steps. 

 Use the File menu’s New option to create a new hierarchy.  A hierarchy window 

displays with a Hierarchy root node. 
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 With the Hierarchy window active, use the Insert menu to insert new Groups in the 

hierarchy window.  Specify the new Group's Type as either Machine group, a SET 

group, or one of your custom groups (if available). 

 Refer to Group Properties for more information. 

 After inserting your Machine hierarchy items, click to highlight a specific Machine 

and insert New POINTs for the Machine.  Specify the new POINT's DAD and POINT 

Properties. 

 Refer to POINT Properties for more information. 

IMPORTANT: 

 

* Machines must have unique names. 

 

* POINTs must branch from a machine. 

 

* POINTs branching from the same machine must have unique names. 

Displaying Existing Hierarchies in the Hierarchy Window 

To display hierarchies in the Hierarchy window: 

 Use the File menu's Open/Close command to display the Open/Close dialog.  All 

available hierarchies display in the Open/Close dialog. 

 Only the hierarchies to which the user has access display.  For 

details on setting Hierarchy access, refer to the Customizing Your 

@ptitude Analyst Software section in Chapter 2 – Getting Around 

in SKF @ptitude Analyst of your SKF @ptitude Analyst Introduction 

and Global Features user manual. 

 In the Open/Close dialog, enable the checkbox next to the hierarchy name(s) you 

wish to display in the Hierarchy window and click OK. 

The selected hierarchies display in the Hierarchy window. 

To remove a hierarchy from the Hierarchy window: 

 Use the File menu’s Open/Close command to display the Open/Close dialog.   

 In the Open/Close dialog, disable the checkbox next to the hierarchy name(s) you 

wish to no longer display in the hierarchy and click OK.  The disabled hierarchies no 

longer display in the Hierarchy window. 



Working With Your SKF @ptitude Analyst Hierarchy 

Creating a New SKF @ptitude Analyst Hierarchy 

3 - 4 SKF @ptitude Analyst and SKF Multilog On-line Systems 

 User Manual 

Creating a New SKF @ptitude Analyst Hierarchy 

@ptitude Analyst’s installation program installs a “demo” Hierarchy (unless you selected 

to install an empty  Hierarchy only).  You should create a new Hierarchy to store your 

machinery vibration measurements. 

To create a new @ptitude Analyst Hierarchy: 

 Select the File menu’s New command.  The New dialog opens. 

 Enter a unique name for the new Hierarchy and click OK.   

A blank Hierarchy window displays.  The Hierarchy name appears in the window’s title 

bar. 

 Access to the new Hierarchy is assigned only to its creator.  To 

give other users access to the new Hierarchy, refer to the 

Managing Users section in the SKF @ptitude Analyst 

Introduction and Global Features User Manual. 

Setting Your Primary Hierarchy 

@ptitude Analyst’s Hierarchy window displays multiple hierarchies at one time in the 

same window.  One hierarchy must be designated as the primary hierarchy. 

The primary hierarchy is the default hierarchy and owns any newly created ROUTEs and 

Workspaces.  When working in areas of the application that require hierarchy selection 

(e.g., Reports, Filters, Workspaces, etc.), this hierarchy will be offered by default.  When 

in areas of the application where hierarchy selection is not offered (for example, 

Transfer), the primary hierarchy will automatically be used. 

To set the primary hierarchy: 

 In the File menu’s Open/Close dialog, you may click the Set Primary button to set 

the highlighted hierarchy as the primary hierarchy.  The primary hierarchy name 

appears in bold with the [primary] displayed next to the hierarchy name. 

OR 

 In the Hierarchy window, right click the hierarchy’s root node, and select the Set 

Primary option.  The primary hierarchy name displays in bold. 
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Inserting @ptitude Analyst Groups 

 The DMx system hierarchy is created automatically, based on 

DMx modules communicating with @ptitude Analyst Monitor.  

(Refer to Chapter 7 for details.)  Although there is no need to 

manually insert the Group, this section contains information on 

configurable Group properties that may be useful to DMx users. 

When building your hierarchy, you insert hierarchy Groups which you identify as either a 

Machine hierarchy item, an organizational SET hierarchy item, or a custom Group Type 

previously created. 

To insert a new Group: 

 Select the Insert menu’s New Groups option.  The Group Properties screen 

displays.   

 The keyboard’s Insert key may also be used to insert a new group 

when in a Hierarchy, ROUTE, or Workspace window. 

Group Properties Screen 

General Tab 

Group Properties / General fields are organized into three areas; Settings, Segment 

and asset tracking, and Miscellaneous. 

Settings fields include: 

Name – Enter a unique name to identify the new group. 

Description – (optional) Enter a description to further identify the new group. 

Type – Select Machine or SET from the drop down list. 

 Custom group types may also be available for selection.  Creation 

of custom group types is discussed later in this chapter. 

 Once a Group’s Type is specified, it cannot be changed. 

Enable data collection checkbox – Click the checkbox to enable POINT transfer to a 

DAD. 

 By default, data collection is enabled.  To temporarily disable data 

collection, clear the checkbox. 

Segment and asset tracking fields include: 

Segment name – Enter text that defines the Group’s physical location.  For example, 

enter “Level 2” or “Press Section.” 

Asset name – Enter text that defines the physical machinery currently occupying the 

Segment entered above.  For example, enter a machine’s serial or part number. 

 Segments remain fixed while Assets may be moved from one 

location (segment) to another. 
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 Segment name and Asset name fields are unavailable when 

working with a template item's group properties. 

Miscellaneous fields include: 

Priority – Priority assignments may be used in filtering and reporting.  A machine is 

typically given a Priority rating when a problem is found and you wish to prioritize the 

problems to be addressed.  Specify a machine's priority from the drop down list.   

 The Priority field is only available if you are working with a 

Machine-type Group. 

 Assign a color for each machine priority to allow easy 

identification of all machines with priority assignments.  Enable to 

display a machine priority color in the hierarchy for all machines 

with assigned priority levels on the Customize / Preferences / 

General tab.  Default is disabled. 

Available priority assignments are: 

<No Priority> 

1 – Critical 

2 – High 

3 – Medium 

4 – Low 

5 – Lowest 

 

Figure 3 - 1. 

Example of Machine Priority Color Displayed in Hierarchy. 
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Filter Keys Tab 

@ptitude Analyst allows you to create Filter Keys which can be associated with POINTs 

and Machines for automated filtering purposes.  For example, if you activated a “Pump” 

filter key for a Group and later filter a hierarchy list using the Filter Key / Pump, then 

all Groups with active Pump filter keys display in the filtered Workspace. 

 Filter key creation is discussed later in this chapter. 

Filter key searches list all POINTs or Machines sharing a specified filter key (or multiple 

filter keys).  The Filter Key tab lists all created filter keys and indicates whether or not 

they are currently assigned.   

 Click a specific filter key’s checkbox to associate it to the current POINT. 

 The checkbox appears gray if the filter key is enabled for a parent 

hierarchy item. 

 Click the Filter Key tab’s OK button to save your filter key assignments. 

Messages Tab 

The Messages tab allows you to apply previously defined “shared” messages, and to 

create new, private messages to assign to the selected group. 

 

Figure 3 - 2. 

The Group Properties Screen’s Messages Tab. 
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@ptitude Analyst's Group Properties / Messages feature allows you to create and 

assign one message for general machine instruction purposes.  The Messages context 

area displays the type of message available for assignment and any existing messages 

already applied.  You can assign a previously created public message to the current 

group, or create and apply a new private message. 

The Name drop down list displays all previously created messages and a <Private> 

option.  Use this drop down list to specify whether you wish to set up a unique 

<Private> message for the current group only, or specify a previously defined “shared” 

message (selected by name).  If you specify a shared message, its format, summary, 

and content automatically display in subsequent fields.  If you specify a Private message, 

proceed to configure the message settings as described below. 

 For more information on creating and managing public messages, 

refer to the Customize / Database Operations section later in 

this chapter. 

Format – This drop down list allows you to specify your message's format. 

Free form – Allows you to manually type in the summary and content for your 

message. 

Summary – Type in text summarizing your message for easy recognition.  For example, 

if you have a message that details specifics about a group of machinery, your summary 

may read, "FD Fan Data Collection Information." 

Content – Enter your complete message in the content text area.  Using the above 

example, your alarm message content would include detailed data collection 

information, specific to the current group.  For example, your message may read 

"Ensure sensor is properly mounted before collecting data, etc." 

To assign a shared message to the current group: 

 Select the shared message from the drop down list and click the OK button.  

Shared messages may be applied to an unlimited number of groups. 

Shared Message 

Alarm messages initially created as private messages may be converted into shared 

(public) messages.  To share a newly created Private message, select the new Private 

message and click the tab’s Share As button. 

The Enter Name  dialog specifies the message as a shared (public) message.  When the 

Enter Name dialog displays, you will be prompted to give the shared message a unique 

name for easy identification.   

 Enter a name for the shared message and click the OK button. 

 The new shared message now appears as an available selection in the dialog's drop 

down list.  Shared messages are easily assigned to other groups to simplify setup 

and maintenance. 
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Notes Tab 

The Group Properties / Notes tab allows you to attach a text note to the Group along 

with a date / time stamp.  This feature conveniently stores and records relevant Group 

information such as maintenance history. 

 Coded notes uploaded from the on-line device for the current 

Machine display in the Notes tab. 

 Click the Notes tab’s Add button to add a new note and date / time stamp. 

 Click the Save button to save edits made to a note. 

 Click the Undo button to cancel edits made to a note. 

 Click the Remove button to remove the selected note from the display. 

Group Properties / Notes fields include: 

Date – Select the current date from the drop down list. 

Time – Select the current time. 

The selected date and time appear in the tab’s left Notes field. 

Text – Type in desired note text in the text field. 

 Click the tab’s OK button to save all entries. 

Images Tab 

Scanned photographs or digital images can be added to a particular Group, stored in the 

Hierarchy, and viewed from the Images tab.  Images help identify SETs / machines, 

organize similar equipment, and document known defects. 

Group Properties / Images fields include: 

Image – All attached images display in the drop down list. 

Description – Enter text to identify the image.  Click the Save button to save your 

description entry.  If saved, the new description replaces the filename in the Images list. 

 Click OK to save your new description entry. 

To add a new image: 

 Click the Add button to add a new image.  The Windows’ Open dialog displays.  

Select desired image and click Open to add or Cancel to undo. 

 Added images use the filename as the default description. 

To replace / update the current image: 

 Click the Browse button. 

 Select a replacement image.  The new image displays on the tab. 

 Click Save to confirm the image replacement. 

 Click Cancel to undo the image replacement. 

 The image name and description of the old image are retained for 

the replacement image. 
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To export an image to a specific location: 

 Select the image to export. 

 Click the Export button. 

 When prompted, enter the desired export location and click OK. 

The image is copied and saved to the specified location, but still remains attached to the 

assigned Group.  

Details Tab 

 

Figure 3 - 3. 

The Group Properties Screen’s Details Tab. 

 The Details tab is available only for custom Group Types. 

Additional Group information can be entered in the Details tab and stored in the 

Hierarchy.  The five fields that appear in the Details tab are defined in the Customize / 

Database / Group Types screen when you define a custom Group Type.   

Enter appropriate information in the text box following the customized fields.  Helpful 

Details information may include serial number, RPM, address, etc.  These fields may be 

customized to support any type of information applicable to your specific application. 
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The Details tab is unavailable if detail options have not been previously defined in the 

Database / Group Type screen. 

Inserting New POINTs 

 The DMx system hierarchy is created automatically, based on 

DMx modules communicating with @ptitude Analyst Monitor.  

(Refer to Chapter 7 for details.)  Although there is no need to 

manually insert POINTs, this section contains information on 

configurable POINT properties that may be useful to DMx users. 

Use the Insert menu to insert new measurement POINTs to your hierarchy machines. 

To insert new POINTs: 

 In the Hierarchy window, select the machine from you wish the new POINT to 

branch. 

 Select the Insert menu’s New POINT option.  The DAD / POINT Type Selection 

dialog displays. 

 The keyboard’s Insert key may also be used to insert a new 

POINT. 

 

Figure 3 - 4. 

The DAD / POINT Type Selection Dialog. 

From the DAD / POINT Type Selection dialog, your DAD Type, Application, Sensor, 

and Units selections determine the POINT type.  For example, Vibration / 

Accelerometer / mm / sec settings denote an acceleration to velocity type 

measurement, whereas Vibration / Accelerometer / gE settings denote an enveloped 

acceleration measurement.  

Fields in this dialog include: 

DAD Type – Select WMx / IMx from the drop down list of available DADs. 

Application – Only applications consistent with your DAD type selection display in the 

Application drop down list.  Select the appropriate application.   

Sensor – Only sensors consistent with your selected application display in the Sensor 

drop down list.  Select the appropriate sensor. 
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Units – Only units consistent with your selected sensor type display in the Units drop 

down list.  Select the appropriate units. 

 Click OK to save your settings. 

 Click Cancel to terminate POINT insertion. 

 Once the POINT is saved with DAD / POINT Type information, 

this information cannot be modified. 

After DAD / POINT Type Selection settings are saved, the POINT Properties screen 

automatically displays. 

POINT Properties 

The POINT Properties screen allows you to enter all POINT information and settings.  

On each tab: 

 Click OK to save settings. 

 Click Cancel to undo settings. 

General Tab 

The POINT Properties screen’s General tab allows you to enter the POINT name and 

description and displays the DAD / POINT Type information you previously entered. 
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Figure 3 - 5. 

The POINT Properties Screen’s General Tab. 

POINT Properties / General fields include: 

Name – Enter a unique name to identify the POINT. 

Description – Enter a description to further identify the POINT. 

Enable data collection – When POINTs are downloaded to the collection instrument, 

the Enable data collection setting determines whether the POINT is downloaded or 

ignored.  Click the checkbox to enable. 

DAD Type – Displays the DAD type previously assigned when the POINT was created. 

Application – Displays the application type assigned when the POINT was created. 

Sensor – Displays the sensor type assigned when the POINT was created. 

Units – Displays the appropriate measurement unit assigned when the POINT was 

created. 

 The DAD Type, Application, Sensor, and Units fields of the 

General tab cannot be edited once they have been assigned. 
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 When a POINT is disabled from downloading, its existing alarm 

conditions do NOT affect the system. 

Location – Enter the data collection POINT on the machine.  Options include: 

Normal – Alphabetic identifiers A-J. 

Displacement – Numeric identifiers 1-10. 

Other – Six specific identifiers: 

Drive End 

Non-Drive End 

Outboard 

Inboard 

Coupled End 

Non-Coupled End 

Orientation – Select from drop down list options (Axial, Horizontal, None, Radial, 

Triax, Vertical, X, Y). 

Exclude from reports if last measurement is a Non-collection event. – Select 

(check) to have any reports that would include this POINT exclude it if its last 

measurement was a non-collection event (for example, the machine was marked as 

non-operating or certain measurement conditions were not met). 

Clear Alarms for Non-collection last measurements. – Select (check) to have the 

system clear any previous measurement alarms for this POINT if its last measurement 

was a non-collection event (for example, the machine was marked as non-operating or 

certain measurement conditions were not met). 
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Sensor Setup Tab 

 

Figure 3 - 6. 

The POINT Properties Screen’s Sensor Setup Tab. 

 RPM POINTs and Logic POINTs do not support sensor setup, so 

the Sensor Setup tab does not appear in the POINT Properties 

screen if the selected POINT is configured as an RPM, or Logic 

POINT. 

The Sensor Setup tab allows you to re-apply previously defined “shared” sensors, 

eliminating the need to define sensor settings individually, saving time and database 

space. 

Use the Sensor Setup tab to set a POINT’s sensor settings.  Settings can be configured 

in a variety of ways using the tab’s fields. 

The current sensor name appears in the Sensor names field.  The current sensor’s 

properties display below in the screen’s Properties and BOV Settings areas. 

The Sensor names drop down list displays all previously created sensors and a 

<Custom Sensor> option.  Use this drop down list to specify whether you wish to set up 

a unique  <Custom Sensor> for the current POINT only, or specify a previously defined 

sensor (selected by name).  If you specify a shared sensor, its settings automatically 
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display in subsequent fields.  If you specify a custom sensor, proceed to configure the 

tab’s alarm settings as described below. 

The Properties area provides options relating to Sensor Power, Settling Time, and 

Sensor Notes.  

Sensor Power – Select the appropriate sensor power setting.  Options include 

Charge Converter, External Power, and Internal ICP (4.4 mA). 

Settling Time – Type in the appropriate settling time in seconds. 

Sensor Notes – Type in any additional information you would like to store with 

the selected sensor settings.   

The BOV Settings area provides options relating to BOV gating. 

Check Sensor OK Status – Click to enable this option.  When enabled, 

@ptitude Analyst software will check the sensor status, and will display the 

sensor status in Device status and Online Data View dialogs. 

Upper Limit – Type in the BOV upper limit value. 

Lower Limit – Type in the BOV lower limit value. 

To assign a shared sensor to the current POINT: 

 Select the shared sensor from the drop down list and click the OK button.  Shared 

sensors may be applied to an unlimited number of POINTs. 

Shared Sensors 

Sensors initially created as custom sensors may be converted into shared sensors.  To 

share a newly created custom sensor, select the new custom sensor and click the tab’s 

Share As button. 

The Share As dialog specifies the sensor as a shared sensor.  When the Share As 

dialog displays, you will be prompted to give the shared sensor a unique name for easy 

identification.   

 Enter a name for the shared sensor and click the OK button. 

The new shared sensor now appears as an available selection in the drop down list.  

Shared sensors are easily assigned to other POINTs to simplify POINT setup and 

maintenance. 
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Setup Tab – WMx POINTs  

 

Figure 3 - 7. 

The POINT Properties / Setup Tab. 

Enter on-line device POINT setup information in this tab. 

 The POINT Properties / Setup tab displays differently, depending 

on the POINT and DAD type.  The following Setup fields apply to 

WMx POINTs. 

If Setup units allow editing, the values display in an edit field.   

 The POINT Setup Validation screen launches when you enter 

incompatible or erroneous information on the Setup tab.   



Working With Your SKF @ptitude Analyst Hierarchy 

POINT Properties 

3 - 18 SKF @ptitude Analyst and SKF Multilog On-line Systems 

 User Manual 

Setup fields include: 

Device – Select the appropriate on-line device name from the drop down list.  The list 

contains all available device names. 

 Devices may be added or removed in the View menu’s WMx 

Device dialog. 

Channel Name – Select the channel name from the drop down list to assign the POINT 

to a channel.  Available channels are limited to channels assigned with the POINT’s 

selected sensor type.  Click the browse (…) button to display the Channel Selection 

dialog.   

 Reference Chapter 2, Setting Up Your WMx Device for details 

on configuring WMx channels. 

The Channel Selection dialog allows you to select a channel name and view the 

selected channel’s properties.  The fields are read only.  Use the drop down list to select 

a different channel and view its properties.  Click OK to save the selected channel and 

return to the Setup tab.  Click Cancel to if you do not wish to keep the selected channel. 

Gain - (1 or 10). For small signals, select a multiplier to apply to the input sample to 

improve resolution. The default value is 1; select 10 to improve amplitude resolution. 

 Gain is not applicable for DC, Diagnostic, Speed, or integrated 

POINTs. 

 Although you apply this multiplier to the input sample to improve 

resolution, it does not affect the final signal. 

Detection - Click on the list box to view the choices (Peak, Peak to Peak, and RMS).  

Select the method of dynamic signal detection from the drop down list. 

Input filter range - Specify the amplitude range scaling for envelope acceleration 

POINTs. 

3K to 60K CPM  30K to 600K CPM 300K to 2.4M CPM 

Freq. Type - (read-only) (Fixed Span). 

Fixed Span – Specifies frequency as the unit of measurement for the 

horizontal axis of the FFT spectrum. 

Full Scale - Enter a number to define the anticipated maximum amplitude to be 

measured for this POINT. 

Save Data – Determines whether the DAD collects FFT data, Time Record data, or 

both.   

Start / End Freq. – The Start frequency is always set to zero.  Select the upper, full 

scale frequency range of the FFT between 1.5 kCPM and 2400 kCPM from the drop 

down list.  Unless you are making a very unusual measurement, the upper full scale 

frequency should always be greater than running speed. 

Low Freq. Cutoff – Enter a low frequency cutoff filter value for dynamic 

measurements.  Although values are allowed from 0.0 CPM to 2,400 kCPM, the range 

for normal measurements is from approximately 200 CPM to 600 CPM, or the 

equivalent in Hz. 
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Pulses / Rev - Used to determine machine running speed.  If a tachometer is 

connected, enter the number of tach. pulses that occur for each shaft revolution. 

Lines – The spectrum’s FFT resolution.  Click the drop down list box to view available 

choices. 

 The higher the resolution, the longer the data collection. 

100 200 400 800 

1600 3200 6400 12,800 

Window – Select the type of window used in the FFT processing.  Click the drop down 

list box to view the choices (Hanning or Flat Top).  A window function must be applied 

to any periodic time record prior to performing an FFT.  The Hanning and Flat Top 

window functions attenuate to zero both the leading and trailing edges of the sample in 

order to prevent leakage error caused by discontinuities in the time record. 

Hanning – A dynamic signal analyzer window function that provides better 

frequency resolution than Flat Top, but with reduced amplitude accuracy.  

Useful for machine vibration measurements, general purpose measurement, 

and measurements containing random noise. 

Flat Top – A dynamic signal analyzer window function which provides the best 

amplitude accuracy for measuring discrete frequency components.  Useful for 

calibration of machine vibration measurements using displacement probes in 

fluid-film bearings. 

Speed – Enter the nominal shaft speed in RPM. 

Averages – Select the number of FFT averages to be collected (1 to 20).  The higher the 

number of averages, the longer the data collection. 

Averaging – (Average or Synchronous Time) If averaging has been selected for the 

POINT, determines the type of averaging performed, (either normal averaging, no 

averaging, peak hold averaging, or synchronous time averaging).  Synchronous Time 

requires a tachometer assignment. 

Enable tacho -  Click to enable tachometer. 

Trigger Timeout -  Enter the number of seconds (1 to 60) that the WMx waits for the 

trigger pulse before it will abort the measurement. An entry of 0 seconds is not allowed. 

Linear Factor – Enter a numerical value for the desired multiple of machine speed to 

calculate the linear production speed. 

Linear Speed Units – Type in the linear speed unit. 
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WMx POINTs’ End Frequency and Lines Validation 

8 MB and 16 MB WMx and Non-enveloped POINTs 

End Frequency Valid Lines Max Time (seconds) 

25 100 or 200 8 

50 100, 200 or 400 8 

100 100, 200, 400 or 800 8 

200 100, 200, 400, 800 or 1600 8 

500 100, 200, 400, 800, 1600 or 3200 6.4 

1K 100, 200, 400, 800, 1600, 3200 or 6400 6.4 

2K 100, 200, 400, 800, 1600, 3200, 6400 or 12800 6.4 

5K 100, 200, 400, 800, 1600, 3200, 6400 or 12800 2.56 

10K 100, 200, 400, 800, 1600, 3200, 6400 or 12800 1.28 

20K 100, 200, 400, 800, 1600, 3200, 6400 or 12800 0.64 

40K 100, 200, 400, 800, 1600, 3200, 6400 or 12800 0.32 

 

WVT and Non-enveloped POINTs 

End Frequency Valid Lines 

50 100, 200 or 400 

100 100, 200, 400 or 800 

200 100, 200, 400, 800 or 1600 

500 100, 200, 400, 800, 1600 or 3200 

1K 100, 200, 400, 800, 1600, 3200 or 6400 

2K 100, 200, 400, 800 or 1600 

5K 100, 200, 400, 800, 1600 or 3200 

10K 100, 200, 400, 800, 1600, 3200 or 6400 

 

WVT devices and enveloped POINTs 

Input Filter Range End Frequency in Hz Valid Lines 

500 to 10K Hz 100 100 

 200 100 or 200 

 500 100, 200 or 400 

 1K 100, 200, 400 or 800 

 2K 100, 200, 400, 800 or 1600 

 5K 100, 200, 400, 800, 1600 or 3200 

 10K 100, 200, 400, 800, 1600, 3200 or 6400 
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8 MB WMx devices and enveloped POINTs 

Input Filter Range End Frequency in Hz Valid Lines 

50 to 1K Hz 25 100 or 200 

 50 100, 200 or 400 

 100 100, 200, 400 or 800 

 200 100, 200, 400, 800 or 1600 

 500 100, 200, 400, 800, 1600 or 3200 

 1K 100, 200, 400, 800, 1600, 3200 or 6400 

500 to 10K Hz 100 100 

 200 100 or 200 

 500 100, 200 or 400 

 1K 100, 200, 400 or 800 

 2K 100, 200, 400, 800 or 1600 

 5K 100, 200, 400, 800, 1600 or 3200 

 10K 100, 200, 400, 800, 1600, 3200 or 6400 

5K to 40K Hz 200 100 

 500 100 or 200 

 1K 100, 200 or 400 

 2K 100, 200, 400 or 800 

 5K 100, 200, 400, 800 or 1600 

 10K 100, 200, 400, 800, 1600 or 3200 

 20K 100, 200, 400, 800, 1600, 3200 or 6400 

 40K 100, 200, 400, 800, 1600, 3200, 6400 or 12800 
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16 MB WMx devices and enveloped POINTs  

Input Filter Range End Frequency in Hz Valid Lines 

50 to 1K Hz 25 100, 200, 400, 800 or 1600 

 50 100, 200, 400, 800, 1600 or 3200 

 100 100, 200, 400, 800, 1600, 3200 or 6400 

 200 100, 200, 400, 800, 1600, 3200, 6400 or 

12800 

 500 100, 200, 400, 800, 1600, 3200, 6400 or 

12800 

 1K 100, 200, 400, 800, 1600, 3200, 6400 or 

12800 

500 to 10K Hz 25 100 or 200 

 50 100, 200 or 400 

 100 100, 200, 400 or 800 

 200 100, 200, 400, 800 or 1600 

 500 100, 200, 400, 800, 1600 or 3200 

 1K 100, 200, 400, 800, 1600, 3200 or 6400 

 2K 100, 200, 400, 800, 1600, 3200, 6400 or 

12800 

 5K 100, 200, 400, 800, 1600, 3200, 6400 or 

12800 

 10K 100, 200, 400, 800, 1600, 3200, 6400 or 

12800 

5K to 40K Hz 25 100 

 50 100 or 200 

 100 100, 200 or 400 

 200 100, 200, 400 or 800 

 500 100, 200, 400, 800 or 1600 

 1K 100, 200, 400, 800, 1600 or 3200 

 2K 100, 200, 400, 800, 1600, 3200 or 6400 

 5K 100, 200, 400, 800, 1600, 3200, 6400 or 

12800 

 10K 100, 200, 400, 800, 1600, 3200, 6400 or 

12800 

 20K 100, 200, 400, 800, 1600, 3200, 6400 or 

12800 

 40K 100, 200, 400, 800, 1600, 3200, 6400 or 

12800 
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Setup Tab – IMx POINTs  

 

Figure 3 - 8. 

The POINT Properties / Setup Tab. 

Enter on-line device POINT setup information in this tab. 

 The POINT Properties / Setup tab displays differently, depending 

on the POINT type.  The following Setup fields apply to IMx 

POINTs. 
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If Setup units allow editing, the values display in an edit field.   

 The POINT Setup Validation screen launches when you enter 

incompatible or erroneous information on the Setup tab.   

Setup fields include: 

Device – Select the appropriate on-line device name from the drop down list.  The list 

contains all available device names. 

 Devices may be added or removed in the Customize menu’s 

Online Settings dialog. 

Channel Name – Select the channel name from the drop down list to assign the POINT 

to a channel.  Available channels are limited to channels assigned with the POINT’s 

selected sensor type.  Click the browse (…) button to display the Channel Selection 

dialog.   

 Reference the Customize / Online Settings section for 

information on configuring IMx channels. 

The Channel Selection dialog allows you to select a channel name and view the 

selected channel’s properties.  The fields are read only.  Use the drop down list to select 

a different channel and view its properties.  Click OK to save the selected channel and 

return to the Setup tab.  Click Cancel to if you do not wish to keep the selected channel. 

Full Scale - Enter a number to define the anticipated maximum amplitude to be 

measured for this POINT. 

Detection - Click on the list box to view the choices (Peak, Peak to Peak, RMS, True 

Peak, and True peak to peak).  Select the method of dynamic signal detection from 

the drop down list.   

Freq. Type - Click the drop down list box to view the choices (Fixed Span or Order 

Track). 

Fixed Span – Specifies frequency as the unit of measurement for the 

horizontal axis of the FFT spectrum. 

Order Track – Specifies orders of running speed as the unit of measure for the 

horizontal axis of the FFT spectrum, requires a phase reference input to collect 

the measurement. 

 During the download to the IMx, if you are using firmware version 

2.0 or greater, enveloped acceleration POINTs will download with 

order tracking. 

For acceleration envelope order track POINTs, the minimum and 

maximum tracking speeds are determined by the envelope band and 

the minimum and maximum Fmax value, based on the formulas 

below: 

 Minimum tracking speed ≥ (minimum final Fmax) x 

(revolutions / lines) 

 Maximum tracking speed ≤ (maximum final Fmax) x 

(revolutions / number of lines) 
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Pre-processing 
Min 

Fmax 

Max 

Fmax 

Minimum tracking 

speed 

ENV1 5 200 1 CPM 

ENV2 5 2000 1 CPM 

ENV3 5 10000 1 CPM 

ENV4 5 40000 1 CPM 

If the formula results in a minimum speed between 0.75 and 1 CPM, 

the system will use 1 CPM as the minimum speed.  

For example, using Envelope 3 with 2 revolutions and 800 lines, the 

minimum speed, as per the formula above, must be greater than: 

 5 x 2 / 800 = 0.0125 Hz or 0.75 CPM 

Using the same parameters, the maximum speed must be less than: 

 10000 x 2 / 800 = 25 Hz or 1500 CPM 

Save Data – Determines whether the DAD collects FFT data, Time Record data, or 

both.  An additional FFT and Phase option is available for Order Tracking POINTs. 

Start / End Freq. – The Start frequency is always set to zero.  Enter the upper, full 

scale frequency range of the FFT between 0.3 kCPM and 2400 kCPM .  Unless you are 

making a very unusual measurement, the upper full scale frequency should always be 

greater than running speed. 

If the End Freq. value is outside the allowable range, an error message will 

display. 

If dividing the End Freq. value into 2400 kCPM does not result in an integer, a 

warning message will display.  For better perofmrance, it is recommended to 

only use frequencies that divide 2400 kCPM into an integer. 

When downloading the POINT information to the IMx, the end frequency value 

sent depends on the firmware version in use.  If using firmware version 2.0 or 

greater, the end frequency value entered will be sent.  If using firmware prior 

to version 2.0, the end frequency entered will scale to the closest value (10, 20, 

50, 100, 200, 500, 1000, 2000, 5000, 10000, 20000, or 40000 Hz).  In this 

case, a message will display informing you that the frequency has been scaled 

down. 

 If Freq. Type is set to Order Track, select upper frequency from 

the End Order drop down list.  End Order list options are 

determined by the Lines of resolution setting. 

 If Freq. Type is set to Order Track, the Start Freq. field changes 

to a Revolutions field that indicates the number of shaft 

revolutions necessary to perform the measurement, as 

determined by the Lines of resolution and End Order settings. 



Working With Your SKF @ptitude Analyst Hierarchy 

POINT Properties 

3 - 26 SKF @ptitude Analyst and SKF Multilog On-line Systems 

 User Manual 

Low Freq. Cutoff – Enter a low frequency cutoff filter value for dynamic 

measurements.  Although values are allowed from 0.0 CPM to 2,400 kCPM, the range 

for normal measurements is from approximately 200 CPM to 600 CPM, or the 

equivalent in Hz. 

 If Freq. Type is set to Order Track, the Low Freq. Cutoff field is 

set in Orders of running speed. 

Lines – The spectrum’s FFT resolution.  Click the drop down list box to view available 

choices. 

 The higher the resolution, the slower the data collection. 

100 200 400 800 

1600 3200 6400 

Window – Select the type of window used in the FFT processing.  Click the drop down 

list box to view the choices (Uniform or Hanning).  A window function must be applied 

to any periodic time record prior to performing an FFT.  The Hanning window function 

attenuates to zero both the leading and trailing edges of the sample in order to prevent 

leakage error caused by discontinuities in the time record. 

Uniform – A dynamic signal analyzer window function with uniform weighting 

across time.  Useful for measuring transients or mechanical response 

measurements. 

Hanning – A dynamic signal analyzer window function that provides better 

frequency resolution than Flat Top, but with reduced amplitude accuracy.  

Useful for machine vibration measurements, general purpose measurement, 

and measurements containing random noise. 

Speed – Enter the nominal shaft speed in RPM. 

Averages – Select the number of FFT averages to be collected (1, 2, 4, 8, 16, 32, 64, or 

128).   The higher the number of averages, the slower the data collection. 

 Averaging is not normally recommended when collecting 

enveloped acceleration (gE) POINTs. 

Averaging – (Average, or Synchronous Time) If averaging has been selected for the 

POINT, determines the type of averaging performed, (either normal averaging, no 

averaging, peak hold averaging, or synchronous time averaging).  Synchronous Time 

requires a tachometer assignment. 

Linear Factor – Enter a numerical value for the desired multiple of machine speed to 

calculate the linear production speed. 

Linear Speed Units – Type in the linear speed unit. 
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Control POINT Setup 

To select a control POINT for the POINT being configured: 

 Click the POINT Properties / Setup tab’s Select POINT button.  The Control Point 

dialog displays. 

 The control POINT and its dependent POINT must be in the same 

Hierarchy. 

 Click the Select control POINT button. 

 In the list, click to select the new POINT's control POINT. 

 Click OK. 

To clear the control POINT for the POINT being configured. 

 Click the Clear button. 

 Click OK. 

Setup Tab – IMx Logic POINTs  

Enter Logic POINT Setup information in this tab. 

 

Figure 3 - 9. 

The POINT Properties / Setup Tab. 
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 The POINT Properties / Setup tab displays differently depending 

on the POINT type.  The following Setup fields apply to IMx Logic 

POINTs. 

A logic POINT monitors the logic state (high or low) of one of eight digital channels of 

IMx-S, IMx-T, IMx-P, and one of two digital channels of IMx-8; and one of eight 

protection digital channels of the IMx-M.  These channels accept TTL or 12-24V signals 

from Programmable Logic Controllers (PLCs) or any other source.  Logic POINTs are 

often used as gating POINTs. 

Setup fields include: 

Device – Select the device from the drop down list. 

Channel name - Select the channel name from the drop down list to assign the POINT 

to a channel.  Available channels are limited to channels assigned with the POINT’s 

selected sensor type.  Click the browse (…) button to display the Channel Selection 

dialog.   

 Reference the Customize / Online Settings section for 

information on configuring IMx channels. 

The Channel Selection dialog allows you to select a channel name and view the 

selected channel’s properties.  The fields are read only.  Use the drop down list to select 

a different channel and view its properties.  Click OK to save the selected channel and 

return to the Setup tab.  Click Cancel to if you do not wish to keep the selected channel. 

Active State – Click to select High or Low.  The active state specifies whether the logic 

condition is true when the signal is high or low. 

In addition to data being saved to the “Scheduled” database on the regular time 

schedule, additional “Scheduled” data is saved for a logic POINT each time its state 

changes (from high to low, or low to high). 
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Orbit/SCL Tab 

Enter orbit and shaft centerline information on this tab.   

 

Figure 3 - 10. 

The POINT Properties Screen’s Orbit/SCL Tab. 

POINT Properties / Orbit/SCL fields may include: 

Channel X and Y Settings  

X-Input mv/EU – Enter a number to define the sensitivity of the pickup to be used in 

taking measurements for channel X. 

X-Sensor angle - Specify the angle that defines the X sensors’ physical location. 

Y-Input mv/EU - Enter a number to define the sensitivity of the pickup to be used in 

taking measurements for channel Y. 

Y-Sensor angle - Specify the angle that defines the Y sensors’ physical location. 
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 The orbit axis may use Scientific or Standard mode for the 0 

degree reference point, depending on your Angular axis view 

preference setting.  This setting should be taken into account 

when entering your sensor angles. 

 

Figure 3 - 11. 

Diagram Showing Scientific vs. Standard. 

Orbit Settings 

Top dead center – Specify the label to display at the top of the Orbit/SCL plot. 

Display tacho angle – Enable to allow the tacho angle to display on the Orbit/SCL plot. 

Shaft rotation – Specify the shaft rotation direction as either Bidirectional, Clockwise, 

or Counter clockwise for reference on the Orbit/SCL plot. 

Tacho angle – Specify the angle that defines the tachometer’s physical location (0 to 

359 degrees). 

Shaft Centerline Settings 

 This section is only available if the POINT uses a displacement 

probe. 

X-Cold gap – Specify the X probe’s cold gap value.  Together the X and Y probe cold gap 

values define the distance between the displacement probe and the shaft’s position in 

the bearing when the machine is at rest. 

Y-Cold gap – Specify the Y probe’s cold gap value. 

Cold gap position – Define the cold gap position in the bearing clearance circle when 

viewing the shaft centerline plot.  Choices are Bottom, Center, Left, Right, and Top. 

Bearing clearance – Specify the bearing’s clearance value (typically supplied by the 

manufacturer).  The clearance value assumes the shaft is centered in the bearing and 

defines the physical distance between the shaft and the bearing, multiplied by 2.   
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Setup Tab (Manual POINTs) 

 The POINT Properties / Setup tab displays differently, depending 

on the POINT type.  The following Setup fields apply to POINTs 

defined with a manual sensor. 

Enter Manual POINT Setup information in this tab.   

 

Figure 3 - 12. 

The POINT Properties Screen’s Manual Setup Tab. 

POINT Properties / Setup fields may include: 

 The POINT Setup Validation Screen launches when you enter 

incompatible or erroneous information on the Setup tab.  

Reference the POINT Setup Validation section later in this 

manual for more information. 

Full Scale – Enter a number to define the spectrum’s maximum amplitude value. 

The Units selected on the DAD/POINT Type Selection dialog display next to the Full 

Scale field.  If Any Units was selected, the units may be edited.  Adjust the units if 

necessary.   
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Setup Tab (DC POINTs) 

If the sensor type is DC, enter POINT setup information on this tab. 

 

Figure 3 - 13. 

The POINT Properties Screen’s DC Setup Tab. 

Device – Select the appropriate on-line device name from the drop down list.  The list 

contains all available device names. 

 Devices may be added or removed in the Customize menu’s 

Online Settings dialog. 

Full Scale – Enter a number to define the measurement’s maximum value. 

The Units selected on the DAD/POINT Type Selection dialog display next to the Full 

Scale field.  Adjust the units if necessary.   

Input mV/EU - Enter a number to define the sensitivity of the pickup to be used in 

taking measurements. 
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Channel # - Enter the terminal strip channel input (sensor input) number (1-3) at 

which the POINT's sensor is connected. 

Autorange - (On or Off).  Determines whether the POINT's full scale value is 

autoranging, or determined with the POINT's Full scale field setting. 

Zero offset – Enter a value (-1000000000.000 to 1000000000.000) in milivolts to 

offset the zero point of the measurement. 

Process Label - Enter a label to use for the process value. 

Control POINT – Displays the name of the current control POINT, if applicable. 

 Click the Select POINT button to select a control POINT. 

Setup Tab (Derived POINTs) 

A derived POINT outputs the result of a calculation based on data collected by online 

systems. 

 Derived POINTs are not downloaded to the online data acquisition 

device.  They are calculated after data has been collected from the 

device and results display in @ptitude Analyst only. 

Prior to setting Setup tab options, use the DAD / POINT Type Selection dialog’s setup 

fields to specify a derived POINT type. 

To specify a derived POINT type: 

 Select the Insert menu’s New POINT option.  The DAD / POINT Type Selection 

dialog displays. 

 Select the DAD type field’s Derived POINT option. 

 Select the Sensor field’s Calculated option. The Calculated setting indicates that 

POINT data used in a derived POINT calculation is first uploaded to @ptitude 

Analyst and then automatically “calculated” for the derived POINT during upload 

data processing. 

 For Derived POINTs, the DAD / POINT Type Selection dialog’s 

Application field defaults to General, and the Units field defaults 

to Any Units. 
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Setup Tab Options 

Enter Derived POINT Setup information in this tab.  A Derived POINT consists of an 

operator created formula (expression) using measurement POINT data (variables), fixed 

numbers (constants; i.e., Pi) and mathematical functions (i.e., sin). 

 

Figure 3 - 14. 

The POINT Properties Screen’s Setup Tab for Derived POINTs. 

POINT Properties / Setup fields may include: 

Full Scale – Enter a number to define the spectrum’s maximum amplitude value. 

Evaluation time – Ensures relevant variable data.  Defines the maximum time range 

during which all variables (POINTs) must collect measurement data for the derived 

POINT to calculate.  All variables in the expression formula must have data collected 

within this specified time range, or the derived POINT does not calculate.  For example, 

if the Evaluation time is set to 15 minutes, all variables (POINTs) must be collected 

within 15 minutes of each other. 
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Canary Labs Setup Tab 

For Canary Labs customers, enter the data historian information on this tab. 

 

Figure 3 - 15. 

The POINT Properties Screen’s Canary Labs Setup Tab. 

POINT Properties / Canary Labs Setup fields include: 

Full Scale - Enter a number to define the measurement’s maximum value.  If a Logic 

sensor type was selected, the Full Scale option will not be available. 

Data Set - Select the applicable data set that is defined in the data historian. 

Historian Tag - Enter a name for the data historian tag. 

Threshold Type - Select the type of threshold to use, Percent or Absolute, or choose 

to disable thresholds.  If a Logic sensor type was selected, the Threshold Type will be 

automatically disabled. 

Threshold Value - Enter a value to determine the threshold of the full scale value. 
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Expressions Tab (Derived POINTs) 

 The POINT Properties / Expressions tab displays when the 

Derived POINT type is selected.  Use this tab to create or edit the 

derived POINT’s Expression formula (the derived POINT’s 

calculation). 

 

Figure 3 - 16. 

The POINT Properties Screen’s Expressions Tab for Derived POINTs. 

The Expressions drop down list displays all previously created “shared” expression 

formulas (calculations) and a <Private Expression> option.  Use this drop down list to 

specify whether you wish to set up a unique <Private Expression> for the current 

derived POINT only, or specify a previously defined “shared” expression formula 

(selected by name).  If you specify a shared expression, its settings display in subsequent 

fields. 

 Specify either a shared or Private Expression and proceed to configure the tab’s 

expression settings as described below.  

Assigning Variables 

POINTs used in the derived POINT’s calculation are identified as “variables.”  Assigned 

variables list in the Available Variables area.   
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To assign variables for a derived POINT: 

 Click the Variables button.  The Variables screen displays. 

 

Figure 3 - 17. 

The Variables Screen. 

 In the Variables screen, click the Add button.  The Variables area displays the New 

Variable with an “unassigned POINT.”  The Properties area also displays the 

NewVariable. 

 Click the Select POINT assignment option button to activate the hierarchy, 

allowing you to select the POINT to assign to the new variable. 

 Click the Clear POINT assignment option to clear the point 

assigned to the selected variable.  Once cleared, <Unassigned> 

displays in the Assigned POINT column in the Variables list.   

 In the hierarchy, select the POINT to assign to the variable. 

 In the Properties area, type in a name for the new variable.  Tip - you may use the 

same name as the POINT ID. 

 Click the Save button to save the new variable.  Its information displays in the 

Variables area.  Repeat the process to Add all necessary variables. 

 You may click the Remove button to remove a variable from the 

Variables list for the current derived POINT. 
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 When finished adding variables, click the Close button to return to the POINT 

Properties / Expressions tab.  The new variables display in the Available 

Variables area. 

Once variables have been created for the derived POINT, you can create the POINT’s 

expression formula (calculation).  Enter the calculation in the Expression formula entry 

box.  An expression formula must contain at least one variable, and may also contain 

constants and functions.  Insert mathematical operators (e.g., +, -, /, *) as necessary. 

To insert a variable to the expression formula: 

 In the Expression Formula area, position the cursor where you wish to insert the 

variable. 

 Select a variable from the Variables list and click the Insert button.  The selected 

variable appears at the cursor position. 

To add a constant to the expression formula: 

 In the Expression formula field, position the cursor where you would like to insert 

the constant. 

 Click the Constants button to display the Constant dialog. 

 Select a constant, or create a new constant by clicking the Add button. 

 

Figure 3 - 18. 

The Add Constant Dialog. 

 Click OK.  The selected constant appears at the cursor position.   

To add a function to the expression formula:  

 Place the cursor in the Expression formula section where you wish to insert the 

function and click the Functions button. The Functions dialog displays. 
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Figure 3 - 19. 

The Functions Dialog. 

 Select a function from the dialog and click OK.  The selected function is entered at 

the cursor position in the Expression formula section along with the type of input 

data that is used for the function, shown in parentheses; for example: 

AVERAGE(<Variable>, <Length>). 

 Highlight the input data placeholder (e.g., <Variable>) and enter the applicable 

data, or select a constant to enter by using the Constants button.  You can also 

enter a variable by selecting it from the Variables section and clicking Insert. 

 To calculate more complex formulas, you can enter multiple 

functions within a single expression formula. 

Depending on the function, the type of input data can either be scalar data or dynamic 

data. 

Scalar data can be derived from: 

 Overall trend data from a Microlog Analyzer, Microlog Inspector/MARLIN, 

WMx/WVT, DMx, IMx, LMU/CMU/TMU 

 Inspection results (the calculated formula for inspection results will produce a result 

of either 0 (not valid) or 1 (valid) based on the inspection result that is entered) 

 Manual entry 

 Data from XML import (from sources such as the SKF Wireless Machine Condition 

Sensor, third party developments, etc.) 

 OPC from other systems (Digital Control Systems (DCS), Canary Labs and other 

data historians, etc.) 

 Oil Analysis / Trend Oil 

 MCD (Enveloped Acceleration, Velocity, or Temperature) 

 WMCD 

 Derived POINTS themselves 
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Dynamic data includes: 

 Time waveform data 

 FFT data 

The table below contains a list of the different functions that you can use for an 

expression formula, along with a description of the function and whether the function is 

based on scalar or dynamic data. 

 

Function Description Type of data 

ABS(<Variable>) Calculates the absolute value of the <Variable> entered. Scalar 

ALARMSTATUS 

(<Variable>) 

Determines and stores the current alarm status for the <Variable> 

(POINT) entered. Notice that this function does not re-evaluate past 

alarm conditions and therefore must be operated immediately when 

new alarm conditions are set for the <Variable>. 

 

Returned values are: 

-1   No alarm level (when the <Variable> has no values, no set alarm) 

0   Safe 

1   Alert 

2   Danger 

Scalar 

Dynamic 

ARCCOS(<Radians>) Calculates the arc cosine of the <Radians> value entered. The value 

returned is in degrees. 

Scalar 

ARCSIN(<Radians>) Calculates the arc sine of the <Radians> value entered. The value 

returned is in degrees. 

Scalar 

ARCTAN(<Radians>) Calculates the arc tangent of the <Radians> value entered. The value 

returned is in degrees. 

Scalar 

AVERAGE(<Variable>, 

<Length>) 

Calculates the average of the <Variable> entered using a sliding window 

of <Length> values entered. 

Scalar 

AVERAGE(<Dynamic 

Variable>,<Channel 

Number>) 

Calculates the average of the <Dynamic Variable> entered for the 

specified <Channel Number>. For non-multi-channel measurements, 

<Channel Number> should be set to 1. 

Dynamic 

CEIL(<Param>) Calculates the smallest (closest to negative infinity) integer that is not 

smaller than the <Param> value. 

Scalar 

CONTRIBUTION2 

(<Dynamic Variable>, 

<Speed Multiple>) 

Calculates the contribution (in percentage) of the energy periodical to 

the <Speed Multiple> entered. The <Dynamic Variable> entered is the 

time waveform. The <Speed Multiple> is specified in multiples of 

running speed including fractional values. 

Dynamic (best 

for time 

waveform data) 

CONTRIBUTION3 

(<Dynamic Variable>, 

<Speed Multiple>, 

<Ref Speed>) 

Calculates the contribution (in percentage) of the energy periodical to 

the <Speed Multiple> entered. The <Dynamic Variable> entered is the 

time waveform. The <Speed Multiple> is specified in multiples of 

running speed including fractional values. The <Ref Speed> entered is 

the machine speed value to use. The <Ref Speed> may be a fixed value, 

an overall value from a trend, or a speed value extracted with Speed() 

from a time waveform or spectrum. 

Dynamic (best 

for time 

waveform data) 

COS(<Radians>) Calculates the cosine of the <Radians> value entered. Scalar 
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Function Description Type of data 

COUNT_SPIKES 

(<Dynamic Variable>, 

<Channel Number>, 

<Threshold>, <DC>) 

Counts the number of spikes in the waveform indicated by the 

<Dynamic Variable> entered for the specified <Channel Number> 

entered. A spike is defined as a signal level equal or higher than the 

<Threshold> value entered. The <DC> bias value entered is subtracted 

from the signal prior to evaluation against the threshold value.  

 

Use the Average function to de-trend signals with strong DC bias i.e.: 

COUNT_SPIKES(<Dynamic Variable>, <Channel Number>, <Threshold>, 

AVERAGE(<Dynamic Variable>, <Channel Number>) ) 

 

For non-multi-channel measurements, <Channel Number> should be 

set to 1. 

Dynamic (best 

for time 

waveform data) 

CRESTFACTOR 

(<Dynamic Variable>) 

Calculates the crest factor. The crest factor is defined as the time 

waveform’s Peak value divided by its RMS value. The <Dynamic 

Variable> entered is the time waveform. The resulting value is 

dimensionless. 

Dynamic (best 

for time 

waveform data) 

CTA_PK_PK(<Waveform 

Data>, <Speed Multiple>) 

Calculates the Cyclic Time Average of a time waveform using the 

<Speed Multiple> averaging period. The <Waveform Data> entered is 

the time waveform. The <Speed Multiple> entered must be in seconds. 

The returned value is in the same engineering units as the <Waveform 

Data> and Peak to Peak detection type. 

Dynamic (best 

for time 

waveform data) 

CTA_RMS(<Waveform 

Data>, <Speed Multiple>) 

Calculates the Cyclic Time Average of a time waveform using the 

<Speed Multiple> averaging period. The <Waveform Data> entered is 

the time waveform. The <Speed Multiple> entered must be in seconds. 

The returned value is in the same engineering units as the <Waveform 

Data> and RMS detection type.  

Dynamic (best 

for time 

waveform data) 

CUSUM(<Variable>, 

<Variable>) 

Calculates the cumulative difference of the first <Variable> entered 

against the second <Variable> entered. 

Scalar 

DEGTORAD(<Degrees>) Converts the angle <Degrees> value entered to radians. Scalar 

DELTATIME(<Variable>) Calculates the difference in seconds between two adjacent 

measurements. 

Scalar 

Dynamic 

DELTAVALUE(<Variable>) Calculates the difference in value between two adjacent measurements. Scalar 

ENERGY_VALUE 

(<Dynamic Variable>, 

<Band Number>) 

Calculates the overall energy found in the specified <Band Number> 

frequency band. <Band Number> starts at 1. Returns zero when no 

frequency band exists for the specified <Band Number>. Returns a 

band overall energy value with the same units and detection type as the 

<Dynamic Variable> entered. 

Dynamic (best 

for FFT data) 

FLOOR(<Param>) Calculates the largest (closest to positive infinity) integer that is not 

greater than the <Param> value. 

Scalar 

FORECAST_EXP 

(<Variable>, <Length>, 

<Length>) 

Calculates a forecasted alarm, in days, of the <Variable> entered using 

a sliding window of specified <Length> values. Uses an exponential 

fitting function. 

Scalar 

FORECAST_LIN 

(<Variable>, <Length>, 

<Length>) 

Calculates a forecasted alarm, in days, of the <Variable> entered using 

a sliding window of specified <Length> values. Uses a linear fitting 

function. 

Scalar 

HAL(<Dynamic Variable>, 

<Speed Multiple>) 

Calculates the Harmonic Activity Index for the frequency specified by the 

<Speed Multiple> entered in the <Dynamic Variable> entered. The 

<Speed Multiple> must be in orders. The returned value is a 

dimensionless indicator of the likelihood that a harmonic pattern at the 

<Speed Multiple> exists. 

Dynamic (best 

for FFT data) 
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Function Description Type of data 

KURTOSIS(<Variable>, 

<Length>) 

For overall measurements, calculates the Kurtosis of excess for the 

<Variable> entered using a sliding window of specified <Length> 

values. There should be at least three measurements in the POINT 

referenced by the <Variable>. 

Scalar 

KURTOSIS(<Dynamic 

Variable>, <Channel 

Number>) 

Calculates the standard deviation of a dynamic signal (FFT or waveform) 

for the specified <Channel Number> entered. For non-multi-channel 

measurements, <Channel Number> should be set to 1. 

Dynamic 

LN(<Param>) Calculates the natural logarithm of the <Param> value entered. Scalar 

LOG(<Param>) Calculates the logarithm of the <Param> value entered. Scalar 

MAX(<Variable>, 

<Variable>) 

Calculates the maximum value between each <Variable> entered. 

Returns the appropriate <Variable>. 

Scalar 

MIN(<Variable>, 

<Variable>) 

Calculates the minimum value between each <Variable> entered. 

Returns the appropriate <Variable>. 

Scalar 

MOD(<Param>, 

<Param>) 

Calculates the remainder after the division of the first <Param> value 

entered by the second <Param> value entered; for example:  

MOD(7, 3) = 1. 

Scalar 

Operating Time This function is available only by selecting “Operating Time” for 

Application Type when creating the POINT. It computes the amount of 

time an asset has been operative in the time unit specified in the create 

POINT dialog. 

Scalar 

PEAK_VALUE(<Dynamic 

Variable>, <Band 

Number>) 

Calculates the peak value found in the specified <Band Number> 

frequency band. <Band Number> starts at 1. Returns zero when no 

frequency band exists for the specified <Band Number>. Returns a 

peak value with the same units and detection type as the <Dynamic 

Variable> entered. 

Dynamic (best 

for FFT data) 

PERCENTCHANGE 

(<Variable>) 

Calculates the percentage change between two adjacent measurements. 

What is computed is: (Value – PreviousValue ) / PreviousValue. 

Scalar 

POWER(<Base>, 

<Exponent>) 

Raises the <Base> entered to the power of the <Exponent> entered. Scalar 

ROC(<Variable>, <Days 

Multiple>) 

Calculates the rate of change (in days) between two adjacent 

measurements. 

Scalar 

ROUND(<Param>) Calculates the integer closest to the <Param> value. Scalar 

SIN(<Radians>) Calculates the sine of the <Radians> value entered. Scalar 

SKEW(<Variable>, 

<Length>) 

Calculates the skew for the <Variable> entered using a sliding window 

of specified <Length> values. There should be at least four 

measurements in the POINT referenced by the <Variable>. 

Scalar 

SKEW(<Dynamic 

Variable>, <Channel 

Number>) 

Calculates the skew of a dynamic signal (FFT or waveform) for the 

specified <Channel Number>. For non-multi-channel measurements, 

<Channel Number> should be set to 1. 

Dynamic 

SMAX(<Dynamic 

Variable>) 

Calculates the maximum vector magnitude of an Orbit. The <Dynamic 

Variable>value entered must refer to a 2 channel time waveform value. 

Dynamic (best 

for time 

waveform data) 

SPEED(<Dynamic 

Variable>) 

Extracts the machine speed from the <Dynamic Variable> entered. The 

<Dynamic Variable> must be either a time waveform or spectrum. The 

returned value is in Hertz. 

Dynamic 

SQRT(<Param>) Calculates the square root of the <Param> value entered. Scalar 

STDEV(<Variable>, 

<Length>) 

Calculates the standard deviation of the <Variable> entered using a 

sliding window of specified <Length> values. There should be at least 

two measurements in the POINT referenced by the <Variable>. 

Scalar 
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STDEV(<Dynamic 

Variable>, <Channel 

Number>) 

Calculates the standard deviation of a dynamic signal (FFT or waveform) 

for the specified <Channel Number>. For non-multi-channel 

measurements, <Channel Number> should be set to 1. 

Dynamic 

SUMDURATION 

(<Variable>, <Duration>) 

Enter any number of days (for example: 1, 7, 31, etc.) or partial days 

(for example: 0.5, 3.5, 11.75, etc.) for <Duration>. This function sums 

the <Variable>’s (POINT’s) last measurement with all of its previous 

measurements found within the specified number of days (or partial 

days) prior to the last measurement date/time. 

 

Sample cases: 

Enter a <Duration> of 7 to sum the <Variable>’s (POINT’s) last 

measurement with all of its previous measurements starting 

exactly 7 days prior to the last measurement. 

 

Enter a <Duration> of 3.5 to sum the <Variable>’s (POINT’s) last 

measurement with all of its previous measurements starting 

exactly 3 and one half days prior to the last measurement. 

Scalar 

SUMPERIOD(<Variable>, 

<Period>) 

Enter a specific <Period> (defined in sample cases, below). This function 

sums the <Variable>’s (POINT’s) last measurement with all of its 

previous measurements found within the specified <Period> and 

stamps the result with the period start date/time. 

 

SUMPERIOD differs from the other functions in that it always creates a 

measurement at the start of a period as soon as it begins, even when 

the source <Variable> (POINT) has not yet collected a measurement. 

The initial value is 0, and will be updated as the source <Variable> 

(POINT) collects measurements for that period. 

 

Sample cases: 

Enter a <Period> of Period_Hour to sum the Variable’s (POINT’s) 

last measurement with all of its previous measurements within the 

same hour, starting at the top of the hour (for example 08:00 AM). 

Alternatively, you can enter the constant 1 as the <Period> value 

to represent Period_Hour. 

 

Enter a <Period> of Period_Day to sum the Variable’s (POINT’s) 

last measurement with all of its previous measurements found 

within the same day, starting at 12:00 AM. Alternatively, you can 

enter the constant 2 as the <Period> value to represent 

Period_Day. 

 

Enter a <Period> of Period_Week_Sunday to sum the Variable’s 

(POINT’s) last measurement with all of its previous measurements 

found within the same week, starting Sunday at 12:00 AM. 

Alternatively, you can enter the constant 3 as the <Period> value 

to represent Period_Week_Sunday. 

 

Enter a <Period> of Period_Week_Monday to sum the Variable’s 

(POINT’s) last measurement with all of its previous measurements 

found within the same week, starting Monday at 12:00 AM. 

Alternatively, you can enter the constant 4 as the <Period> value 

to represent Period_Week_Monday. 

 

Scalar 
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Enter a <Period> of Period_Month to sum the Variable’s (POINT’s) 

last measurement with all of its previous measurements found 

within the same month, starting the first day of the month at 

12:00 AM. Alternatively, you can enter the constant 5 as the 

<Period> value to represent Period_Month. 

 

Enter a <Period> of Period_Quarter to sum the Variable’s 

(POINT’s) last measurement with all of its previous measurements 

found within the same quarter, starting Jan 1, Apr 1, Jul 1, or Oct 

1 at 12:00 AM. Alternatively, you can enter the constant 6 as the 

<Period> value to represent Period_Quarter. 

 

Enter a <Period> of Period_Year to sum the Variable’s (POINT’s) 

last measurement with all of its previous measurements found 

within the same year, starting Jan 1 at 12:00 AM. Alternatively, 

you can enter the constant 7 as the <Period> value to represent 

Period_Year. 

SUMSINCE(<Variable>, 

<Start Date>) 

Enter any <Start Date> code (using the format yyyymmdd or, 

optionally, yyyymmddhhmmss). This function sums all of the 

<Variable>’s (POINT’s) measurements found on or after the specified 

date/time. 

 

Sample cases: 

Enter a <Start Date> of 20140101 to sum all of the Variable’s 

(POINT’s) measurements found on or after Jan 1, 2014 at 12:00 

AM. 

 

Enter a <Start Date> of 20140101090000 to sum all of the 

Variable’s (POINT’s) measurements found on or after Jan 1, 2014 

at 09:00 AM. 

Scalar 

TAN(<Radians>) Calculates the tangent of the <Radians> value entered. Scalar 

Total Operating Time This function is available only by selecting “Operating Time” for 

Application Type when creating the POINT. It computes the total 

amount of time an asset has been operative in the time unit specified in 

the create POINT dialog. 

Scalar 

Dynamic 

TRUNC(<Param>) Removes any fractional part from the <Param> value entered. Scalar 

XMAG(<Dynamic 

Variable>, <Channel 

Number>, <Channel 

Number>, <Speed 

Multiple>) 

Computes the cross magnitude value (as opposed to cross phase) 

between two time waveform signals. The waveform signals are 

referenced by the <Dynamic Variable> entered and either of the 

specified <Channel Number> values. The specific frequency the cross 

magnitude value is computed for is determined by the speed value 

associated with the measurement and the <Speed Multiple> value 

entered: f = 1 / (s * Speed Multiple). 

 

This function operates on multi-channel measurements only. 

Dynamic (best 

for time 

waveform data) 
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XPHASE(<Dynamic 

Variable>, <Channel 

Number>, <Channel 

Number>, <Speed 

Multiple>) 

Computes the cross phase value (as opposed to cross magnitude) 

between two time waveform signals. The waveform signals are 

referenced by the <Dynamic Variable> entered and either of the 

specified <Channel Number> values. The specific frequency the cross 

phase value is computed for is determined by the speed value 

associated with the measurement and the <Speed Multiple> value 

entered: 

f = 1 / (s * Speed Multiple). 

 

This function operates on multi-channel measurements only. 

Dynamic (best 

for time 

waveform data) 

 The value entered for the SIN, COS, and TAN functions must be in 

radians, not degrees.  If the value entered is in degrees, the 

@ptitude Analyst will assume it is in radians, and the calculation 

will be wrong.   

 

To convert degrees to radians, use the DEGTORAD function in the 

formula.  For example, if you have a value of 45 degrees, the 

entered formula may look like this: SIN(DEGTORAD(45))   

 

When the formula is calculated, 45 degrees is automatically 

converted into radians.   

 Use the DeltaTime function to calculate the difference in seconds 

between the two most recent measurements for that POINT. 

 Use the DeltaValue function to calculate the difference in value 

between the two most recent measurements for that POINT.  

 Use the PercentChange function to calculate the percent change 

between the two most recent measurements for that POINT.  The 

formula will look like this: 

(LastValue – PreviousValue) / PreviousValue 

Important – After initial setup of a derived POINT that references variables 

(POINTs) with existing data records, you must manually calculate the derived 

POINT to immediately acquire derived POINT data based upon the variable POINTs’ 

historical data records.  Reference the Calculating Derived POINTs section later in 

this chapter for details. 

Share As 

 Click Share As to make the expression a shared expression.  The Enter Name 

dialog displays. 

 Enter a name for the shared expression and click OK. 

The new shared expression now appears as an available selection in the dialog's drop 

down list.  Shared expressions are easily assigned to other POINTs to simplify setup and 

maintenance. 
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IMx Setup Tab 

Assign alarm groups to your IMx POINT on this tab.   

 

Figure 3 - 20. 

The POINT Properties Screen’s IMx Setup Tab.  

 The POINT Properties / IMx Setup tab displays differently 

depending on the POINT type.  The following Setup fields apply to 

POINTs configured with a General application type. 

 The IMx-8 supports two alert relays, not four. 

Alarm Group – Assign the POINT to an Alarm Group.  Select an alarm group from the 

drop down list.  To view information about the selected alarm group, click the View 

button.  A read-only Alarm Group dialog displays. 

 Reference the Customize / Alarm settings section for 

information on creating alarm groups. 

Alarm Relay – Assign an alarm relay to the POINT.  If collected data from this POINT 

causes an alarm condition, the selected relay activates. 

Danger Relay – Assign a danger relay to the POINT.  If collected data from this POINT 

causes a danger condition, the selected relay activates. 
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Threshold Tab 

Assign reference POINTs to your IMx / WMx / DMx POINTs on this tab.  

 The POINT Properties / Threshold tab displays differently 

depending on the DAD and POINT type.   

 

Figure 3 - 21. 

The POINT Properties Screen’s Threshold Tab. 

Speed Collection – Enter speed collection information in the fields below: 

Speed reference - To assign a POINT for speed tag reference, click the Select… button 

to browse POINTs.   

Speed Ratio – Enter a numerical value for the desired multiple in the Ratio field.   

Enable active range – Click to enable data collection for specified range. 

Min / Max - Enter the Min / Max range at which data collection occurs.   
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Delta - Enter a value to specify the threshold for acceptable change during 

data collection.  If difference is greater than the Delta value, data collection 

does not occur.  

Unit - Enter the unit of measurement. 

Process Collection – Enter process collection information in the fields below: 

Process reference – To assign a POINT for process reference, click the Select… button 

to browse POINTs.   

Enable active range – Click to enable data collection for specified range. 

Min / Max - Enter the Min / Max range at which data collection occurs. 

Delta - Enter a value to specify the threshold for acceptable change during 

data collection.  If difference is greater than the Delta value, data collection 

does not occur.  

Units – Enter the units of measurement. 

Self Collection – Enter self collection information in the fields below:  

 A self collection POINT references its own measurement collection 

data, rather than another POINT’s measurement collection data.   

Enable active range – Click to enable data collection for specified range. 

Min / Max – Enter the Min / Max range at which data collection occurs. 

Unit – (read-only) Displays the selected POINT’s unit of measurement. 

Digital Collection – Enter digital collection information in the fields below: 

Digital reference – To assign a POINT for digital reference, click the Select… button to 

browse POINTs. 

Enable active range – Click to enable data collection for specified active state. 

Active State - Specify whether a High or Low (on / off) setting must be 

present for data to be collected. 

Protection Threshold Levels tab (IMx-M) 

Use the Protection Threshold Levels tab to configure an IMx-M process POINT’s 

protection threshold levels for the IMx-M’s protection I/O module.  The threshold levels 

can be configured in a variety of ways using the Protection Threshold Levels tab’s 

fields. 

 These levels should match the levels set in the IMx-M Protection 

Configurator utility for the protection I/O module.  The levels set 

on this tab are for @ptitude Analyst display purposes only and do 

not affect the settings in the protection system, alarm status, or 

reports.  

 To display an IMx-M’s POINT Properties screen for an IMx-M 

Protection Analog POINT, you must select the General application 

type, and DC sensor type on the DAD / POINT Type Selection 

dialog.  
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Figure 3 - 22. 

The POINT Properties Screen’s Protection Threshold Levels Tab. 

The Properties area options relate to Alert and Danger alarm detection values specified 

in the Settings area.  Select from: 

None – No protection threshold is set for the POINT. 

Level – Measurements exceeding the specified Settings display on the trend 

plot when using the protection threshold limits overlay. 

Out of Window – Measurements falling outside the specified Settings display 

on the trend plot when using the protection threshold limits overlay. 
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Gating Tab 

Use the POINT Properties / Gating tab to specify Extended Logic POINTs. 

 The POINT Properties / Gating tab displays differently 

depending on the DAD and POINT type.   

 Reference Appendix C, Data Collection Gating for more 

information about gating. 

 

Figure 3 - 23. 

The POINT Properties Screen’s Gating Tab. 

Logic Gating Definition – Displays all previously created “shared” gating definitions and 

a <Private Logic Gating Definition> option.  Use this drop down list to specify whether 

you wish to set up a unique <Private Logic Gating Definition> for the current POINT 

only, or specify a previously defined “shared” gating definition. 

Gating type – Specify the gating type: 

 For WMx devices, only the Disabled (default) or Triggered gating 

options are available.  

Triggered – If the specified condition occurs during the specified timeout 

period for that POINT, data is collected for that measurement POINT.  

However, if the condition does not occur during the specified timeout period, 

no data is collected. 
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Extended – After data collection, the device checks that the condition is the 

same before saving collected data.  For example, if the machine that data is 

being collected for shuts down during data collection, the data would not be 

saved because the condition has changed since the start of data collection. 

Triggered Preemptive / Extended Preemptive – Preemptive POINTs take 

precedence over all other POINTs.  If a condition occurs for a preemptive 

POINT during data collection for a non-preemptive POINT, that data will be 

discarded, and the preemptive POINT will collect data instead.   

Mode – Specify the mode to define the gating conditions that control when data is 

collected. 

Bit – Specifies that only one condition must be present for data to be collected. 

Byte – Specifies that all conditions must be present for data to be collected. 

Combi - (extended gating only) Specifies that a combination of conditions must 

be present for data to be collected. 

Allow Preemption – Enables a timeout to occur for a preemptive POINT. 

Timeout value – Specify how many seconds a POINT will wait for the specified 

condition to occur before moving on to the next POINT.   

Dwell time – (preemptive POINTs only) Specify how many seconds the POINT must 

wait to collect data in order to allow for another preemptive POINT to collect data if its 

condition occurs.  For example, POINT 1 and POINT 2 are both preemptive POINTs, and 

POINT 1 has a dwell time setting of 5 seconds.  If during that 5 seconds, a condition 

occurs that POINT 2 must collect data for, data will be collected for POINT 2 instead of 

POINT 1. 

Channels – This section works with the State option buttons to configure whether a 

high or low setting must be present on specified channel(s) for data to be collected.  

(See State below for details.)  The box lists all channels available on the device.  

Selection of channels varies depending on your choice in the Mode field. 

If Bit is selected in the Mode field, the list displays option buttons.  Select the 

single channel you would like to configure and set the state using the State 

option buttons.  

If Byte is selected in the Mode field, all channels are used in gating.  Highlight 

each channel in turn and set the state using the State option buttons, or 

double click to toggle the state. 

If Combination is selected in the Mode field, the list displays check boxes.  

Select any combination of channels to use with gating and set the state using 

the State option buttons. 

 State – Specify whether a High or Low (on / off) setting must be present for data 

to be collected.  Settings may be configured in the Online Settings / Device tab in 

the Customize menu. 

Shared Gating 

Gates initially created as private gating may be converted into shared gating.  To share 

a newly created Private gate, select the new Private gate and click the tab’s Share As 

button. 



Working With Your SKF @ptitude Analyst Hierarchy 

POINT Properties 

3 - 52 SKF @ptitude Analyst and SKF Multilog On-line Systems 

 User Manual 

The Enter Name dialog specifies the gate as a shared gate.  When the Enter Name 

dialog displays, you will be prompted to give the shared gate a unique name for easy 

identification.   

 Enter a name for the shared gate and click the OK button. 

The new shared gate now appears as an available selection in the drop down list.  

Shared gates are easily assigned to other POINTs to simplify POINT setup and 

maintenance. 

Schedule Tab 

Use the Schedule tab to enter data collection and archiving scheduling information. 

@ptitude Analyst allows you to archive collected data using its Scheduler feature, its 

Monitor application, or Manually.  To archive with @ptitude Analyst’s Scheduler wizard 

or with the Monitor application, you must set archive parameters in the POINT 

Properties / Scheduler tab and in the Scheduler wizard or Monitor application 

respectively.  

 

Figure 3 - 24. 

The POINT Properties Screen’s Schedule Tab. 
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 IMPORTANT - Keep current data for, Short term archive, and 

Long term archive settings operate ONLY with the Scheduler’s 

archive process or when using the Monitor application’s archive 

feature.  They do not apply to Manual archives. 

Data collection specifies the POINT’s data collection schedule, and the overdue for 

collection status. 

Fields in the data collection portion of the Schedule tab include: 

Take data every – Enter a numerical value to indicate how often data should 

be collected and select the appropriate units from list box options (Second(s), 

Minute(s), Hour(s), Day(s)).   

 For WMx POINTs, this field is based on the selected device’s 

wake-up schedule, which is determined in the View menu’s WMx 

Device’s / Device Properties screen.  Reference Chapter 2, 

Setting Up Your WMx Device for details. 

 In addition to setting the collection schedule, this option provides 

feedback in case a device fails to collect data as scheduled.  The 

POINT is tagged as overdue for data collection if the time range 

between the current date (today) and the last data collection date 

is longer than the specified Take data every setting. 

Keep current data for – Enter a value to indicate how long to keep (store) the 

measurement record in the database’s “current data” bin and select the 

appropriate units (Wk(s), Mo(s), Yr(s)).  When the specified time from data 

collection elapses, and a Scheduled or Monitor archive process is performed, 

the measurement is typically moved from the “current data” bin into the “short 

term archive” bin (or discarded) as specified in the Short term archive / 

Archive data every field. 

 The Keep current data for field determines the length of time a 

measurement is kept before it is archived. 

Example - Using an IMx DAD, you may select to Take data every <30 days> and Keep 

current data for <1 Yr>.  If you use @ptitude Analyst’s Scheduler feature to schedule an 

archiving process every month, no archiving will take place for the first year.  After the 

first year, on a monthly basis,  all measurement records in the “current data” bin whose 

date / timestamp is older than 1 year from the current date will either be placed in the 

“short term archive” bin (if short term criteria are met) or discarded. 

Short term archive (optional, but typically enabled) 

Fields in the short term archive section include: 

Archive data every – Determines whether data leaving the “current data” bin 

is archived in the “short term archive” bin.  Enter numerical value to indicate 

how often data leaving the “current data” bin is stored in the “short term 

archive” bin and select appropriate units (Wk(s), Mo(s), Yr(s)).  As scheduled 

archives occur, measurements leaving the “current data” bin are accepted into 

the “short term archive” bin only if this Archive data every setting has expired 

since the last measurement was stored in the “short term archive” bin.  

Otherwise, they are discarded. 
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Example - To continue with our example of a scheduled monthly archive.  If we set this 

Archive data every setting to three months, on the 13th month of data collection, the 

measurement(s) leaving the “current data” bin are placed in the “short term archive” bin 

as there is no data yet stored in the “short term archive” bin.  On months 14 and 15, 

measurement(s) that exceed the Keep for setting and leaving the “current data” bin are 

discarded, as three months have not expired since the last “short term archive” data 

was stored.  On month 16, measurement(s) leaving the “current data” bin are three 

months newer than the last measurement stored in the “short term archive” bin, and 

are therefore stored in the “short term archive” bin.  Thus, by configuring this setting to 

three months, you are able to “thin” the data stored in the “short term archive” bin 

(store short term archive data every three months instead of every month). 

Keep archive for – Enter a value to indicate how long to keep (store) the 

measurement record in the “short term archive” bin and select appropriate 

units (Wk(s), Mo(s), Yr(s)).  When the specified time of storage elapses, and a 

scheduled archive process performed, the measurement is typically moved 

from the “short term archive” bin into the “long term archive” bin (or discarded) 

as specified in the Long term archive fields. 

Fields in the long term archive section include: 

Archive data every – Determines whether data leaving the “short term 

archive” bin is archived in the “long term archive” bin.  Enter numerical value to 

indicate how often data leaving the “short term archive” bin is stored in the 

“long term archive” bin and select appropriate units (Wk(s), Mo(s), Yr(s)).  As 

scheduled archives occur, measurements leaving the “short term archive” bin 

are accepted into the “long term archive” bin if this Archive data every setting 

has expired since the last measurement was stored in the “long term archive” 

bin. 

Keep archive for – Enter value to indicate how long to keep (store) the 

measurement record in the “long term archive” bin and select appropriate 

units (Wk(s), Mo(s), Yr(s)).  When the specified time of storage elapses, and a 

scheduled archive process is performed, the measurement is discarded. 

Unscheduled data 

The last section of the tab schedules alarm data.  In on-line DAD systems, alarm data is 

automatically placed in the “Unscheduled data” bin.  This setting determines how long 

alarm data is stored in the alarm data bin before it is discarded.   Fields include: 

Keep for – Specify value to indicate the desired length of time to store alarm 

data and select appropriate units (Wk(s), Mo(s), Yr(s)).  After the specified 

storage time elapses, the alarm data is discarded. 
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Filter Keys Tab 

 

Figure 3 - 25. 

The POINT Properties Screen’s Filter Keys Tab. 

@ptitude Analyst allows you to create Filter Keys which can be associated with POINTs 

and Machines for automated filtering purposes.  For example, if you activate a “Pump” 

filter key for a Group and later filter a hierarchy list using the Filter Key / Pump, then 

all Groups with active Pump filter keys display in the filtered Workspace. 

 Filter key creation is discussed later in this chapter. 

Filter key searches list all POINTs or Machines sharing a specified filter key (or multiple 

filter keys).  The Filter Key tab lists all created filter keys and indicates whether or not 

they are currently assigned.   

 Click a specific filter key’s checkbox to associate it to the current POINT. 

 The checkbox appears gray if the filter key is enabled for a parent 

hierarchy item. 

 Click the Filter Key dialog’s OK button to save your filter key assignments. 
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Overall Tab 

Setting Alarms – Overview 

By setting alarms on your vibration measurements, the hierarchy’s alarm status 

indicators allow you to quickly know if any of your monitored components / machines 

moved into an alarm condition.  If you do not specify measurement alarm settings, 

overall vibration level alarms are set to factory defaults. 

@ptitude Analyst offers many ways to alarm on machinery vibration levels: 

 Overall vibration alarms 

 Spectral enveloping (narrow band) alarms 

 Spectral band alarms 

 Phase alarms 

Of the above, overall vibration alarms are, by far, the most frequently used alarm type 

for detection of machinery faults.  Overall vibration is the total vibration energy 

measured within a specific frequency range.  Measured numerically, a higher than 

normal overall value provides an indication that "something" is causing the machine or 

component to vibrate more.  Below we describe how to go about setting your initial 

overall vibration alarm levels.  However, the same logic may be used to set alarm levels 

for other types of alarms. 

If yours is a new system and no vibration measurement history exists for the monitored 

machinery, the ISO 10816-1 Standard provides guidance for evaluating overall velocity 

vibration measurement severity in machines operating in the 10 to 200 Hz (600 to 

12,000 RPM) frequency range.  Examples of these types of machines are small, direct 

coupled, electric motors and pumps, production motors, medium motors, generators, 

steam and gas turbines, turbo compressors, turbo pumps and fans. 

It is possible for a machine to be in the early stages of wear or damage and still meet 

the criteria in these ISO 10816-1 guidelines.  While the Standard can provide a quick 

indication of machines that are in serious trouble; long term overall vibration level 

trending and experience with a machine’s history provide much more accurate 

information on where to set your machinery vibration alarm levels. 

Once you have collected enough measurement data (e.g., six data sets), SKF @ptitude 

Analyst can display meaningful trends of each measurement’s data.  Over time, when 

you are convinced that the measurement’s trending vibration level indicates the 

component’s known good condition, you may designate it as the measurement’s 

“baseline” vibration level, upon which you set two overall vibration alarm levels for 

detection of machinery faults, the “alert” level and the “danger” level.  Where to set 

these two overall alarm levels is the question. 
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Figure 3 - 26. 

Example Trend Plot with Alert (Yellow) and Danger (Red) Alarm Levels. 

In general, it is most desirable to specify alert alarm settings high enough to minimize 

extraneous alarms, yet conservative enough to not miss a critical excursion in machine 

condition.  In addition, initially you should set “loose” alarm levels so as to avoid false 

alarms.  False alarms significantly degrade confidence in the condition monitoring 

system’s accuracy.  Over time, as you continue to better understand your machinery’s 

vibration levels and gain confidence in the accuracy of your vibration measurements, 

you may “tighten” the initial alarm levels to acquire earlier detection of machine faults. 

A general rule of thumb is to initially set alert alarm levels at one and a half to twice the 

baseline levels for measurements.  This “alert” alarm level should indicate that a 

problem has developed and more frequent monitoring and analysis should occur.  Fault 

analysis should be initiated and the severity and root cause of the problem should be 

established.  In addition, analysis results should determine whether necessary repair 

parts are ordered, and the date for repair should be established based on minimum 

production interruption. 

The initial “danger” level alarm is typically set from two and a half to three times the 

baseline vibration level.  In general, if the danger alarm is reached on a critical machine, 

it should be scheduled for repairs as soon as possible.  Again, over time, after more 

experience with said machine and your vibration measurements, the alarm level can be 

adjusted to better fit the specific component / machine. 

On bearing measurements, an accurate enveloped acceleration measurement alert 

alarm indicates that a bearing is approaching the end of its usable lifetime.  Upon such 

an alarm, you should more closely monitor the bearing using spectrum analysis with 

bearing fault frequency markers to verify the bearing fault and determine proactive 

maintenance measures, or to plan the most efficient bearing replacement during a 

scheduled machine outage. 
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Once a good operating baseline is established and sufficient data and experience have 

been acquired for you to set your initial alert and danger overall vibration alarm levels, 

SKF @ptitude Analyst provides a Statistical Overall Alarms Wizard that guides you 

through a process that automatically generates overall alarm settings based upon 

historical measurement data (reference the Statistical Alarms Wizard section later in 

this chapter for details). 

The Overall tab allows you to re-apply previously defined “shared” overall alarms, 

eliminating the need to define alarms individually, saving time and database space. 

Use the Overall tab to set a process POINT’s overall alarm settings.  The alarm can be 

configured in a variety of ways using the Overall tab’s fields. 

The current alarm appears in the Overall alarm field.  The current alarm’s values 

display below in the tab’s Properties and Settings areas. 

 

Figure 3 - 27. 

The POINT Properties Screen’s Overall Tab. 
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The Overall alarms drop down list displays all previously created overall alarms and a 

<Private Alarm> option.  Use this drop down list to specify whether you wish to set up 

a unique <Private Alarm> for the current POINT only, or specify a previously defined 

“shared” alarm (selected by name).  If you specify a shared alarm, its alarm settings 

automatically display in subsequent fields.  If you specify a Private Alarm, proceed to 

configure the tab’s alarm settings as described below. 

The Properties area options relate to Alert and Danger alarm detection values specified 

in the Settings area.  Select from: 

None – No overall alarm is set for the POINT. 

Level – Measurements exceeding the specified Settings will result in an alarm 

condition. 

In Window – Measurements falling within the specified Settings will result in 

an alarm condition. 

Out of Window – Measurements falling outside the specified Settings will 

result in an alarm condition. 

To assign a shared alarm to the current POINT: 

 Select the shared alarm from the drop down list and click the OK button.  Shared 

alarms may be applied to an unlimited number of POINTs. 

Shared Alarm 

Alarms initially created as private alarms may be converted into shared alarms.  To 

share a newly created Private alarm, select the new Private alarm and click the tab’s 

Share As button. 

The Share As dialog specifies the alarm as a shared alarm.  When the Share As dialog 

displays, you will be prompted to give the shared alarm a unique name for easy 

identification.   

 Enter a name for the shared alarm and click the OK button. 

The new shared alarm now appears as an available selection in the drop down list.  

Shared alarms are easily assigned to other POINTs to simplify POINT setup and 

maintenance. 

Variable Speed Alarms 

As a machine’s speed increases, the overall vibration increases.  In order to accurately 

determine if measurements are in alarm, alarm levels should be adjusted based on the 

machine’s speed levels.  @ptitude Analyst’s variable speed alarms allow you to 

customize overall and band alarm levels based on machine speed. 

Variable speed alarms are available for IMx / WMx dynamic POINTs that reference a 

speed POINT.   

The POINT Properties / Speed Alarm tab allows you to specify the POINT’s alarm 

adjustments for each speed region.   
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Figure 3 - 28. 

The POINT Properties’ Speed Alarm Tab. 

Speed alarm fields include: 

Speed Alarm – Specify a private or shared alarm from the drop down list. 

Range – Select the speed regions for which the Properties settings will apply.  You may 

select the region from the Range drop down list, or by clicking on the specific region on 

the speed alarm display.  The values in the Properties fields update to reflect the 

specified speed region. 

 Click Insert to add a new region to the speed alarm. 

 Click Clear to remove the selected speed region. 

Start / End Range– Enter each region’s start and end RPMs (i.e., 0 to 1000, 1000 to 

2000, 2000 to 3000, etc.).  

Ratio – Enter the adjustment to overall and band alarm levels.  The normal running 

speed region's ratio will be 100.  If the next higher speed range is expected to produce 

vibration levels 10% higher than the nominal running speed, then the next speed range 

ratio would be set to 110. 

Linear – (always enabled for IMx / WMx POINTs) This option allows for either a flat, 

rectangular definition of the adjustment (if disabled, the entire region will have the same 
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ratio), or a more linear definition of the ratio (if enabled, the ratio will start from the 

level defined in the previous speed region and rise throughout the region until it reaches 

the next speed region's level).  

Deadband – When enabled, no alarm processing will occur for this region.  This is 

mainly to be used when the machine reaches its resonant speed, at which vibration will 

be indeterminately high.  When enabled, Ratio and Linear fields are disabled.  

The variable speed alarm settings produce a table of speed ratios for the POINT.  When 

data is collected, the overall alarm value is multiplied by the speed ratio before it is 

compared to the overall value returned from the sensor to determine whether the 

POINT is in alarm.  When viewing a trend display, the variable speed alarm overlay 

adjusts based on the speed of the measurement. 

 

Figure 3 - 29. 

Trend Display with Variable Speed Alarm Overlay. 

 

Figure 3 - 30.  

Band Trend Display with Variable Speed Alarm Overlay. 
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Shared Alarm 

Variable speed alarm adjustments initially created as private definitions may be 

converted into shared definitions.  To share a newly created Private definition, select the 

new Private definition and click the tab’s Share As button. 

The Share As dialog specifies the definition as a shared definition.  When the Share As 

dialog displays, you will be prompted to give the shared definition a unique name for 

easy identification.  Enter a name for the shared definition and click the OK button. 

The new shared definition now appears as an available selection in the drop down list.  

Shared definitions are easily assigned to other POINTs to simplify POINT setup and 

maintenance. 

Messages 

The Messages tab allows you to apply previously defined “shared” alarm messages, and 

to create new alarm messages for various overall alarm levels. 

 

Figure 3 - 31. 

The POINT Properties Screen’s Messages Tab. 
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@ptitude Analyst's POINT Properties / Messages feature allows you to create and 

assign four alarm messages corresponding to the four overall alarm levels; Overall 

Alert High, Overall Alert Low, Overall Danger High, and Overall Danger Low.  The 

Messages context area displays the message context available for message assignment 

and any existing alarm messages already applied.  You can assign a created public 

alarm message to one or more alarm levels, or create a new private alarm message 

and apply it to the selected POINT. 

The Name drop down list displays all previously created alarm messages and a 

<Private> option.  Use this drop down list to specify whether you wish to set up a 

unique <Private> message for the current POINT only, or specify a previously defined 

“shared” message (selected by name).  If you specify a shared message, its format, 

summary, and content automatically display in subsequent fields.  If you specify a 

Private message, proceed to configure the message settings as described below. 

 For more information on creating and managing public alarm 

messages, refer to the Customize / Database Operations section 

later in this chapter. 

Format – This drop down list allows you to specify your alarm message's format. 

Free form – Allows you to manually type in the summary and content for your 

alarm message. 

Summary – Type in text summarizing your alarm message for easy recognition.  For 

example, if you have an alarm message that details shut down instructions in the case 

of an overall danger high alarm level, your summary may read, "Emergency Shut Down 

Instructions." 

Content – Enter your complete alarm message in the content text area.  Using the 

above example, your alarm message content would include detailed shut down 

instructions, and any other pertinent information required in the case of the triggered 

alarm type. 

To assign a shared message to the current POINT: 

 Select the shared message from the drop down list and click the OK button.  

Shared messages may be applied to an unlimited number of POINTs. 

Shared Message 

Alarm messages initially created as private messages may be converted into shared 

(public) messages.  To share a newly created Private message, select the new Private 

message and click the tab’s Share As button. 

The Enter Name dialog specifies the message as a shared (public) message.  When the 

Enter Name dialog displays, you will be prompted to give the shared message a unique 

name for easy identification.   

 Enter a name for the shared message and click the OK button. 

 The new shared message now appears as an available selection in the dialog's drop 

down list.  Shared messages are easily assigned to other POINTs to simplify POINT 

setup and maintenance. 
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Frequencies Tab 

The POINT Properties screen’s Frequencies tab allows you to re-apply previously 

defined Frequency Sets, or configure a new fault Frequency Set to attach to the 

current POINT. 

 

Figure 3 - 32. 

The POINT Properties Screen’s Frequencies Tab. 

You can select a frequency shared with other POINTs or create a private frequency set 

for use with the current POINT only. 

To assign a shared frequency set to the current POINT: 

 Select the shared frequency set from the Frequency Set drop down list.  The 

corresponding included frequencies appear in the tab’s Included frequencies area.   

 Click OK to assign the selected set to the current POINT. 

Use the Frequency tab to create a private set for use with the current POINT only.   

 Check the Private frequency set checkbox.  <Private frequencies> displays in the 

tab’s Frequency Set field. 

 Click the Edit Set button.  The Frequency Sets Editor dialog opens automatically.   

 Complete edits and click OK. 



 Working With Your SKF @ptitude Analyst Hierarchy 

 POINT Properties 

SKF @ptitude Analyst and SKF Multilog On-line Systems 3 - 65 

User Manual 

The Frequencies tab also allows you to create a private set based on an existing shared 

set.  This is convenient when your new frequency set is only slightly different from an 

existing frequency set. 

 When a shared frequency set is made private, changes made to 

the shared set will not be reflected in private sets. 

To edit a shared set for private use: 

 Select the shared frequency set you wish to modify from the Frequency Set drop 

down list.   

 Click the Private Frequency set box.  The Frequency Sets Editor dialog opens. 

 Complete edits and click OK. 

 Refer to the Frequency Sets section in this chapter for more 

information on Frequency Sets. 

Notes Tab 

The POINT Properties / Notes tab allows you to attach a text note to the POINT along 

with a date / time stamp.  This feature conveniently stores and records relevant POINT 

information such as maintenance history. 

 Coded notes uploaded from the on-line device for the current 

Machine display in the Notes tab. 

 Click the Notes tab’s Add button to add a new note and date / time stamp. 

 Click the Save button to save edits made to a note. 

 Click the Undo button to cancel edits made to a note. 

 Click the Remove button to remove the selected note from the display. 

POINT Properties / Notes fields include: 

Date – Select the current date from the drop down list. 

Time – Select the current time. 

The selected date and time appear in the tab’s left Notes field. 

Text – Type in desired note text in the text field. 

 Click the tab’s OK button to save all entries. 
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HAL Alarms Tab 

HAL (harmonic activity locator) alarms provide alert and danger alarms on Harmonic 

Activity Index (HAI) indicators for designated frequencies. Use the HAL Alarms tab to 

configure HAL alarms for a dynamic measurement POINT.  

 

Figure 3 - 33. 

HAL Alarms Tab. 

If you are working with a multi-channel POINT, first select a Channel. Any existing HAL 

alarm settings that display and any existing or new HAL alarm settings you configure 

are for the selected Channel only. 

 At any time, you can click Copy to All Channels to apply the 

selected Channel’s settings to all channels. 

To exclude all frequencies from HAL alarm analysis on the selected channel: 

 Select (mark) the None radio button.  

 If no frequencies are defined for the POINT, None is the only 

available option. To associate a frequency set with the POINT, go 

to the Frequencies tab.  
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To set the same HAL alarms for all frequencies on the selected channel: 

 Select (mark) the HAL Alarms for all frequencies radio button. 

 At least one frequency must be defined for the POINT before you 

can select this radio button. 

 Select (check) the Danger High checkbox and enter a value to represent the HAI 

value danger alarm threshold. Any calculated HAI values for any of the frequencies 

on this channel that are greater than or equal to the value entered will trigger a 

danger alarm. 

 The default value is “8.” 

 Select (check) the Alert High checkbox and enter a value to represent the HAI value 

alert alarm threshold. Any calculated HAI values for any of the frequencies on this 

channel that are greater than or equal to the value entered but less than the 

Danger High threshold value will trigger an alert alarm. 

 The default value is “5.” 

 

To set HAL alarms individually per frequency on the selected channel: 

 Select (mark) the HAL Alarms for individual frequencies radio button. 

 At least one frequency must be defined for the POINT before you 

can select this radio button. 

Each row in the grid represents an individual frequency on the selected channel and 

contains the Name assigned to the frequency, the Frequency value itself, the 

Danger alarm threshold, and the Alert alarm threshold. 

 Select (check) a row’s Danger checkbox and enter a value to represent the HAI 

value danger alarm threshold for the frequency. Any calculated HAI value for this 

frequency on this channel that is greater than or equal to the value entered will 

trigger a danger alarm. 

 Select (check) a row’s Alert checkbox and enter a value to represent the HAI value 

alert alarm threshold for the frequency. Any calculated HAI value for this frequency 

on this channel that is greater than or equal to the value entered but less than the 

frequency’s Danger threshold value will trigger an alert alarm. 

 

To copy one frequency’s HAL alarm settings to other individual frequencies on a 

channel: 

 Select the entire source frequency row and click Copy. 

 Select the entire destination frequency row and click Paste. 

 To copy the source frequency’s thresholds to all frequencies on 

this channel, click Copy to All Frequencies instead of Paste. 

 If you wish to disable an alarm for any frequency, deselect (uncheck) the 

appropriate checkbox. 

If you are working with a multi-channel POINT, select each Channel and proceed with 

any of the appropriate steps described above. When you click OK to save all changes on 
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the POINT Properties screen, the system saves all settings you have configured or 

updated for each applicable channel on this tab. 

Contribution Tab 

To configure the combination contribution bar chart and profile plot display, the POINT 

Properties provides the Contribution tab. The list of frequencies presented on the 

Contribution tab is always based on the frequencies currently associated with the 

POINT on the Frequency tab. Any frequency types that are not supported on the 

Contribution plot are excluded from the Contribution tab.  The Contribution tab 

displays two types of frequencies:  

 Frequencies from bearings  

 Non-bearing RPM multiple frequencies 

 Unsupported frequencies are: Non-bearing Constant, Non-

bearing Offset and Non-bearing Sideband 

Use the Contribution tab to choose which frequencies to include in the contribution bar 

graph and roundness profile plot display, as well as to select an external source to use 

as the Speed Reference.  

Important! Upon opening, the Contribution tab list of frequencies will update to 

match changes made to the Frequency tab list. If frequencies from bearings or 

non-bearing RPM-multiple frequencies were edited on the Frequencies tab, the list 

on the Contribution tab will update to match those changes. 

Any frequencies of the relevant types (from bearings or Non-bearing RPM multiple 

frequencies) that were deleted are removed from the Contribution tab list. Any 

frequencies of the relevant types that were added are also added to the 

Contribution tab list. They are set to their default settings: unchecked, with the 

speed reference set to the current point. 
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Figure 3 - 34. 

POINT Properties, Contribution Tab.  

The columns and features on the Contribution tab are described below: 

Name – If the checkbox in the Name column is selected, that frequency will be 

displayed in the POINT’s contribution bar graph and roundness profile plot display. Click 

Check All to select and include all the frequencies. Click Uncheck All to deselect all the 

frequencies. 

Frequency – This column displays the frequency as <F> x RPM>.  The value of F depends 

on the frequency type, the Speed reference and Frequency: <value> x RPM (external 

reference) values. If the frequency is for a bearing, the numeric value substituted for F will 

be the Fundamental frequency for the row (for example, BPFO, BPFI etc.).  

 Bearing frequencies do not support external Speed References or 

Frequency: <value> x RPM (external reference) values. 

Speed Reference – Each frequency has its own speed reference. The default speed 

reference is the current POINT itself, shown in the column as <Self reference>. If the 

frequency is for a non-bearing RPM multiple and no external speed reference is set, F is 

the value of the Frequency formula of the row.  
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Figure 3 - 35. 

Frequency Sets Editor > Other Tab, Frequency Formula Field. 

The speed reference value for a non-bearing RPM multiple frequency can be changed 

to an external speed reference (for example, a tachometer signal), as detailed in the 

procedure below. 

To change the speed reference POINT for the selected frequency: 

 Highlight the frequency you want to modify. The Speed Reference field 

displays the speed reference point that will be used to derive the speed for 

calculations made in contribution graphs for this point.  

 Click the “Select...” button. The POINT Selection dialog opens.  
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Figure 3 - 36. 

POINT Selection Dialog for Selecting a New Speed Reference Point. 

If the speed reference for the current frequency is set to the default, the Set to current 

point option button will be selected and the machine for the current POINT will be 

displayed in the item hierarchy presented.  

 Select the option button Select new speed reference point.  

 Browse to the POINT in the hierarchy that you want to use as the speed 

reference. (See the section About Speed References, below.) 

 When the correct POINT is highlighted, click OK.  

 To return the speed reference to its default, select the option 

button Set to current point, and then press OK. 

You are returned to the Contribution tab. The new reference for the selected row displays 

in the Speed Reference field as “<Machine>/<Point>”. 
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Figure 3 - 37. 

Contribution Tab Showing One External Speed Reference. 

Frequency: <value> x RPM (external reference) is enabled when the selected row is 

using an external speed reference. The Frequency: <value> x RPM (external reference) 

value is used in conjunction with the frequency to calculate the speed for the frequency 

on the Contribution plot. The default value is 1.0. Enter the Frequency: <value> x RPM 

(external reference) value (as a multiple of the external speed reference). 

 If the Frequency: <value> x RPM (external reference) value is not 

1.0, F is the value of the Frequency: <value> x RPM (external 

reference) field. 

 If the Frequency: <value> x RPM (external reference) is 1.0, F is 

the value of the Frequency formula of the row (the same as no 

external reference). 

 If the speed reference is set back by using the Set to current 

point option button, then the Frequency: <value> x RPM 

(external reference) returns to its default value of 1.0. 
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OK – Click OK to save changes. Settings changed on the Contribution tab are saved 

only when one of the following conditions is met:  

 At least one frequency is checked, or  

 At least one Speed Reference or Frequency: <value> x RPM (external reference) 

value is set to something other than the default. 

More about Speed References 

Valid speed references can be any POINT (static or dynamic). For static measurements, 

the overall value is to be taken as the speed reference. For dynamic measurements 

which are speed stamped, the speed stamp will be used as the external reference. OPC 

provided speeds, as well as MODBUS provided speeds, are also supported.  

The date/time stamp (DTS) of the incoming measurement and DTS of the 

tachometer/speed reference must be within a user-defined window of time (in seconds) 

or else a warning message will be displayed on the Contribution plot. The message 

states: Speed reference out of range. 

The initial size of this window is set in a pair of Plot preferences: Speed Reference Time 

Window (Unit) and Speed Reference Time Window (Value). Go to Customize > 

Preferences > Plot tab to set these preferences. 

 

Figure 3 - 38. 

Contribution Plot Preferences for Speed Reference Time Window. 



Working With Your SKF @ptitude Analyst Hierarchy 

POINT Properties 

3 - 74 SKF @ptitude Analyst and SKF Multilog On-line Systems 

 User Manual 

You can change the Speed Reference Time Window values from within the Contribution 

plot by right-clicking to open the context menu. Select Settings to open the 

Contribution Plot Settings dialog. The default is 24 hours; the maximum is 48 hours. 

 

Figure 3 - 39. 

Contribution Plot Settings Dialog. 

Images Tab 

Scanned photographs or digital images can be added to a particular POINT, stored in 

the Hierarchy, and viewed from the Images tab.  Images help identify SETs / machines, 

organize similar equipment, and document known defects. 

POINT Properties / Images fields include: 

Image – All attached images display in the drop down list. 

Description – Enter text to identify the image.  Click the Save button to save your 

description entry.  If saved, the new description replaces the filename in the Images list. 

To add a new image: 

 Click the Add button to add a new image.  The Windows’ Open dialog displays.  

Select desired image and click Open to add or Cancel to undo. 

 Added images use the filename as the default description. 

To replace the current image file with a newer image: 

 Click the Browse button. 

 Select a replacement image file.  The new image displays on the tab. 

 The image name and description of the old image are retained for 

the replacement image. 

 Click Save to confirm the image replacement. 

 Click Cancel to undo the image replacement. 

To export an image to a specific location: 

 Select the image to export. 

 Click the Export button. 

 When prompted, enter the desired export location and filename and click OK. 

The image is copied and saved to the specified location, but still remains attached to the 

assigned POINT.  
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Baseline Tab 

A Baseline is a measurement taken when the machine is in “known good” operating 

condition.  Baseline spectra are used for analysis comparison with future spectral 

measurement results. 

 The POINT Properties / Baseline tab is available only when the 

current POINT has stored spectral data.  If there is no collected 

FFT or overall data, the Baseline tab does not appear. 

 

Figure 3 - 40. 

The POINT Properties Screen’s Baseline Tab. 

To specify a POINT’s baseline spectrum: 

 Select the POINT in the hierarchy list. 

 Right-click to display the POINT’s context menu and select the Properties option.  

The POINT Properties screen displays. 

 Select the Baseline tab. 
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Current Baseline  

The Current baseline field lists measurement record timestamps for the POINT’s 

stored measurements.  Click to specify the measurement to use as the baseline 

spectrum.  The specified measurement’s spectrum displays graphically in the tab’s lower 

area.   

 A No baseline option appears in the drop down list as the default, 

and to clear the current baseline selection. 

 In the drop down list, the assigned baseline is tagged for easy 

recognition. 

All measurements with FFT or overall data for the current POINT appear with a 

time/date stamp in the Current Baseline drop down list.  The last assigned baseline is 

tagged for easy recognition.  The current baseline value is indicated by “ ___ date / ___ 

time” in the Current baseline field. 

Phase Tab 

 This tab is available only if the POINT has stored phase data. 

 

Figure 3 - 41. 

The POINT Properties Screen’s Phase Tab. 
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Polar vector plots show vibration amplitude and phase.  The phase angle is the angle 

the shaft travels from the start of a triggering event to when the point at which the 

sensor experiences maximum positive force.  This relationship provides valuable 

information on shaft orbit and shaft position and is used for analysis, balancing, and 

shaft orbital analysis. 

The POINT Properties / Phase tab set up area specifies polar vector alarm settings, 

and provides a graphical display of the defined alert and danger acceptance regions. 

Orders are multiples of running speed.  Use the Order drop down list box to assign new 

acceptance regions to a specific order of the phase measurement (1X, 2X, 3X, 4X). 

Alert / Danger alarm fields 

 Click the Alert or Danger checkbox to enable set-up of an alert or danger 

acceptance region. 

 Use text box operations to enter Min Mag., Max Mag., Min Phase, and Max Phase 

polar vector settings. 

A summary of Enabled alarms displays vertically in the tab’s lower left column.  Alarm 

settings may also be defined graphically with drag and drop operations. 

To define graphically: 

 Move the mouse cursor over the line to be modified. 

 Depress and hold the left mouse button and drag the line to its new location before 

releasing the mouse button. 

 Click the SET button to apply alarm settings. 

Band Tab 

Band Alarms provide alert and danger alarms on both peak and spectral values within a 

defined frequency band.  Use the Band tab to Add new band alarms for the POINT, or 

Load existing “shared” and “private” band alarms for the POINT.   

 Loaded band alarms may not be edited from this tab.  Use the 

Customize menu’s Alarm Settings option to edit “shared” and 

“private” alarm parameters. 
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Figure 3 - 42. 

The POINT Properties Screen’s Band Tab. 

The current band alarm name appears in the Band alarms field.  All available band 

alarms are listed in the drop down list.   

To Load “shared” and “private” alarms to the selected POINT: 

 Click the Band tab’s Load button, the Load Band Alarms dialog displays all 

available “shared” and “private” band alarms by name.  Enable all band alarms to 

assign to the POINT and click OK.  The names of the enabled band alarms appear in 

the Band tab’s Band Alarms drop down list. 

To add a new band alarm for the POINT: 

 You may mix added band alarms with loaded band alarms.  

However, only added band alarms may be edited from this tab. 

 Click the Band tab’s Add button, the tab’s Band Information fields become 

available. 

Edit and view alarm values in the tab's Band information area.  The band name 

appears in the Label field. 
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The following fields are available for viewing set values or editing: 

Label – Enter band name. 

Low freq – View or edit the low frequency value or multiple of running speed. 

High freq – View or edit the high frequency value or multiple of running speed. 

 In Low and High Frequency fields, you may specify a multiple of 

running speed by adding x to the end of the number.  For 

example, enter “1.5x” for 1.5 times running speed. 

Peak danger – View or edit the peak danger value or % Full Scale value. 

Peak alert – View or edit the peak alert danger value or % Full Scale value. 

 In Peak and Overall alarm fields, you may specify the alarm 

setpoint as a percentage of full scale by adding “%” to the end of 

the entered number.  For example, enter “10%” to set the alarm 

at 10 percent of the full scale value.   

Overall danger – View or edit the overall danger value or % Full Scale value. 

Overall alert – View or edit the overall alert value or % Full Scale value. 

 The tab's spectrum graphic display automatically updates as edits 

are made. 

Download to IMx – Enable to download band alarm to the IMx.  The IMx supports a 

total of four band alarms per POINT.  If more than four band alarms are defined for the 

POINT, select the four band alarms you wish to download to the IMx.  The remaining 

band alarms are evaluated by @ptitude Analyst during post-processing.  An asterisk (*) 

displays next to each band alarm’s name if the band alarm is enabled to download to 

the IMx. 

Edits may be made on the tab's spectrum graphic display.   

To edit the band graphically: 

Spectrum source - If two or more POINTs are currently active, specify the POINT 

whose spectrum you wish to graphically display. 

Spectrum - using its time record, specify the spectrum measurement to display.  

Once the proper spectrum is displayed, specify the band alarm to edit from the Band 

Alarms drop down list.  Notice the mouse pointer changes when positioned over a band 

alarm parameter (line) on the graphic.   

 Click on the line of the band to edit and drag the line to its new position.  The value 

in the affected field automatically updates to reflect your setting. 

 Use the Save or Undo buttons to save or undo changes for the current band alarm 

edit.  After editing all necessary band alarms, use the tab’s OK or Cancel buttons to 

save all edited band alarms with the POINT, or cancel all edited and new band 

alarm efforts. 

The total number of band alarms appears in the upper right corner of the tab’s Band 

information area.  Use the up and down arrow buttons to navigate between band 

alarms. 
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 Click the Show all bands checkbox to display all available band alarms on the 

spectrum display.  The checkbox is not available when editing a band. 

 Click Share As to make the current band alarm a shared alarm.  The Enter Name 

dialog displays.  Enter a name and click OK. 

 Click Add to create a new band alarm. 

 Click Remove to remove the current band alarm.  A confirmation dialog displays. 

 Confirm action.  The band alarm is deleted. 

 A band alarm may not be removed if it is currently assigned. 

Load Band Alarms 

Use the Load Band Alarms dialog to select “shared” and “private” band alarm(s) for the 

active POINT.  All available “shared” and “private” band alarms display.   

 Click the checkbox to select alarm(s) to be included / assigned to the active POINT. 

 “Private” alarms appear within square brackets. 

 Click OK to select, Cancel to close dialog without saving selections. 

 You may sort the available “shared” and “private” alarms by band 

alarm name, inclusion status (included or excluded), or frequency 

range. 

Envelope Tab 

Use the POINT Properties' Envelope tab to specify a "total spectrum" envelope alarm for 

the POINT.  You can select from a list of previously created envelope alarms or edit a 

private (unique) alarm for the current POINT. 

 Only IMx firmware version 0.97 and newer supports enveloped 

alarms for filters 1, 2, and 3 only.  @ptitude Analyst evaluates any 

defined alarms during post-processing.  
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Figure 3 - 43. 

The POINT Properties Screen’s Envelope Tab. 

All available envelope alarms display in the Envelope alarm drop down list, or you may 

generate a new envelope alarm.   

Shared envelope alarms may not be edited from this tab (use the Customize menu’s 

Alarm Database option to edit "shared" alarm parameters). 

 First, select the FFT spectrum to which the envelope alarm will conform, using: 

Spectrum source – specifies from which POINT to graphically display the spectrum if 

two or more POINTs are currently active. 

Spectrum – displays all available time record measurements for the active POINT 

(typically the baseline measurement) in a drop down list.  The current spectrum displays 

graphically below. 

To assign a "shared" envelope alarm to the POINT: 

 On the Envelope tab, select the desired shared envelope alarm’s name from the 

Envelope Alarms drop down list, the tab fields display the specified alarm’s settings 

and the specified envelope appears on the displayed spectrum. 
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To generate a new envelope alarm for the POINT: 

 Select the Envelope Alarms drop down list’s <Custom envelope> option. 

 Click the Generate button.  The Generate Envelope Alarm dialog displays. 

Use the Generate Envelope Alarm Dialog to create an envelope alarm based on your 

entered values. 

% Overdrive – Enter the percent of the POINT’s full scale value to determine the height 

of the envelope alarm above the spectral peak.  The smaller the number specified, the 

tighter the comparison envelope conforms to the designated spectrum. 

Spreading % – Enter percent of full scale (or center frequency) to increase the width of 

the envelope alarm around spectral peaks.  The smaller the number specified, the 

tighter the envelope conforms to the sides of the peaks in the specified spectrum. 

Spreading Type – (either Center Frequency or Full Scale).  If Center Freq. is selected, 

the bandwidth about each center frequency increases with higher frequencies.  If Full 

Scale is selected, the bandwidth about each center frequency is constant, based on a 

percent of the full scale frequency. 

Threshold – Enter % of the POINT’s full scale value, or an absolute value.  The threshold 

value provides an opportunity to eliminate false alarms due to vibration "noise."  It also 

establishes the envelope alarm’s low amplitude "threshold" on the displayed spectrum.  

The envelope alarm conforms around all peaks whose amplitudes are higher than the 

established threshold as per the Overdrive %, Spreading %, and Spreading Type 

settings.  All peaks below the established threshold are ignored by the envelope alarm.  

The Threshold % default value is set using the Customize menu’s Preferences / Plot 

tab. 

 Click OK to generate an envelope alarm based on your entries.  Click Cancel to 

close the dialog without creating an envelope alarm. 

Editing the Envelope Alarm 

After you have generated an envelope alarm, you can edit it graphically using your 

mouse, or enter numeric envelope parameters using the Set Frequency Range dialog. 

To graphically edit the envelope alarm: 

 Click anywhere inside the Envelope dialog’s spectrum window.  The cursor appears 

as an up arrow.   

 Click the mouse on the portion of the envelope alarm line to be edited.  A square 

icon identifies where the line will be drawn. 

 Drag the mouse to draw the line to create the new envelope alarm.   

 Click the dialog’s OK button to save your changes. 

Tip - You can use your keyboard’s Insert key to begin drawing the envelope alarm line.  

Then, use the arrow keys to move the line, and the Insert key again to stop drawing the 

line.   
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To edit the envelope alarm using numeric frequency ranges: 

 Click the Set Range button.  The Set Frequency Range dialog displays. 

 Use the Set Frequency Range dialog to enter low frequency, high frequency, and 

level values to edit an existing envelope alarm. 

To numerically edit an envelope alarm: 

 Enter the desired low frequency, high frequency, and level value. 

 Click OK.  The displayed envelope alarm automatically conforms to your entries. 

Share As 

 Click Share As to make the envelope alarm a shared alarm.  The Enter Name 

dialog displays. 

 After completing the POINT’s envelope alarm setup, click the OK button to save the 

envelope alarm with the POINT. 

Setup Log 

The POINT Properties’ Setup Log tab records changes made to the POINT’s 

configuration.   

POINT Properties / Setup Log fields include:  

Date/Time – Displays the date/time stamp when the change occurred. 

User – Displays the user’s name that made the change. 

Category – Displays the POINT properties tab to which changes were made. 

Previous Value – Displays the previous value before the current change occurred. 

Reason – Displays the user entered reason for making a change to the POINT’s 

configuration.  If no reason is required or entered, this column is empty.   

 When you make a change to a POINT’s properties, you are 

requested to enter a reason for the change.  Reference Chapter 2 

- Setting Your @ptitude Analyst Preferences in the SKF 

@ptitude Analyst Introduction and Global Features user 

manual for details. 

Save As – Click to save a copy of the log file to your computer’s hard drive.   

Print – Click to print a copy of the log file. 
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Setting Up a Control POINT 

To choose a control POINT for the POINT being configured: 

Click the Control POINT Select button on the POINT Properties screen’s Setup tab to 

bring up the Control POINT Selection dialog. 

 The control POINT and its dependent POINT do not need to be in 

the same online device, but must be in the same Hierarchy. 

In the list, click to select the POINT's control POINT (or select None, for no control 

POINT). 

Gating - POINT Configuration Rules 

There are three rules for setting up control and dependent POINTs. 

Rule 1.  There is no limit to how many dependent POINTs a control POINT can 

have, as all evaluation is done in the WMx / IMx Service and not downloaded to 

the device. 

Rule 2.  A dependent POINT can have only one control POINT. 

In the figure below, data is collected for control POINT A prior to collecting data on each 

dependent POINT.  Data will be collected for a dependent POINT only if control POINT 

A's alarm criteria are met. 

 

Figure 3 - 44. 

Gating Rules 1 and 2. 

Rule 3.  A control POINT can also be a dependent POINT, that is, it can also be 

controlled. 

 The calculation of a derived POINT cannot be a dependent of a 

POINT that is in alarm. 

 

Control POINT A Dependent POINT 1 

Dependent POINT 2 

Dependent POINT n 
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Figure 3 - 45. 

Gating Rule 3. 

In the figure above, data is collected for control POINT A prior to collecting data on its 

dependents (control POINTs B through Z).  If control POINT A's alarm criteria are met, 

data will be collected on control POINT B.  If control POINT B's alarm criteria are met, 

data will be taken on its dependent POINT and so on down to dependent POINT Z.  This 

implies that all of the conditions of control POINTs A through Y must be met to collect 

data on dependent POINT Z. 

The figure below is an example of a combination of the three rules for setting up control 

and dependent POINTs.  

 

Figure 3 - 46. 

A Combination of Gating Rules 1, 2, and 3. 

If control POINT A's alarm criteria are met, data will be collected on control POINT B 

and dependent POINT 2.  If control POINT B's alarm criteria are met, data will be 

collected on dependent POINT C.  The possible combinations are endless. 

Dependent POINT z 

Dependent POINT C 

Control POINT A 

Control POINT B 

Control POINT B 

Control POINT A 

Control POINT Y 

Dependent POINT 2 
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POINT Setup Validation Dialog 

The POINT Setup Validation Dialog launches when you enter incompatible or erroneous 

information on the Setup or Expressions tabs.   

The POINT Setup Validation dialog displays both errors and recommendations.  For 

recommendations, a message box displays prior to the POINT Setup Validation dialog, 

which allows you to ignore or view the POINT Setup Validation dialog. 

 

Figure 3 - 47. 

The POINT Setup Validation Recommendation Message Box. 

 If you do not wish to see the POINT Setup Validation Message Box for 

recommendations or warnings, uncheck and disable the Show this message box 

again checkbox.   

 You may also modify this preference from the Customize menu's 

Preferences screen. 

 Press Yes to view the POINT Setup Validation dialog.  

 Press No if you wish to close the message box without viewing the 

recommendation details. 
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Figure 3 - 48. 

The POINT Setup Validation Dialog for the Setup Tab. 

 

Figure 3 - 49. 

The POINT Setup Validation Dialog for the Expressions Tab. 

 The POINT Setup Validation dialog displays automatically for 

settings in error, and after the message box for settings that are 

recommendations or warnings. 

You may edit POINT setup information while the POINT Setup Validation dialog is 

displayed.  Simply move the dialog out of the way, and make any changes to your 

POINT Properties / Setup or Expressions tab while referencing the errors or 

recommendations. 
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 Press the Refresh button if you have made corrective changes to your POINT 

Properties / Setup or Expressions tab in the background.  If you have eliminated 

the error or recommendation, they will no longer display in the POINT Setup 

Validation dialog. 

 Press the Close button to close the POINT Setup Validation dialog and return to 

the POINT Properties Setup or Expressions tab. 

Multiple POINT Properties 

The Multiple POINT Properties screen is available when more than one POINT is 

selected.  This screen provides a set of tabs to view and modify set-up parameters 

common among the set of selected POINTs.  The type of POINTs selected determine 

which tabs display in the Multiple POINT Properties screen.   

 Configured parameters overwrite each selected POINT’s previous 

settings. 

Schedule Tab 

The Schedule tab allows you to set a common schedule for all the currently selected 

POINTs. 

Fields in the data collection portion of the Schedule tab include: 

Take data every – Enter a numerical value to indicate how often data should 

be collected and select the appropriate units from list box options (Second(s), 

Minute(s), Hour(s), Day(s)).  The POINT is tagged as overdue for data 

collection if the time range between the current date (today) and the last data 

collection date is longer than the specified Take data every setting. 

 The Take data every field is used to determine if a POINT is 

overdue for data collection.   

Keep current data for – Enter a value to indicate how long to keep (store) the 

measurement record in the database’s “current data” bin and select the 

appropriate units (Wk(s), Mo(s), Yr(s)).  When the specified time from data 

collection elapses, and a Scheduled or Monitor archive process is performed, 

the measurement is typically moved from the “current data” bin into the “short 

term archive” bin (or discarded) as specified in the Short term archive / 

Archive data every field. 

 The Keep current data for field determines the length of time a 

measurement is kept before it is archived. 

Short term archive (optional, but typically enabled) 

Fields in the short term archive section include: 

Archive data every – Determines whether data leaving the “current data” bin 

is archived in the “short term archive” bin.  Enter numerical value to indicate 

how often data leaving the “current data” bin is stored in the “short term 

archive” bin and select appropriate units (Wk(s), Mo(s), Yr(s)).  As scheduled 

archives occur, measurements leaving the “current data” bin are accepted into 
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the “short term archive” bin only if this Archive data every setting has expired 

since the last measurement was stored in the “short term archive” bin.  

Otherwise, they are discarded. 

Keep archive for – Enter a value to indicate how long to keep (store) the 

measurement record in the “short term archive” bin and select appropriate 

units (Wk(s), Mo(s), Yr(s)).  When the specified time of storage elapses, and a 

scheduled archive process performed, the measurement is typically moved 

from the “short term archive” bin into the “long term archive” bin (or discarded) 

as specified in the Long term archive fields. 

Fields in the long term archive section include: 

Archive data every – Determines whether data leaving the “short term 

archive” bin is archived in the “long term archive” bin.  Enter numerical value to 

indicate how often data leaving the “short term archive” bin is stored in the 

“long term archive” bin and select appropriate units (Wk(s), Mo(s), Yr(s)).  As 

scheduled archives occur, measurements leaving the “short term archive” bin 

are accepted into the “long term archive” bin if this Archive data every setting 

has expired since the last measurement was stored in the “long term archive” 

bin. 

Keep archive for – Enter value to indicate how long to keep (store) the 

measurement record in the “long term archive” bin and select appropriate 

units (Wk(s), Mo(s), Yr(s)).  When the specified time of storage elapses, and a 

scheduled archive process is performed, the measurement is discarded. 

Unscheduled data 

The last section of the tab schedules alarm data.  In on-line DAD systems, alarm data is 

automatically placed in the “Unscheduled data” bin.  This setting determines how long 

alarm data is stored in the alarm data bin before it is discarded.   Fields include: 

Keep for – Specify value to indicate the desired length of time to store alarm 

data and select appropriate units (Wk(s), Mo(s), Yr(s)).  After the specified 

storage time elapses, the alarm data is discarded. 

Filter Keys Tab 

@ptitude Analyst allows you to create Filter Keys which can be associated with POINTs 

and Machines for automated filtering purposes.  For example, if you activated a “Pump” 

filter key for a Group and later filtered by Filter Key / Pump, the group would display. 

 Filter key creation is discussed later in this chapter. 

Filter key searches list all POINTs or Machines sharing a specified filter key (or multiple 

filter keys).  The Filter Key tab displays all created filter keys and indicates whether or 

not they are currently assigned.   

 Click a specific Filter Key’s checkbox to associate it with the current Group. 

 Click the Filter Key tab’s OK button to save your filter key assignments. 

 The checkbox appears gray if the filter key is assigned to the 

current group only because it was assigned to the group’s parent. 
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 Click the Filter Key tab’s OK button to save your filter key 

assignments. 

Overall Tab 

The Overall tab allows you to re-apply previously defined “shared” overall alarms, 

eliminating the need to define alarms individually, saving time and database space. 

 

Figure 3 - 50. 

The Multiple POINT Properties Screen's Overall Tab. 

Use the Overall tab to set POINTs’ overall alarms.  The alarm can be configured in a 

variety of ways using the Overall tab’s fields. 

The current alarm appears in the Overall alarm field.  The current alarm’s values 

display below in the tab’s Properties and Settings areas. 

The Overall alarms drop down list displays all previously created overall alarms and a 

<Private Alarm> option.  Use this drop down list to specify whether you wish to set up 

a unique  <Private Alarm> for the current POINTs only, or specify a previously defined 

“shared” alarm (selected by name).  If you specify a shared alarm, it’s alarm settings 

automatically display in subsequent fields.  If you specify a <Private Alarm>, proceed to 

configure the tab’s alarm settings as described below. 
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The Properties area displays alarm detection options.  Select from: 

None – No overall alarm is set for the POINTs. 

Level – Measurements exceeding the set levels will result in an alarm 

condition. 

In Window – Measurements falling within the set levels will result in an alarm 

condition. 

Out of Window – Measurements falling outside the set levels will result in an 

alarm condition. 

To assign a shared alarm to the current POINTs: 

 Select the shared alarm from the drop down list and click the OK button.  Shared 

alarms may be applied to an unlimited number of POINTs. 

Shared Alarm 

Alarms initially created as private alarms may be converted into shared alarms.  To 

share a newly created Private alarm, select the new Private alarm and click the tab’s 

Share As button. 

The Share As dialog specifies the alarm as a shared alarm.  When the Share As dialog 

displays, you will be prompted to give the shared alarm a unique name for easy 

identification.   

 Enter a name for the shared alarm and click the OK button. 

The new shared alarm now appears as an available selection in the drop down list.  

Shared alarms are easily assigned to other POINTs to simplify POINT setup and 

maintenance. 

Frequencies Tab 

The Multiple POINT Properties screen’s Frequencies tab allows you to reapply 

previously defined Frequency Sets, or configure a new fault Frequency Set to attach to 

the current POINT. 

The <Private Alarm> is used to set the same alarm values for all currently selected 

POINTs, yet making the alarm definition private for each POINT.  This option may be 

used when you know all the selected POINTs will have unique alarm values, but the 

initial settings will be the same. 

To assign a shared frequency set to the current POINTs: 

 Select the shared frequency set from the drop down list.  The corresponding 

included frequencies appear in the Included frequencies portion of the tab.   

 Two additional options are available, <No selection made> and 

<No frequencies>.  Use the <No selection made> option when 

no changes to the current frequency setting for the POINTs are 

needed.  Use the <No frequencies> option to clear all frequency 

settings for all selected POINTs. 

 Click OK to assign the selected set to the current POINT. 
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Band Tab 

Band Alarms provide alert and danger alarms on both peak and spectral values within a 

defined frequency band.  Use the Band tab to Add new band alarms for the active 

POINTs, or Load existing “shared” band alarms for the POINTs.   

 Loaded band alarms may not be edited from this tab.  Use the 

Customize menu’s  Alarm Database option to edit “shared” 

alarm parameters. 

The current band alarm name appears in the Band alarms field.  All available band 

alarms are listed in the drop down list.   

To Load “shared” alarms to the selected POINTs: 

 Click the Band tab’s Load button, the Load Band Alarms dialog displays all 

available “shared” band alarms by name.  Enable all band alarms to assign to the 

POINT and click OK.  The names of the enabled band alarms appear in the Band 

tab’s Band Alarms drop down list. 

To Add a new band alarm for the POINTs. 

 You may mix added band alarms with loaded band alarms.  

However, only added band alarms may be edited from this tab. 

 Click the Band tab’s Add button, the tab’s Band Information fields become available. 

Edit and view alarm values in the tab's Band information area.  The band name 

appears in the Label field. 

The following fields are available for viewing set values or editing: 

Label – Enter band name. 

Low freq – View or edit the low frequency value or multiple of running speed. 

High freq – View or edit the high frequency value or multiple of running speed. 

 In Low and High Frequency fields, you may specify a multiple of 

running speed by adding x to the end of the number.  For 

example, enter “1.5x” for 1.5 times running speed. 

Peak danger – View or edit the peak danger value or % Full Scale value. 

Peak alert – View or edit the peak alert danger value or % Full Scale value. 

Overall danger – View or edit the overall danger value or % Full Scale value. 

Overall alert – View or edit the overall alert value or % Full Scale value. 

 In Peak and Overall alarm fields, you may specify the alarm 

setpoint as a percentage of full scale by adding “%” to the end of 

the entered number.  For example, enter “10%” to set the alarm 

at 10 percent of the full scale value.   

 The tab's spectrum graphic display automatically updates as edits 

are made. 

Edits may also be made on the tab's spectrum graphic display.   



 Working With Your SKF @ptitude Analyst Hierarchy 

 Multiple POINT Properties 

SKF @ptitude Analyst and SKF Multilog On-line Systems 3 - 93 

User Manual 

To edit the band graphically: 

Spectrum source - If two or more POINTs are currently active, specify the POINT 

whose spectrum you wish to graphically display. 

Spectrum - using its time record, specify the spectrum measurement to display.  

Once the proper spectrum is displayed, specify the band alarm to edit from the Band 

Alarms drop down list.  Notice the mouse pointer changes when positioned over a band 

alarm parameter (line) on the graphic.   

 Click on the line of the band to edit and drag the line to its new position.  The value 

in the affected field automatically updates to reflect your setting. 

 Use the Save or Undo buttons to save or undo changes for the current band alarm 

edit.  After editing all necessary band alarms, use the tab’s OK or Cancel buttons to 

save all edited band alarms with the POINT, or cancel all edited and new band 

alarm efforts. 

The total number of band alarms appears in the upper right corner of the tab’s Band 

information area.  Use the up and down arrow buttons to navigate between band 

alarms. 

 Click the Show all bands checkbox to display all available band alarms on the 

spectrum display.  The checkbox is not available when editing a band. 

 Click Share As to make the current band alarm a shared alarm.  You will be 

prompted to assign the band alarm a unique name.  Enter a name and click OK. 

 Click Add to create a new band alarm. 

 Click Remove to remove the current band alarm.  A confirmation dialog displays. 

 Confirm action.  The band alarm is deleted. 

 A band alarm may not be removed if it is currently assigned. 

Load Band Alarms 

Use the Load Band Alarms dialog to select “shared” band alarm(s) for the active 

POINTs.  All available “shared” band alarms display.   

 Click the checkbox to select alarm(s) to be included / assigned to the active POINTs. 

 Click OK to select, or Cancel to close dialog without saving selections. 

 You may sort the available “shared” alarms by band alarm name, 

inclusion status (included or excluded), or frequency range. 
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Envelope Tab 

Use the POINT Properties' Envelope tab to specify a "total spectrum" envelope alarm for 

the POINT.  You can select from a list of previously created envelope alarms or edit a 

private (unique) alarm for the current POINT. 

All available envelope alarms display in the Envelope alarm drop down list, or you may 

generate a new envelope alarm.   

Shared envelope alarms may not be edited from this tab (use the Customize menu’s 

Alarm Database option to edit "shared" alarm parameters). 

 First, select the FFT spectrum to which the envelope alarm will conform, using: 

Spectrum source – specifies from which POINT to graphically display the spectrum if 

two or more POINTs are currently active. 

Spectrum – displays all available time record measurements for the active POINT 

(typically the baseline measurement) in a drop down list.  The current spectrum displays 

graphically below. 

To assign a "shared" envelope alarm to the POINT: 

 On the Envelope tab, select the desired shared envelope alarm’s name from the 

Envelope Alarms drop down list, the tab fields display the specified alarm’s settings 

and the specified envelope appears on the displayed spectrum. 

To generate a new envelope alarm for the POINT: 

 Select the Envelope Alarms drop down list’s <Custom envelope> option. 

 Click the Generate button.  The Generate Envelope Alarm dialog displays. 

Use the Generate Envelope Alarm Dialog to create an envelope alarm based on your 

entered values. 

% Overdrive – Enter the percent of the POINT’s full scale value to determine the height 

of the envelope alarm above the spectral peak.  The smaller the number specified, the 

tighter the comparison envelope conforms to the designated spectrum. 

Spreading % – Enter percent of full scale (or center frequency) to increase the width of 

the envelope alarm around spectral peaks.  The smaller the number specified, the 

tighter the envelope conforms to the sides of the peaks in the specified spectrum. 

Spreading Type – (either Center Frequency or Full Scale).  If Center Freq. is selected, 

the bandwidth about each center frequency increases with higher frequencies.  If Full 

Scale is selected, the bandwidth about each center frequency is constant, based on a 

percent of the full scale frequency. 

Threshold – Enter % of the POINT’s full scale value, or an absolute value.  The threshold 

value provides an opportunity to eliminate false alarms due to vibration "noise."  It also 

establishes the envelope alarm’s low amplitude "threshold" on the displayed spectrum.  

The envelope alarm conforms around all peaks whose amplitudes are higher than the 

established threshold as per the Overdrive %, Spreading %, and Spreading Type 

settings.  All peaks below the established threshold are ignored by the envelope alarm.  

The Threshold % default value is set using the Customize menu’s Preferences / Plot 

tab. 
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 Click OK to generate an envelope alarm based on your entries.  Click Cancel to 

close the dialog without creating an envelope alarm. 

Editing the Envelope Alarm 

After you have generated an envelope alarm, you can edit it graphically using your 

mouse, or enter numeric envelope parameters using the Set Frequency Range dialog. 

To graphically edit the envelope alarm: 

 Click anywhere inside the Envelope tab’s spectrum window.  The cursor appears as 

an up arrow.   

 Click the mouse on the portion of the envelope alarm line to be edited.  A square 

icon identifies where the line will be drawn. 

 Drag the mouse to draw the line to create the new envelope alarm.   

 Click the tab’s OK button to save your changes. 

Tip - You can use your keyboard’s Insert key to begin drawing the envelope alarm line.  

Then, use the arrow keys to move the line, and the Insert key again to stop drawing the 

line.   

To edit the envelope alarm using numeric frequency ranges: 

 Click the Set Range button.  The Set Frequency Range dialog displays. 

 Use the Set Frequency Range dialog to enter low frequency, high frequency, and 

level values to edit an existing envelope alarm. 

To numerically edit an envelope alarm: 

 Enter the desired low frequency, high frequency, and level value. 

 Click OK.  The displayed envelope alarm automatically conforms to your entries. 
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Modify by Attribute 

@ptitude Analyst’s Modify by Attribute feature allows you to make similar changes for 

one or more machines or POINTs by allowing you to change specific attributes (for 

example, alarm values, collection schedules, etc.) all at once. 

 POINT setup changes made in Modify by Attribute are not 

incorporated into POINT Properties. 

 If you use Modify by Attribute to make changes to DMx POINTs, 

you must either select the Refresh Monitor option on the DMx 

Monitor status indicator, or stop and restart @ptitude Analyst 

Monitor for the changes to be recognized. 

 

Figure 3 - 51. 

The Modify by Attribute Screen. 

To Modify Settings: 

 Select the hierarchy group (SET / Machine) that contains POINTs whose attributes 

you wish to modify. 

 All Groups and POINTs branching from the specified Group display 

in the Modify by Attribute screen.   

 Select the Edit menu’s Attributes option.  The Modify by Attribute screen 

displays. 
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The Modify by Attribute screen is split into two panels: 

Right panel - displays the selected hierarchy items and their value for the 

currently selected attribute in the left panel. 

 Click to highlight the POINT for which you wish to modify the selected 

attribute.  Its current setting / value displays in an area beneath the 

panels. 

Left panel - displays the attributes available for modification organized into 

nine categories: Alarm Settings, Channel Settings, Derived Settings, FFT 

Settings, General Settings, IMx Settings, Messages Settings, Misc. Settings, 

Online Settings, Orbit/SCL Settings, and Threshold settings. 

 Open the appropriate category’s folder to view its attributes, then click to specify 

the attribute you wish to modify.  The right panel updates to show the selected 

attribute’s current setting for each item. 

 Edit the setting. 

 Click the Set button to update the attribute setting for the selected POINT only, or 

click the Set All button to update the attribute setting for all POINTs in the right 

panel.  

 Use the Set All feature to quickly modify an attribute value for 

multiple items simultaneously.  For example, if you want to set all 

Averages to an identical value, select Averages from the 

Attributes list.  Attribute values display for all items in the tab's 

Attribute values area.  Select an individual item, enter the 

desired value, and click the Set All button.  All items will now have 

the specified number of averages. 

 After completing attribute modifications for all POINTs, click the OK button to save 

the settings in the database. 
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Measurement Properties 

General Tab 

The Measurement Properties screen displays properties for individual measurement 

data records.   

To view / edit a measurement’s properties: 

 Select the measurement record.  

 Select the Edit menu’s Properties option, or use the Properties toolbar button.  

The Measurement Properties screen displays.  

The current measurement’s time and date appears in the Date and Time fields of the 

Measurement Properties / General tab.   

Measurement Properties fields include: 

Date - View or edit the measurement record’s data collection date.  Select a new date 

from the drop down list.   

Time - View or edit the measurement record’s data collection time.   Use the arrows to 

adjust the time. 

 This feature should only be used to edit an incorrect date or time. 

Overall / Channel # - View or edit the measurement record’s overall value.  Values are 

displayed for Channel 1 and/or Channel 2 as applicable.  

 

Figure 3 - 52. 

The Measurement Properties Screen’s General Tab's Overall Area. 

 This feature should only be used to edit an incorrect overall value.  

 If necessary, the measurement’s alarm status will automatically 

update for the new measurement value.   

Exclude measurement - Enables / disables the measurement record for inclusion in 

statistical calculations. 

Readings - Displays which readings correspond to the current measurement on the 

indicated date / time.  

Alarm status will be automatically updated for the new current measurement, if 

necessary.   
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The overall value for the current Process measurement's indicated date / time appears 

in the tab’s Overall area.  Values are displayed for Channel 1 and/or Channel 2 as 

applicable.  These values may be edited in the General tab.  Enter a new value in the 

appropriate channel’s text box. 

 This feature should only be used to edit an incorrect overall value.  

The tab’s Readings area displays which readings correspond to the current 

measurement on the indicated date / time. 

 Click the Exclude measurement checkbox to exclude the current measurement 

from being included in statistical calculations. 

 After editing all necessary properties, click the OK button to save changes. 

 Click Cancel to close the screen without saving changes. 

Set Baseline 

Use the Edit menu's Set Baseline screen to specify the selected POINT's (or multiple 

POINTs') baseline.  This feature allows you to quickly reset baselines within a database 

after a change is made to the machinery. 

 In the hierarchy list, select one or more POINTs (or a hierarchy branch) whose 

baseline you wish to set as the oldest measurement record or the newest 

measurement record, or to clear the baseline altogether.. 

 Select the Edit menu’s Set Baseline option. 

 Using the screen's option buttons, specify whether to use the Oldest measurement 

or Newest measurement record as the baseline for the selected POINT(s), or 

select Clear baseline to remove the current baseline for the selected POINT(s). 

 A baseline spectrum is a vibration spectrum taken when a 

machine is in good operating condition.  It is used as a reference 

for monitoring and analysis.   

 Click OK to save setting. 

 Click Cancel to undo. 
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Set Speed (Multiple) 

Use the Set Speed (Multiple) feature to set the same measurement speed for multiple 

FFT measurements: 

 Starting from a hierarchy, ROUTE, or workspace, expand the appropriate machine. 

Beneath the machine in the hierarchy, right-click on the measurement POINT you 

wish to use as a reference and select Set Speed (Multiple) from the resulting 

context menu. 

OR 

 Starting from a hierarchy, ROUTE, or workspace, expand the appropriate machine. 

Beneath the machine in the hierarchy, click on the appropriate measurement 

POINT to display its measurements in the right panel. Then, right-click on the 

single measurement you wish to use as a reference and select Set Speed 

(Multiple) from the resulting context menu. 

OR 

 Starting from an FFT measurement plot, right-click on the single cursor and select 

Set Speed (Multiple) from the resulting context menu. 

 

           

Figure 3 - 53. 

Selecting Set Speed (Multiple) from a POINT Versus from a Measurement within a Hierarchy. 
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Figure 3 - 54. 

Selecting Set Speed (Multiple) from an FFT Measurement Plot. 

 

The Set Speed (Multiple) window appears. 

 

Figure 3 - 55. 

Set Speed (Multiple) Window. 

 Expand the machine in the Set Speed (Multiple) window’s hierarchy view and 

deselect (remove checks from) any POINTs for which you do NOT intend to set a 

measurement speed value. By default, all POINTs are selected (checked) for 

adjustment. 

 Specify the range of measurements for which you intend to set a measurement 

speed value: 
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Last measurement – Select to work only with the last measurement collected 

for each selected POINT. 

Measurements + / - … minutes – Select, then specify x number of minutes to 

work only with measurements collected within the range starting x minutes 

prior to and ending x minutes following the basis date and time. 

 If you selected a POINT as the reference (launched this window 

from a POINT), the basis date and time are equal to the date/time 

stamp of the POINT’s last measurement. If you selected a single 

measurement as the reference (launched this window from a 

single measurement or from an FFT plot), the basis date and time 

are equal to the date/time stamp of that measurement. 

 The system will remember the specified number of minutes when 

you launch this dialog again. 

Measurements… From… To… - Select, then specify starting and ending dates 

and times to work only with measurements collected within that range. 

 By default, this range starts x minutes prior to and ends x 

minutes following the basis date and time, based on the current 

Measurements + / - … minutes setting. 

 Select, then enter an MPA Tag value to work only with measurements that contain 

that value in their Description (Point Properties > General tab). 

 Click Next>>. The Set Speed (Multiple) Measurement List window appears, 

displaying a list of all measurements for the applicable POINTs that meet the 

criteria established. 

 

The Set Speed (Multiple) Measurement List window displays a list of all 

measurements for the applicable POINTs that meet the criteria established in the Set 

Speed (Multiple) window. 
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Figure 3 - 56. 

Set Speed (Multiple) Measurement List Window. 

 From the measurement list, select (check) each measurement to which you intend 

to apply the reference POINT’s measurement speed. 

 Select (check) the checkbox in the list header to select all 

measurements. 

 To change the criteria established in the previous window that 

determine the measurements in this list, click <<Back. 

 Click on any column header to sort the list according to that 

column. 

 Verify and/or enter Set Speed values. 

Current Frequency – The speed value from the reference POINT 

measurement. 

 If you initially selected a POINT as the reference, this speed value 

comes from the POINT’s last measurement. If you initially 

selected a single measurement as the reference, this speed value 

comes from that measurement. If you launched this function from 

an FFT plot, this speed value is the frequency value of the single 

cursor on that FFT plot. 

Equivalent to order – If the speed value entered is at a known harmonic, then 

you can use this value to factor the Calculated running speed to its 1x 

component. 

Calculated running speed – Enter the speed value you wish to apply to all 

selected (checked) measurements. 

 Click Finish. The system applies the Calculated running speed and Equivalent to 

order values to all measurements selected (checked) in this list. 
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Calculate Derived POINTs 

You must manually calculate derived POINTs upon the initial creation of a derived 

POINT, or after editing a derived POINT’s expression settings.  Once the initial 

calculation has been performed manually, @ptitude Analyst automatically calculates the 

derived POINT during data upload processing.   

 Upon the initial creation of a derived POINT, if the assigned 

variables do not have existing measurement data, it is not 

necessary to manually calculate the derived POINT.  It is 

necessary to manually calculate a derived POINT only when the 

assigned variables already have measurement data. 

To manually calculate a derived POINT: 

 Select the newly created or recently edited derived POINT from the Hierarchy. 

 Select the Edit menu's Calculate Derived POINTs option to quickly calculate 

measurement values for the derived POINT. 

 The Calculate Derived POINTs message dialog displays.  Select Yes to calculate 

the selected derived POINT. 

 If calculating a newly created derived POINT, new measurement 

data displays in the Hierarchy’s right panel.  Existing 

measurement data for the assigned variables is used in the 

calculation to create measurement data records for the derived 

POINT.   

 If calculating a recently edited derived POINT, all existing derived 

POINT measurement values previously calculated for the selected 

derived POINT(s) are deleted and replaced with new derived 

POINT measurements. 

 

Figure 3 - 57. 

The Edit menu’s Calculate Derived POINTs Message Dialog. 

After manual calculation of a derived POINT, @ptitude Analyst automatically calculates 

any newly uploaded data for the derived POINT during data upload processing.  The 

newly calculated data displays along with the existing derived POINT data measurement 

records in the right panel. 

 For a multi-user environment, @ptitude Analyst Monitor 

calculates the new data for derived POINTs.  If @ptitude Analyst 

Monitor is not running, then the derived POINTs will not be 

calculated.  
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Manual Archive 

@ptitude Analyst’s Manual Archive feature adds flexibility as it allows you to specify 

POINTs to archive, and allows you to archive the newest data in addition to the oldest 

data. 

The Manual Archive process differs from a Scheduled or Monitor archive process in 

several ways.   

Manual Archive: 

 Takes place immediately.   

 Archives only POINTs branching from the selected hierarchy item (or specified 

measurement records). 

 Only archives measurements from the “current data” bin (unless a specific 

measurement record from another bin is specified). 

 Allows you to specify whether to archive each selected POINT’s Oldest or Newest 

measurement record from the current data bin. 

 Allows you to specify the archive bin in which to place the archived measurements. 

Use Manual Archive to change the archive status for any or all hierarchy items.  

Manual Archive is useful to manually set a measurement’s archive status, bypassing 

automatic archive schedule (if applicable). 

To use manual archive: 

 In the hierarchy list, select a hierarchy item(s) whose measurements you wish to 

manually archive.  All POINTs branching from the selected item are archived. 

 Select the File menu’s Manual Archive option.  The Manual Archive screen 

displays. 

The screen’s top area displays a warning if the selected data is tagged as baseline.  

Baseline data cannot be modified. 

Change archive status in the screen’s Store measurements as area.  Select from: 

Current data bin (available only when archiving a measurement record from 

other bins) 

Unscheduled data bin 

Short term archive data bin 

Long term archive data bin 

The screen’s bottom area displays Archive measurements.  If working from a POINT or 

above on the hierarchy branch, select from: 

Oldest Measurement – Each selected POINT’s oldest measurement in the 

current data bin. 

Newest Measurement – Each selected POINT’s newest measurement in the 

current data bin. 

 Manual Archive does not utilize “scheduled” archive settings 
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@ptitude Analyst Scheduler 

Current Scheduled Events 

The Scheduler feature allows you to configure the software to perform scheduled 

functions based on specific conditions.  A scheduled event consists of a system event 

and an action to be executed whenever that event occurs. For example, you can use 

Scheduler to configure the software to display a message when a specific operation 

completes (action) when a DAD has completed processing (system event). 

 Select the Customize menu’s Scheduler option.  The Scheduler screen displays. 

The Scheduler screen displays all current scheduled events and the action assigned to 

each event.  Use the Scheduler screen to add new events and maintain existing events. 

To add an event:  

 Click the Add button to define an event.  The Event Scheduler Wizard launches 

automatically. 

You can also add an event by copying an existing event, then modifying the copy as 

necessary. 

To copy an event:  

 Highlight the event you would like to copy and click Copy.  The Event Scheduler 

Wizard launches.  As you navigate the wizard, options default to the settings from 

the copied event.  You may modify the settings as necessary. 

To edit an event:  

 Highlight the event you would like to modify and click Edit.  The Event Scheduler 

Wizard launches with the settings from the event you are editing.   

 Navigate the wizard to the settings you wish to modify and edit the event as 

necessary. 

To remove an event:  

 Click the Remove button to delete a scheduler entry. 

 Scheduled entries remain in effect until they are removed. 

Event Scheduler Wizard 

A scheduled event consists of a system event and an action to be executed whenever 

that event occurs.   

The Event Scheduler Wizard guides you through the process of scheduling events. 

 Click the Next button to continue. 

 Select the event you want the system to monitor and that will cause the scheduled 

action to be performed.  All available events appear in the Select an event window.   
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Figure 3 - 58. 

The Event Scheduler Wizard’s First Screen. 

Some events require specific settings that further define the event.  When settings are 

required, the Settings button is enabled.  You must specify the required Settings 

before the Next button is enabled. 

 Complete all Settings entries, if required. 

 Click the Next button. 

 Individual events are detailed later in this section. 

All available actions display in the Select an action area. 

 Select the action you wish the system to perform when the indicated event occurs 

Some actions require specific settings that further define the action.  When settings are 

required, the Settings button is enabled.  You must specify the required Settings 

before the Next button is enabled. 

 Complete all Settings entries, if required. 

 Click the Next button. 

 Individual actions are detailed later in this section. 

By default, scheduled events only execute if the user who created the event performs 

the triggering action.  (For example, a report set to run on @ptitude Analyst startup only 

runs when the user who created the event logs in.)   

If the user creating the scheduled event is an administrator, an additional dialog displays 

providing the option of assigning the event to another user, or delegating it to the 

Transaction Server.  
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The Select Users list shows all @ptitude Analyst users.   

 Select the user who should trigger this event. 

 Events scheduled to trigger at a specified time only occur if the 

user with whom the event is associated is logged into @ptitude 

Analyst.  This applies to both users who are assigned an event by 

an administrator and non-administrator users who create an 

event for themselves.  For example, if the event is scheduled for 

three a.m., the specified action will not be performed if the 

designated user is shut down at three a.m., and it will not be 

automatically performed when the program is restarted.  

Alternatively, if you have selected to generate a report at a specified time with this 

scheduled event, Delegate to Transaction Server enables.  The transaction server is a 

process that stays running in the background at all times.  If your triggering event is a 

specified time, the report runs at that time, regardless of whether the associated user is 

logged in.  

 The report is generated to a file in the path specified in the 

Report Location field on the Report Generator’s Assign tab.  If 

the Delegate to Transaction Server option is selected and the 

report location path references a local hard drive, the report is 

written to the Transaction Server host computer.  It is 

recommended that you set the report location to a network drive 

and make sure the Transaction Server has read / write access to 

that location. 

 Enable Delegate to Transaction Server to have the transaction server generate 

the report, rather than a specified user. 

 Click the Next button. 

The Event Scheduler Wizard displays a summary of the new scheduled event settings. 

 Click the Finish button to save the scheduled event. 

 Click the Back button to modify the scheduled event. 

 Click the Cancel button to cancel. 
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Scheduler Events 

Alarm condition 

This event is used to schedule an action to be performed when specific alarms occur. 

 Click the Settings button to specify the data source, alarm condition, and alarm 

type for which this event should occur.  The Alarm Condition Settings dialog 

displays. 

Data source –Select the Hierarchies, SETs, Machines, POINTs, ROUTEs, and / or 

Workspaces to monitor for alarm conditions. 

Alarm Conditions –Select the alarm condition (In alert, In danger, or Both) to monitor. 

Alarm Type – Select one or more alarm types to monitor. 

 Click OK to save settings. 

 Click Cancel to discard settings. 

Analyst startup 

This event is the application’s start up.  Performs an action as soon as the application 

completes its start up process. 

At specified time 

Schedules a task to be performed at a specific time.   

 Click the Settings button to specify the time that this event should occur.  The 

Time Event Settings dialog appears. 

Start Date - Select the date on which the scheduled event should run for the first time. 

Start Time – Select the time at which the scheduled event should run for the first time. 

Specify the interval for the event.  Options are: 

Hourly – Select to run the event Every X hour(s).  Enter the hourly time 

increment in the field (e.g., every 8 hours). 

Daily - Select to run the event Every X day(s).  Enter the number of days in 

the field (e.g., every 3 days). 

Weekly – Select to run the event Every X week(s).  Enter the number of weeks 

in the field, and enable the check box(es) for the day(s) of the week on which 

the event should run. (e.g., Every 2 weeks on Monday and Wednesday) 

Monthly – Select to run the event on a monthly basis.  Select the day of the 

month (1-31) and the frequency of the event in month(s) (e.g., Day 15 of every 

2 month(s)); or select a day of the week and the 1st, 2nd, 3rd, 4th, or last week 

of the month, and the frequency of the event in month(s). (e.g., The 2nd Friday 

of every 1 month(s)) 

Yearly – Select to run the event on a yearly basis.  Select the month / day and 

the frequency of the event in year(s). (e.g., January 1st  of every 1 year(s)); or 

select a day of the week, the 1st, 2nd, 3rd, 4th, or last week of the month, the 

month, and the frequency of the event in year(s). (e.g., The 2nd Friday of 

January every 2 year(s)) 
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 Click OK to save settings. 

 Click Cancel to discard settings. 

 The Scheduler feature is user specific and may only be applied to 

data uploaded by the current user. 

Scheduler Actions 

Display a message 

Select the “display message” action to display your specified message text when the 

associated event occurs.   

 Click the Settings button to enter your message text. 

 The Display Message Action Settings dialog appears. 

 Type in the desired text. 

 Click the OK button to save. 

 Click the Cancel button to discard changes. 

Generate Report 

Select the Generate Report action to generate a specified report type when the 

associated event occurs. 

To select report type: 

 Select Generate Report from the dialog’s Select an action area. 

 Click the Settings button.  The Generate Report dialog appears. 

Generate Report Settings 

Description – Enter descriptive text to identify this report in the Scheduler. 

Report – Select the desired report type from the drop down list. 

Data Source – Select the data source for the report.  This section varies, depending on 

whether the Report can specify data sources from multiple hierarchies option was 

enabled on the Report Editor’s General tab for the selected report. 

If Report can specify data sources from multiple hierarchies was enabled, all of your 

@ptitude Analyst hierarchies display.  Select multiple hierarchies, groups, and POINTs to 

include in your report. 

If Report can specify data sources from multiple hierarchies was not enabled, 

available options include: 

Primary Hierarchy – Use the POINTs from the currently selected primary 

hierarchy as the report’s source. 

Last Upload – Use the POINTs last uploaded from the data collector as the 

report’s source. 

ROUTEs (all available) – Enable the check box next to each ROUTE you would 

like to include. 
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Workspaces (all available) – Enable the check box next to each Workspace you 

would like to include. 

 If the Data Source is a Filtered Workspace, the Workspace will not 

be filtered again before report generation.  The report is based on 

the Workspace in its current state. 

Destination – Select the desired report destination from the drop down list.  Available 

options include: 

Email – Automatically sends an email of the report in HTML and PDF format to 

selected email recipients.  Click the Select button to display the Recipient 

Selection dialog and select one or more contacts or groups of contacts.  

HTML – Save to the subdirectory as an HTML file. 

Open Window – Window opens automatically, displaying the report. 

Printer / Landscape – Automatically prints in landscape mode. 

Printer / Portrait – Automatically prints in portrait mode. 

 The Destination selection is not used if the report is delegated to 

the Transaction Server, unless the Email option is selected as the 

destination.  Otherwise, the report is always generated to HTML. 

 Click OK to save report settings. 

 Refer to the SKF @ptitude Analyst Introduction and Global 

Features User Manual, Chapter 2, Getting Around in @ptitude 

Analyst / Contact Information section for details on how to set up 

contacts and groups. 

Measurement Management / Archive 

Select the Measurement Management / Archive action to schedule the Monitor 

application to perform measurement management and archiving.  This action checks 

the measurements in the current database, and either archives old data to the short 

term or long term status, or deletes old data from the database.  This action is 

performed on measurements in the current database only.  Refer to the SKF @ptitude 

Analyst Monitor Application section in the SKF @ptitude Analyst Introduction and 

Global Features User Manual for more information on the Monitor’s functions, 

including archiving data. 

Send Message 

Select the Send message action to send an email or text message to selected recipients 

when the associated event occurs. 

 Click the Settings button to configure your message settings. 

The Send Message Settings dialog appears. 

 In the Subject text box, type the subject of the event’s email message. 

 In the Message text area, type the event’s message to be sent as email and/or text 

messages. 

 Text messages are often limited to a maximum number of 

characters.  Check with the recipient’s service provider to 

understand text message limitations. 
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 Click the Select button to display the Recipient Selection dialog and select one or 

more recipients from the list of available contacts and groups. 

 Refer to the SKF @ptitude Analyst Introduction and Global 

Features User Manual, Chapter 2, Getting Around in @ptitude 

Analyst / Contact Information section for details on how to set up 

contacts and groups. 

 If you wish to include an HTML file with your email message, use the Browse 

button next to the HTML content text box and select an HTML file to include. 

 HTML content is not supported by text messaging. 

 If you wish to include any other type of attachment with your email message, select 

the Browse button next to the Attachments text box to select the file you wish to 

include. 

 Attachments are not supported by text messaging. 

 Enable the Allow content from triggering event check box to allow the default 

alarm message to override the Message text message when a triggering event 

occurs. 

 Enable the Send email check box to send the message to the selected recipients as 

an email. 

 Enable the Send text to phone check box to send the message to the selected 

recipients as a text message. 

 Texting limitations depend on the recipient’s service provider. 

 Click the OK button to save the message settings. 

 Click the Cancel button to discard changes. 

Customize / Database Operations 

The Database screen allows you to create custom group types and to define filter keys, 

coded notes, and operator names.  

Creating Custom Group Types 

Use the powerful Customize / Database screen’s Group Types tab to create custom 

Group Types to conveniently organize your machines, SETs, and POINTs to fit your 

application. 

To create a custom Group Type: 

 Select the Customize menu’s Database option.  The Database screen displays. 

 Select the Group Types tab. 
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Figure 3 - 59. 

The Database Screen’s Group Types Tab. 

 Click the Group Types tab’s Add button.  The tab enters edit mode. 

 Specify appropriate information into the following fields: 

Group Type – This field is unavailable if you are adding a new Group Type.  In the 

Group type properties area, the following fields are available: 

Name – Specify a name to define your custom group type.  For example, you may want 

to create a custom Group type named “pumps,” for easy organization of all pump 

machinery. 

Base on – Select a type to base the new group type on (SET or Machine). 

 Once a Group Type has been “based on” a SET or Machine, the 

setting cannot be edited. 

Once defined, the new Group Type will be available as a selection in the Group 

Properties screen’s Type list. 
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Optional data - Provides up to five fields to enter titles for additional data.  Text 

entered in these fields appears as prompts for data entry when new Groups are 

created.  This feature allows you to store detailed information with your Groups. 

 Specify prompt titles that will appear in the Group Properties / Details tab. 

 Examples are “serial number,” “manufacturer,” “operator name,” 

etc. 

 Click the Save button to save the new Group Type and add it to the available types. 

 Click the Undo button to undo changes. 

 Click Remove to remove the current Group Type. 

 Group types currently in use cannot be removed. 

Creating Filter Keys 

Custom filter keys can be assigned to POINTs and/or Machines or SETs.  

To add a new filter key: 

 Select the Customize menu’s Database option.  The Database screen displays. 

 Select the Filter Keys tab. 
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Figure 3 - 60. 

The Database Screen’s Filter Key Tab. 

 Click the screen’s Add button.  The screen enters edit mode. 

Fields include: 

Filter keys – Displays all previously defined filter keys. 

Name – Specify filter key text. 

 Click the Save button.  The new filter key is now available for assignment. 
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Frequency Sets 

Frequency Sets allow you to quickly assign fault frequency markers to a POINT.  When 

the POINT’s FFT measurements display in a spectral plot, you may overlay its assigned 

fault frequency markers to easily determine if spectral peaks appear at anticipated fault 

frequencies. 

Select the Customize / POINT Attributes menu’s Frequency Sets option to display the 

Frequency Sets screen.   

All shared frequency sets appear in the Frequency sets area.   

Available options include: 

Add – Click to add a new frequency set.  The Frequency Sets Editor dialog launches 

automatically. 

Copy – Click to make a copy of an existing shared frequency set.  This option is useful 

when you are creating a new frequency set that is a slight modification of an existing 

frequency set.  The Frequency Sets Editor dialog launches automatically. 

Edit – Click to edit an existing frequency set.  The Frequency Sets Editor dialog 

launches automatically. 

Remove – Remove the selected frequency set. 

Frequency Sets Editor 

The Frequency Sets Editor screen contains three tabs; General, Bearings, and Other.  

Each tab is detailed below. 

 

Figure 3 - 61. 

The Frequency Sets Editor Screen’s General Tab. 
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General Tab 

Displays the current frequency set’s name and description.  Included frequencies appear 

with their Name, Type, Multiples, Bandwidth%, and Details. 

Name - Displays current frequency set name. 

Description - Displays current frequency set description. 

Included frequencies - Displays all frequencies included in the current frequency set, 

with their: 

Name – Displays the frequency name. 

Type – Displays the type of frequency. 

Multiples – Displays the multiple of frequency markers to display on the plot. 

Bandwidth % - Displays the frequency range boundaries used by the 

frequency marker to locate a peak. 

Details – Displays fault frequency settings for the bearing’s components. 

 Click on a frequency to select it.   

Display Adjustments – Allows you to edit the Multiples and Bandwidth% settings for 

the selected frequency.   

 Click OK to save changes. 

 Click Cancel to close screen without saving changes. 

Bearings Tab 

 

Figure 3 - 62. 

The Frequency Sets Editor Screen’s Bearings Tab. 
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The Frequency Sets Editor / Bearings tab allows selection and/or de-selection of 

bearings included in the current set.   

Select manufacturer - Use the drop down list to select the desired bearing 

manufacturer. 

Find bearing - Specify the bearing name and click the Find button.  @ptitude Analyst 

locates bearings matching your entry, and displays them in the Available bearings 

(Model #) window. 

Bearings included in set - Displays bearings currently included in the frequency set. 

Available bearings (Model #) - Displays bearings from the selected manufacturer that 

match the entered criteria. 

 Use the << Include button to include the selected bearing(s) in the frequency set 

(move selected bearing(s) from the Available bearings (Model)# column to the 

Bearings included in set column). 

 Use the Exclude >> button to exclude the selected bearing(s) from the frequency 

set (move selected bearing(s) from the Bearings included in set column to the 

Available bearings (Model #) column). 

Fundamentals of – Displays the fault frequency settings for the selected bearing’s 

components. 

 Click Add to add bearings to the database, or Edit to modify an existing bearing.  

The Bearing Editor window displays in both cases.   

 Click Remove to remove a bearing from the bearing database. 

Bearing Editor 

 The Bearing Editor window displays in either “edit” or “add” 

mode, depending on your previous selection in the Frequency 

Sets Editor. 



 Working With Your SKF @ptitude Analyst Hierarchy 

 Frequency Sets 

SKF @ptitude Analyst and SKF Multilog On-line Systems 3 - 119 

User Manual 

 

Figure 3 - 63. 

The Bearing Editor Window. 

The Bearing model # and Manufacturer fields in the window’s Identity area cannot 

be modified when in “edit” mode. 

Bearing Editor fields include: 

Identity area - Enter the identification characteristics in the following fields: 

Bearing model #: - Displays the model number.  Cannot be modified in “edit” 

mode. 

Manufacturer: - Displays the bearing’s manufacturer.  Cannot be modified in 

“edit” mode. 

Description - Specify up to 32 characters that identify the new bearing. 

Dimensions - Specify the appropriate values in the following fields: 

Number of balls 

Ball diameter 

Pitch diameter 

Contact angle 

 Click the Calculate button.  @ptitude Analyst automatically calculates and enters 

the Fundamentals values. 

Fundamentals – Manually specify appropriate values in the available fields: 

BPFO: (Ball Pass Freq. Outer race) 

BPFI: (Ball Pass Freq. Inner race) 

BSF: (Ball Spin Freq.) 

FTF: (Fundamental Train Freq. / Cage Freq.) 

 Click OK to save changes. 
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 Click Cancel to close the window without saving changes. 

Other Tab 

 

Figure 3 - 64. 

The Frequency Sets Editor Screen’s Other Tab. 

Use the Frequency Sets Editor / Other tab to select a generic frequency to include in 

the current Frequency Set, or to add, edit, or remove a generic frequency. 

The Other tab displays all included generic frequencies.   

To include a frequency in the current frequency set: 

 Click the frequency's checkbox in the Included generic frequencies area.  The 

checkbox toggles the Included status between Yes and No. 

To add a new frequency: 

 Click the Add button.  A new frequency displays with default settings that may be 

edited. 

To remove a frequency: 

 Select the desired frequency from the Included generic frequencies windows so 

that the frequency information is visible in the Properties area 

 Click the Remove button. 

 You cannot remove a frequency that is currently used within any 

frequency set.  You must remove all associations with frequency 

sets before you can remove a frequency. 
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Properties- Displays the selected frequencies attributes.  You may edit these attributes: 

Name: - The selected frequency's name. 

Frequency type: - The selected frequency’s frequency type.  

Frequency formula: - Specific fields based on the frequency type. 

To edit frequency properties: 

 Enter a descriptive name (up to 32 characters). 

 Select the desired frequency type option from the drop down list. 

Frequency type options include: 

Constant - Constant frequency value.  (Example: 10 Hz) 

Offset - Multiple of running speed and offset (+) by constant frequency value.  

(Example: 4.00 x RPM + 10 Hz) 

RPM - Multiple of running speed.  (Example: 4.00 x RPM) 

Sideband - Multiple of running speed and offset (+ and -) by constant 

frequency value.  (Example: 4.00 x RPM + / - 10 Hz) 

 Edit the applicable Frequency formula fields. 

 Specific Frequency formula edit options are available according 

to the current frequency type selection.  If enabled, the first field 

is a running speed, or RPM value.  The second field is a fixed 

frequency in Hz or CPM.   

For example, with an RPM multiple frequency type, entering a 4 in the 

first field indicates that the frequency would show up at 4 times the 

running speed. 

 Click the tab's Save button to save changes. 

 Click Undo to undo changes. 

 Click the OK button to close the tab.  You will be prompted to save any unsaved 

changes. 
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Online Settings 

@ptitude Analyst’ Online Settings screen allows you to add or remove devices and 

sensors, and configure Gating options. 

Devices 

 Select the Customize menu’s Online Settings option.  The Online Settings screen 

displays the Devices tab. 

 

Figure 3 - 65. 

The Online Settings Screen’s Devices Tab. 

All available devices display in the Available hardware devices drop down list.  When a 

device from this list is selected, its entered Properties and Settings display in the tab’s 

other fields. 

 When you select a WMx / WVT from the Available hardware 

devices drop down list, the Properties area displays the Device 

Name and DAD type in read-only format.  To manage WMx 

devices, use the View menu’s WMx Device screen.  Reference 

Chapter 2, Setting Up Your WMx Device for details. 
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To add a new device: 

 Click the tab’s Add button.  By default, the name “New Device.#” displays.   

Fields include: 

Device Name - Assign the new device a unique name by typing it in the Device name 

field.   

Host – Identifies the computer that controls the device.  Select the appropriate host 

from the drop down list.  If the appropriate host is not available in the drop down list, 

click the Hosts button to display the Hosts dialog.  Use this dialog to add, edit, or 

remove host computers. 

Dad Type – Select the appropriate DAD type.  Different fields display depending on the 

device type selected. 

IMX Service – Select the appropriate name of the IMx Service connected to the IMx.   

 Set up IMx Service using the SKF Multilog IMx Configurator.  

Reference the SKF Multilog IMx Configurator User Manual for 

details. 

Config – Click the Config button to configure the digital output and input labels, to 

configure the analog and digital channel properties, and assign channels to the IMx. 

 For more information on configuring your device, reference the 

Configuring the Device section below. 

Communication Type – Select the appropriate communication type. 

DAD # - Select the appropriate DAD number (1 – 255 for IMx).  DAD #s are unique for 

Host / Communication type combination. 

Communication timeout – The IMx initiates communication with @ptitude Analyst.  

Enter the number of minutes to determine how long @ptitude Analyst waits for 

communication from the IMx before indicating it is overdue. 

Always connected – Determines the IMx’s connection status.  Click the Always 

Connected checkbox to enable connection to the IMx.  When the IMx is connected, the 

IMx continuously sends data to @ptitude Analyst.  When the IMx is not connected, the 

IMx wakes up periodically to send data to @ptitude Analyst.  

Connection Interval – Specify how often the IMx wakes up to send data to @ptitude 

Analyst when the IMx is not connected.  

Reference time – Set the time to offset the data upload cycle on the IMx System.  This 

allows a system with multiple IMxs to stagger data upload by the specified reference 

time so IMxs do not attempt to upload simultaneously. 

Time zone – Select the current time zone of the IMx device.  Data is always collected in 

local time. 

Once you have made changes, the Save and Undo buttons appear.  Click Save to save 

your new device settings.  Click Undo to clear the entered settings. 
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To remove a device: 

 Select the device you wish to remove from the Available Hardware Devices drop 

down list.  

 Only devices without assigned POINTs can be removed. 

 Click the Remove button. 

 When prompted, confirm you wish to remove the selected device by clicking Yes. 

Configuring the Device 

To configure your device, click the Config button.  The configuration screen displays 

differently depending on the type of DAD selected.  

Configure IMx Channel 

Analog 

The IMx has 16 analog channels, except the IMx-8, which has eight analog channels.  

Configure each channel on the Channel Properties / Analog tab.   

 

Figure 3 - 66. 

The Channel Properties Screen’s Analog Tab. 

Analog channels – Lists all analog channels.  Highlight a channel to edit the channel’s 

properties. 
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Properties area – When a channel is selected in the Analog channels list, the channel 

properties display for editing purposes.  Edit the following fields to make changes to a 

channel’s settings: 

Channel name – Assign the channel a unique name. 

Channel Enabled – Click the Channel Enabled checkbox to enable a channel 

on the IMx.  If the channel is disabled, the IMx skips the POINTs assigned to 

that channel during data collection. 

Sensor type – Specify the type of sensor used by the selected channel. 

Sensitivity - Enter a value for the sensitivity of the sensor to be used in 

making the measurement. 

Current shunt – (IMx-8 / IMx-P / IMx-M) If a resistor of 220 ohms is added to 

a channel input, select Enable to display the correct input unit for this 

particular channel. 

 Only IMx-8 devices include both the Current Shunt and Enable 

ICP options. 

Zero offset – Enter a value to offset the zero point of the measurement.   

Autoset button - Click the Autoset button to adjust the sensitivity and zero 

offset calculation using the Offset Calculator.  The Offset Calculator allows 

you to set the sensitivity and offset values for scaling the IMx process input 

using two signal levels and their corresponding engineering units.  

Enable ICP - Click to enable the support of ICP-type sensors (for example, 

accelerometers) with internal power from the IMx. 

Check sensor OK status - Click to enable this option. When enabled, @ptitude 

Analyst will check the sensor status, and will display the sensor status in 

Device status and Online Data View dialogs. If data is outside specified range, 

the IMx does not collect the data.  

Upper Limit – Type in the BOV upper limit value.  

Lower Limit – Type in the BOV lower limit value. 

Sensor notes – Type in any additional information you would like to store with 

the selected sensor settings.   

To edit channel properties:  

 Select the channel you wish to edit from the Analog channels list.   

 In the Properties area, edit channel name, enable / disable the channel, and edit 

the sensor information.   

 When you start to edit a field in the Properties area, the Analog 

channels list turns gray, allowing you to only make changes to 

the selected channel.  Also, the Save and Undo buttons become 

available. 

 To cancel changes to the selected channel, click Undo.   

 When you have finished editing the channel properties, click Save to save your 

changes. 
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 Use the Copy / Paste function to copy the selected channel’s properties and paste 

to another channel.  To copy channel properties to multiple channels, use 

Shift+Click and Ctrl+click keyboard functions to select multiple items, then click 

Paste.  

 Channel name and sensor notes are not copied to other channels. 

 Click OK to apply any changes and return to the Online Settings / Devices screen. 

Digital 

The IMx has eight digital channels, except the IMx-8, which has two digital channels.  

Configure each channel on the Channel Properties / Digital tab. 

 

Figure 3 - 67. 

The Channel Properties Screen’s Digital Tab. 

Digital channels – Lists all digital channels.  Highlight a channel to edit the channel’s 

properties. 

Properties area– When a channel is selected in the Digital channels list, the channel 

properties display for editing purposes.  Edit the following fields to make changes to a 

channel’s settings: 

Channel name – Assign the channel a unique name. 
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Channel Enabled – Click the Channel Enabled checkbox to enable a channel 

on the IMx.  If the channel is disabled, the IMx skips the POINTs assigned to 

that channel during data collection. 

Pulse per revolution – Enter the number of pulses the IMx unit receives per 

shaft revolution. 

To edit channel properties:  

 Select the channel you wish to edit from the Digital channels list.   

 In the Properties area, edit channel name, enable / disable the channel, and edit 

the sensor information.   

 When you start to edit a field in the Properties area, the Digital 

channels list turns gray, allowing you to only make changes to 

the selected channel.  Also, the Save and Undo buttons become 

available. 

 To cancel changes to the selected channel, click Undo.   

 When you have finished editing the channel properties, click Save to save your 

changes. 

 Use the Copy / Paste function to copy the selected channel’s properties and paste 

to another channel.  To copy channel properties to multiple channels, use 

Shift+Click and Ctrl+click keyboard functions to select multiple items, then click 

Paste.  

 Channel name and sensor notes are not copied to other channels. 

 Click OK to apply any changes and return to the Online Settings / Devices screen. 

Protection Channels (IMx-M only) . 

The IMx-M’s protection channels get data from the analog, BOV, and digital channels on 

the IMx-M’s protection I/O module through internal IMx-M communication.  Changes 

made to the Protection Analog, Protection BOV, and Protection Digital tabs do not 

affect the physical protection I/O module’s settings.  These channels help detect critical 

issues that the IMx-M’s CPU module’s analog and digital channels do not detect.   
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Protection Analog  

The IMx-M has 16 protection analog channels.  Configure each channel on the Channel 

Properties / Protection Analog tab.   

 

Figure 3 - 68. 

The Channel Properties Screen’s Protection Analog Tab. 

Protection Analog channels – Lists all protection analog channels.  Highlight a channel 

to edit the channel’s properties. 

Properties area – When a channel is selected in the Protection Analog channels list, 

the channel properties display for editing purposes.  Edit the following fields to make 

changes to a channel’s settings: 

Channel name – Assign the channel a unique name. 

Channel Enabled – Click the Channel Enabled checkbox to enable a channel 

on the IMx.  If the channel is disabled, the IMx skips the POINTs assigned to 

that channel during data collection. 

Min / Max Scale - Enter the minimum and maximum magnitude scale values 

in the designated text boxes.  Set this value to the same scale value that is 

configured for the protection I/O module in the IMx-M Protection Configurator.   
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 These values should not be confused with the channel sensitivity 

values that are configured in the IMx-M Configurator. 

Zero offset - Enter a value to offset the zero point of the measurement.   

Sensor notes – Type in any additional information you would like to store with 

the selected sensor settings.   

To edit channel properties:  

 Select the channel you wish to edit from the Protection Analog channels list.   

 In the Properties area, edit channel name, enable / disable the channel, and edit 

the sensor information.   

 When you start to edit a field in the Properties area, the 

Protection Analog channels list turns gray, allowing you to only 

make changes to the selected channel.  Also, the Save and Undo 

buttons become available. 

 To cancel changes to the selected channel, click Undo.   

 When you have finished editing the channel properties, click Save to save your 

changes. 

 Use the Copy / Paste function to copy the selected channel’s properties and paste 

to another channel.  To copy channel properties to multiple channels, use 

Shift+Click and Ctrl+click keyboard functions to select multiple items, then click 

Paste.  

 Channel name and sensor notes are not copied to other channels. 

 Click OK to apply any changes and return to the Online Settings / Devices screen. 
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Protection BOV 

The IMx-M has 16 protection BOV channels.  Configure each channel on the Channel 

Properties / Protection BOV tab.   

 

Figure 3 - 69. 

The Channel Properties Screen’s Protection BOV Tab.  

Protection BOV channels – Lists all protection BOV channels.  Highlight a channel to 

edit the channel’s properties. 

Properties area – When a channel is selected in the Protection BOV channels list, the 

channel properties display for editing purposes.  Edit the following fields to make 

changes to a channel’s settings: 

Channel name – Assign the channel a unique name. 

Channel Enabled – Click the Channel Enabled checkbox to enable a channel 

on the IMx.  If the channel is disabled, the IMx skips the POINTs assigned to 

that channel during data collection. 
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Sensor notes – Type in any additional information you would like to store with 

the selected sensor settings.   

To edit channel properties:  

 Select the channel you wish to edit from the Protection BOV channels list.   

 In the Properties area, edit channel name, enable / disable the channel, and edit 

the sensor information.   

 When you start to edit a field in the Properties area, the 

Protection BOV channels list turns gray, allowing you to only 

make changes to the selected channel.  Also, the Save and Undo 

buttons become available. 

 To cancel changes to the selected channel, click Undo.   

 When you have finished editing the channel properties, click Save to save your 

changes. 

 Use the Copy / Paste function to copy the selected channel’s properties and paste 

to another channel.  To copy channel properties to multiple channels, use 

Shift+Click and Ctrl+click keyboard functions to select multiple items, then click 

Paste.  

 Channel name is not copied to other channels.  

 Click OK to apply any changes and return to the Online Settings / Devices screen. 
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Protection Digital 

The IMx has eight protection digitial channels.  Configure each channel on the Channel 

Properties / Protection Digital tab.   

 

Figure 3 - 70. 

The Channel Properties Screen’s Protection Digital Tab. 

Protection Digital channels – Lists all protection digital channels.  Highlight a channel 

to edit the channel’s properties. 

Properties area– When a channel is selected in the Protection Digital channels list, 

the channel properties display for editing purposes.  Edit the following fields to make 

changes to a channel’s settings: 

Channel name – Assign the channel a unique name. 

Channel Enabled – Click the Channel Enabled checkbox to enable a channel 

on the IMx.  If the channel is disabled, the IMx skips the POINTs assigned to 

that channel during data collection. 

Scale factor – Enter a scale factor to adjust the monitored reading to a scaled 

value, when necessary.  For example, if the machine’s running speed is 3,000 

RPM, but the sensor’s location is capturing a running speed of 1,500 RPM, a 
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scale factor of two will capture the actual running speed of the machine for the 

sensor’s location. 

To edit channel properties:  

 Select the channel you wish to edit from the Protection Digital channels list.   

 In the Properties area, edit channel name, enable / disable the channel, and edit 

the sensor information.   

 When you start to edit a field in the Properties area, the 

Protection Digital channels list turns gray, allowing you to only 

make changes to the selected channel.  Also, the Save and Undo 

buttons become available. 

 To cancel changes to the selected channel, click Undo.   

 When you have finished editing the channel properties, click Save to save your 

changes. 

 Use the Copy / Paste function to copy the selected channel’s properties and paste 

to another channel.  To copy channel properties to multiple channels, use 

Shift+Click and Ctrl+click keyboard functions to select multiple items, then click 

Paste.  

 Channel name and sensor notes are not copied to other channels. 

 Click OK to apply any changes and return to the Online Settings / Devices screen. 
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Communication 

The Communication tab enables you to activate the communication between the IMx-

M’s protection I/O module and CPU module, or communication between the IMx-8, IMx-

S or IMx-T and CPU module using a Modbus communication protocol.   

To activate communication between the IMx-M’s protection I/O module and CPU 

module: 

 Select Protection to enable external communication with the protection I/O 

module.  By default, the Protection option is enabled. 

 Select None if you wish to disable communication (i.e., for maintenance purposes, 

or to replace cards on the CPU module).  

 If None is selected, no data is stored from the device for these 

protection channels.  

A Note About Modbus RTU and Modbus TCP 

Communication can be enabled via Modbus protocols for IMx-8, IMx-S or IMx-T 

devices. The Modbus protocol is currently implemented using serial transmission lines 

(RTU) or TCP over Ethernet and Modbus Plus. Modbus RTU (remote terminal unit) is 

communication between devices using binary data. Modbus TCP (transmission control 

protocol) is a Modbus protocol with a TCP wrapper that uses Ethernet to transfer data 

between master and slave devices.  

 Standard TCP port 502 is used for communication. 

 TCP protocol uses big endian format. 

 For existing Modbus RTU devices a gateway is required to convert 

from physical layer RS485 (or others) to Ethernet. 

 The Modbus standard specifies only 16-bit integers. Floating 

points and 32-bit integers are vendor extensions that use 

multiple registers.  

A Note About Master-Slave Communication Rules 

There can be only one master but there can be one or more slaves. The master controls 

the communication with the different slaves. The master sends the messages and the 

slave answers them. The slaves are limited to returning the information requested by 

the master.  

 

To activate communication for IMx-8, IMx-S or IMx-T via Modbus RTU protocol 

with the IMx configured as a Modbus master: 

 From the Settings (None, Protection, Modbus RTU or Modbus TCP), select 

Modbus RTU to enable communication using this Modbus protocol. 
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Figure 3 - 71. 

The Channel Properties Screen’s Communication Tab, Modbus RTU Master. 

 Select Master as the Mode for Modbus communication. 

 When you set this IMx as a Modbus master, you can configure 

and enable virtual channels (via the Modbus Master tab) to 

support the following Modbus data transfers:  

- An external Modbus master writing data to this IMx 

(configured as a Modbus slave).  

- This IMx (configured as a Modbus master) reading data 

from an external Modbus slave.  

- This IMx (configured as a Modbus master) reading data 

from another IMx configured as a Modbus slave. 

 Enter the Slave Address number of the Modbus Slave with which this Modbus 

Master will connect and communicate. 

 The exact Slave Address number is to be entered when creating 

the Modbus Master to identify the Modbus Master-Slave pair. 

 Check that the other parameters – Bps (Bits per second, or Baud rate), Parity, 

Stop Bits – are set appropriately or modify as needed. 

Bps defines the speed of Modbus, transfer rate in bps. 

Parity can be set to None, Even or Odd. 

Stop Bits defines the number of stop bits in use. It can be 1 or 2. 
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 Click OK to save the settings. The Channel Properties window closes. 

 

To activate communication for IMx-8, IMx-S or IMx-T via Modbus TCP protocol 

with the IMx configured as a Modbus master: 

 From the Settings (None, Protection, Modbus RTU or Modbus TCP), select 

Modbus TCP to enable communication using this Modbus protocol. 

 

Figure 3 - 72. 

The Channel Properties Screen’s Communication Tab, Modbus TCP Master. 

 Select Master as the Mode for Modbus communication. 

 When you set this IMx as a Modbus master, you can configure 

and enable virtual channels (via the Modbus Master tab) to 

support the following Modbus data transfers:  

- An external Modbus master writing data to this IMx 

(configured as a Modbus slave).  

- This IMx (configured as a Modbus master) reading data 

from an external Modbus slave.  

- This IMx (configured as a Modbus master) reading data 

from another IMx configured as a Modbus slave. 

 Enter the Slave Address number of the Modbus Slave with which this Modbus 

Master will connect and communicate. 
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 The exact Slave Address number is to be entered when creating 

the Modbus Master to identify the Modbus Master-Slave pair. 

 Enter the Slave IP Address of the Modbus Slave with which this Modbus Master 

will connect and communicate. 

 Enter the Slave Port (the default is 502). 

 Click OK to save the settings. The Channel Properties window closes. 

 

To activate communication for IMx-8, IMx-S or IMx-T via a Modbus RTU protocol 

with the IMx configured as a Modbus slave: 

 Select Modbus RTU to enable communication using the Modbus protocol. 

 

Figure 3 - 73. 

The Channel Properties Screen’s Communication Tab, Modbus RTU Slave. 

 Select Slave as the Mode for Modbus communication.  

 When you set this IMx as a Modbus slave, you can configure and 

enable virtual channels (via the Modbus Slave tab) to support the 

following Modbus data transfers:  

- An external Modbus master reading data from this IMx 

(configured as a Modbus slave).  

- Another IMx configured as a Modbus master reading 

data from this IMx (configured as a Modbus slave). 
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 Enter the Slave Address matching the setup on your physical IMx that connects to 

the Modbus source. Slave Address becomes the Modbus address of this Slave. This 

Slave address number is the address with which the Modbus Master will connect 

and communicate.  

 This exact Slave Address number is to be entered when creating 

a Modbus Master if the Master will be communicating with this 

Slave and become a Modbus Master-Slave pair. 

 Check that the other parameters – Bps (Bits per second, or Baud rate), Parity, 

Stop Bits – are set appropriately or modify as needed. 

Bps defines the speed of Modbus, transfer rate in bps. 

Parity can be set to None, Even or Odd. 

Stop Bits defines the number of stop bits in use. It can be 1 or 2. 

 Click OK to save the settings. The Channel Properties window closes. 
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To activate communication for IMx-8, IMx-S or IMx-T via a Modbus TCP protocol 

with the IMx configured as a Modbus slave: 

 Select Modbus TCP to enable communication using the Modbus protocol. 

 

Figure 3 - 74. 

The Channel Properties Screen’s Communication Tab, Modbus TCP Slave. 

 Select Slave as the Mode for Modbus communication.  

 When you set this IMx as a Modbus slave, you can configure and 

enable virtual channels (via the Modbus Slave tab) to support the 

following Modbus data transfers:  

- An external Modbus master reading data from this IMx 

(configured as a Modbus slave).  

- Another IMx configured as a Modbus master reading 

data from this IMx (configured as a Modbus slave). 

 Enter the Slave Address matching the setup on your physical IMx that connects to 

the Modbus source. Slave Address becomes the Modbus address of this Slave. This 

Slave address number is the address with which the Modbus Master will connect 

and communicate.  

 This exact Slave Address number is to be entered when creating 

a Modbus Master if the Master will be communicating with this 

Slave and become a Modbus Master-Slave pair. 

 Click OK to save the settings. The Channel Properties window closes. 
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With Modbus communication enabled and the Slave and Master pair configured, the 

next step is to set up the Modbus import and/or export properties for IMx-8, IMx-S and 

IMx-T units.    

 

Modbus Import 

On the Modbus Master tab, you can configure and enable virtual channels to support 

the following Modbus data transfers:  

 An external Modbus master writing data to this IMx (configured as a Modbus slave).  

 This IMx (configured as a Modbus master) reading data from an external Modbus 

slave.  

 This IMx (configured as a Modbus master) reading data from another IMx 

configured as a Modbus slave.  

 

Figure 3 - 75. 

Modbus Master Tab with Channel Enabled. 
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The summary table at the top displays existing Modbus channels and their properties. 

 Select the channel you wish to edit from the Modbus channels list. 

 Enter a unique Channel name. 

 Click the Channel enabled checkbox to enable a channel on the IMx. If the channel 

is enabled, enter the following values. 

 In order to know which Lower limit, Upper limit and Zero offset 

values to configure, refer to the configuration of the Modbus 

device that will interface with the IMx, that is, the Programmable 

Logic Controller (PLC), Digital Control System (DCS) or sensors. 

 If the channel is disabled, the IMx skips the channel and points 

assigned to that channel during data collection. 

 Enter the Lower limit value. 

 Enter the Upper limit value. 

 In Zero offset, enter a value to offset the zero point of the measurement. 

 Register number – enter the register number from which the data will be read.  

 Register type – select Input (read only) or Holding (read/write). 

 Data type – select S16 (16-bit signed integer value) or Float.  

 In Sensor notes, type in any additional information you would like to store with the 

selected sensor settings. 

 When you start to edit a field in the Properties area, the Save 

and Undo buttons become available. 

 When you have finished editing the channel properties, click Save to save your 

changes. 

 To cancel changes to the selected channel, click Undo.  

 Use the Copy / Paste function to copy the selected channel’s properties and paste 

them to another channel.  Select a single channel and click the Copy button. The 

Paste button then becomes active. You can select a single channel as the target for 

the pasted channel properties, or use Shift+Click and Ctrl+click keyboard functions 

to select multiple items. Click Paste. 

 Channel name and sensor notes are not copied to other channels. 

 Click OK to apply any changes and return to the Online Settings window. 

 

Modbus Export 

The Modbus export feature in SKF @ptitude Analyst applies to IMx-8, IMx-S and IMx-T 

only. It is supported by IMx firmware version 5.0 or later. If you are using an earlier IMx 

firmware version, some Modbus export features, such as the Filter Criteria and Assign 

All, will be unavailable in SKF @ptitude Analyst.  
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On the Modbus Slave tab, you can configure and enable virtual channels to support the 

following Modbus data transfers:  

 An external Modbus master reading data from this IMx (configured as a Modbus 

slave).  

 Another IMx configured as a Modbus master reading data from this IMx (configured 

as a Modbus slave).  

The tab enables you to map @Analyst points to specific Modbus registers and save the 

desired configuration into the @Analyst database. 

 

Figure 3 - 76. 

Modbus Slave Tab. 

The summary table at the top displays existing Modbus export configuration settings 

from the @Analyst database along with all known register assignments. If there are no 

existing Modbus register assignments, the Point column displays <Unassigned>. Each 

line shows information from a single record in the database table that associates a 

Modbus register with a specific point in @Analyst.  

The critical action to take is to assign an Exported point to the selected Register 

number. You can use one of two methods to assign a point to the register number: 

 The Exported point drop-down list with optional filter criteria 

 The Assign All automated function 
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Both methods are presented below in detail.  

Multi Channel – If the Exported point is a multi channel point, it will be identified as 

CH X or CH Y (2-channel point) or CH Z (3-channel point).  

Full scale range (-/+) - enables you to enter a value for the full scale range of 

measurement values for the selected point. This range will be from the negative of the 

value entered to the value. 

Floating point output – click the check box to enable/disable floating point format. 

Floating point representations are 32 bit numbers, which support a much wider range 

of values than fixed point.  

With this format enabled, for every measurement a pair of registers is needed (that is, 

measurement 1 on registers 1 and 2, measurement 2 on registers 3 and 4, and so on).  

The point name is displayed in register 1 and register 2 displays <Assigned to floating 

point>. 

 The floating point format is available with firmware version 6.0 or 

later. 

Buttons 

Save – Saves any modified configuration information from the lower edit fields 

to the summary table. 

 It is the OK button rather than the Save button that saves the 

configuration data to the @ptitude Analyst database. 

Undo – Discards any modifications made to configuration information in the 

lower edit fields and returns values to what they were before the modifications 

were made. 

 When Modbus Slave first opens, the Save and Undo buttons are 

unavailable and appear dimmed. When you have made entries or 

edits in the fields, these buttons will activate. 

At any time during the configuration process, you have the option to use the 

following buttons: 

Assign all – assigns all exported points to a register automatically. 

Unassign all – Clears all existing assignments from the summary table and 

sets all entries to <Unassigned>. 

Export CSV – exports the summary table as a CSV file.  

Import CSV – browse to a CSV file and import it into Analyst. 

OK – Saves the Modbus export register configuration information shown in the 

summary table to the @ptitude Analyst database and closes the Modbus Slave 

tab. 

Cancel – Discards any recent edits and closes the Modbus Slave tab. 

Help – Opens help window providing guidance on how to use the Modbus 

Slave tab. 
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Method 1 – Assign an Exported Point with optional Filter Criteria 

Follow the steps below to assign an export point. The filter criteria features are 

optional. 

 Highlight a register in the summary table. The number selected for 

configuration is reflected in the Register number field in the Attributes 

section below.  

 Use the Exported point drop-down arrow and select a point from the 

drop-down list. 

 

Figure 3 - 77. 

Register Number and Exported Point. 

All of the available points associated with the current IMx device in the 

Analyst database are displayed in the Exported point list unless you use 

the Filter Criteria to reduce the points displayed, as described below. 

 

Figure 3 - 78. 

Filter Critera. 

 To limit the exported point options to a specific channel number, click the 

Channel drop-down arrow and select the desired channel. Only points 

related to that channel will display in the Exported point options.  
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 To limit the point options to a specific type of point, click the Point Type 

drop-down arrow and select the type. Only points of the selected type will 

display in the Exported point options.  

 More than one filter criterion may be used to further reduce the 

number of available points listed in the Exported point options. 

The Attributes section in the lower part of the page displays information about 

the selected Exported point.  

Full scale range (-/+) enables you to enter a value for the full scale range of 

measurement values for the selected point. This range will be from the 

negative of the value entered to the value. 

 Click Save to save your changes from the lower edit fields to the summary 

table. 

 When you are satisfied with the resulting summary table, click OK to save 

the Modbus export register configuration information shown in the 

summary table to the @ptitude Analyst database and close the Channel 

Properties window. 

 

Method 2 – Assign points by using the Assign All and optional CSV 

functions 

Instead of selecting an exported point, you can use Assign All, an automatic 

assignment function. Export CSV and Import CSV are additional functions that 

work with Assign All. We’ll describe how this works below. 

 

Figure 3 - 79. 

Assign All, Export CSV, and Import CSV. 

 If you click Assign All, an informational dialog warns you that continuing 

with automatic Modbus register assignment will clear all existing 

configuration information from the summary table. 

 If you agree to Continue, the summary table is populated with Modbus 

register assignments with all supported IMx points found to be associated 

with the current IMx device configuration. 
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 The Exported points drop-down list will no longer display any 

points available for assignment. 

You will probably want to establish the order of the register assignments 

and/or the assigned points. You can export the data into a CSV (comma 

separated values) format file. Then, open the file and reorder the assigned 

register numbers in another application, such as Microsoft Excel, that can 

facilitate this process. 

 To export the summary table, click Export CSV. In the Windows dialog, 

specify the folder location and file name.  

 Click OK. The Windows dialog closes and a CSV formatted file that contains 

the current Modbus register assignments is generated. 

 After using the file to establish the register number/measurement POINT 

pairings you want, save the revised data in CSV format to import it.  

 Click Import CSV. In the Windows dialog, browse to the updated CSV file 

and select it for import into SKF @ptitude Analyst. 

 Click OK. The Windows dialog closes and the summary table is then 

updated with the imported Modbus export register configuration 

information. 
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Sensor Settings 

 Select the Customize menu’s Online Settings option. 

 Select the Sensor Settings tab. 

 

Figure 3 - 80. 

The Online Settings Screen’s Sensor Setup Tab. 

All available sensors display in the Sensor Names drop down list.  When a sensor from 

this list is selected, its entered Properties and Settings display in the tab’s other fields. 

To add a new sensor: 

 Click the tab’s Add button.  By default, the name “New Sensor Settings.#” displays.   

Fields include: 

Name - Assign the new sensor a unique name by typing it in the Name field. 

Sensor Power – Select the appropriate sensor power setting.  Options include Charge 

Converter, External Power, and Internal ICP (4.4 mA). 

Settling Time – Type in the appropriate settling time in seconds. 

Sensor Notes – Type in any additional information you would like to store with the 

selected sensor settings.   
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The Channel status settings area provides options relating to BOV gating. 

Check Sensor OK Status – Click to enable this option.  When enabled, 

@ptitude Analyst software will check the sensor status, and will display sensor 

status in Device status and Online Data View dialogs. 

Lower Limit – Type in the BOV lower limit value. 

Upper Limit – Type in the BOV upper limit value. 

To remove a sensor: 

 Select the sensor you wish to remove from the Sensor Names drop down list. 

 Only sensors without assigned POINTs can be removed. 

 Click the Remove button. 

 When prompted, confirm you wish to remove the selected device by clicking Yes. 

Gating 

 Select the Customize menu’s Online Settings option. 

 Select the Gating tab. 

 

Figure 3 - 81. 

The Online Settings Screen’s Gating Tab. 
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Use this tab to configure shared gating definitions that can be assigned to POINTs on 

the POINT Properties screen’s Gating tab.   

 Reference the Appendix C, Data Collection Gating for more 

information about gating. 

To add a new gating definition: 

 Click the tab’s Add button.  By default, the name “New Logic Gating” displays.   

Fields include: 

Name - Assign the new sensor a unique name by typing it in the Name field. 

Device – Select the device to apply the gating definition to. 

Gating Type – Specify the gating type.   

 Gating type is always Triggered for WMx devices. 

Mode – Specify the mode to define the gating conditions that control when data is 

collected. 

Dwell Time – (preemptive POINTs only) Specify how many seconds the POINT must 

wait to collect data in order to allow for another preemptive POINT to collect data if its 

condition occurs. 

Allow preemption – Enables a timeout to occur for a preemptive POINT. 

Timeout value – Specify how many seconds a POINT will wait for the specified 

condition to occur before moving on to the next POINT.   

Channels – This section works with the State option buttons to configure whether a 

high or low setting must be present on specified channel(s) for data to be collected.  

(See State below for details.)  The box lists all channels available on the device.  

Selection of channels varies depending on your choice in the Mode field. 

If Bit is selected in the Mode field, the list displays option buttons.  Select the 

single channel you would like to configure and set the state using the State 

option buttons.  

If Byte is selected in the Mode field, all channels are used in gating.  Highlight 

each channel in turn and set the state using the State option buttons, or 

double click to toggle the state. 

If Combination is selected in the Mode field, the list displays check boxes.  

Select any combination of channels to use with gating and set the state using 

the State option buttons. 

State – Specify whether a High or Low (on/off) setting must be present for data to be 

collected. 

To remove a device: 

 Select the gating definition you wish to remove from the Logic Gating drop down 

list. 

 Only gating definitions without assigned POINTs can be removed. 
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 Click the Remove button. 

 When prompted, confirm you wish to remove the selected device by clicking Yes. 

Alarm Settings 

Use the Alarm Settings to create alarms that can be assigned to one or more POINTs.  

Created alarms can be re-assigned and edited. 

Setting Alarms – Overview 

By setting alarms on your vibration measurements, the hierarchy’s alarm status 

indicators allow you to quickly know if any of your monitored components / machines 

moved into an alarm condition.  If you do not specify measurement alarm settings, 

overall vibration level alarms are set to factory defaults. 

@ptitude Analyst offers many ways to alarm on machinery vibration levels: 

 Overall vibration alarms 

 Spectral enveloping (narrow band) alarms 

 Spectral band alarms 

 Phase alarms 

Of the above, overall vibration alarms are, by far, the most frequently used alarm type 

for detection of machinery faults.  Overall vibration is the total vibration energy 

measured within a specific frequency range.  Measured numerically, a higher than 

normal overall value provides an indication that "something" is causing the machine or 

component to vibrate more.  Below we describe how to go about setting your initial 

overall vibration alarm levels.  However, the same logic may be used to set alarm levels 

for other types of alarms. 

If yours is a new system and no vibration measurement history exists for the monitored 

machinery, the ISO 10816-1 Standard provides guidance for evaluating overall velocity 

vibration measurement severity in machines operating in the 10 to 200 Hz (600 to 

12,000 RPM) frequency range.  Examples of these types of machines are small, direct 

coupled, electric motors and pumps, production motors, medium motors, generators, 

steam and gas turbines, turbo compressors, turbo pumps and fans. 

It is possible for a machine to be in the early stages of wear or damage and still meet 

the criteria in these ISO 10816-1 guidelines.  While the Standard can provide a quick 

indication of machines that are in serious trouble; long term overall vibration level 

trending and experience with a machine’s history provide much more accurate 

information on where to set your machinery vibration alarm levels. 

Once you have collected enough measurement data (e.g., six data sets), SKF @ptitude 

Analyst can display meaningful trends of each measurement’s data.  Over time, when 

you are convinced that the measurement’s trending vibration level indicates the 

component’s known good condition, you may designate it as the measurement’s 

“baseline” vibration level, upon which you set two overall vibration alarm levels for 

detection of machinery faults, the “alert” level and the “danger” level.  Where to set 

these two overall alarm levels is the question. 
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Figure 3 - 82. 

Example Trend Plot with Alert (Yellow) and Danger (Red) Alarm Levels. 

In general, it is most desirable to specify alert alarm settings high enough to minimize 

extraneous alarms, yet conservative enough to not miss a critical excursion in machine 

condition.  In addition, initially you should set “loose” alarm levels so as to avoid false 

alarms.  False alarms significantly degrade confidence in the condition monitoring 

system’s accuracy.  Over time, as you continue to better understand your machinery’s 

vibration levels and gain confidence in the accuracy of your vibration measurements, 

you may “tighten” the initial alarm levels to acquire earlier detection of machine faults. 

A general rule of thumb is to initially set alert alarm levels at one and a half to twice the 

baseline levels for measurements.  This “alert” alarm level should indicate that a 

problem has developed and more frequent monitoring and analysis should occur.  Fault 

analysis should be initiated and the severity and root cause of the problem should be 

established.  In addition, analysis results should determine whether necessary repair 

parts are ordered, and the date for repair should be established based on minimum 

production interruption. 

The initial “danger” level alarm is typically set from two and a half to three times the 

baseline vibration level.  In general, if the danger alarm is reached on a critical machine, 

it should be scheduled for repairs as soon as possible.  Again, over time, after more 

experience with said machine and your vibration measurements, the alarm level can be 

adjusted to better fit the specific component / machine. 

On bearing measurements, an accurate enveloped acceleration measurement alert 

alarm indicates that a bearing is approaching the end of its usable lifetime.  Upon such 

an alarm, you should more closely monitor the bearing using spectrum analysis with 

bearing fault frequency markers to verify the bearing fault and determine proactive 

maintenance measures, or to plan the most efficient bearing replacement during a 

scheduled machine outage. 

Once a good operating baseline is established and sufficient data and experience have 

been acquired for you to set your initial alert and danger overall vibration alarm levels, 
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SKF @ptitude Analyst provides a Statistical Overall Alarms Wizard that guides you 

through a process that automatically generates overall alarm settings based upon 

historical measurement data (reference the Statistical Alarms Wizard section earlier in 

this chapter for details). 

To access the Alarm Settings screen: 

 Select the Customize menu’s Alarm Settings option.  The Alarm Settings screen 

displays. 

 

Figure 3 - 83. 

The Alarm Settings Screen’s Overall Tab. 

Alarm Settings - Overall 

Existing alarms may be edited or removed from the database.  The Overall tab allows 

you to create, edit, or remove shared Overall alarms. 

To create a new alarm: 

 Click the tab's Add button.  The Overall alarms field displays “New Overall Alarm” 

to indicate that you have created a new alarm.   

 In the Name field, assign the new alarm a unique name. 
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 Once the editing process begins, the Overall alarms field is no 

longer accessible.  You must complete and Save your edits or 

cancel them by clicking the Undo button. 

 Click Save.  The Overall alarms field now displays the new alarm name you 

specified.   

You can also adjust the alarm’s Properties and Settings in this tab.  The current 

settings graphically display in the tab’s Settings area. 

To edit or create Overall Alarm Properties and Settings: 

Properties – Select the type of Overall Alarm by clicking the desired option button.  

Choose from: 

Level - Measurements exceeding the specified alert and danger Settings will 

result in an alarm condition. 

In Window - Measurements falling within the specified alert low, danger, and 

alert high Settings will result in an alarm condition. 

Out Of Window - Measurements falling outside the specified danger low, alert 

low, alert high, and danger high Settings will result in an alarm condition. 

Settings – Select the levels you wish to include by clicking each checkbox. 

 The availability of the levels, their checkboxes, and their text fields 

is based on the type of Overall Alarm selected in the Properties 

area.  

 Enter the desired values for each available alarm level. 

 Click the Save button to save your alarm settings. 

To remove an existing alarm from the database: 

 Select the desired alarm from the drop down list.   

 Click the Remove button.  A confirmation dialog displays.   

 Confirm removal.  The selected alarm is permanently removed from the database. 

 An alarm cannot be removed if it is currently assigned to one or 

more POINT.  A warning dialog displays if you attempt to remove 

a currently assigned alarm. 
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Alarm Settings – Band 

Band Alarms provide alert and danger alarms on both peak and spectral values within a 

defined frequency band.  Use the Band tab to edit and/or specify POINTs’ bands and to 

manage shared band alarms. 

 

Figure 3 - 84. 

The Alarm Settings Screen’s Band Tab. 

Band alarms – Displays the current band alarm.  All available band alarms list in the 

drop down list. 

Band information – Edit and view alarm values. 

The following fields are available for viewing set values or editing: 

Label – Displays the band name. 

Low freq – View or edit the low frequency value or multiple of running speed. 

High freq – View or edit the high frequency value or multiple of running speed. 
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 To make the value a multiple of running speed, add an "x" to the 

end of the entered number.  For example, enter "1.5x" for 1.5 

times running speed. 

Peak danger – View or edit the peak danger value or % Full Scale value. 

Peak alert – View or edit the peak alert danger value or % Full Scale value. 

Overall danger – View or edit the overall danger value or % Full Scale value. 

Overall alert – View or edit the overall alert value or % Full Scale value. 

 To make the value a percentage of the full scale, add a "%" to the 

end of the entered number.  For example, enter "10%" for 10 

percent of the full scale value at the time the band is used. 

 The tab's spectrum graphic display automatically updates as edits 

are made. 

The Spectrum source field displays the source of the spectrum if two or more POINTs 

are currently active. 

The Spectrum field displays all available spectra for the active POINT in a drop down 

list.  The current spectrum displays graphically below. 

 The tab's spectrum graphic display automatically updates as edits 

are made 

Browse – Click to select a POINT to use as the source of the spectrum readings viewed 

while editing the band alarm.  The POINT Selection dialog displays.  Select a POINT to 

use to define a shared alarm.  The hierarchy displays.  Select the desired POINT and 

click OK. 

 Bands defined in the Alarm Database are not assigned to the 

POINTs used to create them. 

Edits may be made on the tab's spectrum graphic display.   

To edit the band graphically: 

 Click on the portions of the graphic band to edit.  Notice the mouse cursor changes 

when over a portion of the band.   

 Drag the band piece to a new position.  The value in the edit field updates. 

 When editing, you may Save or Undo changes for the current 

alarm. 

 Click Add to create a new band alarm. 

 Click Remove to remove the current band alarm.  A confirmation dialog displays. 

 Confirm action.  The band alarm is deleted. 

 A band alarm may not be removed if it is currently assigned. 
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Alarm Settings – Speed Alarm 

Speed alarms allow you to customize overall and band alarm levels based on machine 

speed.  Use the Speed Alarm tab to edit and/or specify the POINTs’ alarm adjustments 

for each speed region. 

 

Figure 3 - 85. 

The Alarm Settings / Speed Alarm Tab. 

Speed alarm – Displays the current speed alarm.  All available speed alarms list in the 

drop down list. 

Name – Displays the speed alarm name. 

Interpret as IMx – Select to display a preview of the speed alarm as it is interpreted for 

an IMx POINT. 

 Interpretation is for display purposes only.  Point Properties / 

Setup not affected by this setting.   
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Range – Select the speed regions for which the Properties settings will apply.  You may 

select the region from the Range drop down list, or by clicking on the specific region on 

the speed alarm display.  The values in the Properties fields update to reflect the 

specified speed region. 

 Click Insert to add a new region to the speed alarm. 

 Click Clear to remove the selected speed region. 

Properties - Edit and view alarm values. 

The following fields are available for viewing set values or editing: 

Start / End Range - Enter each region’s starting and stopping RPMs (i.e., 0 to 1000, 

1000 to 2000, 2000 to 3000, etc.).  

Ratio - Enter the adjustment to overall and band alarm levels.  The normal running 

speed region's ratio will be 100.  If the next higher speed range is expected to produce 

vibration levels 10% higher than the nominal running speed, then the next speed range 

ratio would be set to 110. 

Linear - This option allows for either a flat, rectangular definition of the adjustment (if 

disabled, the entire region will have the same ratio), or a more linear definition of the 

ratio (if enabled, the ratio will start from the level defined in the previous speed region 

and rise throughout the region until it reaches the next speed region's level).   

 IMx POINTs always use linear region.   

Deadband – When enabled, no alarm processing will occur for this region.  This is 

mainly to be used when the machine reaches its resonant speed, at which vibration will 

be indeterminately high.  When enabled, Ratio and Linear fields are disabled. 

 The tab's spectrum graphic display automatically updates as edits 

are made. 

 IMx does not support deadband; however, @ptitude Analyst 

supports deadband for IMx POINTs in post-processing. 

 Click Add to create a new speed alarm. 

 Click Remove to remove the current speed alarm.  A confirmation dialog displays. 

 Confirm action.  The speed alarm is deleted. 

 A speed alarm may not be removed if it is currently assigned. 
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Alarm Settings – Envelope 

Use the Envelope tab to manage and edit shared envelope alarms.  All available 

envelope alarms display in the Envelope alarms drop down list.   

 

Figure 3 - 86. 

The Alarm Settings Screen’s Envelope Tab. 

All available envelope alarms display in the Envelope alarm drop down list, or you may 

generate a new envelope alarm.   

Shared envelope alarms may not be edited from this tab (use the Customize menu’s 

Alarm Database option to edit "shared" alarm parameters). 

 First, select the FFT spectrum to which the envelope alarm will conform, using: 

Spectrum source – specifies from which POINT to graphically display the spectrum if 

two or more POINTs are currently active. 

Spectrum – displays all available time record measurements for the active POINT 

(typically the baseline measurement) in a drop down list.  The current spectrum displays 

graphically below. 
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To assign a "shared" envelope alarm to the POINT: 

 On the Envelope tab, select the desired shared envelope alarm’s name from the 

Envelope Alarms drop down list, the tab fields display the specified alarm’s settings 

and the specified envelope appears on the displayed spectrum. 

To generate a new envelope alarm for the POINT: 

 Select the Envelope Alarms drop down list’s <Custom envelope> option. 

 Click the Generate button.  The Generate Envelope Alarm dialog displays. 

Use the Generate Envelope Alarm Dialog to create an envelope alarm based on your 

entered values. 

% Overdrive – Enter the percent of the POINT’s full scale value to determine the height 

of the envelope alarm above the spectral peak.  The smaller the number specified, the 

tighter the comparison envelope conforms to the designated spectrum. 

Spreading % – Enter percent of full scale (or center frequency) to increase the width of 

the envelope alarm around spectral peaks.  The smaller the number specified, the 

tighter the envelope conforms to the sides of the peaks in the specified spectrum. 

Spreading Type – (either Center Frequency or Full Scale).  If Center Freq. is selected, 

the bandwidth about each center frequency increases with higher frequencies.  If Full 

Scale is selected, the bandwidth about each center frequency is constant, based on a 

percent of the full scale frequency. 

Threshold – Enter % of the POINT’s full scale value, or an absolute value.  The threshold 

value provides an opportunity to eliminate false alarms due to vibration "noise."  It also 

establishes the envelope alarm’s low amplitude "threshold" on the displayed spectrum.  

The envelope alarm conforms around all peaks whose amplitudes are higher than the 

established threshold as per the Overdrive %, Spreading %, and Spreading Type 

settings.  All peaks below the established threshold are ignored by the envelope alarm.  

The Threshold % default value is set using the Customize menu’s Preferences / Plot 

tab. 

 Click OK to generate an envelope alarm based on your entries.  Click Cancel to 

close the dialog without creating an envelope alarm. 

Editing the Envelope Alarm 

After you have generated an envelope alarm, you can edit it graphically using your 

mouse, or enter numeric envelope parameters using the Set Frequency Range dialog. 

To graphically edit the envelope alarm: 

 Click anywhere inside the Envelope tab’s spectrum window.  The cursor appears as 

an up arrow.   

 Click the mouse on the portion of the envelope alarm line to be edited.  A square 

icon identifies where the line will be drawn. 

 Drag the mouse to draw the line to create the new envelope alarm.   

 Click the tab’s OK button to save your changes. 
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Tip - You can use your keyboard’s Insert key to begin drawing the envelope alarm line.  

Then, use the arrow keys to move the line, and the Insert key again to stop drawing the 

line.  Refer to Appendix B, SKF @ptitude Analyst Keyboard Support of the 

accompanying Introduction manual for more information on using your keyboard to edit 

your envelope alarm. 

To edit the envelope alarm using numeric frequency ranges: 

 Click the Set Range button.  The Set Frequency Range dialog displays. 

 Use the Set Frequency Range dialog to enter low frequency, high frequency, and 

level values to edit an existing envelope alarm. 

To numerically edit an envelope alarm: 

 Enter the desired low frequency, high frequency, and level value. 

 Click OK.  The displayed envelope alarm automatically conforms to your entries. 

Alarm Settings – Alarm Group 

Alarm groups allow you to group POINTs together.  Use the Alarm Group tab to create 

new alarm groups. 

 POINTs are added to an alarm group from the Point Properties / 

IMx Setup tab. 

 

Figure 3 - 87. 

The Alarm Settings Screen’s Alarm Group Tab. 
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To create a new alarm group: 

 Select an IMx device from the drop-down list. 

 Click the Add button and enter a name for the alarm group in the Name text entry 

box.   

For existing alarm groups, you may view the POINTs that have been added to the alarm 

group in the Included POINTs area.  This is a read-only field.  To add or remove 

POINTs from the alarm group, you must edit the POINT’s properties on the POINT 

Properties / IMx Setup tab. 

To remove an alarm group: 

 Select the alarm group you wish to remove from the Alarm Groups drop-down list.   

 If POINTs are included in this alarm group you must first remove 

them by editing the POINT’s properties on the POINT Properties 

/ IMx Setup tab. 

 Click the Remove button.   

Messages 

Use the Customize / Alarm Settings screen’s Messages tab to create shared (public) 

alarm messages to assign to machines and POINTs to automatically display important 

alarm information.   

All previously defined alarm messages appear in the Alarm messages drop down list. 

To create a public Message: 

 Select the Customize menu’s Alarm Settings option.  The Alarm Settings screen 

displays. 

 Select the Messages tab. 

 Click the Messages tab’s Add button.  The tab enters edit mode. 

 Specify appropriate information into the following fields: 

Name – Specify a name to define your custom message.   

Format – Select the message format from the drop down list.  Available options 

include: 

Free form – Allows you to manually type in the summary and content for your 

message. 

Summary – Type in text summarizing your alarm message for easy recognition.  For 

example, if you have an alarm message that details shut down instructions in the case 

of an overall danger high alarm level, your summary may read, "Emergency Shut Down 

Instructions." 

Content – Enter your complete alarm message in the content text area.  Using the 

above example, your alarm message content would include detailed shut down 

instructions, and any other pertinent information required in the case of the triggered 

alarm type. 
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 Click the Save button to save the new message and add it to the available public 

messages. 

 Click the Undo button to undo changes. 

 Click Remove to remove the current message. 

 Messages currently in use cannot be removed. 
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Statistical Overall Alarms Wizard 

Overview 

For POINTs in a Workspace window, the Statistical Overall Alarms Wizard guides you 

through a process that automatically generates overall alarm settings based upon 

historical measurement data. 

 The Statistical Overall Alarms Wizard only operates on an active 

Workspace window. 

To initiate the wizard: 

 Open the desired Workspace window. 

 Select the Customize menu’s Alarm Attributes / Statistical Overall… option.  The 

wizard’s Introduction screen displays. 

Introduction 

The Introduction screen is the first screen in the Statistical Overall Alarms Wizard.  

The measurement data used to generate the alarm values is generated from the 

POINTs included in the selected Workspace (identified in the Workspace field). 

 From the Workspace drop down list, select the Workspace containing POINTs for 

which you would like to generate the alarm values. 

 From the Full scale units drop down list, select a measurement unit.  The Full 

scale units drop down list displays a list of the full scale units for POINTs in the 

selected workspace.  Only POINTs with the selected measurement unit are used to 

generate alarm values. 

 Click the Save processing details to “Statistical Overall Alarms.log” check box to 

create and save a log file. 

 Click Next to continue. 

Alarm Assignment 

Select the calculation method to use to determine alarm values. 

Individual POINTs – Select to use each POINT's readings to generate a unique set of 

alarm values for the POINT.  The resulting values are assigned to each POINT as a 

private alarm. 

 This operation generates and assigns a private alarm for each 

POINT. 

Across all POINTs – Select to use the readings for all the POINTs to generate one set 

of alarm values that is assigned to each POINT included in the calculation.  The resulting 

values are saved as a shared alarm. 

 If Across all POINTs is selected, a Review window displays before 

alarms are applied, allowing verification and confirmation. 

 Click Next to continue. 
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 Click Back to return to the previous screen. 

 Click Cancel to exit the wizard. 

Measurement Selection 

Determine the method for selecting the measurement data to generate overall alarm 

values. 

All measurements – Select to use all measurement data to generate the overall alarm 

values. 

Measurements in this date range – Select and enter a date range to use all 

measurements in the indicated date range to generate the overall alarm values. 

Last fixed number of measurements – Select and enter number of measurements to 

use the specified number of measurements to generate overall alarm values. 

Limits – Allow you to filter abnormal measurements from the calculation: 

Max. Amplitude- Enter the maximum amplitude of the overall value to include 

in calculation. 

Min. Amplitude – Enter the minimum amplitude of the overall value to include 

in calculation. 

Min Measurements – Enter the minimum number of the POINT's 

measurements to be included in calculation. 

 Only POINTs that have the number of indicated minimum 

measurements (or more) are included in the calculation. 

 Min. Measurements field is not available if measurement selection 

is "Last fixed number of measurements." 

Channel – Enter the channel number of multi-channel POINTs to include in 

the calculation.  

Enable outlier removal – An “outlier” refers to data that is not typical, or is 

outside a specified data measurement range.  When the Enable outlier 

removal check box is enabled, measurement values that fall outside the outlier 

range are excluded from the calculation. 

 Outlier detection only occurs if the number of measurements is 

greater than or equal to the Min Measurements specification. 

Outlier threshold factor – Enter a threshold factor (1.0 to 5.0) to calculate the 

lower and upper limits of the outlier range (outlier threshold).  The threshold 

factor is multiplied by the standard deviation to calculate the outlier threshold.  

The default threshold factor is 3.0. 

 Click Next to continue. 

 Click Back to return to the previous screen. 

 Click Cancel to exit the wizard. 
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Alarm Type 

Select the type of overall alarm to generate: 

Level – Provides two alarm levels (Alert High and Danger High).  An appropriate alarm 

registers if the measured value is greater than either of the alarm levels.   

Out of Window – Provides four alarm levels (Danger High, Alert High, Alert Low, 

Danger Low).  An appropriate alarm registers if the measured value progresses out of 

the alarm window (does not fall between the alert high and alert low alarm settings). 

Generation Parameters 

 

Figure 3 - 88. 

The Statistical Overall Alarms Wizard’s Generation Parameters Screen. 

Note that you need not perform the standard deviation math.  The wizard’s default 

values have been selected to produce overall alarms that work well for most situations.  

However, if you wish to conform the overall alarms closer, enter smaller numbers.  To 

conform the overall alarms further away, enter higher numbers.  After completing the 

wizard, view your trend plots and make adjustments as necessary. 

 If necessary, edit the standard deviation information to be used in the overall alarm 

calculations.   
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Standard deviation factors 

Danger High – Value to be multiplied by the standard deviation to establish the danger 

high level. 

Alert High - Value to be multiplied by the standard deviation to establish the alert high 

level. 

Alert Low – Value to be multiplied by the standard deviation to establish the alert low 

level. 

Danger Low – Value to be multiplied by the standard deviation to establish the danger 

low level. 

 Click Next to continue. 

 Click Back to return to the previous screen. 

 Click Cancel to exit the wizard. 

Minimum Alarm Values 

Set the minimum alarm values to be used in the calculation.  If the standard deviation is 

small, the minimum alarm values allow you to set a wider range, minimizing the chance 

for bad alarms to occur. 

Enter the minimum values for Danger High, Alert High, Alert Low, and Danger Low. 

 Click Next to continue. 

 Click Back to return to the previous screen. 

 Click Cancel to exit the wizard. 

Process 

Click the Next button to begin the overall alarm calculations.  Process progress displays 

along with the number of POINTs processed. 

 Click Next to continue. 

 Click Back to return to the previous screen. 

 Click Cancel to exit the wizard. 
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Review 

 This screen only displays if Across all POINTs was selected on 

the wizard's Alarm Assignment screen. 

 

Figure 3 - 89. 

The Statistical Overall Alarms Wizard’s Review Screen. 

The statistically derived overall alarm results display on this screen.  These numbers 

may be edited, if necessary. 

Fields include: 

Alarm set name – Specify a unique name for the alarm. 

Calculated alarm values – Edit values as needed. 

 Calculated alarm values fields are available based on overall 

alarm type selection. 

POINTs processed for input criteria – Number of POINTs selected as candidates for 

processing. 

POINTs included – Number of included POINTs. 

POINTs excluded – Number of excluded POINTs. 

 Alarms are still applied to the POINTs excluded from calculation 

functions. 

 Click Next to continue. 

 Click Back to return to the previous screen. 

 Click Cancel to exit the wizard. 
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Finish 

 Click the Finish button to assign the statistically derived overall alarm to all POINTs 

in the specified workspace. Process progress displays on the screen. 

 Click Back to return to the previous screen. 

 Click Cancel to stop the operation without changing the POINTs. 

Statistical Band Alarms Wizard  

Overview 

For POINTs in a Workspace window, the Statistical Band Alarms Wizard guides you 

through a process that automatically generates band alarm settings based upon 

historical measurement data. 

 The Statistical Band Alarms Wizard only operates on an active 

Workspace window—not on a Route. 

To initiate the wizard: 

 Select the Customize menu’s Alarm Attributes / Statistical Band option.  The 

wizard’s first screen displays. 

To complete the wizard: 

 On each screen, enter values and select options as appropriate. 

 Click Next to proceed to the next screen. 

 Alternatively, you can click Back to return to the previous screen 

or Cancel to exit the wizard. 

Choose a Workspace 

Choose a Workspace is the first screen you encounter in the Statistical Band Alarms 

Wizard. On this screen, you select the Workspace for which you intend to create band 

alarms. The measurement data used to generate the alarm values come from the 

applicable POINTs within the Workspace you select. 

 The POINTs must have an existing band alarm setup that 

specifies the spectra frequency range for the new alarm levels. If 

no band alarm exists, the wizard will have nothing to calculate. 



 Working With Your SKF @ptitude Analyst Hierarchy 

 Statistical Band Alarms Wizard 

SKF @ptitude Analyst and SKF Multilog On-line Systems 3 - 169 

User Manual 

 

Figure 3 - 90. 

The Statistical Band Alarms Wizard’s Choose a Workspace Screen. 

 From the Workspace drop down list, select the Workspace containing POINTs for 

which you would like to generate the alarm values. 

 From the Full scale units drop down list, select a measurement unit.  The Full 

scale units drop down list displays a list of the full scale units for POINTs in the 

selected workspace.  Only POINTs with the measurement unit you select are used 

to generate alarm values. 

 Click the Save processing details to “Statistical Band Alarms.log” check box to 

create and save a log file. 

 Click Next to continue to the Choose Calculation Method screen. 
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Choose Calculation Method 

The wizard calculates statistical band alarms based on POINTs measurements only. On 

this screen, you select the calculation method to use to determine how alarm values will 

be generated and applied to those POINTs. 

 

Figure 3 - 91. 

The Statistical Band Alarms Wizard’s Choose Calculation Method Screen. 

 Select a calculation method: 

Individual POINTs – Select to use each POINT's readings to generate a unique set 

of alarm values for the POINT.  The resulting values are assigned to each POINT as 

a private alarm. 

 This operation generates and assigns a private alarm for each 

POINT. It replaces POINTs' existing private alarms with new, 

statistically derived private alarms on the same frequency band. 

Any shared alarm assignments remain the same. 

Across all POINTs – Select to use all readings from all POINTs to generate one set 

of alarm values that is assigned to each POINT included in the calculation.  The 

resulting values are saved as a shared alarm. 

 If Across all POINTs is selected, the Disable assignments of 

existing private alarms checkbox becomes editable. Select this 

checkbox to ignore (disable) existing private alarm assignments. 
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 This operation replaces existing shared alarms with new, 

statistically derived shared alarms on the same frequency band, 

which is calculated only on the measurements of the POINTs to 

which an alarm is assigned. Any private alarm assignments 

remain the same. 

 Click Next to continue to the Specify Input Criteria screen. 

Specify Input Criteria 

On this screen, you specify the historical measurements to use for the statistical data 

set, the minimum measurement count for a POINT, the peak and overall ranges 

(measurements outside of which are to be excluded), and the outliers (the sigma 

distance from the mean value). 

 

Figure 3 - 92. 

The Statistical Band Alarms Wizard’s Specify Input Criteria Screen. 

 Select the historical measurements to use: 

All measurements – Select to use all measurement data to generate the band 

alarm values. 

Measurements from/to – Select, then enter a date range to use all measurements 

in the indicated date range to generate the band alarm values. 
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Last ___ measurements – Select, then enter a number of measurements to use 

the specified number of measurements to generate band alarm values. 

 Use the remaining fields to filter abnormal measurements from the calculation: 

Min measurements – Enter the minimum number of the POINT's measurements 

to be included in calculation. 

 Only POINTs that have the number of indicated minimum 

measurements (or more) are included in the calculation. 

 The Min. Measurements value cannot be greater than the Last 

___ measurements value, if one has been entered. 

Channel – Select the channel number of multi-channel POINTs to include in the 

calculation.  

Max peak – Enter the maximum peak of the band value to include in calculation. 

Min peak – Enter the minimum peak of the band value to include in calculation. 

Max overall – Enter the maximum overall band value to include in calculation. 

Min overall – Enter the minimum overall band value to include in calculation. 

Enable outlier removal – An “outlier” refers to data that is not typical, or is outside 

a specified data measurement range.  When the Enable outlier removal check box 

is enabled, measurement values that fall outside the outlier range are excluded 

from the calculation. 

There are two passes of outlier removal. The first is a simple exclusion of 

measurements whose peaks and overall values are outside of the range specified 

by the min/max peak and min/max overall input. The second is the removal of 

measurements by calculating the normal distribution of both peak and overall 

values and excluding measurements whose values are beyond the specified factor 

of standard deviation of the data. You can turn off the second pass if it is not 

desired. 

 Outlier detection only occurs if the number of measurements is 

greater than or equal to the Min measurements specification. 

Outlier threshold factor – Enter a threshold factor (1.0 to 5.0) to calculate the 

lower and upper limits of the outlier range (outlier threshold).  The threshold factor 

is multiplied by the standard deviation to calculate the outlier threshold.  The 

default threshold factor is 3.0. 

 Click Next to continue to the Set Alarm Level Factors screen. 
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Set Alarm Level Factors 

On this screen, you specify the standard deviation factors to be used in calculating alarm 

levels. Alarm levels are calculated using the equation Value = Mean + (n * Standard 

Deviation), where n represents the factor for the level to be calculated.  

 

Figure 3 - 93. 

The Statistical Band Alarms Wizard’s Set Alarm Level Factors Screen. 

 To use a standard deviation factor in an alarm level’s calculation, select that alarm 

level’s checkbox and enter the appropriate n value: 

Peak danger – Value to be multiplied by the standard deviation to establish the 

peak danger level. An appropriate alarm registers if the measured peak value is 

greater than mean + (the number entered * standard deviation). 

Peak alert – Value to be multiplied by the standard deviation to establish the peak 

alert level. An appropriate alarm registers if the measured peak value is greater 

than mean + (the number entered * standard deviation). 

Overall danger – Value to be multiplied by the standard deviation to establish the 

overall danger level. An appropriate alarm registers if the measured overall value is 

greater than mean + (the number entered * standard deviation). 

Overall alert – Value to be multiplied by the standard deviation to establish the 

overall alert level. An appropriate alarm registers if the measured overall value is 

greater than mean + (the number entered * standard deviation). 
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 Click Next to continue to the Set Alarm Level Limits screen. 

 To continue, you must set at least one alarm level’s standard 

deviation factor. 

Set Alarm Level Limits 

On this screen, you set minimum and maximum alarm level ranges to guard against 

unacceptably narrow statistically derived alarm levels. You can enter each alarm range 

as an absolute value (e.g. “5”), as an offset relative to the calculated mean (e.g. “5+”), or 

as a percentage factor to be multiplied by the mean (e.g. “100%”). 

 

Figure 3 - 94. 

The Statistical Band Alarms Wizard’s Set Alarm Level Limits Screen. 

 To set a level, select its checkbox and enter the appropriate absolute value, offset, 

or percentage factor: 

Minimum Levels – Set the minimum alarm values to be used in the calculation.  If 

the standard deviation is small, the minimum alarm values allow you to set a wider 

range, minimizing the chance for bad alarms to occur. 

Peak danger – Value to be applied to establish the peak danger low level. 

Peak alert – Value to be applied to establish the peak alert low level. 

Overall danger – Value to be applied to establish the overall danger low level. 
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Overall alert – Value to be applied to establish the overall alert low level. 

Maximum Levels – Set the maximum alarm values to be used in the calculation.  If 

the standard deviation is large, the maximum alarm values allow you to set a wider 

range, minimizing the chance for bad alarms to occur. 

Peak danger – Value to be applied to establish the peak danger high level. 

Peak alert – Value to be applied to establish the peak alert high level. 

Overall danger – Value to be applied to establish the overall danger high level. 

Overall alert – Value to be applied to establish the overall alert high level. 

 Click Next to continue to the Start Calculation Process screen. 

Start Calculation Process 

On this screen, you begin the band alarm calculation process. 

 

Figure 3 - 95. 

The Statistical Band Alarms Wizard’s Start Calculation Process Screen. 

 Click Next to begin the band alarm calculations.  The screen displays information 

about the process progress, the number of POINTs processed, etc. 

 This information will appear in the log file. 

 Click Next to continue to the Apply New Alarms screen. 
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Apply New Alarms 

On this screen, you apply alarm assignments. 

 

Figure 3 - 96. 

The Statistical Band Alarms Wizard’s Apply New Alarms Screen. 

 Click Next to assign the statistically derived band alarms to the POINTs in the 

specified workspace. The screen displays information about the process progress. 

 Click Finish to close the screen. 

Once the alarm assignments have been applied, you can go to any of the POINTs’ 

POINT Properties / Band tab to view the new statistical band and statistical alarm 

values (see figure on following page). 

 To revert back to a previous alarm band, click Load from the 

Band tab and select a different alarm band. 
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Figure 3 - 97. 

The POINT Properties Screen’s Band Tab. 

Templates 

Templates save time, contribute to consistent organization, and allow you to make bulk 

entries.  For example, you can quickly set the machine speed for all POINTs beneath a 

machine with a template.  Templates allow you to define custom organizational 

structures for repeated use when building or defining your hierarchy.   

 The same template may be used across many different 

hierarchies.   
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Managing Templates 

To add a new template: 

 Select the Customize menu’s Template option.  The Template dialog displays. 

 

Figure 3 - 98. 

The Template Dialog. 

 Click the dialog’s Add button.  The Template Properties dialog displays. 

 Enter the new template’s Name and Description. 

 Select the template’s Type from the drop down list.  Select a previously created 

template or <Custom>.   

 If you need a new template that is only slightly different from a 

previously created template, you can select a previous template 

as your Type and then edit only the necessary items. 

 Click the dialog’s OK button.  The new template window displays. 

In the template window, insert new Groups and POINTs to build the new template’s 

hierarchy structure. 

 Using the Insert menu, insert desired structure elements (groups and POINTs) in 

the desired configuration into the template window. 

 You may also use Copy, Paste, and Paste Multiple to build your 

template’s structure. 
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Figure 3 - 99. 

Template Window with Custom Structure. 

When building your template structure, you may also set up custom names using 

“special” characters in the name fields. 

When applying a template, the template wizard assists with naming hierarchy items 

whose template name includes “special” characters 

Custom Names 

Templates hierarchy items may be inserted in your database: 

 With the name specified in the template, or 

 With the Template wizard prompting you to enter a name for items inserted in your 

database, or 

 With custom names created by the Template wizard that are based upon your 

existing database. 

The last two options are accomplished by special characters within your template 

hierarchy names. 

 When a new item is inserted into the Template, its Properties dialog displays. 

 You may also access the Properties dialog by right-clicking to 

access the context menu, or using the Properties toolbar button. 

You can configure the custom naming feature to prompt you to input a unique name for 

the specified item as the template is applied.  You can also set up your template to 

automatically name structure items based on your entered parameters. 

To set up name prompt: 

 In the Properties dialog’s Name field, enter a “^” as the first character.  During the 

application of the template, the template wizard will prompt you to either accept 

the item’s name as it appears after the “^”, or enter a new name for the hierarchy 

item as the template is being processed. 
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Use of special characters enables automatic naming during template application.  Based 

on your entries, the new items take their name from the portions of the parent item’s 

name. 

To set up automatic naming: 

 In the Properties dialog’s Name field, use a “$” to cause the inserted template item 

(child) to use a portion of the target hierarchy parent’s name.  Each “$” in the 

template item’s name is replaced by a sequential word from the target hierarchy 

parent’s name.  Use as many “$”s as necessary.  For example, if the parent item’s 

name is “Dryer Section,” you might apply a template item named “$ $ Felts.”  This 

will insert the template item (child) and name it “Dryer Section Felts.” 

 Also, square brackets (“[ ]”) may be used to strip items from the final name.  This 

allows you to use “[ ]”s and “$”s together to use some portions of the parent’s name 

while skipping others.  For example, if the parent’s name is “FD Fan”, and you wish 

to remove the “FD” prefix, place “[ ]”s around the dollar sign representing the “FD” 

( [$]$ ).  The inserted item will be named “Fan.”  You can also use “[ ]”s to include 

comments that are visible when viewing the template and as the template is 

applied.  The comment text does not appear in the final name.  To do so, enter your 

auto-naming characters followed by your comment text enclosed in brackets.  For 

example, using the earlier “FD Fan” example, the entry “[$]$[left env] would result 

in the item being named “Fan.”  The comment text, “left env” is visible to you when 

you view the template, and as the template is applied, but is deleted from the item’s 

name in the hierarchy list. 

To open an existing template: 

 In the Template window, select the template to open. 

 Click the window’s Open button.  The selected template window displays. 

To remove an existing template: 

 In the Template window, select the template to remove. 

 Click the window’s Remove button.  When prompted, confirm action. 

The selected template is removed. 

To add a Template Type: 

 In the Template window, click Add, or select an existing template and click Edit.  

The Template Properties dialog displays. 

 In the General tab’s Type field, place your cursor in the drop down list and enter 

the new type name. 

 Click OK to save the new template type and apply it to the current template. 
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Applying Templates 

To apply a template: 

 In your target Hierarchy, select the item under which you wish the template items 

to branch. 

 Select the Insert menu’s Apply Template option.  The Apply Template screen 

displays. 

The Apply Template screen lists all available templates. 

 Select desired template and click Apply to launch the Apply Template Wizard. 

Introduction Screen 

 

Figure 3 - 100. 

The Apply Template Wizard Screen. 

The Apply Template Wizard guides you through the required steps to create new 

entries under the selected hierarchy item, using the selected template. 

The introduction screen displays the following information about the selected template: 

Name – Displays the name of the template being applied. 

Description – Displays the description provided for the template. 

Destination – Displays the location in the hierarchy to which the template will 

be applied.   

Before continuing, ensure the template name is correct, and ensure the destination is 

accurate. 

 Click Next to continue. 
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Configuration Screen 

The template application process begins on the Configuration screen.  This screen 

walks through the template, gathering information as needed:   

Name - If necessary, you will be prompted to specify the name of the item being 

processed. 

Running speed - Specify the machine speeds for the highlighted machine.  This speed 

will be used to set the speed of each POINT beneath the machine.   

 The processing stops to allow you to enter necessary information. 

Custom Naming 

 You will be prompted to enter a name if you set your template up 

using the special name-prompt character “^.”  Your structure 

elements will be automatically named if you set up your template 

using auto-name characters. 

 Click Next to continue. 

When the template processing is complete, click Next to continue to the build screen. 

 View the template’s progress in the screen’s progress bar. 

 Click Back to return to the wizard’s last stopping point. 

Build Screen 

 

Figure 3 - 101. 

The Apply Template Wizard Screen. 
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This screen uses the template to build the template hierarchy items within the specified 

target hierarchy item.   

 The wizard is capable of generating multiple copies of the 

template. 

 Specify the number of copies required. 

 Click Next to build the hierarchy. 

 Click Finish to close the wizard. 

Working with Filters 

Filters allow you to setup and apply filter criteria that determine which POINTs display 

in a new filtered Workspace window.  Filtered workspaces group together POINTs and 

Groups (based on your filter input) in one window for easy comparison and analysis. 

Managing Filters 

Use the Customize menu’s Filters option to manage (add, copy, edit, and remove) 

filters.  This allows you to define reusable filters. 

To add a new filter: 

 Select the Customize menu’s Filters option.  The Filters screen displays. 

 Click the Add button.  The Filter Editor screen displays. 

 

Figure 3 - 102. 

The Filter Editor Screen. 
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Name - Specify the new filter’s name. 

 It is helpful to give the filter a name based on its criteria for easy 

recognition.  For example, if you need to sort Groups based on 

their priority setting, you may want to create and name a filter 

specifically for Priority. 

Keep hierarchy – Click the checkbox to determine whether the hierarchy Groups appear 

with their filtered POINTs in the filtered workspace, or whether only the filtered POINTs 

appear in the filtered workspace.  If disabled, filtered POINTs appear beneath the 

filtered machine without the original hierarchical format.  The filtered workspace lists all 

filtered POINTs under a “Filtered Machine” hierarchy item. 

Filter on attributes – Define which attributes to filter on.  Attributes are categorized by 

machine, measurement, POINT, data type, and/or attribute type.  Select an attribute 

group to modify its individual settings. 

Settings – Displays current individual attribute settings for the specified attribute 

category.  Use the edit fields to view and/or edit attributes as necessary. 

 When one or more attribute within an attribute category is 

included in the current filter, a checkmark displays next to the 

attribute category folder. 

 Use the All and Clear buttons to quickly include all or none of the displayed 

attributes (rather than selecting / de-selecting one by one) for the selected attribute 

category in your current filter. 

Include – Specify whether to filter for POINTs that match every attribute setting, or 

filter for POINTs that match at least one attribute setting. 

Any Selected – Select to filter for POINTs matching any individual attribute of 

the total included in the filter.  Only these POINTs display in the Filtered 

Workspace 

All Selected - Select to filter for POINTs matching all attributes included in the 

filter.  Only these POINTs display in the Filtered Workspace. 

 The number of attributes selected and the total number of 

available attributes displays in the screen’s lower left corner. 

 Click the OK button to create a new workspace based on the defined criteria of the 

current filter.  A progress bar displays, indicating filter process status. 

 Click Cancel to close screen without performing filter and without saving filter 

entries. 

To create a new filter based on a copy of an existing filter: 

If you need a new filter that is only slightly different from a previously created filter, you 

can select the previous filter and then edit only the necessary items. 

 In the Filters screen, select the existing filter you wish to copy and use as a 

template. 

 Click the screen’s Copy button.  The Filters Editor screen displays. 

 Enter the new filter’s name. 
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 By default, the new filter is given the same name as the copied 

filter on which it is based, with a numerical suffix. 

Filter on attributes - Select additional individual attributes, or edit the existing 

attributes.  When an existing filter is selected, its existing selected attributes display. 

 Click OK to apply the new filter. 

To edit an existing filter: 

 In the Filters screen, select the existing filter you wish to edit. 

 Click the screen’s Edit button.  The Filters Editor screen displays. 

Filter on attributes – Displays the selected existing filter’s selected attributes. 

 Perform your edits and click the screen’s OK button to save the edited filter. 

To remove an existing filter: 

 In the Filters screen, select the existing filter you wish to remove. 

 Click the screen’s Remove button.  Confirm removal when prompted.  The filter is 

removed. 

Applying Filters 

You can create and apply private and shared filters using the Insert menu’s Apply 

Filters screen.  When a filter is applied, the resulting items display in a new Workspace 

window. 

To apply a filter: 

 Select the Insert menu’s Apply Filter option.  The Apply Filter screen displays. 

 

Figure 3 - 103. 

The Apply Filter Screen. 

Filter – Select an existing filter or <Private Filter>.  This determines what to base your 

filter on (either a copy of an existing shared filter or to create a new private filter). 
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Filter on attributes – Displays the selected existing filter’s selected attributes. 

Keep hierarchy - Click the checkbox to determine whether the hierarchy Groups appear 

with their filtered POINTs in the filtered workspace, or whether only the filtered POINTs 

appear in the filtered workspace.  If disabled, filtered POINTs appear beneath the 

filtered machine without the original hierarchical format.  The filtered workspace lists all 

filtered POINTs under a “Filtered Machine” hierarchy item. 

 In the screen’s Filter from area, select Root node – Hierarchy to search the entire 

hierarchy for matching POINTs.  Select Selected node to search from your selected 

node and below only. 

 In the screen’s Filter on attributes area, define which attributes to filter on.  

Attributes specific to machine, measurement, POINT, data type, and/or attribute 

type are grouped together.  Select an attribute type to include in the filter. 

 Attribute settings for the selected attribute group display in the screen’s Settings 

area.  View and/or edit attributes as necessary in the displayed input fields. 

 Individual attributes are described in detail in the next section. 

 When one or more attribute within an attribute group is included 

in the current filter, a checkmark displays next to the attribute 

group folder. 

Include – Specify whether to filter for POINTs that match every attribute setting, or 

filter for POINTs that match at least one attribute setting. 

Any Selected – Select to filter for POINTs matching any individual attribute of 

the total included in the filter.  Only these POINTs display in the Filtered 

Workspace. 

All Selected - Select to filter for POINTs matching all attributes included in the 

filter.  Only these POINTs display in the Filtered Workspace. 

 The Include option may or may not appear, depending on the 

Filter on attribute option that is currently selected. 

 The number of attributes selected and the total number of 

available attributes displays in the screen’s lower left corner. 

 Click the screen’s OK button to apply the filter as a private filter 

 When a filter is applied, the resulting items display in a new 

Workspace window. 

To make the filter a shared filter: 

 Click Share As to assign the current filter a unique name and make it available as a 

shared filter.  The Enter Filter Name dialog displays. 

 Enter a unique filter name and click OK. 

 Click the Apply Filter screen’s OK button to create a workspace based on the 

defined criteria of the current filter.  A progress bar displays, indicating filter 

process status. 

 Click Cancel to close screen without performing filter and without saving filter 

entries. 
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Individual Filter Attributes 

All individual filter attributes are described below. 

Asset 

This attribute is located under General / Machine. 

Filters for all POINTs under the selected machine with the indicated asset (the 

physical machinery occupying the segment). 

Edit – Enter the asset in the text field. 

 Standard wildcard operations are supported. 

Machine Description 

This attribute is located under General / Machine. 

Filters for all POINTs under the selected machine with the indicated 

description. 

Edit – Enter the machine description in text field. 

 Standard wildcard operations are supported. 

Machine Name 

This attribute is located under General / Machine. 

Filters for all POINTs under the selected machine with the indicated name. 

Edit – Enter the machine name in the text field. 

 Standard wildcard operations are supported. 

Priority 

This attribute is located under General / Machine. 

Filters for all POINTs under the selected machine with the indicated priority 

assignment. 

Edit – Select one or more priority assignment(s). 

Segment 

This attribute is located under General / Machine. 

Filters for all POINTs under the selected machine with the indicated segment 

(physical location of a Group). 

Edit – Enter the segment in the text field. 

 Standard wildcard operations are supported. 
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Alarms 

This attribute is located under Measurement. 

Filters for all POINTs with a last measurement in the indicated alarm. 

Edit – Select one or more alarms from the settings list.  Use the All button to 

select all alarms in the settings list.  Use the Clear button to clear all selections 

from the alarms in the settings list.  Select Include All Selected to include 

POINTs matching all alarm selections.  Select Include Any Selected to include 

POINTs matching at least one alarm selection. 

Last Measurement Date 

This attribute is located under Measurement. 

Filters for all POINTs with a last measurement taken between (and including) 

the specified dates. 

Edit – Enter the dates using standard date selection operation. 

Last Measurement Value 

This attribute is located under Measurement. 

Filters for all POINTs with an overall value (Channel 1) between and including 

specified values. 

Edit – Enter values in the edit fields. 

Overdue 

This attribute is located under Measurement. 

Filters for all POINTs’ schedule condition (Overdue or Not Overdue). 

Edit – Select Overdue or Not Overdue. 

Number of Days – Enter the number of days (from now).  Filters for POINTs 

matching the selected status (Overdue or Not Overdue) within the entered 

date range. 

Band Alarm 

This attribute is located under POINT / Alarm. 

Filters for all POINTs with the selected shared band alarm. 

Edit – Select one or more shared band alarm from the settings list.  Use the All 

button to select all shared band alarms in the settings list.  Use the Clear 

button to clear all selections from the shared band alarms in the settings list. 

Envelope Alarm 

This attribute is located under POINT / Alarm. 

Filters for all POINTs with the selected shared envelope alarm. 

Edit – Select one or more shared envelope alarm from the settings list.  Use 

the All button to select all shared envelope alarms in the settings list.  Use the 

Clear button to clear all selections from the shared envelope alarms in the 

settings list. 
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HAL Alarm 

This attribute is located under POINT/Alarm. 

If HAL Alarm Set is set to “Yes” for the HAL Alarm filter attribute, then when 

the filter is applied, the workspace will display only POINTs for which HAL 

alarms are configured. 

If HAL Alarm Set is set to “No” for the HAL Alarm filter attribute, then when 

the filter is applied, the workspace will display only POINTs for which HAL 

alarms are not configured. 

Overall Alarm 

This attribute is located under POINT / Alarm. 

Filters for all POINTs with the selected shared overall alarm. 

Edit – Select one or more shared overall alarm from the settings list.  Use the 

All button to select all shared overall alarms in the settings list.  Use the Clear 

button to clear all selections from the shared overall alarms in the settings list. 

Speed Alarm 

This attribute is located under POINT / Alarm. 

Filters for all POINTs with the selected shared speed alarm. 

Edit – Select one or more shared speed alarm from the settings list.  Use the 

All button to select all shared speed alarms in the settings list.  Use the Clear 

button to clear all selections from the shared speed alarms in the settings list. 

Application Type 

This attribute is located under POINT / General. 

Filters for all POINTs configured to collect the indicated application data. 

Edit – Select one or more application type from the settings list.  Use the All 

button to select all application types in the settings list.  Use the Clear button to 

clear all selections from the application types in the settings list. 

DAD Type 

This attribute is located under POINT / General. 

Filters for all POINTs with the indicated DAD type. 

Edit - Select one or more DAD type from the settings list.  Use the All button 

to select all DAD types in the settings list.  Use the Clear button to clear all 

selections from the DAD types in the settings list. 

Enable / Disable 

This attribute is located under POINT / General. 

Filters for all POINTs enabled or disabled for download. 

Edit – Select Enable or Disable. 
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Filter Keys 

This attribute is located under POINT / General. 

Filters for all POINTs with the indicated filter key(s). 

Edit - Select one or more filter key from the settings list.  Use the All button to 

select all filter keys in the settings list.  Use the Clear button to clear all 

selections from the filter keys in the settings list.  Select Include All Selected 

to include POINTs matching all filter key selections.  Select Include Any 

Selected to include POINTs matching at least one filter key selection. 

Frequency Sets 

This attribute is located under POINT / General. 

Filters for all POINTs with the selected shared frequency set. 

Edit – Select one or more shared frequency set from the settings list.  Use the 

All button to select all shared frequency sets in the settings list.  Use the Clear 

button to clear all selections from the shared frequency sets in the settings list. 

POINT Description 

This attribute is located under POINT / General. 

Filters for all POINTs with the indicated description. 

Edit – Enter POINT description in POINT Description field. 

POINT Name 

This attribute is located under POINT / General. 

Filters for all POINTs with the indicated name. 

Edit – Enter POINT name in POINT Name field. 

 Wildcard characters are available for use. 

Sensor Type 

This attribute is located under POINT / General. 

Filters for all POINTs with the indicated sensor type. 

Edit - Select one or more sensor type from the settings list. 

Evaluation Time 

This attribute is located under POINT / Derived. 

Filters for all derived POINTs with the indicated evaluation time. 

Edit – Enter the evaluation Units, and Minimum and Maximum values in the 

appropriate fields. 
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Expression 

This attribute is located under POINTs / Derived. 

Filters for all POINTs with the selected shared expression. 

Edit – Select one or more expressions from the settings list.  Use the All 

button to select all expressions in the settings list.  Use the Clear button to 

clear all selections from the settings list. 

Active State 

This attribute is located under POINT / Online. 

Filters for all POINTs matching the indicated Active State setting (High or 

Low) (as configured in POINT Properties / Setup for Logic POINTs).   

Edit – Select the Active State setting, High or Low. 

Autorange 

This attribute is located under POINT / Online. 

Filters for all POINTs matching the indicated Autorange setting (On or Off) (as 

configured in POINT Properties / Setup). 

Edit – Select the Autorange setting: On or Off. 

Channel Number 

This attribute is located under POINT / Online. 

Filters for all POINTs matching the indicated minimum and maximum Channel 

Number entries. 

Edit – Enter the Minimum and Maximum channel number values. 

Control POINT 

This attribute is located under POINT / Online. 

Filters for all POINTs matching the indicated Control POINT selection. 

Edit – Select the appropriate Control POINT from the displayed hierarchy. 

Device 

This attribute is located under POINT / Online. 

Filters for all POINTs matching the indicated Device type (as configured in 

POINT Properties / Setup). 

Edit – Select one or more device type from settings list.  Use the All button to 

select all device types units in the settings list.  Use the Clear button to clear all 

selections from the device types in the settings list. 
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Downloaded POINTs 

This attribute is located under POINT / Online. 

Filters for all POINTs that have been downloaded to the selected device. 

Edit – Select one or more devices from settings list.  Use the All button to 

select all devices in the settings list.  Use the Clear button to clear all selections 

from the devices in the settings list. 

Gain 

This attribute is located under POINT / Online. 

Filters for all POINTs matching the indicated Gain value (as configured in 

POINT Properties / Setup). 

Edit – Select the Gain value: 1 or 10. 

Sensor Settings 

This attribute is located under POINT / Online. 

Filters for all POINTs matching the indicated Sensor Settings (as configured in 

Customize / Online Settings / Sensor Setup). 

Edit – Select one or more sensor setting definitions from settings list.  Use the 

All button to select all sensor setting definitions in the settings list.  Use the 

Clear button to clear all selections from the sensor setting definitions in the 

settings list. 

Tacho Number 

This attribute is located under POINT / Online. 

Filters for all POINTs matching the indicated Tacho number (as configured in 

POINT Properties / Setup). 

Edit – Select one or more tacho number from settings list.  Use the All button 

to select all tacho numbers in the settings list.  Use the Clear button to clear all 

selections from the tacho numbers in the settings list. 

Tacho Enable 

This attribute is located under POINT / Online. 

Filters for all POINTs matching the indicated Tacho enable setting (Enable or 

Disable) as configured in POINT Properties / Setup). 

Edit – Select the Enable Tacho setting; Enable or Disable. 
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DAD Schedule 

This attribute is located under POINT / Schedule. 

Filters for all POINTs with the indicated Take data every setting (as configured 

in POINT Properties / Schedule). 

Edit – Select units from the drop down list.  Enter minimum and maximum 

number of selected units.   

 Units are automatically evaluated for compatibility.  For example, 

an entry of 24 hours will include a POINT with a DAD schedule set 

to 1 day. 

Keep Current Data 

This attribute is located under POINT / Schedule. 

Filters for all POINTs matching the indicated Keep Current Data units (as 

configured in POINT Properties / Schedule). 

Edit - Select units from the drop down list.  Enter minimum and maximum 

number of selected units.   

Keep Unscheduled Data 

This attribute is located under POINT  / Schedule. 

Filters for all POINTs matching indicated Keep Unscheduled Data units (as 

configured in POINT Properties / Schedule). 

Edit – Select units from the drop down list.  Enter minimum and maximum 

number of selected units. 

Long Term Archive Keep Data 

This attribute is located under POINT  / Schedule. 

Filters for all POINTs matching the indicated Long Term Archive Keep Data 

units (as configured in POINT Properties / Schedule). 

Edit – Select units from the drop down list.  Enter minimum and maximum 

number of selected units. 

Long Term Archive Take Data 

This attribute is located under POINT / Schedule. 

Filters for all POINTs matching the indicated Long Term Archive Take Data 

units (as configured in POINT Properties / Schedule). 

Edit – Select units from the drop down list.  Enter minimum and maximum 

number of selected units. 
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Short Term Archive Keep Data 

This attribute is located under POINT / Schedule. 

Filters for all POINTs matching the indicated Short Term Archive Keep Data 

units (as configured in POINT Properties / Schedule). 

Edit – Select units from the drop down list.  Enter minimum and maximum 

number of selected units. 

Short Term Archive Take Data 

This attribute is located under POINT / Schedule. 

Filters for all POINTs matching the indicated Short Term Archive Take Data 

units (as configured in POINT Properties / Schedule). 

Edit – Select units from the drop down list.  Enter minimum and maximum 

number of selected units. 

Autocapture 

This attribute is located under POINT / Setup. 

Filters for POINTs matching the indicated autocapture setting. 

Edit – Select the autocapture setting from the settings list.  Use the All button 

to select all autocapture settings in the settings list.  Use the Clear button to 

clear all selections from the autocapture setting in the settings list. 

Averages 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the specified number of averages (as configured in 

POINT Properties). 

Edit – Enter minimum and maximum number of averages in edit fields. 

Averaging 

This attribute is located under POINT / Setup. 

Filters for all POINTs matching the indicated Averaging Type (Average, Off, 

Peak Hold, or Synchronous Time)  

Edit – Select one or more average types from the settings list.  Use the All 

button to select all average types in the settings list.  Use the Clear button to 

clear all selections from the average types list. 

Detection 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the specified detection setting. 

Edit - Select detection setting from the settings list.  Use the All button to 

select all detection settings in the settings list.  Use the Clear button to clear all 

selections from the detection setting in the settings list. 
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FFT Frequency 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the indicated frequency settings. 

Edit – Specify Fixed span or Order track.  Enter the minimum / maximum 

start (freq or orders) and the minimum / maximum end (freq or orders). 

 Enter Minimum and maximum values in frequency or orders, as 

indicated in Freq. Type selection. 

Full Scale 

This attribute is located under POINT / Setup. 

Filters for all POINTs whose Full Scale setting falls within the indicated full 

scale value range.  

Edit – Select unit types from the settings list.  Use the All button to select all 

unit types in the settings list.  Use the Clear button to clear all selections from 

the settings list.  

Full Scale Units 

This attribute is located under POINT / Setup. 

Filters for all POINTs matching the indicated Full Scale Units type.  

Edit – Select full scale unit types from the settings list.  Use the All button to 

select all full scale unit types in the settings list.  Use the Clear button to clear 

all selections from the full scale units settings list. 

Input Filter Range 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the indicated input filer range settings. 

Edit – Select input filter range(s) from the settings list.  Use the All button to 

select all input filter ranges in the settings list.  Use the Clear button to clear all 

selections from the settings list. 

Input mV / EU 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the indicated mV / EU settings. 

Edit – Enter minimum and maximum mV / EU values in edit fields. 

Lines 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the indicated lines setting. 

Edit – Select line(s) from the settings list.  Use the All button to select all lines 

in the settings list.  Use the Clear button to clear all selections from the 

settings list. 
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Linear Factor 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the indicated linear factor value (as indicated in 

POINT Properties / Setup). 

Edit – Enter the minimum and maximum linear factor values. 

Linear Speed Units 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the indicated linear speed units (as configured in 

POINT Properties / Setup). 

Edit – Select one or more linear speed units type from the settings list.  Use 

the All button to select all liner speed units in the settings list.  Use the Clear 

button to clear all selections from the linear speed units settings list. 

Location 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the indicated location setting. 

Edit – Select location(s) from the settings list.  Use the All button to select all 

locations in the settings list.  Use the Clear button to clear all selections from 

the settings list. 

Low Frequency Cutoff 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the indicated low frequency cutoff. 

Edit – Enter minimum and maximum frequency values in edit fields. 

 Units display in either CPM or Hz, based on frequency units 

preference setting (Preferences / General). 

Orientation 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the indicated orientation. 

Edit – Select orientation(s) from the settings list.  Use the All button to select 

all orientations in the settings list.  Use the Clear button to clear all selections 

from the settings list. 

Pulses / Rev 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the indicated minimum and maximum pulses / rev 

setting (as configured in POINT Properties / Setup). 

Edit – Enter Minimum and Maximum pulses / rev values. 
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Save Data 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the indicated save data setting. 

Edit - Select save data setting from the settings list.  Use the All button to 

select all save data settings in the settings list.  Use the Clear button to clear all 

selections from the settings list. 

Speed 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the indicated speed settings. 

Edit – Enter minimum and maximum speed values in edit fields. 

Speed Ratio 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the indicated speed ratio. 

Edit – Enter minimum and maximum speed ratio values in edit fields. 

Window 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the indicated window setting. 

Edit - Select window setting(s) from the settings list.  Use the All button to 

select all window settings in the settings list.  Use the Clear button to clear all 

selections from the settings list. 

Zero Offset 

This attribute is located under POINT / Setup. 

Filters for all POINTs with the indicated zero offset. 

Edit – Enter the minimum and maximum zero offset values in edit fields. 

Clear Alarm Non Collection  

This attribute is located under POINT / General.  

Filters for all POINTs with Clear Alarms for Non-collection last 

measurements enabled or disabled. 

Edit – Select Enable or Disable. 

Exclude Non-Collection From Report 

This attribute is located under POINT / General.  

Filters for all POINTs with Exclude from reports if last measurement is a 

Non-collection event enabled or disabled. 

Edit – Select Enable or Disable. 
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Customize / Derived POINTs 

The Derived POINTs screen allows you to customize shared expressions, create new 

expressions, and to edit variables, constants, and the expression formula. 

 

Figure 3 - 104. 

The Customize Menu’s Derived POINTs Screen’s Expressions Tab. 

To customize a shared expression: 

 Select the expression you wish to edit from the Expressions drop down list. 

Important - Any changes made to a shared expression affect all other POINTs 

sharing that expression, and overwrites the currently selected expression 

 You may rename the shared expression in the Name entry box.  

 Click the Variables button to edit, add, or remove variables.   
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 You cannot assign POINTs to the variables from the Customize / 

Derived POINTs screen.  Refer to the POINT Properties / 

Expressions tab section earlier in this chapter for details on 

assigning POINTs to variables. 

 

Figure 3 - 105. 

The Variables Dialog. 

 Edit the expression formula by inserting variables, constants, or formulas.   

 To add a new expression, click the Add button, and enter settings 

as previously described in this chapter’s POINT Properties / 

Expression Tab section. 

To edit constants: 

There are two ways to edit shared constants.  You can edit constants using the 

Expressions tab's Constants button, or by using the Constants tab.  Both methods are 

described below. 

 From the Expressions tab, click the Constants button to add a new constant to the 

Constants list.  In the Constants dialog, click the Add button. 

Or 

 Click the Constants tab to add or remove a constant, or to edit pre-existing 

constants. 

 Click the Add button to create a new constant, or select a constant from the 

Constants list and edit the Name and Value in the Constant properties area.   

 Click the Remove button to remove the selected constant from the Constants list. 
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Figure 3 - 106. 

The Customize menu’s Derived POINTs Constants Tab. 

Important – After editing a derived POINT, you must manually calculate the derived 

POINT to update the POINT’s existing data records.  Reference the Calculating 

Derived POINTs section earlier in this chapter for details. 
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Canary Lab Settings 

For Canary Lab customers, use the Canary Lab Settings to define historian data sets to 

be available when setting up Canary Labs POINT properties. 

 The IPMS data set comes preloaded; if you do not recognize this 

data set, you can safely remove it. 

To add a new Canary Lab data set: 

 Select the Customize menu’s Canary Lab Settings option.  The Data Set Settings 

dialog displays. 

 

Figure 3 - 107. 

The Data Set Settings Dialog. 

 Enter the name of the data set in the Data Set field and click Add.  The new data 

set will display in the Data Sets section, along with any other available data sets. 

 When finished adding the data sets, click Close. 

To remove a data set: 

 From the Data Set Settings dialog, click the data set to remove from the Data 

Sets section and click Remove.  The selected data set will no longer be available. 

 When finished removing the data sets, click Close. 
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Data Collection ROUTEs and Other Data Transfer 

Operations 

Overview 

After establishing your hierarchy's POINTs, you are ready to create your collection 

ROUTEs. 

 It is not imperative that you create @ptitude Analyst ROUTEs to 

download POINTs to the data acquisition device.  Downloading 

directly from a plant hierarchy list is discussed later in this 

chapter. 

A ROUTE is a measurement POINT collection sequence.  ROUTEs are downloaded to a 

DAD to provide orderly collection of measurement data on a timely basis. 

ROUTEs are first created on paper.  You simply walk through your facility and list (in a 

logical, efficient collection sequence) the equipment and pre-defined POINTs you plan to 

collect at a given time.  For example, list the measurements you plan to perform weekly 

(e.g., every Tuesday) as “Tuesday's ROUTE”, and/or list the measurements you plan to 

perform monthly as the “monthly ROUTE.” 

Take time to organize your collection ROUTE paper copy thoroughly.  A complete and 

organized paper copy collection ROUTE makes building @ptitude Analyst ROUTEs much 

easier. 

After establishing your paper copy ROUTE(s), your next task is to use your paper copy 

ROUTE to create a @ptitude Analyst ROUTE. 

How to Build ROUTEs 

 This section is not applicable to DMx systems. 

@ptitude Analyst's method for creating ROUTEs is simple. 

Using your paper copy ROUTE, open the Hierarchy, ROUTE, or Workspace window for 

those measurement POINTs you wish to have in the ROUTE, and copy selected items 

(machines with their POINTs, SETs with their machines and POINTs, Custom Groups 

with their machines and POINTs, or the entire hierarchy) from the open Hierarchy 

window to the new ROUTE window, creating the new ROUTE's hierarchy list. 

You may also insert (Insert menu) Groups directly into a ROUTE window, then select 

POINTs from a Hierarchy, ROUTE, or Workspace window, and copy them to your new 

ROUTE, organized beneath your newly inserted Groups. 

If necessary, move hierarchy items in the ROUTE window to match the most efficient 

collection sequence (detailed on your paper copy ROUTE). 
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 IMPORTANT - In a ROUTE window, changes to a POINT’s 

placement in the list, and POINT deletions do not affect the 

Hierarchy window.  However, changes to individual POINT setup 

settings (POINT Properties) do apply to the hierarchy and reflect 

in Hierarchy window. 

 

Changes to Group item Properties do not affect the Hierarchy 

window. 

To open an existing ROUTE: 

 Select the View menu’s ROUTE command.  The ROUTE screen displays. 

 Select an existing ROUTE and click the Open button.  The selected ROUTE window 

opens. 

To add a new ROUTE: 

 Click the ROUTE screen’s Add button.  The ROUTE Properties screen displays. 

ROUTE Properties / General 

 

Figure 4 - 1. 

The ROUTE Properties Screen’s General Tab. 

ROUTE Properties screen’s General tab’s fields include: 

Name – Enter a new ROUTE name. 

Description – Enter a new description. 
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The ROUTE Statistics area allows you to make your ROUTE a structured ROUTE, and 

determine the type of historical information to keep.  If historical record settings are 

entered, then ROUTE statistics, such as collection time duration, start and stop times, 

and operator ID, are recorded with the ROUTE.  If the ROUTE is designated as a 

structured ROUTE, then data must be collected in the order in which the POINTs are 

listed in the ROUTE. 

To create a structured ROUTE: 

 Click the Structured ROUTE checkbox to designate the selected ROUTE as a 

structured ROUTE. 

To enter ROUTE statistic settings: 

 Click an option button to specify the amount of historical records to keep.  Included 

in each historical record are the ROUTE’s collection time duration, start and stop 

times, and Operator ID.  Options include: 

Keep all historical records – Saves all historical ROUTE collection statistics for 

the selected ROUTE. 

Keep fixed number of historical records – Enter the number of historical 

records to save for the selected ROUTE. 

Keep records for – Enter a time duration value for storing historical records.  

For example, enter 6 in the text box and select weeks from the drop down list 

to save historical records for 6 weeks.   

The number of POINTs included in the selected ROUTE display at the bottom of the 

screen. 

 The ROUTE Properties Schedule tab is not applicable to ROUTEs 

for online data. 

ROUTE Properties / Notes 

ROUTE Properties / Notes fields include: 

ROUTE instruction notes – Allows you to create, edit, and store instructions / 

notes relating to the ROUTE.  ROUTE instructions are downloaded to the data 

acquisition device along with the ROUTE, and may be viewed on the DAD’s LCD 

panel. 

 Enter appropriate ROUTE properties and click OK.  The new ROUTE’s window 

displays. 

 Use drag and drop or copy and paste operations to copy selected Groups and 

POINTs, from the Hierarchy or Workspace windows into the new ROUTE's window 

to create the new ROUTE's hierarchy list. 
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Figure 4 - 2. 

The ROUTE Window With Copied Items. 

To remove an unnecessary ROUTE: 

 In the ROUTE window, select the ROUTE name. 

 Click the Remove button.  Confirm action when prompted.  The selected ROUTE is 

removed. 

To set the same measurement speed for multiple FFT measurements: 

 Starting from a ROUTE, expand the appropriate machine. Beneath the machine in 

the hierarchy, right-click on the measurement POINT you wish to use as a 

reference and select Set Speed (Multiple) from the resulting context menu. 

OR 

 Starting from a ROUTE, expand the appropriate machine. Beneath the machine in 

the hierarchy, click on the appropriate measurement POINT to display its 

measurements in the right panel. Then, right-click on the single measurement you 

wish to use as a reference and select Set Speed (Multiple) from the resulting 

context menu. 

The Set Speed (Multiple) window appears. 

Downloading ROUTEs to the On-line Device  

 WMx devices automatically transfer data for WMx devices / 

channels with assigned POINTs when the WMx Service is running. 

On-line System Transfer Overview 

The On-line transfer function allows you to download measurement POINT setups to 

the IMx, check the IMx status, and configure, clear, or reset the IMx. 
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After configuring your IMx POINTs, and configuring your system's preferences, use 

“Download” options in the Transfer menu’s On-line dialog to download the new 

POINTs to your On-line network.   

 A maximum of 80 IMx POINTs can be downloaded. 

 In @ptitude Analyst, select Online from the Transfer menu.  The Online Transfer 

screen displays.   

On-line Transfer Download Tab 

 The Online Transfer screen’s Download tab allows you to 

download an individual hierarchy item, or an entire ROUTE or 

workspace.   

 

Figure 4 - 3. 

The Download Tab. 

 Click to select a single hierarchy item or a ROUTE or workspace for download from 

the appropriate Hierarchy, ROUTE, or Workspace list. 

ROUTEs are organized into three categories; By Name, By Due Date, and By 

Downloaded Date.  ROUTEs that are overdue appear in bold type. 
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 A ROUTE is downloaded only once, even if it is selected in more 

than one organizational category. 

 Only complete ROUTEs and Workspaces may be downloaded.  To 

download individual POINTs, select them from the Hierarchy list. 

Clear all devices – Click to enable.  When enabled, all devices will be cleared when the 

download is initiated. 

Collect data as soon as download completes and then as scheduled – Click to 

enable. 

Check Size – Click to check the download size of the selected item(s).  The Check 

Download Size window displays.  Download size details include the selected device’s 

available memory, total memory used, and status.  The POINT details area displays the 

memory used by each POINT in the selected ROUTE or Workspace.  Click Save As to 

save the displayed information to a comma separated text file. 

 

Figure 4 - 4. 

The Check Download Size window. 

Download – Click to download the selected item(s) to the selected device.  A dialog 

appears indicating whether or not the download request was successfully sent. 

 Download progress can be viewed through the Status progress 

bar. 
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Status 

The Online Transfer’s Status tab allows you to view a selected device’s status 

information.  

 

Figure 4 - 5. 

The Status Tab. 

To determine the device status: 

 Select the appropriate device from the Device drop down list. 

 Click the Get Status button.  The selected device’s status appears in the Channel 

status and Device status information areas. 

 Click the Prev. device or Next device buttons to navigate the Device drop down list 

and to get status. 

The Channel status area displays up to 32 numbered boxes, each representing a 

channel on the IMx.  A blue indicator through the channel number represents a sensor 

problem for the indicated channel.  Green indicates there are no problems. 

 Channel status is applicable only for channels set up for BOV 

Gating. 
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The Device status information area displays the following information: 

Collection status – Indicates whether collection for the IMx is enabled or disabled. 

DAD status - Indicates the channel number and tachometer being used.   

DAD address - The physical DAD number as per the switches on the box itself.  

ROUTE/Workspace / Hierarchy source - Name of the ROUTE or Workspace that was 

downloaded to the DAD.   

 Items deleted from the ROUTE or Workspace are not deleted 

from the DAD.   

Data Source - Name of the current database. 

IMx Version – The hardware version number.  If the selected device is an IMx, this 

option appears as “IMx Version.”   

Firmware Version – The on-line device’s firmware version number.  Useful for 

servicing and product update information. 

Time - The on-line device’s clock's date and time settings. 

Number of POINTs - Displays the number of POINTs downloaded to the on-line device. 

Temperature - The on-line device’s temperature, recorded in both degrees Fahrenheit 

and centigrade. 

Free RAM - The amount of free RAM in the on-line device. 

Selection Mode - Either On-line or Local.  “Local” displays when the DAD is being 

accessed with a data collection device from its front panel BNC connectors.  While in the 

Local mode, no on-line data collection occurs. 

Power Up - Displays a numeric code indicating power up status. 

DAD State – Displays the on-line device’s activity status.   

Digital Error - Displays the on-line device’s RAM status.  “No” indicates no RAM 

problems.  “Yes” indicates RAM problems. 

Force Connection to IMx  

If an IMx’s Always Connected option has been disabled on the Customize menu’s 

Online Settings screen, you can force a connection to the device if necessary.   

To force a connection to an IMx: 

 Select the IMx device to which you wish to connect from the Device drop-down list. 

 Make sure the IMx Status value is “connected” in the Device status information 

area. 

 Click the Connect button.  The Force Connection dialog displays.   

 Enter the amount of time to stay connected to the IMx and click OK. 



 Data Collection ROUTEs and Other Data Transfer Operations 

 Downloading ROUTEs to the On-line Device 

SKF @ptitude Analyst and SKF Multilog On-line Systems 4 - 9 

User Manual 

On-line Transfer Settings 

The Transfer menu’s Online Tranfer screen allows you to configure your processing 

delay settings. 

 Select Transfer / Online and then the Settings tab. 

 

Figure 4 - 6. 

The Settings Tab. 

 Select the appropriate host orserver from the Configure Host drop down list. 

 Use the arrows to adjust the processing delay time for the following operations: 

Device synchronization 

Unscheduled data 

Scheduled data 

Live data 

 Click the Activity button to view an activity log of the interaction between the 

@ptitude Analyst and the on-line device network. 

The Device Activity dialog displays activity between the current hardware device and 

@ptitude Analyst. 

Save As – Click to save Device Activity window contents to a specified location. 
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Clear – Click to clear the Device Activity window contents. 

Stop – Click to stop the Device Activity window from displaying the interaction between 

the @ptitude Analyst and the WMx / IMx network. 

Close – Click to close the Device Activity window. 

Automatic Data Retrieval  

Once the @ptitude Analyst hierarchy has been transferred to online devices, @ptitude 

IMx Services automatically begins data collection for IMx POINTs and @ptitude Analyst 

Monitor automatically begins data collection on all other POINTs according to the 

schedule specified in POINT Properties.  (Refer to the SKF @ptitude Analyst 

Introduction and Global Features manual’s SKF @ptitude Analyst Monitor 

Application section for more information on Monitor.)  The status bar at the bottom of 

the @ptitude Analyst screen provides color-coded status information. 

 

 

Figure 4 - 7. 

Data Collection Status. 

 WMX Service ID 

 IMx Service ID 

 alarm status  

 name of the PC running Monitor 

 If you are collecting data for the DMx, two Monitor status 

indicators appear, one for the DMx, and one for all other devices.  

Refer to Chapter 7, Multilog DMx Machine Monitoring Module 

for details on the DMx Monitor status indicator.   
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 If you are collecting data for the IMx, a Service status indicator 

appears.  Refer to Chapter 1, Introduction to SKF @ptitude 

Analyst for SKF Multilog On-line Systems for details on IMx 

Service. 

 Multiple WMx services running on separate servers and 

connecting to one Analyst client (a single database) now show 

separate status bar indicators for each service. 

The status indicator has three informational areas: 

ID – Displays the machine name of the Monitor program or IMx Service that is in use.  If 

one of the POINTs being monitored has an alert level alarm, this flashes yellow.  If a 

POINT has a danger level alarm, this flashes red.  If there is a system error, for 

example, a device not communicating, this flashes blue.  The alarm flashes until it is 

reset. 

 If multiple conditions exist, a system error takes precedence, 

followed by a danger alarm.  This only flashes yellow if there are 

no other issues. 

System status – The diamond on the status line provides information concerning 

communication with the devices.  If there is an issue with any device, this changes color 

to blue.  Green indicates all devices are communicating properly. 

Alarm status – The circle on the status line provides information concerning the 

danger and alert alarm levels of the POINTs being monitored.  If any POINTs are in 

alert, the circle appears yellow.  If any POINTs are in danger, the circle appears red.  If 

there are no alarms on any POINTs, the circle appears green. 

 If there are both danger and alert level alarms active, the circle 

appears red. 

A right click menu on the status provides access to additional functionality. 

Options may include: 

Reset – opens a sub- menu that provides options to clear status alerts. 

Alarm Indicator – Clears danger and alert alarm status. 

Digital Outputs – When an alarm condition is met, digital output conditions 

trigger.   This includes enabling a light on the online device, as well as 

triggering any additional signals (e.g., ringing a bell) that have been connected 

to the device’s output channels.  This option turns off the lights and any other 

output signals. 

System Indicator – If an issue with any devices communicating with Monitor is 

detected, the status line flashes blue.  This option clears the alert. 

All – Clears all alerts. 

Digital Output – Opens the Digital Output dialog.  (The settings on this dialog are also 

available in POINT Properties and the Online Transfer screen, documented earlier in 

this manual.  Refer to the appropriate sections above for details.) 

Hardware Activity – Opens the Hardware Activity dialog, which provides an activity log 

of the interaction between the @ptitude Analyst and the on-line device network.  (This 
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dialog is also available from the Online Transfer screen’s Settings tab.  Refer to Online 

Transfer Settings earlier in this chapter for details.) 

Settings – Opens the Settings dialog, which allows you to configure your processing 

delay settings.  (These settings are also available on the Online Transfer screen’s 

Settings tab.  Refer to Online Transfer Settings earlier in this chapter for details.) 

Status – Opens the Status dialog, which allows you to view a selected device’s status 

information.  (These settings are also available on the Online Transfer screen’s Status 

tab.  Refer to the Status section earlier in this chapter for details.) 

System Information – Opens the System Information dialog, which provides access to 

the Event Log and the Online Data log.  (Refer to the SKF @ptitude Analyst 

Introduction and Global Features manual for details.) 

Manual Data Entry 

Use the Insert menu's Manual Entry option to manually enter overall measurement 

values into your @ptitude Analyst hierarchy.  This feature allows you to store, trend, 

and analyze measurements made with the SKF Pens (VibPen Plus, SEE Pen, and 

ThermoPen).  Also, other machinery operating conditions such as flow, speed, and 

pressure can be manually entered and trended.  The Manual Entry window allows you 

to manually type in one overall value per POINT. 

 

Figure 4 - 8. 

The Manual Entry Window. 
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To manually enter data: 

 Select a POINT from the Items area.  

 Type in the value in the Measurement data field(s). 

 The Measurement data section varies depending on the type of 

POINT that is selected. 

 Click the Set button. 

 By default, the current date / time is applied to the entered POINT 

value.  Select desired date and time from the drop down menus 

to edit these fields as needed. 

 To quickly enter multiple values that all use the default Date / 

Time, simply click the Measurement data field, type the value 

and press Enter.  The value is stored and the pointer moves to 

the next item’s Measurement data field. 

To clear entered data: 

 Select a measurement with a set value and click the Clear button. 

 Click OK to store the specified values and automatically re-process alarms, or 

Cancel to undo settings. 
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Displaying Graphic Plots 

Overview 

@ptitude Analyst allows you to display your collected measurements in various plot 

formats for machinery analysis purposes. 

Graphic On-line Systems plot formats include: 

 Trend 

 Spectrum 

 Trend / Spectrum 

 Time 

 Trend / Time 

 Trend / Spectrum / Time 

 Spectrum Waterfall 

 Polar Vector 

 Mag / Phase Trend 

 Band Trend 

 Extracted Trend 

 Extracted Band 

 Variable Speed 

 Orbit 

 Shaft Centerline 

 Nyquist 

 Bode 

 Cascade 

 Topology 

 Contribution /Profile  

 HAL Trend 

 Orbit and Shaft Centerline plots are available for the DMx, IMx, 

and WMx.   

 Nyquist, Bode, Cascade, and Topology plots primarily apply to 

transient data.  They are documented Chapter 8, Transient Data 

Analysis. 
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How To Display Graphic Plots 

@ptitude Analyst offers multiple methods for displaying measurement data in plot 

format.  Each method has its advantages.  However, regardless of the selected method, 

the first step in displaying plots is to open any view that contains POINTs (Hierarchy, 

ROUTE, Workspace, Plot, and Alarms view).  The second step is to select the 

measurement POINT(s) whose data you wish to display in plot form.   

Then use one of the following methods for displaying measurement data in graphic plot 

format. 

 The File menu's Print option may be used at any time to print the 

contents of the “active” window (including graphic display 

windows). 

Displaying Plots Using Toolbar Buttons 

@ptitude Analyst has toolbar buttons for commonly used plots. 

 

Figure 5 - 1. 

Plot Toolbar Buttons (Shown Here as Two Columns). 

 To select multiple POINTs for display in a single plot, you must 

first select the machine in which the POINTs list in the hierarchy’s 

left panel, then select the desired multiple POINTs in the 

hierarchy’s right panel. 
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 To select POINTs from multiple machines, you must first copy the 

desired POINTs to a Workspace window. 

To display graphic plots using the toolbar: 

 Select (highlight) the POINT(s) you wish to display in the Hierarchy, ROUTE, 

Workspace, or Alarms windows. 

 Click one of the toolbar's graphic display buttons to display the selected POINTs or 

measurement(s) in a specific type of plot. 

Click the All Plots toolbar button to display the All Plots dialog.  From this dialog, you 

may select the plot type to display from all available plots, rather than only the 

commonly used plot types represented with toolbar buttons. 

 Different plot display toolbar buttons may be manually added or 

removed using the Customize menu’s Toolbars option.  Custom 

toolbars are detailed in Appendix A, SKF @ptitude Analyst 

Toolbars. 

Displaying Plots Using the View Menu 

View menu graphic display operations are similar to toolbar button graphic display 

operations. The View menu allows you to display every graphic plot type that applies to 

the selected POINT(s).   
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Figure 5 - 2. 

The View Menu’s Plot Option. 

To display graphic plots using the View menu: 

 Highlight the POINT(s) you wish to display in the Hierarchy, ROUTE, Workspace, or 

Alarms windows. 

 Select the View menu’s Plot option.  Select one of the visible plot types, or select 

All Plots for more selections.  All plot types display in the dialog.   
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Displaying Plots Using the POINT’s Context Menu 

You can also display a plot directly from selected single or multiple POINTs using the 

context menu.   

To display a plot using the context menu: 

 Select POINT(s) from a Hierarchy, ROUTE, Workspace, or Alarm window. 

 Using your mouse, right click to activate the context menu. 

 

Figure 5 - 3. 

Hierarchy Context Menu’s Plot Option. 

 Select the desired Plot type.  The selected plot type displays in a plot window for 

the selected POINT(s). 

 You can also use the right-click context menu to display a plot 

directly from a selected single measurement data record or 

multiple measurement data records. 
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Plot Window 

Plot window displays collected measurements in various graphic plot formats for 

machinery analysis purposes.  

 

 

 

 

Figure 5 - 4. 

Plot Window. 

 cursor feedback  various overlay tabs 

 mouse feedback  active overlay   

 inactive plot line  inactive overlays 

 active plot line  right-click context menu 

 running speed anchor   

Plot Window Overview 

The Plot window’s title bar displays the plot type displayed for the current POINT.  The 

Machine name (from the hierarchy) corresponding to the POINT displays in front of the 

POINT name (for a single POINT).  The Machine and POINT name display in the plot 

window’s top center area for all plots.  The date / time stamp and overall value display 

for spectrum and time plots.  Multiple POINTs are not individually identified. 

There are two areas in the Plot window.  The top area is the plot area.  The lower part 

is the information area. 

 You may re-size the entire Plot window, and/or either of the 

window's areas, for customized viewing.  You may also hide the 

information area automatically (using Preferences) or manually 

(using the toolbar or context menu). 

 The status of the information area affects plot print-out.  If a plot 

is printed when the Info tab is displayed, the Info tab’s 

information prints along with the plot.  If a plot is printed when 
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the Info tab is hidden, the Info tab’s information does not print 

with the plot. 

Plot Window Information Area  

 

Figure 5 - 5. 

The information area’s tabs display various plot information for the active plot.   

 Use the “I” key to toggle the information area on and off. 

Info tab – Displays general information for the active plot.  

Summary tab – Displays measurement summary information for all POINTs displayed 

on the plot.   

Plot type tab (Trend, Spectrum, etc.) – Displays information for each single cursor on 

the active plot.   

Other tabs appear in the information area depending on the type(s) of overlay(s) used 

on the current plot, and display information specific to each overlay type. 

Plot Feedback Areas 

 

 feedback areas 

Figure 5 - 6. 

Plot Feedback Areas. 

The first line displays information corresponding to the active cursor overlay’s current 

position. 

The second line displays information corresponding to the mouse pointer’s current 

position (when positioned over a plot item). 

Plot Window Operations 

Mouse Operations 

There are several ways to work within the Plot window.  The mouse can be used to 

display specific plot information.  The mouse’s pointer changes to an up arrow () when 
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placed over a plot item.  Typical plot items include overlay, plot line (trace), anchor, any 

object with feedback information, and context menus. 

Overlays 

Plot “overlays” superimpose cursors, alarms, text annotations, and frequency markers 

on displayed plots.  Each overlay displays an “anchor” which you use to manipulate the 

overlay. 

Anchors 

Anchors indicate overlays and plot lines on the active plot.  Anchors also identify the 

active status of an overlay and plot line (trace). 

The Active plot line anchor is indicated using a triangle icon.  Plot line anchors 

display on the plot’s left. 

The Active overlay anchor is indicated using a square icon.   Active overlay 

anchors indicate which plot’s data is displayed using the plot’s color in the 

overlay’s square icon.   

Inactive plot line and overlay anchors are indicated using circle icons. 

 Double-click an overlay’s anchor to switch it to another plot.   

Some overlay anchors appear at the top of the plot, others appear to the plot’s right.  

Band cursor, harmonic cursor, sideband cursor, and single cursor anchors display 

across the top of the plot, directly above their respective overlays.  Band alarm, 

envelope alarm, frequencies, curve fit, overall alarm, and peak cursor anchors display 

on the plot’s right.  The running speed anchor displays beneath the plot. 

Many anchors indicate overlay position in respect to the plot’s X and/or Y axis.  Anchors 

provide easy access to the plot item’s right-click context menu.  For example, to access 

the settings dialog for your frequencies overlay, right-click on the frequency overlay 

anchor to launch the frequencies Settings dialog. 

If two or more traces are displaying on a plot and an overlay is added to the plot, it 

automatically attaches itself to the active plot line (trace). 

Text annotations (temporary textual annotations) may be placed anywhere on the plot. 

Text annotations do not have anchors. 
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Figure 5 - 7. 

Plot Window with Text Annotation. 

Plot Line (Trace) Right-Click Context Menu 

Position the cursor over the plot line and using your mouse, right-click to access the 

plot line context menu.  Menu options include: 

Lock Trace – Enable this option to “lock” the selected plot line data so it will 

remain visible when auto linking is used.  This allows you to compare the 

“locked” plot line data to the new data that is added or removed when 

autolinking is used. 

Remove – Removes trace from plot. 

Properties – Displays POINT Properties screen for the plot’s active POINT. 

Go to Hierarchy – Displays the Hierarchy window with the selected hierarchy 

item highlighted for easy identification. 

Priority – Assign a priority level to the Machine the POINT is under. 

Plot Right-Click Context Menu 

Position the cursor over the plot background and using your mouse, right-click to 

access the plot context menu.  Menu options include: 

Plot Specific Options – Plot options display in the menu’s top area (if 

available), allowing you to configure the plot’s content.  Which options appear 

(if any) depends upon the current plot type.   

For example, you can convert the units in an acceleration, velocity, or 

displacement spectrum plot.  Unit types display in the menu’s top area and are 

available for selection. 

Settings – Launches the Settings dialog for the current plot type.  This dialog 

allows you to change the way the plot displays.  For example, use the Settings 

dialog to change axis ranges. 
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Reset Settings – Resets to default plot settings.  Use Reset Settings to clear 

all settings you made and reset the plot window based on its current content. 

Copy – Copies the plot image to the clipboard. 

Info Area – Show / Hide the current plot’s information area. 

 Square icons on a trend plot line indicate the measurement is 

included in calculations for mean and standard deviation (as in the 

Info tab) and statistical alarm generation.  Use the single cursor's 

context menu or Measurement Properties to change the 

“include” status. 

Overlay Anchor Right-Click Context Menu 

The Overlay anchor right-click context menu provides quick access to the overlay’s 

options (e.g. Remove the overlay, or if more than one trace is displayed, move the 

overlay to the Next Trace, etc.) 

Drag and Drop Operation 

Drag and drop operation allows you to easily display plots for different measurements.  

These measurements can belong to the same POINT, or to different POINTs.  By 

default, when the POINT is selected, the plot is displayed for the POINT’s last 

measurement.  The drag and drop feature allows you to override this default setting 

and display specific measurements on the plot. 

You can also drag and drop to view multiple POINTs on the same plot.  Simply drag the 

desired POINT(s) and/or measurement(s) into the open plot window. 

 Some plots combine multiple plot types in one window for side-

by-side comparison.  In most cases, you may only drag and drop 

into the primary plot (i.e., the top plot area). 

Multiple Measurements and Channels in Plots 

You may have multiple measurements from one or more POINTs represented in a plot, 

either by selecting them when opening the plot, or by dragging and dropping additional 

measurements onto an open plot.   

It is also possible to have multiple channels represented on a plot for multi-channel 

POINTs.  When you access a plot from a multi-channel POINT, the Plot Preferences 

Channel Number setting specifies whether all channels open automatically, only 

channel X opens, or the Select Channel Number dialog displays where you may select 

a single channel or All Channels.  

 If Auto Link is turned on, this setting is overridden and all 

channels display.  
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Figure 5 - 8. 

The Select Channel Number Dialog. 

If all channels open, each channel is treated as a separate measurement on the plot. 

Depending on your plot type, multiple measurements may overlay each other (e.g., 

spectrum and time plots) or may be represented as individual data points on the plot 

(e.g., waterfall and trend plots).  

A plot anchor is located on the left of the plot for each measurement.  Depending on the 

plot type, the anchors are color-coded to match the data.   

Inactive plot line and overlay anchors are indicated using circle icons. 

The Active plot line anchor is indicated using a triangle icon.   

In the case of plots that are designed to display multiple measurements (e.g., waterfall 

and trend plots), all measurements under the same POINT are included in one plot 

anchor.  Separate plot anchors only appear if you have multiple POINTs or channels 

represented in the plot.   

For combination plots (e.g., Trend / Spectrum), the channel anchors only toggle the 

channel on the top plot.  To toggle the channels on additional plots, click the single 

cursor overlay anchor. 

The active measurement determines the cursor feedback and information window's 

content and overlay settings.  You may toggle between the measurements by clicking on 

the appropriate anchor.   

Zoom Operation 

The zoom operation allows you to easily zoom in and out on the plots for a closer look.  

You may zoom in and out one of two ways: 

 Using the zoom buttons on the toolbar 

 Using the mouse scroll wheel 

To zoom in / out on a plot using the zoom buttons: 

 

Figure 5 - 9. 

Zoom Buttons. 

 activates zoom 

 zooms out 

 Activate the zoom by clicking the left magnifying glass.   

 Click and drag across the area of the plot to which you would like to zoom.   
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 Click the right magnifying glass to zoom out. 

To zoom in / out using the mouse scroll wheel: 

 Position your cursor over the area of the plot to which you would like to zoom. 

 While holding the Ctrl key, roll the mouse scroll wheel up or down.  Rolling up 

causes the plot to zoom in, while rolling down causes the plot to zoom out. 

Plot Navigation 

While viewing a plot, use the arrow keys on your keyboard to navigate to the next / 

previous measurement on the plot or to the next / previous POINT’s plot.   

To navigate to the next / previous measurement on the plot: 

 While holding the Ctrl key, press the left arrow to display the previous 

measurement, or press the right arrow to display the next measurement. 

To navigate to the next / previous POINT’s plot: 

 While holding the Ctrl key, press the up arrow to display the plot for the previous 

POINT, or press the down arrow to display the plot for the next POINT. 

Set Speed (Multiple) 

Use the Set Speed (Multiple) feature to set the same measurement speed for multiple 

FFT measurements. 

 Starting from an FFT measurement plot, right-click on the single cursor and select 

Set Speed (Multiple) from the resulting context menu.  

The Set Speed (Multiple) window appears. 

Plot Types 

Machinery measurements can be displayed in a variety of graphic display formats that 

aid machinery analysis.  Each graphic display type is detailed below. 

 This section does not document Orbit, Shaft Centerline, Nyquist, 

Bode, Cascade, or Topology plots.  Orbit and Shaft Centerline 

plots are only available for the DMx On-line System.  They are 

documented in Chapter 7, Multilog DMx Machine Monitoring 

Module.  Nyquist, Bode, Cascade, and Topology plots primarily 

apply to transient data.  They are documented Chapter 8, 

Transient Data Analysis. 

For each type of graphic display, @ptitude Analyst provides settings to manipulate the 

plot display and to gain valuable analysis information.  These settings dialogs are 

available from the @ptitude Analyst View menu and from the toolbar (which changes 

according to the active plot display type).  Each plot’s settings dialogs are also detailed 

below. 
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Trend Plot 

 

Figure 5 - 10. 

Example of a Trend Plot. 

Trend plots allow you to easily compare a POINT’s most recent reading against its 

previous readings and its alarm set up, allowing you to see how the POINT is “trending” 

over time.  Trend plots are an easy and accurate method of detecting gradual changes 

in process conditions and changes that might otherwise be overlooked. 

In addition to displaying trend plots for individual POINTs, you can display multiple 

POINTs' trends (from the same machine or from different machines) in one graphic 

display window.  This allows easy comparison between various POINTs' trends. 

In a trend plot, the X axis (horizontal axis) represents time and the Y axis (vertical axis) 

represents magnitude. 

 Square icons on a trend plot indicate the measurement is 

included in calculations.  Use the single cursor’s context menu or 

the Measurement Properties dialog to change the “include” 

status. 

Trend Settings 

To access the Trend Settings Dialog: 

With a trend plot displayed, select the View menu’s Plot / Settings option, use the 

settings toolbar button, or right-click to display the plot’s context menu and select the 

Settings option. 

Magnitude scale fields include: 

Autoscale - Enabling Autoscale automatically scales the initial amplitude axis so it is 

approximately 120% of the largest amplitude.  Disabling Autoscale displays the 

spectrum on the same full scale vertical axis used when it was recorded.  
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% Full Scale - When enabled, the amplitude axis displays as a % value of the POINT’s 

full scale value.  Use % Full Scale to compare measurements that do not have the same 

units or the same Full Scale value. 

 If you do not select Autoscale or % Full Scale, you must enter 

values to determine the plot’s magnitude scale (Y-axis scaling). 

Magnitude Scale - Enter the minimum and maximum magnitude scale values in the 

designated text boxes. 

Magnitude Lin / Log - Select Linear scaling to space out data equally.  Select 

Logarithmic scaling to emphasize lower values. 

Date / Time scale fields include: 

Date / Time Scale - Enter minimum and maximum date and time. 

 With a plot displayed, to reset all settings back to their defaults, 

click the right-click context menu’s “Reset Settings” option. 

Adjust date/time range to include latest notes – When enabled, all notes created 

after the date / time of the last collected measurement display on the plot.  Default is 

enabled.   

BOV or Gap Trend Plot 

 

Figure 5 - 11. 

Example of a BOV Trend Plot. 

For IMx POINTs that have channels with the Check sensor ok status option enabled, 

the BOV or Gap Trend plot option allows you to trend a sensor’s Bias Output Voltage 

value.  The BOV limit overlay (blue horizontal lines) indicate the specified BOV limits.  If 

a sensor’s BOV value exceeds its limits, it indicates a bad sensor, and a zero overall 

value is stored for its vibration measurements. 
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BOV or Gap Trend Settings 

With a trend plot displayed, select the View menu’s Plot / Settings option, use the 

settings toolbar button, or right-click to display the plot’s context menu and select the 

Settings option. 

Fields include: 

Autoscale - Enabling Autoscale automatically scales the initial amplitude axis so it is 

approximately 120% of the largest amplitude.   

BOV min / BOV max - Enter the minimum and maximum magnitude scale values in 

the designated text boxes. 

Date / Time scale fields include: 

Date / Time Scale - Enter minimum and maximum date and time. 

Spectrum Plot 

 

Figure 5 - 12. 

Example of a Spectrum Plot. 

As different types of machinery problems often occur at different frequencies, it is very 

useful to analyze measured vibration signals with respect to frequency. 

FFT spectrum plots (pl. spectra) display vibration amplitudes at various component 

frequencies. 

 FFT is the abbreviation for Fast Fourier Transform (the 

mathematical formula that transforms the vibration signal into its 

component frequencies). 
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In an FFT spectrum, the X axis (horizontal axis) represents vibration frequency in Hz or 

CPM (or orders of running speed).  The Y axis (vertical axis) represents vibration 

amplitude. 

FFT spectrum plots are extremely useful machinery analysis tools.  FFT spectra provide 

information that helps determine the location of a problem, the cause of the problem, 

and with trending, how long until the problem becomes critical. 

In addition to single display, you can display multiple POINTs’ or measurements’ FFT 

spectra (POINTs may be from the same machine or from different machines).  This 

allows easy comparison between various POINTs' FFT spectra. 

Spectrum Settings 

To access the Spectrum Settings dialog: 

With a spectrum plot displayed, select the View menu’s Plot / Settings option, or use 

the settings toolbar button. 

 The Settings dialog is also available from the spectrum plot’s 

context menu. 

View Type fields include: 

Combined / Stacked - Determine the plot orientation for multi-channel data.  Stacked 

displays each channel as a separate plot.  Combined shows a single plot overlaid with all 

channels.  

Link - If View Type is set to Stacked, determine whether cursors and overlays are 

linked across all plots, or operate independently.  If Link is enabled, cursors and 

overlays appear in the same position across all plots.  If Link is disabled, you may add 

and move cursors and overlays in each plot independently. 

Magnitude scale fields include: 

Autoscale - Enable to automatically scale the initial amplitude axis so it is approximately 

120% of the largest amplitude.  Disable to display the spectrum on the same full scale 

vertical axis used when it was recorded.  

% Full Scale - Enable to display the amplitude axis as a % value of the full scale.  Use % 

Full Scale to compare measurements that do not have the same units or the same Full 

Scale value. 

 If you do not select Autoscale or % Full Scale, you must enter 

values to determine the plot’s magnitude scale (Y-axis scaling).  

Magnitude Scale - Enter the minimum and maximum magnitude scale values in the 

designated text boxes. 

Magnitude Lin / Log - Select Linear scaling to space out data equally.  Select 

Logarithmic scaling to emphasize lower values. 

You must enter values to determine the plot’s frequency scale (X-axis scaling). 
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Frequency scale fields include: 

Frequency Scale - Enter the minimum and maximum frequency scale values in the 

designated text boxes. 

Frequency Lin / Log - Select Linear scaling to space out data equally.  Select 

Logarithmic scaling to emphasize lower values. 

 With a plot displayed, to reset all settings back to their defaults, 

click the right-click context menu’s Reset Settings option. 

Spectrum Plot – Multi Channel 

For two channel and Triax POINTs, you have the option to display spectrum plots in 

either a Stacked or Combined view, based on preferences.  

 To view multi-channel spectrums in Stacked view, set the Layout Orientation / 

Spectrum Plot Preference to Stacked. 

 

Figure 5 - 13. 

Example of a Stacked Spectrum Plot with Unlinked Cursors / Overlays. 

In Stacked mode, each channel displays in a separate panel.  Depending on your Stack 

Mode plot preference, cursors and overlays on the plot may either be linked or unlinked.   

If Link is selected, cursors and overlays appear in the same position across all plots.  

Where applicable, overlay tabs in the information area provide a separate column for 

each channel (for example, Amp X, Amp Y, and Amp Z). 
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If Unlink is selected, you may add and move cursors and overlays in each plot 

independently.  Where applicable, overlay tabs in the information area list overlay 

details for each channel on a separate line. 

 To view multi-channel spectrums in Combined view, set the Layout Orientation / 

Spectrum Plot Preference to Combined. 

 

Figure 5 - 14. 

Example of a Combined Spectrum Plot. 

 Inactive channels 

 Active channel 

Combined spectrum plots overlap the data from each channel.  The channel indicators 

on the side of the plot are color-coded to match the spectrum data.  The active 

spectrum is shown as a triangle.  Toggle between the channels by clicking on the 

appropriate indicator.  The active channel determines the cursor feedback and 

information window's content and overlay settings.  
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Trend / Spectrum Plot 

 

Figure 5 - 15. 

Example of a Trend / Spectrum Plot. 

Trend / Spectrum Plots display both a trend plot and a spectrum plot for a trend record 

indicated by the single cursor position.  

Each single cursor on the trend plot has a corresponding spectrum data line, if FFT data 

is available.  Removing the cursor from the trend also removes the associated spectrum 

data line. 

The active plot (trend or spectrum) determines the information window’s content and 

overlay settings.   

All other trend and spectrum operations behave as described previously in the trend 

and spectrum plot descriptions. 

 Right-click on either plot to access the appropriate context menu. 

 See Trend Settings and Spectrum Settings for display parameters 

that can be modified to change the plot display. 
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Time Plot 

 

Figure 5 - 16. 

Example of a Time Plot. 

Time Plots display a short time sample of a raw vibration signal with vibration 

amplitude plotted over the time scale.  Current time plots are compared to past time 

plots to analyze changes in vibration amplitude or frequency.  

Each plot line represents a time waveform measurement for a single POINT.  You may 

configure the X-axis to display time in seconds or milliseconds.   

Time Plot Settings 

To access the Time Plot Settings dialog: 

 With a time plot displayed, select the View menu’s Plot / Settings option, or use 

the settings toolbar button. 

 The Settings dialog is also available from the time plot’s right-

click context menu. 

Magnitude Scale fields include: 

Autoscale - Enabling autoscale automatically scales the initial amplitude axis so it is 

approximately 120% of the largest amplitude.  Disabling autoscale displays the 

spectrum on the same full scale vertical axis used when it was recorded.  

% Full Scale - When enabled, the amplitude axis displays as a % value of the full scale.  

Use % Full Scale to compare measurements that do not have the same units or the 

same Full Scale value. 
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 If you do not select Autoscale or % Full Scale, you must enter 

values to determine the plot’s magnitude scale (Y-axis scaling). 

Magnitude Scale - Enter the minimum and maximum magnitude scale values in the 

designated text boxes. 

Magnitude Lin / Log - Select Linear scaling to space out data equally.  Select 

Logarithmic scaling to emphasize lower values. 

You must enter values to determine the plot’s time scale (X-axis scaling) 

Time Scale - Enter the minimum and maximum time scale values in the designated 

text boxes.  Select Seconds or Milliseconds.   

Sound Byte 

@ptitude Analyst's Sound Byte utility allows you to listen to sound data waveform 

through your computer's speakers or connected earphones. 

To utilize Sound Byte: 

 Select a POINT with saved time data and display its time plot. 

 Click the Sound Byte toolbar button, or select the Plot menu's Play Sound Byte 

option.  The Sound Byte utility launches, providing various playback options. 

Sound Byte Controls 

Play Time – Controls the play back period length.  To change the setting, highlight the 

displayed play back length value and type in a new value, or use the arrows to increase 

or decrease play back length.  The maximum play time is 10 seconds. 

RPM Multiplier – Controls the play back speed.  The range is 0.5 – 2, which is 

equivalent to playing the data back at half the running speed, or double the running 

speed. 

Cursor Update Speed – Controls the cursor update rate so the sound and cursor 

position are synchronized.  Use a lower cursor update speed setting if the cursor is 

slower than the sound.  To change the setting, click the drop down list and select the 

new cursor update speed. 

Volume – Controls the play back sound volume.  Click the slider bar and move up or 

down to increase or decrease the volume. 

 Click the Play button to generate sound from the vibration data, and listen to the 

waveform. 

 Click the Save button to save the sound data into a Windows ".wav" file. 

 Click the Exit button to exit the Sound Byte utility. 
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Trend / Time Plot 

 

Figure 5 - 17. 

Example of a Trend / Time Plot. 

Trend / Time Plots display both a trend plot and a time waveform plot for a trend 

record indicated by the single cursor (if available). 

The active plot (trend or time) determines the information window’s content and overlay 

settings.  Use a single cursor to view dynamic data for the measurement’s date and 

time.  Use multiple cursors to overlay dynamic data to visually display different data 

values. 

All other trend and time plot operations behave as described previously in the single 

trend and time plot descriptions. 

 Right-click on either plot to access the appropriate context menu. 

 See Trend Settings and Time Plot Settings for display 

parameters that can be modified to change plot display. 
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Trend / Spectrum / Time Plot 

 

Figure 5 - 18. 

Example of a Trend / Spectrum / Time Plot. 

Trend / Spectrum / Time plots display a point’s trend plot, spectrum plot, and time 

waveform plot.  The three plots display in three different panels.  The trend panel is the 

primary panel of the display.   

Use a single cursor to view dynamic data for the measurement’s date and time.  Use 

multiple cursors to overlay dynamic data to visually display different data values. 

All trend, spectrum, and time plot operations behave as described previously in plot 

descriptions.   

 Right-click on each plot to access its context menu 

 See Trend Settings, Spectrum Settings, and Time Plot 

Settings for display parameters that can be modified to change 

plot display. 
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Waterfall Plot 

 

Figure 5 - 19. 

Example of a Waterfall Plot. 

Three-dimensional Waterfall Plots display POINT’s historical spectra collected over time.  

Historical spectra may be displayed as either a waterfall plot or a palogram plot as 

configured in Plot Settings or Plot Preferences. 

In a waterfall plot: 

X axis = frequency (Hz / CPM, or orders of running speed) 

Z axis = date 

In a palogram plot: 

X axis = date 

Z axis = frequency (Hz / CPM, or orders of running speed) 

 The slant angle for palogram and waterfall mode may be modified 

in Plot Preferences, allowing further customization of the 

waterfall plot, including even spacing between spectra regardless 

of time interval between readings. 
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Waterfall Settings 

To access the Waterfall Plot Settings dialog: 

 With a waterfall plot displayed, select the View menu’s Plot / Settings option, or 

use the settings toolbar button. 

 The Settings dialog is also available from the waterfall plot’s 

right-click context menu. 

Waterfall Plot Settings fields include: 

View type - Select display configuration, Waterfall or Palogram. 

Waterfall - Three dimensional plot displaying a single POINT’s historical spectral data 

collected over time (frequency axis along bottom). 

Palogram - Shows a rotated historical spectrum displaying in a three dimensional 

format, allowing easy observation of trends at each frequency (date / time axis along 

bottom). 

Even Spacing - Enable to retain the date order, but space evenly for simple viewing. 

Date / Time Scale - Enter the minimum and maximum date / time scale values in the 

designated text boxes. 

Magnitude Scale - Enter the minimum and maximum magnitude scale values in the 

designated text boxes. 

Magnitude Lin / Log - Select Linear scaling to space out data equally.  Select 

Logarithmic scaling to emphasize lower values. 

Frequency Scale - Enter the minimum and maximum frequency scale values in the 

designated text boxes. 

Frequency Lin / Log - Select Linear scaling to space out data equally. Select 

Logarithmic scaling to emphasize lower values. 
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Polar Vector Plot 

 

Figure 5 - 20. 

Example of a Polar Vector Plot. 

Polar Vector plots show vibration amplitude and phase.  Phase is the angular difference 

between a known mark on a rotating shaft and the shaft’s vibration signal.  This 

relationship provides valuable information on shaft orbit and shaft position and is used 

for analysis, balancing, and shaft orbital analysis. 

The newest measurement for the current data line is indicated by an asterisk ( * ). 

 Access the right-click context menu anywhere on the polar vector plot to change 

order view, copy, reset settings, and turn amplitude labels on or off. 

Polar Vector Settings 

To access the Polar Vector Settings dialog: 

 With a polar vector plot displayed, select the View menu’s Plot / Settings option, or 

use the settings toolbar button. 

 The Settings dialog is also available from the polar vector plot’s 

context menu 

Polar Vector Settings fields include: 

Full Scale - Enter full scale amplitude 

Order - Select order from drop down menu (1-4). 
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Mag / Phase Trend 

 

Figure 5 - 21. 

Example of a Mag / Phase Trend Plot. 

Mag / Phase trends plot the amplitude (top) and phase / angle (bottom) aligned by the 

measurement date.  Mag / Phase trends may be used to determine if a machine’s 

mechanics are changing by analyzing the shifting in phase. 

Mag / Phase Settings 

To access the Mag / Phase Plot Settings dialog: 

 With a mag / phase plot displayed, select the View menu’s Plot / Settings option, 

or use the settings toolbar button. 

 The Settings dialog is also available from the mag / phase plot’s 

right-click context menu. 

Mag / Phase Plot Settings fields include: 

Date / Time Scale- Enter the minimum and maximum date / time scale values in the 

designated text boxes. 

Magnitude Scale - Enter the minimum and maximum magnitude scale values in the 

designated text boxes. 

Magnitude Lin / Log - Select Linear scaling to space out data equally.  Select 

Logarithmic scaling to emphasize lower values. 

Phase Scale - Enter the minimum and maximum phase angles in the designated text 

boxes. 

Order - Determines which frequency order of running speed to display (1X, 2X, 3X, 4X). 
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Mag / Speed Trend 

 

Figure 5 - 22. 

Example of a Mag / Speed Trend Plot. 

Mag / Speed trends plot the speed (top) and amplitude (bottom) aligned by the 

measurement date.  Mag / Speed trends may be used to determine if a machine’s 

mechanics are changing by analyzing the relationship between vibration amplitude and 

speed. 

 The speed value comes from the dynamic measurement.  If only 

the overall value is stored for a particular date / time, then there 

will not be a corresponding Mag / Speed trend value. 

Mag / Speed Settings 

To access the Mag / Speed Plot Settings dialog: 

With a mag / speed plot displayed, select the View menu’s Plot/Settings option, or use 

the settings toolbar button. 

 The Settings dialog is also available from the mag / speed plot’s 

right-click context menu. 

Mag / Speed Plot Settings fields include: 

Date / Time Scale – Enter the minimum and maximum date / time scale values in the 

designated text boxes. 

Speed Scale - Enter the minimum and maximum speed scale values in the designated 

text boxes. 
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Magnitude Scale – Enter the minimum and maximum magnitude scale values in the 

designated text boxes. 

Magnitude Lin / Log – Select Linear scaling to space out data equally.  Select 

Logarithmic scaling to emphasize lower values. 

Mag / Speed / Spectrum Trend 

 

Figure 5 - 23. 

Example of a Mag / Speed / Spectrum Trend Plot. 

Mag / Speed / Spectrum trends display a POINT’s mag / speed plot and spectrum plot.  

The two plots display in two different panels.  The mag / speed panel is the primary 

panel of the display.   

All mag / speed and spectrum plot operations behave as described previously in plot 

descriptions.   

 Right-click on each plot to access its context menu 

See Mag / Speed Settings and Spectrum Settings for display parameters that can be 

modified to change plot display. 
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Mag / Speed / Spectrum / Time Trend 

 

Figure 5 - 24. 

Example of a Mag / Speed / Spectrum / Time Trend Plot. 

Mag / Speed / Spectrum / Time trends display a POINT’s mag / speed  plot, spectrum 

plot, and time plot.  The three plots display in three different panels.  The mag / speed 

panel is the primary panel of the display.   

All mag / speed, spectrum, and time plot operations behave as described previously in 

plot descriptions.   

 Right-click on each plot to access its context menu 

See Mag / Speed Settings, Spectrum Settings, and Time Settings for display 

parameters that can be modified to change plot display. 
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Mag / Speed / Time Trend 

 

Figure 5 - 25. 

Example of a Mag/Speed/Time Trend Plot. 

Mag / Speed / Time trends display a POINT’s mag / speed  plot and time plot.  The two 

plots display in two different panels.  The mag / speed panel is the primary panel of the 

display.   

All mag / speed and time plot operations behave as described previously in plot 

descriptions.   

 Right-click on each plot to access its context menu 

See Mag / Speed Settings and Time Settings for display parameters that can be 

modified to change plot display. 
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Band Trend 

 

Figure 5 - 26. 

Example of a Band Trend. 

Band trends combine the spectrum and available band trends for the selected POINT.  

Band Trends are used to analyze the energy within the band to closely monitor that 

particular frequency range. 

To view a spectral band trend plot: 

 Select the POINT whose band trends you wish to display. 

 Select the View menu’s Plot / All Plots option.  The All Plots dialog displays. 

 Select the Band Trend option. 

Initially, all bands for the specified POINT display in the Band Trend display’s plots. 

To view specific bands / band trends: 

 On the display’s spectrum plot, right-click on the overlay “anchor” in the plot’s 

upper right corner and select the Settings option.  The Band Alarm Settings dialog 

displays. 
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Figure 5 - 27. 

Band Alarm Settings Dialog. 

POINT – Displays the selected POINT name. 

Available band alarms 

 Use checkboxes to enable and disable bands for display. 

In the plot window’s lower band trend plot, specified bands display along with band 

alarm overlays for one of the band trends.  Right-click on the trend’s overlay anchor to 

display the Next Trace’s band alarms. 

 On the band trend plot, position the cursor and mouse pointer and use feedback 

areas to analyze the plot. 

 Right-click on either plot to access the appropriate context menu. 

See Trend Settings and Spectrum Settings for display parameters that can be 

modified to change plot display. 
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Extracted Trend 

 

Figure 5 - 28. 

Example of an Extracted Trend Plot. 

Extracted trend plots display a trend plot of spectrum amplitudes at a frequency.  A 

waterfall plot shows which spectra are to be used.  The single cursor in the waterfall 

controls which frequency to plot in the trend.  In addition, the single cursor in the 

waterfall plots selects which spectrum is displayed in the spectrum plot.  The waterfall 

plot is the primary plot. 

 Right-click on each plot to access its context menu. 

See Trend Settings, Spectrum Settings and Waterfall Settings for display 

parameters that can be modified to change plot display. 
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Extracted Band 

 

Figure 5 - 29. 

Example of an Extracted Band Plot. 

Extracted band plots display a waterfall and extracted band plot.  The energy of the 

frequency within the band across the spectrum displays.  You may create and move the 

band while viewing, allowing you to analyze a particular component’s energy. 

 Right-click on either plot to access the appropriate context menu. 

See Trend Settings and Waterfall Settings for display parameters that can be 

modified to change plot display. 

HAL Trend 

The HAL trend plot can be viewed for any POINT that has: (a) a defined Frequency set in 

the POINT Properties dialog and (b) FFT data measurements. The POINT does not need 

to be in HAL alarm to view the trend.  

The HAL trend plot has the following characteristics: 

 Trend plot shows the HAI values calculated from the FFT data.  

 Each plot/data line in the HAL trend represents a frequency. 

 The selection of one or more frequencies can be displayed. 

 The HAL trend plot view supports individual POINT and multiple POINT trends. 

 You can right-click the active plot line (triangle) anchor and select View 

Frequencies from the context menu to exclude or include specific frequency 

plot/data lines. 
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 The cursor in a HAL trend plot is used to update the frequency display for that 

particular date and time. 

 You can drag and drop POINTs from the hierarchy into the HAL trend view to 

display all applicable HAL trends that are assigned to the same bearing type and 

same frequencies (BPFO, BPFI, etc.). 

 Standard trend plot functionality applies. 

 Live HAL trend plots are NOT supported due to processing time 

constraints and the need to recalculate the HAL values before the 

next live measurement. 

 If the HAI value for a frequency cannot be calculated, that frequency does not 

display on the plot. See About HAL Trend Plot Calculation Limitations below for 

details. 

About HAL Trend Plot Calculation Limitations  

Under specific limiting conditions, the HAI value for a frequency cannot be calculated or 

the calculation result is zero. When this occurs, a HAL trend plot for that frequency is 

not generated. The main benefit of these limiting conditions is to eliminate the display of 

trace lines that do not present coherent, useful information. 

 Derived point HAL calculations that return a non-calculation 

result will produce a non-collection measurement. 

The following terms are used in the table below: 

Fundamental Frequency = Multiplier x Running Speed 

Resolution = Fmax / (Number of Lines – 1 ) 

Harmonics = Fmax / Fundamental Frequency 

Base Energy = Sum (FFT values ) 

Average Base Energy = Base Energy / Number of Lines 

 

Reason a HAL Trend Plot Is Not 

Produced  

One or More Limiting Conditions Applied to the Calculation 

HAL Calculation Cannot Be 

Completed 

No FFT values in the measurement 

Number of Lines = 0 

Harmonics is greater than or equal to Number of Lines / 4 

HAL Calculation Results = 0 Harmonics is less than 1.0. 

All individual harmonic energy levels are less than Average Base 

Energy. 

Two additional limitations are enforced by Analyst to make the HAL calculation results 

meaningful for condition monitoring purposes.  

 One is a global preference setting, Maximum harmonics to use in HAL 

calculations. The default range is 4 to 50, but the maximum can be increased up 

to 500. 

 The other limitation is that the Fundamental Frequency cannot be in low frequency 

cut-off region. (Low freq. cutoff parameter displays on POINT Properties, Setup 

tab.) 
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Information Area Displays 

In the HAL Trend tab (which shows the values for the measurement where the single 

cursor is active), the column is blank for any frequency that could not be calculated (the 

FTF column in the example below). 

 

Figure 5 - 30. 

HAL Trend Tab’s FTF Column. 

In the Summary tab, frequencies for which HAI values could not be calculated display in 

the Not Calculated column, as shown below.  

 

Figure 5 - 31. 

Summary Tab’s Not Calculated Column. 

To view historical HAL data in a trend plot: 

 From the hierarchy, select a POINT that meets the two requirements of having 

assigned frequencies and FFT data. 

 Right–click the POINT and select Plot > HAL Trend, OR click the HAL trend icon 

. 
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Figure 5 - 32. 

Path to Open a HAL Trend Plot. 

 

Figure 5 - 33. 

Example of HAL Trend Plot. 

All HAL trends display in one trend plot.  Each frequency associated with the POINT 

displays a separate HAL trend line.  When a frequency has a sideband cursor, two 

trends are displayed for the sidebands: one for the right side and one for the left. 
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 Click the Previous Frequency/Next Frequency buttons ( /

) or use the -/+ keys on your keyboard’s ten-key area to cycle 

through which frequencies are shown in the plot (all, each 

individually, etc.). 

Preference settings determine how many historical spectra are computed in the HAL 

trend. The preferences for all measurements are set in the Measurement tab (go to 

Customize > Preference > Measurement tab).  

 HAL Trend plot itself and the Summary tab show Units = HAI 

(harmonic activity index). 

 A plot line anchor represents a POINT and one of its channels 

(indicated as X, Y, or Z). A 3-channel POINT will display three plot 

line anchors, as shown below. 

 

Figure 5 - 34. 

Example of a 3-channel POINT Showing Three Plot Line Anchors. 

You can right-click the anchor at the upper left to open the context menu. Select View 

Frequencies to specify which frequencies to display in the HAL trend view. 

  

Figure 5 - 35. 

Example of the Context Menu Accessible Via the Anchors. 

The View Frequency dialog opens, showing only available frequencies. 
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Figure 5 - 36. 

View Frequency Dialog. 

In the View Frequency dialog, all frequencies associated with the POINT are listed with 

the Visibility set to Yes by default. You can deselect a checkbox to change Visibility in 

the HAL trend plot to No. Click OK to accept your changes. 

 The Show All and Hide All buttons enable setting all the 

frequencies as visible or not visible. 

 

Figure 5 - 37. 

Example of HAL Trend Plot with Some Frequencies Changed to Not Visible. 

If you drag a single channel POINT into the HAL trend, it will add another plot line 

anchor. Similarly, dragging in a 2-channel POINT will add two more plot line anchors 

and a 3-channel POINT will add three plot line anchors. 
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 The drag and drop feature does NOT check if the additional 

POINTs are assigned to the same bearings or frequencies. The 

View Frequencies dialog can be used to remove any frequencies 

that do not match the frequencies associated with the original 

POINT. 

Spectrum/HAL Trend Plot 

When a POINT with associated frequencies is selected in the hierarchy, you can view the 

Spectrum and HAL Trend plots together. The two plots interact so that the 

measurement and frequency selections made on one plot alter the data displayed on 

the other. This behavior is described below. 

When the Spectrum/HAL Trend plot opens, the spectrum is highlighted by default and 

the HAL trend below is disabled by default. 

 

Figure 5 - 38. 

Example of a Spectrum/HAL Trend Combo Plot. 

The frequencies displayed in the spectrum plot control which frequencies are shown in 

the HAL trend plot. This includes the frequencies indicated with spectrum single cursor 

markers and the frequency markers shown by the frequency overlay. 

The Spectrum/HAL trend combo plot does not support the frequency selection menus 

that are available on the standalone HAL trend plot. Instead, the frequencies displayed 

in the HAL trend plot are controlled by the frequencies being called out in the spectrum 

plot. You can show or hide frequencies by using the methods described below. 

 To show all frequencies, click on the Frequencies  icon in the SKF @ptitude 

Analyst toolbar. The spectrum plot will show all the frequencies available. The info 

area is also updated and the FAM tab appears containing the details of the 

frequencies. 
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Figure 5 - 39. 

Example of Spectrum Plot Showing all Available Frequencies with the Cursor on 7414B (SKF) BPFO. 

 You can change from one frequency to another by clicking the Next Frequency  

or Previous Frequency  icons in the toolbar. The frequency now displayed in 

the spectrum plot is reflected in the HAL trend also. 

 To select a specific frequency (hiding the others), you can right-click on any 

frequency in the spectrum to open the Frequency Settings dialog. Enable the 

desired frequency (in this example, 7416B (SKF) BPFI) to show, and then click OK. 

 

Figure 5 - 40. 

The Frequency Settings Dialog. 

 The selected frequency is now the only one shown in the in the HAL trend plot. 
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Figure 5 - 41. 

Example of Frequency Changed to 7416B (SKF) BPFI in the Spectrum/HAL Trend Plot. 

You can drag and drop an additional POINT on to the existing combo plot window in the 

same manner as other plot types. The additional POINT will display all HAL trends 

related to it. 

Contribution/Profile 

A Note about Cyclic Time Averaging (CTA) 

CTA is a post process operation that operates on time waveform signals, creating an 

averaged waveform similar to a Synchronous Time Averaging (STA) measurement. 

Unlike STA, CTA does not require a trigger and can be computed on already acquired 

time domain signals.   

One of the best cases for using Cyclic Time Averaging is when an external trigger is not 

possible, or practical, such as when monitoring the inner shafts of a gearbox. The goal is 

to find out if there are damaged gear teeth on the gear without having to stop the 

machine and open it up for inspection. 

CTA uses only a single measurement to perform averaging. CTA can be performed on 

any time domain measurement as long as this measurement covers more than two 

revolutions of the defect source under study. Consider a measurement length of 10 

seconds (not uncommon in the paper industry) and a defect frequency of 5 Hz (200 

ms). One single measurement captures 10/0.2 = 50 cycles of the defect. CTA realigns 

the samples in the measurement so that they can be averaged to produce an improved 

signal waveform with reduced noise.  

In the Roundness Profile plot, the time domain is wrapped around each component 

frequency’s periodic cycle time. It can be seen that a damaged gear tooth generates a 

significant amount of high frequency vibration during initial contact with the mating 

tooth.  

The Contribution/Profile Plot 

The Contribution/Profile combo plot shows the contribution bar graph. The Trend plot in 

the bottom panel is a standard Trend plot that displays traces for selected points and 

channels. The Contribution (upper left panel) and Roundness Profile (upper right panel) 
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plots display data for the point and channel indicated by the active Single Cursor on the 

trend plot.  

 

Figure 5 -42. 

Example of Contribution/Profile Plot with Contribution Tab Below. 

The Trend Plot and Data Selection 

The Trend plot is the standard Trend plot so it supports the usual behaviors and 

overlays. It opens with a Single Cursor but additional Single Cursors can be added. 

The data selection process through the plots is as follows: 

 The Trend plot is the initial content driver. The active Single Cursor determines the 

data that displays in the Contribution plot.  When there are multiple Single Cursors 

on the Trend plot, only the active Single Cursor drives the Contribution plot. 

 Use the arrow keys to navigate among measurements. The Contribution plot 

updates to display data for the selected measurement. 

 The Contribution plot drives the content of the Roundness Profile plot based on the 

selected bar (either the CTA Overall or a Frequency). The CTA Overall bar is initially 

selected. CTA stands for Cyclical Time Averaging; CTA Overall applies specifically to 

the Contribution plot. 

 If the Single Cursor that currently drives the Contribution plot is 

removed, the Contribution and Roundness Profile plots will go 

blank and show the message: “There is no data available to 

display on the plot”. 

 The Contribution/Profile combo plot supports “live data” mode. 

Details are provided later in this document. 
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 Only the Trend plot supports the zoom function. 

The Contribution Plot 

As stated, the contribution plot displays data for the frequencies associated with the 

particular trace that is indicated by the active single cursor on the Trend plot.  The plot 

title presents the following elements: plot type as Contribution, Machine/Point name, 

Measurement date/time, and Channel. 

 

Figure 5 - 43. 

Example of a Contribution Plot Only. 

The data displays in bar chart format, showing the measurement value and vibration 

contribution by percent of the total (the x-axis) for each frequency (the y-axis). The top 

bar, labeled CTA Overall, represents the total of the selected frequencies associated 

with the POINT and therefore represents 100%. The overall value of the measurement 

is given at the right of the CTA Overall bar.  

The other bars show the names (up to 15 characters) of the frequencies selected for 

inclusion by the checkboxes on the POINT Properties > Frequencies tab. Each bar 

represents the relative contribution of a frequency; the label at the right provides both 

the measurement value and percent of the contribution to the overall. If more than 15 

frequencies are enabled on the Frequencies tab, only the first 15 (depending on the 

sort type) will display in the bar chart.  

Right-click in the Contribution plot to open the context menu. 

 

Figure 5 - 44. 

Contribution Plot Context Menu 

Settings… - open the Contribution Settings dialog. 
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Reset Settings - reset changes made in the Contribution Settings dialog to the default 

settings. 

Copy - copy the Contribution plot to the Windows clipboard. (This menu item appears in 

all plots.) 

Info Area – hide or show the Info Area. (This menu item appears in all plots.) 

Sort Frequency Bar by Name - sort the Frequency bars by the frequency name in 

ascending order.  

 The CTA Overall bar is not sortable and remains at the top.  

Sort Frequency Bar by % Contribution - sort the Frequency bars by the % contribution 

in descending order.  

To change the Speed Reference Time Window: 

 Select Settings… to open the Contribution Plot Settings dialog.  

 

Figure 5 - 45. 

Contribution Plot Settings Dialog. 

 You can change the Speed reference time window value and units. The maximum 

allowable value is 48 hours; this is equivalent to 2880 minutes or 172800 seconds. 

 Click OK to save the settings.  Any change you make applies only to the plot 

currently open; the global plot preference setting is not changed.  Bear in mind that 

the settings implemented in this dialog continue to be applied to this plot when the 

data changes (until the settings are changed manually again). 

The Roundness Profile Plot 

The Roundness Profile plot shows only one time waveform at a time.  The Roundness 

Profile plot is determined by the frequency bar selected in the Contribution section.  

Selecting a frequency bar (the color changes upon selection) updates the profile to show 

CTA(Fd) in a roundness plot.  The calculated statistics for the Contribution-derived time 

waveform are also displayed. 

 The Roundness Profile plot supports only the Linear Speed 

overlay 

The Roundness Profile plot is drawn as follows:  

 The circle angle represents the Time.  

– 0 degree is 0 second. 

– 360 degrees is the time for one revolution, using the specified speed reference. 
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 Each circle represents the waveform amplitude.  

– The innermost circle is the minimum amplitude.  

– The outermost outer circle is the maximum amplitude. 

– There are five circles for the max value, min value, mid level, a circle between 

the mid and max circles and another between the mid and min circles. 

 Traces for values outside the minimum and maximum values will be clipped. 

When first opened, the CTA Overall bar is selected in the Contribution plot and the 

Roundness Profile plot draws the whole raw time waveform, with each cycle 

representing one revolution. The plot line color matches the color of the CTA Overall bar 

in the Contribution plot. (Refer to the first example, Figure 2-1.) The plot title presents 

the following elements: plot type as Roundness Profile, Machine/Point name, 

Measurement date/time, Channel, and Overall value. The Machine/Point name, 

Measurement date/time, Channel, and Overall value reflect the data from the trace 

selected by active single cursor in the Trend plot. 

When a Frequency bar is selected in the Contribution plot, the roundness plot draws 

one revolution of the frequency time waveform. The plot line color matches the color of 

the selected Frequency bar in the Contribution plot. The plot title presents the following 

additional elements: the selected frequency name, RMS and speed.  

 

Figure 5 - 46. 

The Roundness Profile Plot with a Frequency Bar Selected. 

Right-click in the Roundness Profile plot to open the context menu. 

 The access levels "Operator" and "View Data HMI Operator" will 

not see Settings… and Reset Settings. All users will see the 

Copy and Info Area options.  

 

Figure 5 - 47. 

Roundness Profile Plot Context Menu (Complete). 

Settings… - open the Roundness Profile Plot Settings dialog. 
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Reset Settings - reset changes made in the Roundness Profile Plot Settings dialog to 

the default settings. 

Copy - copy the Contribution plot to the Windows clipboard. (This menu item appears in 

all plots.) 

Info Area – hide or show the Info Area. (This menu item appears in all plots.) 

To change the Magnitude Range: 

 Select Settings… to open the Roundness Profile Plot Settings dialog.  

 

Figure 5 - 48. 

Roundness Profile Plot Settings Dialog.  

 When Autoscale is disabled, you can change the values for Mag. min. and Mag. 

max. Negative values and values with decimal points are allowed.  

 Click OK to save the settings. 

Linear Speed Overlay 

From the Roundness Profile plot, click the Linear Speed tool  in the overlay toolbar. 

Or go to View > Plot Overlays > All Overlays and select Linear Speed. 

 Only one instance of the Linear Speed overlay is supported in the 

Roundness Profile plot. 

The overlay behavior is the same as Linear Speed in the Time plot.  An anchor displays 

at the top left of the plot and feedback for Linear Speed displays. 

 

Figure 5 - 49. 

Roundness Profile Plot with Linear Speed Overlay. 
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Speed References 

As stated previously, the Contribution/Profile combo plot supports “live” display. For 

setups that require an external speed reference, the live display includes the external 

speed reference as part of the live display so that a valid value is obtained. 

If the nearest speed measurement is outside the allowable speed reference window 

time, the frequency bar will change different color.  The Contribution plot will display the 

massage: "Speed reference out of range". The same color change and message also 

appear in the Roundness Profile plot. 

If the speed measurement is not available (that is, the speed reference was removed 

from system, or no measurement data is available), then the Frequency bar is not 

shown.  Instead, there is the message: “No speed data”. 

If any of the calculations fail (for frequencies or CTA Overall), then the bar is not shown.  

Instead, there is the message: "Insufficient data". 

Live Data Mode 

Click the Live Data tool to switch the Trend plot (main content driver) into live mode.  

As the Trend plot is updated with live data, the Contribution plot is also updated 

depending on the Single Cursor position in the live Trend plot. 

If the frequency uses an external speed point, the speed point is also put into live mode 

so that the frequency will have the live speed data. 

 The external speed point live data will not be shown in the Trend 

plot. 

 If one or more external speed points fail to go live, a message will 

inform you of it, but other live POINTs will continue. 

 As with other plots, saving live data is supported.  If an external 

speed point is used, the speed point’s live data is saved as well.  
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Working with Overlays 

Plot “overlays” superimpose cursors, alarms, and frequency markers on displayed plots.  

Each overlay displays an “anchor” which you use to manipulate the overlay. 

Displaying Overlays Using Toolbar Buttons 

@ptitude Analyst has toolbar buttons for commonly used overlays. 

 

Figure 5 - 50. 

Overlay Toolbar Buttons (Shown Here as Two Columns). 

Toolbar buttons are available for each overlay.  The buttons on the toolbar can be 

configured using the Customize menu’s Toolbar option.  For more information on 

customizing toolbars, refer to Appendix A, SKF @ptitude Analyst Toolbars.  

Each button is enabled / disabled based on whether the overlay can appear on the 

active plot.  Individual toolbar buttons are identified later in this section. 

Displaying Overlays Using the View Menu 

The View menu’s Plot Overlays option contains a list of commonly used overlays.  

Individual items on this list are enabled or disabled based on whether the overlay is 

available for the plot window displayed when the item is selected. 
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Figure 5 - 51. 

The View Menu’s Plot Overlays Option. 

Using the View menu’s Overlay option: 

Select the View menu’s Plot Overlay option.  A group of commonly used overlay types 

displays on the menu. 

 Select one of the visible overlay types, or select All Overlays for more selections. 

You may also use the All Overlays toolbar button to display the All Overlays dialog. 

All Overlays 

 Select the View menu’s All Overlays option.  The All Overlays dialog displays.   

All overlays applicable to the open plot display in the dialog. 

 Select an overlay to display and click OK.  The selected overlay displays in the plot 

window. 

 You may add as many instances of overlays as needed (excluding 

the peak cursor). 

 Click Cancel to undo your selection. 

Overlay Settings 

To access the Settings dialog for the selected overlay, either click the toolbar’s overlay 

settings button, or use the View menu’s Plot Overlays / Settings option. 
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Overlay Types 

Individual Overlay types and settings are listed below: 

Text Annotation 

Use text annotation overlays to create temporary textual notations and display on a 

plot. 

 Text annotations are for temporary use.  They are not attached to 

the measurement or stored in the database.  They remain on a 

plot until the plot is closed. 

To create a text annotation: 

 With a plot displayed, click the toolbar’s text annotation button, or select the View 

menu’s Plot Overlays / Text Annotation option.  The “Text Annotation” displays on 

the plot. 

To edit the text annotation: 

 Double-click the text annotation.  The Text Annotation Settings dialog displays. 

 

Figure 5 - 52. 

The Text Annotation Settings Dialog. 

Annotation text - Enter text to display on the plot.  The entered text displays in the 

dialog’s Preview area, allowing you to view the entered text before displaying it on the 

plot. 
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Text attributes options include: 

Left justified, Centered, or Right justified - Determine how the text displays in its text 

box. 

Transparent - Enable to make the annotation’s background area transparent, allowing 

you to see the plot beneath the text. 

Background Color - Click to select the annotation’s background area color. 

Font - Click to select the font for the annotation text. 

 Click the OK button.  The entered text annotation displays on the active plot. 

Context Menu - Right-click on the displayed text annotation to reveal its context menu.  

Available operations are: 

Remove – Removes the annotation from the plot. 

Settings – Launches Text Annotation Settings dialog. 

Keyboard Support – Press Delete to remove the annotation from the plot.  Use up / 

down / left / right arrow keys to re-position.  Use Shift and the left or right arrow key to 

enlarge in the direction of the selected arrow.  Use Ctrl and the up / down / left / right 

arrow keys to shrink the box from the direction of the selected arrow. 

Feedback Area – Displays the annotation text. 

Information Area – None. 

Available Preferences 

None. 

 Text annotation may also be moved with the mouse (drag and 

drop).  Click on an anchor area and drag to re-size. 

Linear Speed Overlay Settings 

Use a Linear Speed Settings dialog to set the text attributes for your linear speed 

overlay. 

 

Figure 5 - 53. 

The Linear Speed Settings Dialog. 
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In the Text attribute section: 

 Click the Transparent checkbox to display a transparent text annotation over the 

active plot. 

 Click the Background Color button to select the color of textbox background. 

 Click the Font button to select the desired font. 

 Observe linear speed edits in the Preview window before applying 

your linear speed overlay. 

 Click OK to close the dialog and save your edits. 

Trend / Notes 

Use the notes overlay to create and display notes at a specific date / time on the trend 

plot. 

To create a note: 

 With a trend plot displayed, position your cursor over the plot area and right click to 

display the right-click context menu.   

 Select Add Notes.  The Add Notes dialog displays.  A new note displays in the 

Notes list with the date and time of the location you right-clicked on the plot.   

 

Figure 5 - 54. 

The Add Notes Dialog.  
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 If you need to change the date / time of the note, use the Date and Time fields to 

adjust the date / time as necessary.  The Add / Remove buttons will change to 

Save / Undo buttons.  Click Save and the note’s date / time adjusts accordingly in 

the Notes list. 

 Type your note in the Text area and click Save. 

 Click OK.  The created note displays on the plot at its specified date / time location.  

To create additional notes: 

 Click the Add button.  A new note is added to the Notes list with the current date / 

time stamp. 

 Adjust the date / time using the Date and Time fields as necessary.   

 Type your note in the Text area and click Save. 

 Click OK.  The created note displays on the plot at its specified date / time location.    

To remove a note: 

 Select the note you wish to remove in the Notes list. 

 Click the Remove button. You will be asked to confirm that you wish to remove the 

note. 

 Click Yes, or if you do not wish to remove the note, click No. 

How Notes Overlays Display on the Plot 

Feedback Area - Displays note and date / time information. 

Information Area – Specific information displays on the Notes tab.  Tab information 

includes the POINT on which the cursor is currently positioned, note, and date / time. 

Context Menu - Right-click on the displayed note to reveal its context menu.  Available 

operations are: 

Remove – Removes overlay from the plot.   

 This does not delete existing notes.  To display the notes overlay 

again, select View / Plot Overlays / Notes. 

Next Trace – Toggles between traces when the plot is displaying more than 

one trace. 

Display Note – Displays the note on the plot. 

Remove All Display Notes – Hides all notes displayed on the plot. 

Filter Notes – Allows you to select one ore more note categories to display on 

the plot.   
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Figure 5 - 55. 

The Filter Notes Dialog. 

 From the list of note categories, enable the check box next to one or more note 

categories.   

 In the Include from group area, select the check boxes to include notes from SETs, 

Machines, and / or POINTs. 

 Click OK.  Only notes from the selected note categories display on the plot. 

Available Preferences 

The following preferences are found on the Preferences dialog’s Plot tab. 

Notes – Configure the default display status (on or off). 

Notes Indicator Location – Configure the display notes indicator (at top or 

bottom of plot).  

Notes Indicator Tooltip – Configure whether to display the tooltip (on or off) 

when hovering over the notes indicator. 

Notes Line Style – Configure how the notes cursor line displays (dashed, solid, 

etc.).  
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Trend / Single Cursor 

Use a single cursor to view individual measurement data on the trend plot by moving 

the cursor to various measurement records.   

To display a single cursor: 

 With a trend plot displayed, select the View menu’s Plot / Plot Overlays / Single 

Cursor option, or use the single cursor overlay toolbar button. 

 Drag the cursor to position it on the plot. 

 If multiple traces appear in a plot, double-click the cursor overlay’s anchor to 

position it on another trace.  The anchor’s color indicates the current trace. 

Feedback Area - Displays amplitude and date / time information. 

Information Area – Specific information displays on the Trend tab.  Tab information 

includes the POINT on which the cursor is currently positioned, cursor color, amplitude, 

and date / time. 

Right-Click Context Menu - Right-click on the single cursor overlay anchor to reveal its 

context menu.   

Available options include: 

Next trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from plot. 

Exclude Reading – Toggles selected measurement's Exclude status on and off.  

When Exclude is selected, the measurement is excluded from all calculations.  

This setting is stored with the measurement and is in effect until the setting is 

changed. 

Keyboard Support – Move the cursor with the left and right arrow keys.  Press Enter 

to toggle to next trace.  Press Delete to remove the cursor. 

Available Preferences 

Color - Cursor is the color of the next available cursor (as configured in 

Cursor / Color Preferences in the Preferences dialog). 

Display Status – Display status (on or off) is configured in the Trend Single 

Cursor / Plot Preferences in the Preferences dialog. 

 The default status is on. 
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Trend / Overall Alarm 

Use an overall alarm overlay to display your overall alarms graphically (as configured in 

POINT Properties) on the active trend plot. 

To display an overall alarm overlay: 

 With a trend plot displayed, select the View menu’s Plot / Plot Overlays / All 

Overlays option.  The All Overlays dialog displays. 

 Select Overall Alarm and click OK. 

Feedback Area - Identifies the POINT, displays private alarm or alarm name (if shared), 

and the alarm levels set. 

Information Area - Specific information displays on the Overall Alarm tab.  Tab 

information includes POINT name, type, alarm level values and alarm message 

summaries.   

Overall Alarm tab - Information includes name, type, and alarm level values. 

Right-Click Context Menu -  Right-click on the overall alarm overlay anchor to reveal 

its context menu.   

Available options include: 

Next trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from plot. 

Keyboard Support – Press Enter to toggle to next trace.  Press Delete to remove. 

Available Preferences 

Color – Alert and Danger colors appear as configured in Cursor / Color 

Preferences in the Preferences dialog. 

Display Status – Display status (on or off) is configured in the Trend Overall 

Alarm / Plot Preferences in the Preferences dialog. 

 The default status is on. 

Trend / Linear Speed 

Use a linear speed overlay to graphically display the value of the linear factor multiplied 

by the running speed. 

To display linear speed overlay: 

 With a trend plot displayed, select the View menu’s Plot / Plot Overlays / All 

Overlays option.  The All Overlays dialog displays. 

 Select Linear Speed and click OK. 

Feedback Area – Displays amplitude, frequency, orders, and linear speed. 

Information Area – No tabs display for this overlay. 

Right-Click Context Menu – Right-click on the linear speed overlay anchor to reveal its 

context menu.   
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Available options include: 

Next trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from plot. 

Keyboard Support – Press Enter to toggle to next trace.  Press Delete to remove. 

Available Preferences 

Display Status – Display status (on or off) is configured in the Trend / Linear 

Speed / Plot Preferences in the Preferences dialog.  

 The default status is off. 

Linear Speed Settings 

 

Figure 5 - 56. 

The Linear Speed Settings Dialog. 

Use the Linear Speed Settings dialog to set the text attributes for your linear speed 

overlay. 

In the Text attribute section: 

 Click the Transparent checkbox to display a transparent text annotation over the 

active plot. 

 Click the Background Color button to select the color of the textbox background. 

 Click the Font button to select the desired font. 

 Observe linear speed edits in the Preview window before applying 

your linear speed overlay. 

 Click OK to close the dialog and save your edits. 
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Trend / Curve Fit 

Use a curve fit overlay to graphically display the projected linear direction a trend is 

heading based on current data. 

To display a curve fit overlay: 

 With a trend plot displayed, select the View menu’s Plot / Plot Overlays / Curve 

Fit option, or use the curve fit toolbar button. 

Feedback Area - Identifies the curve fit and associated POINT. 

Information Area - Specific information displays on the Curve Fit tab.  Tab information 

includes:  

Date, time, and amplitude for 2 years from last plotted measurement. 

Date, time, and amplitude when alert exceeded (or projected to be reached). 

Date, time, and amplitude when danger exceeded (or projected to be reached). 

Information is sorted by the POINT name or color of the current trace. 

Right-Click Context Menu - Right-click on the curve fit overlay anchor to reveal its 

context menu.   

Available options include: 

Next trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from the plot. 

Keyboard Support – Press Enter to toggle to next trace.  Press Delete to remove. 

Available Preferences  

Color – Color appears as configured in Curve Fit / Color Preferences in the 

Preferences dialog. 

Display Status – Display status (on or off) is configured in the Trend Curve 

Fit / Plot Preferences in the Preferences dialog. 

 The default status is off. 

Trend / Protection Threshold Limits 

Use a protection threshold limits cursor on a trend plot to graphically display the 

protection levels for IMx-M protection POINTs.  The protection threshold limits display 

as red (danger) and/or yellow (alert) dashed lines for the Alert High, Alert Low, Danger 

High, and Danger Low settings defined on the POINT Properties / Protection 

Threshold Levels tab.  

To display a protection threshold limits overlay: 

 With a trend plot displayed, select the View menu’s Plot / Plot Overlays / 

Protection Threshold Limits option, or use the Protection Threshold Limits 

toolbar button. 

Feedback Area - Identifies the protection threshold limits and associated POINT. 
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Information Area - Specific information displays on the Protection Threshold tab.  

Tab information includes the IMx-M protection POINT’s danger and alert protection 

threshold levels.   

Information is sorted by the POINT name of the current trace. 

Right-Click Context Menu - Right-click the protection threshold limit overlay anchor to 

reveal its context menu.   

Available options include: 

Next trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from the plot. 

Keyboard Support – Press Enter to toggle to next trace.  Press Delete to remove.   

Available Preferences  

Display Status – Display status (on or off) is configured on the Plot 

Preferences / Protection Threshold Limits in the Preferences dialog. 

 The default status is off. 

Spectrum / Single Cursor 

Use a single cursor on a spectrum plot to display the amplitude for the frequency of the 

cursor’s current placement 

To display a single cursor overlay: 

 With a spectrum plot displayed, select the View menu’s Plot / Plot Overlays / 

Single Cursor option, or use the single cursor toolbar button. 

Feedback Area – Displays amplitude, frequency, number of orders, and phase angle (if 

available). 

Information Area – Specific information displays on the Spectrum tab.  Tab 

information includes POINT name, cursor color, frequency, amplitude of each channel, 

number of orders, and phase angle (if available).   

Right-Click Context Menu – Right-click on the single cursor overlay anchor to reveal its 

context menu.  Available options include: 

Next trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from the plot. 

Set Speed – Launches the Set Running Speed dialog. 

Keyboard Support – Press Enter to toggle to next trace.  Press Delete to remove.  Left 

and right arrow keys move one line at a time.  Shift and the left or right arrow moves 

15 lines at a time. 

Available Preferences 

Color - Cursor is the color of the next available cursor (as configured in 

Cursor / Color Preferences in the Preferences dialog). 
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Display Status – Display status (on or off) is configured in the Spectrum 

Single Cursor / Plot Preferences in the Preferences dialog. 

 The default status is on. 

Set Running Speed 

The calculated or custom running speed appears on the active plot if the running speed 

overlay is displayed. 

To specify the running speed: 

 Right click on the single cursor overlay and select Set Speed from the pop-up 

menu. 

 

Figure 5 - 57. 

The Set Speed Dialog. 

Use the Set Running Speed dialog to edit the running speed for the measurement.   

Current frequency – Displays the frequency of the current cursor position on the open 

plot. 

To set a custom running speed: 

 Enter the desired frequency in the Calculated running speed field and click OK. 

To automatically calculate running speed by current frequency and number of 

orders: 

 Enter the desired value in the Equivalent to order# field. 

 Click OK. 

Trend / HAL Alarm 

The HAL alarm overlay has the following characteristics: 

 If HAL alarm levels have been defined for a POINT in the POINT Properties > HAL 

Alarms tab, then the HAL trend plot will open with the HAL alarm overlay displaying 

the alert and danger level lines.  

 The alert (yellow) and danger (red) lines are shown for the selected frequency. 
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Figure 5 - 58. 

Example of HAL Trend Plot with HAL Alarm Overlay. 

In the example below, the active overlay is the single cursor (indicated by the square box 

on the cursor) and the primary feedback text is displayed in black. When you use the 

mouse to hover your cursor on the circle at the right, representing the HAL Alarm 

overlay, the blue secondary feedback text highlights and displays alarm information.  

 

Figure 5 - 59. 

Example of HAL Trend Plot with HAL Alarm Overlay Feedback Text. 

To change the HAL alarm cursor to a different frequency, either: 

 click the HAL alarm anchor and use the up/down arrow keys to select different 

frequencies on the HAL Alarm plot, OR 

 right click the HAL alarm anchor to open the context menu and then select another 

HAL alarm frequency to highlight on the trend plot.  

The line for the selected frequency is highlighted and the corresponding highlight 

rectangle indicates the current measurement displayed in the feedback text. 
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Figure 5 - 60. 

Example of the HAL Trend Plot Anchor Context Menu. 

A HAL Alarm tab is added to the information area at the bottom of the HAL trend plot 

when the cursor is visible. The tab shows the POINT name, its frequency, and the alert 

and danger threshold values set on the POINT Properites > HAL Alarm tab for the 

current selected HAL alarm. Alarm levels display in the plot and are updated 

appropriately for each HAL frequency. 

 

Figure 5 - 61. 

Example of the HAL Alarm Tab for the HAL Trend Plot. 

Spectrum / Running Speed 

Use a Running Speed overlay to visually indicate the running speed frequency 

(Machine’s running speed at time of measurement). 

To display a running speed overlay: 

 With a spectrum plot displayed, select the View menu’s Plot / Plot Overlays / All 

Overlays option to display the All Overlays dialog.  

 Select Running Speed and click OK. 
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 Use the Customize menu’s Toolbar option to activate the running 

speed overlay toolbar button. 

Feedback Area - Displays amplitude, frequency, orders, and running speed. 

Information Area – None. 

Right-Click Context Menu – Right-click on the running speed overlay anchor to reveal 

its context menu.   

Available options include: 

Next Trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from plot. 

Keyboard Support – Press Enter to toggle to next trace.  Press Delete to remove. 

 An anchor symbol appears on the bottom of the plot.  Click the 

anchor to toggle between multiple spectra. 

Available Preferences 

Color – Running speed color is configured in Running Speed / Colors in the 

Preferences dialog). 

 The default color is black. 

Display Status – Display status (on or off) is configured in the Running 

Speed - Spectrum / Plot Preferences in the Preferences dialog. 

 The default status is on. 

Spectrum / Band Cursor 

Use a band cursor to display the frequency / time and amplitude difference (delta) 

between two cursor positions. 

To display a band cursor overlay: 

 With a spectrum plot displayed, select the View menu’s Plot / Plot Overlays / 

Band Cursor option, or use the band cursor toolbar button. 

Feedback Area - Displays left amplitude and frequency, right amplitude and frequency, 

orders, and delta (distance between cursor positions in frequency units).  

Information Area – Specific information displays on the Spectrum Band tab.  Tab 

information includes left frequency and amplitude for each channel, right frequency and 

amplitude for each channel, orders, delta, and overall for each channel.   

Right-Click Context Menu - Right-click on the band cursor overlay anchor to reveal its 

context menu.  Available options include: 

Next trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes the overlay from the plot. 

Keyboard Support – Press Enter to toggle to next trace.  Press Delete to remove. 
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The band cursor is made up of three parts.  The fundamental left line, fundamental 

right line, and the band width.  The active line is indicated by the cursor line focus icon.  

This icon displays as a triangle on the active part of the cursor.  Use left and right arrow 

keys to move band width or an individual line (depending on which is active) left or right.  

The Page Up and Page Down keys toggle between left line, right line, and band width. 

 The individual fundamental lines and the band width move in 

small increments (one line at a time).  Use the Shift and the left 

or right arrow key to move part or the entire band in larger 

increments (15 lines at a time). 

Available Preferences  

Color – Cursor is the color of the next available cursor (as configured in Color 

Preferences in the Preferences dialog).  Cursor line focus icon color appears 

as configured in Cursor Line Focus in Color Preferences in the Preferences 

dialog. 

Display Status – Display status (on or off) is configured in the Spectrum Band 

Cursor / Plot Preferences in the Preferences dialog. 

 The default status is off. 

Spectrum / Harmonic Cursor 

Use a harmonic cursor to display multiples of the current frequency. 

To display a harmonic cursor overlay: 

 With a spectrum plot displayed, select the View menu’s Plot / Plot Overlays / 

Harmonic Cursor option, or use the harmonic cursor toolbar button. 

Feedback Area – Displays the value for fundamental and harmonic amplitude, 

frequency, and orders.  When the mouse pointer is positioned over a harmonic marker, 

that marker’s amplitude, frequency, and orders display on the feedback area’s second 

line. 

Information Area – Specific information displays on the Harmonic Cursor tab.  Tab 

information includes POINT name, cursor color, frequency, amplitude of each channel, 

number of orders, and percentage of each channel’s fundamental frequency for each 

harmonic. 

 

Figure 5 - 62. 

The Harmonic Cursor Tab. 

The Harmonic Cursor tab provides details on potential harmonics using SKF’s 

Harmonic Activity Index (HAI).  All impact defects create spectra with a fundamental and 

a series of harmonics (i.e., a harmonic pattern).  The amplitudes of these harmonics are 
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affected by the defect itself, as well as the filtering effect of the machine.  HAI is a 

calculation that quantifies the likelihood of harmonic patterns being present in a 

spectrum, and therefore, the likelihood of a defect being present. 

The result of the HAI calculation is displayed in the Activity Index column.  The Activity 

Index is a quick indicator to determine if there is a meaningful pattern under the 

current cursor position (i.e., whether or not there is a defect associated with this 

frequency).  It can also act as a guide to determine the best cursor position for a 

suspected a harmonic pattern. 

An HAI value of 2.5 or greater indicates a likely defect pattern; HAI values of 3 or more 

show clear patterns. 

 HAI values are the same across spectra from different sources 

(i.e., the number of lines or unit types do not matter).  

 HAI values are calculated from spectral data only.  In some 

spectra, many different sources unrelated to each other may 

create a seemingly harmonious pattern.  The HAI value for this 

pattern might be high enough to suggest a true pattern is shown.  

To verify it is a true pattern, always check a few spectra taken 

over time for similar HAI values. 

Right-Click Context Menu - Right-click on the harmonic cursor overlay anchor to 

reveal its context menu.  Available options include: 

Next trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes the overlay from the plot. 

Set Running Speed 

The calculated or custom running speed appears on the active plot if the running speed 

overlay is displayed. 

To specify the running speed: 

 Right click on the harmonic cursor overlay and select Set Speed from the pop-up 

menu. 

 

Figure 5 - 63. 

The Set Speed Dialog. 

Use the Set Running Speed dialog to edit the running speed for the measurement.   

Current frequency – Displays the frequency of the current cursor position on the open 

plot. 
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To set a custom running speed: 

 Enter the desired frequency in the Calculated running speed field and click OK. 

To automatically calculate running speed by current frequency and number of 

orders: 

 Enter the desired value in the Equivalent to order# field. 

 Click OK.  

Keyboard Support – Press Enter to toggle to the next trace.  Press Delete to remove. 

Left and right arrow keys move the fundamental line in small increments (one line at a 

time).  Use the Shift and the left or right arrow key to move in larger increments (15 

lines at a time).   

Ctrl and the left or right arrow key moves the marker on the far right in small 

increments. 

Available Preferences –  

Color - Cursor is the color of the next available cursor (as configured in Color 

Preferences in the Preferences dialog). 

Display Status – Display status (on or off) is configured in the Harmonic 

Cursor / Plot Preferences in the Preferences dialog. 

 The default status is off. 

Number of Harmonics – Maximum number of harmonic markers displayed 

(1-100). 

 The default number is 50. 

Spectrum / Sideband Cursor 

Sideband markers consist of an array of five pairs of markers evenly spaced on both 

sides of a sideband cursor reference position.  Sideband markers are referenced as 

located from left to right around the center cursor.  Sideband markers to the left of the 

center cursor are referenced with negative numbers; their associated markers to the 

right of the cursor are referenced with positive numbers.   

To display a sideband cursor overlay: 

 With a spectrum plot displayed, select the View menu’s Plot / Plot Overlays / 

Sideband Cursor option, or use the sideband cursor toolbar button.  

Feedback Area - Displays the center position's amplitude and frequency, orders, delta, 

and each sideband marker's amplitude and frequency (arranged negative to positive). 

When the mouse pointer is over a sideband marker, its amplitude and frequency display 

on the feedback area’s second line. 

Information Area – Specific information displays on the Sideband tab.  Tab 

information includes sideband position, frequency, orders, amplitude, and delta 

(arranged negative to positive by sideband marker number).  

Right-Click Context Menu - Right click on the sideband cursor overlay anchor to reveal 

its context menu.  Available options include: 
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Next Trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from plot. 

Keyboard Support – Press Enter to toggle to next trace.  Press Delete to remove. 

Use the left and right arrow keys to move the center cursor in small increments (one 

line at a time).  Use Shift and the left and right arrow keys to move the center cursor in 

larger increments (15 lines at a time).  Use Ctrl and the left and right arrow keys to 

move the markers in and out in small increments (left arrow to expand / right arrow to 

contract).  Use Ctrl and Shift and the left and right arrow keys to move markers in 

larger increments (15 lines at a time). 

You may drag every individual marker, effectively changing the delta value, and thus the 

location of all other markers. 

Available Preferences 

Color - Cursor is the color of the next available cursor (as configured in Color 

Preferences in the Preferences dialog). 

Display Status – Display status (on or off) is configured in the Sideband 

Cursor Spectrum / Plot Preferences in the Preferences dialog. 

 The default status is off. 

Spectrum / Peak Cursor 

Peak cursors label all peaks above a user determined amplitude. 

 The default amplitude is based on the Threshold % preference.   

To display a peak cursor overlay: 

 With a spectrum plot displayed, select the View menu’s Plot / Plot Overlays / Peak 

Cursor option, or use the peak cursor toolbar button. 

Feedback Area - Displays the amplitude line value and the total number of peaks.  

Displays each peak's position, amplitude, frequency, and orders. 

Information Area – Specific information displays on the Peak tab.  Tab information 

includes peak position (index), amplitude, frequency, and orders.  

Right-Click Context Menu - Right-click on the peak cursor overlay anchor to reveal its 

context menu.  Available options include: 

Next Trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from plot. 

Keyboard Support – Press Enter to toggle to next trace.  Press Delete to remove. 

Use the up and down arrow keys to increase or decrease the amplitude line 1% of the 

current amplitude value.  Use the Shift and up and down arrow keys to increase / 

decrease the amplitude range in larger increments (10% at a time). 
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Available Preferences 

Color - Cursor is the color of the next available cursor (as configured in Color 

Preferences in the Preferences dialog). 

Display Status – Display status (on or off) is configured in the Peak Cursor - 

Spectrum / Plot Preferences in the Preferences dialog. 

 The default status is off. 

Threshold % - This value is used to determine the initial position of the cursor as a 

percentage of the full scale value. 

 The default amplitude is based on the Threshold% preference 

Spectrum / Band Alarm  

Use a band alarm overlay to display all band alarms assigned to the active POINT. 

 If the band alarms display was previously modified for the active 

POINT, then only those marked visible will display. 

To display a band alarm overlay: 

 With a spectrum plot displayed, select the View menu’s Plot / Plot Overlays / All 

Overlays option.  The All Overlays dialog displays. 

 Select Band Alarm and click OK. 

 Use the Customize menu’s Toolbar option to activate the band 

alarm overlay toolbar button. 

In displayed band alarm overlays, solid lines represent peak values and dashed lines 

represent overall values.  Green lines represent the band’s peak and overall value for 

the measurement, yellow lines show alert alarm values, red lines show danger alarm 

values. 

Feedback Area– When anchor is active, displays band alarm for specific POINT.  When 

band alarm is active, displays band name, alarm level, and value (Overall Danger and 

Alert / Peak Danger and Alert). 

Information Area – Specific information displays on the Band Alarm tab.  Tab 

information includes low and high frequency values, orders, peak, overall alert and 

danger alarm values, data values, for example: peak value and status / overall value, 

and status.  

Right-Click Context Menu - Right-click on the band alarm overlay anchor to reveal its 

context menu.  Available options include: 

Next Trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes the overlay from the plot. 

Settings – Launches Band Alarm Settings dialog. 

Keyboard Support – Press Enter to toggle to next trace.  Press Delete to remove. 
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Available Preferences 

Color – Color preferences set in following areas of the Preferences dialog: 

Band Alarm / Colors – Configures frequency lines (left and right) 

colors. 

Clear / Colors – Configures data value line colors. 

Alert / Colors – Configures alert color. 

Danger / Colors – Configures danger color. 

Display Status – Display status (on or off) is configured in the Band Alarm - 

Spectrum / Plot Preferences in the Preferences dialog. 

 The default status is off. 

Band Alarm Settings Dialog 

Use the Band Alarm Settings dialog to show / hide available band alarms on the active 

POINT's plot.  Available Band Alarm names, visibility status, and frequency range display 

on the tab.   

 

Figure 5 - 64. 

The Band Alarm Settings Dialog. 

Band Alarm Settings fields include: 

POINT - Displays POINT name. 

Available band alarms - Displays individual band alarms and their visibility status, 

frequency ranges, and channels.  

To show / hide band alarms: 

 Click the band alarm’s checkbox to toggle the band alarm’s status from Show to 

Hide. 

 Click OK to save changes, click Cancel to close the dialog without saving changes. 

 These display settings are stored with the POINT.  Whenever the 

POINT displays, the current settings are used. 



Displaying Graphic Plots 

Overlay Types 

5 - 72 SKF @ptitude Analyst and SKF Multilog On-line Systems 

 User Manual 

Spectrum / Envelope Alarm 

Use an envelope alarm overlay to display the envelope alarm assigned to the active 

POINT(s). 

To display an envelope alarm overlay: 

 With a spectrum plot displayed, select the View menu’s Plot / Plot Overlays / All 

Overlays option.  The All Overlays dialog displays. 

 Select Envelope Alarm and click OK. 

The generated envelope alarm remains in * EDIT * mode until you Save or Undo your 

settings using the plot’s context menu. 

Editing the Envelope Alarm 

After you have generated an envelope alarm, you can edit it graphically using your 

mouse, or enter numeric envelope parameters using the Set Frequency dialog. 

To graphically edit the envelope alarm: 

 While in edit mode, the plot window displays * EDIT * in each upper corner.  Move 

the mouse over the envelope alarm.  The cursor changes to an up arrow. 

 Click the mouse on the portion of the envelope alarm line to be edited.  A square 

icon identifies where the line will be drawn. 

 Drag the mouse to draw the line to create the new envelope alarm.   

Tip - You can use your keyboard’s Insert key to begin drawing the envelope alarm line.  

Then, use the arrow keys to move the line, and the Insert key again to stop drawing the 

line. 

 Right-click within the plot to display its context menu. 

 Select Save to save your envelope alarm settings and end * EDIT * mode, or select 

Undo to undo your settings. 

To edit the envelope alarm using numeric frequency ranges: 

 Click the Set Range button.  The Set Frequency dialog displays. 

 Enter the desired low frequency, high frequency, and level value. 

 Click OK.  The displayed envelope alarm automatically conforms to your entries. 

Feedback Area – Identifies the envelope alarm and POINT. 

Information Area – Specific information displays on the Envelope tab.  Tab information 

includes each frequency that pierced the envelope, FFT amplitude, and alarm amplitude.  

Additional overlay information displays on the Envelope tab. 

Right-Click Context Menu – Right-click on the envelope alarm overlay anchor to reveal 

its context menu.  Available options include: 

Next Trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from the plot. 

Keyboard Support – Press Enter to toggle to next trace.  Press Delete to remove. 
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Available Preferences 

Color – Alarm line color is configured in Danger / Colors in the Preferences 

dialog. 

Display Status – Display status (on or off) is configured in the Envelope 

Alarm - Spectrum / Plot Preferences in the Preferences dialog. 

 The default status is off. 

Spectrum / Linear Speed 

Use a linear speed overlay to graphically display the value of the linear factor multiplied 

by the running speed. 

To display linear speed overlay: 

 With a spectrum plot displayed, select the View menu’s Plot / Plot Overlays / All 

Overlays option.  The All Overlays dialog displays. 

 Select Linear Speed and click OK. 

Feedback Area – Displays amplitude, frequency, orders, and linear speed. 

Information Area - No tabs display for this overlay. 

Right-Click Context Menu - Right-click on the linear speed overlay anchor to reveal its 

context menu.   

Available options include: 

Next trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from plot. 

Settings – Launches the Linear Speed Settings dialog.   

Keyboard Support – Press Enter to toggle to next trace.  Press Delete to remove. 

Available Preferences 

Display Status – Display status (on or off) is configured in the Spectrum / 

Linear Speed / Plot Preferences in the Preferences dialog.  

 The default status is off. 

Spectrum / Frequency 

Use a frequency overlay to label POINTs’ assigned frequency set(s) for identification and 

analysis of bearing defects, etc. 

 The current POINT must have an assigned frequency set.  

To display a frequency overlay: 

 With a spectrum plot displayed, select the View menu’s Plot / Plot Overlays / 

Frequency option, or use the frequency toolbar button. 

Feedback Area – Displays the number of fundamental frequencies available for the 

POINT.  Displays individual frequency label, orders, each multiple’s amplitude and 

frequency. 
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When the mouse pointer is over a frequency label, that label’s amplitude and frequency 

values display feedback area’s second line. 

 The number of fundamental frequencies is not limited to the 

number of displayed frequencies. 

Information Area – Specific information displays on the FAM tab.  Tab information 

includes all displayed frequencies for active overlay, harmonic, frequency, orders, and 

amplitude values.  

Also included on the FAM tab is an Activity Index column.  The Activity Index displays 

the result of an HAI (Harmonic Activity Index) calculation, which quantifies the likelihood 

of defects at the FAM frequencies for the BPFO, BPFI, BSF, and FTF harmonics in the 

spectrum.  

A HAI value in the Activity Index column of 2.5 or greater indicates a likely defect 

pattern; HAI values of 3 or more show clear patterns. 

Right-Click Context Menu - Right-click on the frequency overlay anchor to reveal its 

context menu.  Available options include: 

Next trace – Toggles between traces when the plot is displaying more than 

one trace. 

Next Frequency – Advance to next frequency set. 

Previous Frequency - Return to previous frequency set. 

Remove – Removes the overlay from the plot. 

Settings – Launches Frequency Settings dialog. 

Keyboard Support – Press Enter to toggle to next trace.  Press Delete to remove the 

overlay.  Use the plus (+) and minus ( -) keys to cycle through the frequency sets for an 

individual POINT and return to original selection. 

Available Preferences 

Color – Frequency color is configured in Frequency  / Color Preferences in 

the Preferences dialog). 

Display Status – Display status (on or off) is configured in Frequency – 

Spectrum / Plot Preferences in the Preferences dialog. 

 The default status is off. 
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Frequency Settings Dialog 

Use the Frequency Settings dialog to enable / disable any or all frequencies for display 

on the current POINT’s plot. 

 

Figure 5 - 65. 

The Frequency Settings Dialog. 

To enable / disable frequencies: 

 Click the checkbox next to the frequency set to enable it for display.  Clear the 

checkbox to disable the frequency set. 

Display parameters fields include: 

Multiples - Enter number of multiples for each label. 

Bandwidth % - Enter bandwidth % for each label. 

 Settings are permanently saved with the POINT. 

 Click Show All to enable all frequencies for display, click Hide All to disable all 

frequencies for display. 

 Click OK to save changes, click Cancel to close dialog without saving changes. 
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Spectrum / Diagnostic Cursor 

Use a diagnostic cursor to let @ptitude Analyst compute and display all relevant 

harmonic series of the current spectrum, and rank all series found according to 

probability.  

 This option is only available with @ptitude Analyst CMSW 7400. 

To display a diagnostic cursor overlay: 

 With a spectrum plot displayed, select the View menu’s Plot Overlays / Diagnostic 

Cursor option, use the diagnostic cursor toolbar button, or press X on your 

keyboard. 

@ptitude Analyst uses a patented algorithm to distinguish between very probable and 

less probable harmonic series, and ranks all series found according to probability. 

The result is shown on the Diagnostics tab in the info area below the spectrum plot.  

The probability is expressed as an activity index, whereby values of 1.5 and higher 

indicate an increasing probability of a significant harmonic pattern.   

In addition, the algorithm compares the fundamental frequency of each series to any 

frequency associated with the POINT (e.g., bearing defect frequencies).  If a match is 

found, it displays the name of this frequency next to the related harmonic pattern. 

 

 

 

Figure 5 - 66. 

The Diagnostics Tab. 

 list of patterns ranked by probability 

 Activity Index (2.5 or greater indicates a likely defect pattern; 3 or more show 

clear patterns)  

 pattern matches BPFO 

Feedback Area – Displays the values for the currently shown harmonic series by activity 

index, fundamental frequency, and orders. 

Information Area – Specific information displays on the Diagnostics tab.  Tab 

information includes harmonic frequency, orders, and activity index for all relevant 

harmonic series, sorted by activity index.  Use the mouse or cursor keys to scroll 

through the list and display the highlighted series on the spectrum plot. 
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Right-Click Context Menu - Right-click on the diagnostic cursor overlay anchor to 

reveal its context menu.  Available options include: 

Next trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes the overlay from the plot. 

Keyboard Support – Press Enter to toggle to the next trace.  Press Delete to remove. 

Available Preferences  

Color - Cursor is the color of the next available cursor (as configured in Color 

Preferences in the Preferences dialog). 

Diagnostics Percentage – Configured in Diagnostic Percentage – 

Spectrum/Plot Preferences in the Preferences dialog.  Filters the list of 

harmonic patterns displayed, based on a percentage of the highest Activity 

Index detected in the spectrum.  (For example, if the highest Activity Index is 

3.5, a Diagnostics Percentage of 50% would filter out any harmonic patterns 

with an Activity Index below 1.75.) 

 The default percentage is 30%. 

Diagnostic Cursor – Configured in Diagnostic Cursor – Spectrum / Plot 

Preferences in the Preferences dialog. Determines whether the diagnostic 

cursor is on by default when a spectrum plot is displayed. 

 The default status is off. 

Waterfall / Single Cursor 

Use a single cursor to select a particular frequency across one or more spectra and 

toggle between open spectra. 

To display a single cursor overlay: 

 With a waterfall plot displayed, select the View menu’s Plot / Plot Overlays / Single 

Cursor option, or use the single cursor toolbar button. 

Feedback Area – Displays the amplitude and frequency for the selected spectrum line 

with a marker.  Displays the spectrum's name and date / time. 

Information Area – Specific information displays on the Waterfall tab.  Tab 

information includes selected spectrum line's amplitude and frequency, measurement 

date / time, and selected measurement details.  

Right-Click Context Menu - Right-click on the single cursor overlay anchor to reveal its 

context menu.  Available options include: 

Next POINT - Toggles between open POINTs  (with two or more POINTs 

active). 

Next / Previous Spectrum – Moves to next or previous spectrum for active 

POINT. 

Remove – Removes overlay from plot. 
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Keyboard Support – Press Enter to toggle to the next POINT.  Press Delete to remove.  

Use the left and right arrow keys to move to next / previous frequency in small 

increments (one line at a time).  Use the up and down arrow keys to move to next / 

previous spectrum for the POINT. 

 Use Shift and left and right arrow keys to move to next or 

previous frequency in larger increments (10 lines at a time).   

 In Palogram mode, the keys are reversed.  Use left and right 

arrow keys to move to next / previous spectrum, and up and 

down arrow keys to move to next / previous frequency. 

Available Preferences 

Color – Cursor is the color of the next available cursor (as configured in 

Cursor / Color Preferences in the Preferences dialog. 

Display Status – Display status (on or off) is configured in the Single Cursor - 

Waterfall / Plot Preferences in the Preferences dialog. 

 The default status is on. 

Waterfall / Band Cursor 

Use a band cursor to calculate and display the delta between two frequencies. 

To display a band cursor overlay: 

 With a waterfall plot displayed, select the View menu’s Plot / Plot Overlays / Band 

Cursor option, or use the band cursor toolbar button.  

Feedback Area – Displays the minimum and maximum frequency and delta for the 

active POINT. 

Information Area – Specific information displays on the Waterfall Band tab.  Tab 

information includes minimum and maximum frequency and delta for the active POINT.  

Right-Click Context Menu - Right-click on the band cursor overlay anchor to reveal its 

context menu.  Available options include: 

Next POINT - Toggles between open POINTs  (with two or more POINTs 

active). 

Remove – Removes overlay from plot. 

Keyboard Support – Press Enter to toggle to the next POINT.  Press Delete to remove.  

The band cursor is made up of three parts, the fundamental left line, fundamental right 

line, and the entire band.  The active line is indicated by the cursor line focus icon.  This 

icon displays as a triangle on the active part of the cursor.  Use left and right arrow keys 

to move the entire band or an individual line (depending on which is active) left or right.  

The Page Up and Page Down keys toggle between left line, right line, and entire band. 

 The individual fundamental lines and the entire band move in 

small increments (one line at a time).  Use the Shift and the left 

or right arrow key to move part or all of the band in larger 

increments (15 lines at a time). 
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Available Preferences 

Color – Cursor is the color of the next available cursor (as configured in 

Cursor / Color Preferences in the Preferences dialog.  Cursor line focus icon 

color appears as configured in Cursor Line Focus in Color Preferences in the 

Preferences dialog. 

Display Status – Display status (on or off) is configured in the Band Cursor - 

Waterfall / Plot Preferences in the Preferences dialog. 

 The default status is off. 

Polar Vector / Single Cursor 

Use a single cursor to display the magnitude and phase for FFT / phase data and to 

navigate between individual readings for a selected order. 

To display a single cursor overlay: 

 With a polar vector plot displayed, select the View menu’s Plot / Plot Overlays / 

Single Cursor option, or use the single cursor toolbar button. 

Feedback Area – Displays amplitude, phase angle, POINT name, and measurement 

date / time for cursor location. 

Information Area – Specific information displays on the Polar Vector tab.  Tab 

information includes POINT name, date / time stamp, amplitude, and phase angle. 

Right-Click Context Menu - Right-click on the single cursor overlay anchor to reveal its 

context menu.  Available options include: 

Next Trace - Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from plot. 

Keyboard Support – Press Enter to toggle to next POINT.  Press Delete to remove.  

Use the left and right arrow keys to move to next or previous reading (by date / time). 

Available Preferences 

Color – Cursor is the color of the next available cursor (as configured in 

Cursor / Color Preferences in the Preferences dialog. 

Display Status – Display status (on or off) is configured in the Single Cursor – 

Polar Vector / Plot Preferences in the Preferences dialog. 

 The default status is on. 



Displaying Graphic Plots 

Overlay Types 

5 - 80 SKF @ptitude Analyst and SKF Multilog On-line Systems 

 User Manual 

Polar Vector / Phase Alarm Cursor 

Use a phase alarm overlay to graphically display alarm levels for phase data.  Normal 

levels display inside small enclosed areas.  Alert levels are contained within a larger 

enclosed area.  Danger levels appear outside the enclosed area. 

To display a phase alarm overlay: 

 With a polar vector plot displayed, select the View menu’s Plot / Plot Overlays / All 

Overlays option.  The All Overlays dialog displays. 

 Select Phase Alarm and click OK. 

 Use the Customize menu’s Toolbar option to activate the phase 

alarm overlay toolbar button. 

Feedback Area– Displays POINT name and phase alarm. 

Information Area – Specific information displays on the Phase Alarm tab.  Tab 

information includes order number, start and end angle, and low and high amplitudes 

for enabled alarms (alert, danger, or both). 

Right-Click Context Menu - Right-click on the phase alarm overlay anchor to reveal its 

context menu.  Available options include: 

Next Trace - Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from the plot. 

Keyboard Support – Press Enter to toggle to next POINT.  Press Delete to remove.   

Available Preferences 

Color – Alarm colors configured in Danger and Alert / Colors in the 

Preferences dialog. 

Display Status – Display status (on or off) is configured in the Phase Alarm – 

Polar Vector / Plot Preferences in the Preferences dialog. 

 The default status is on. 

Mag / Phase / Single Cursor 

Use a single cursor to display amplitude and phase data in linear form for trending 

purposes.  Navigate by date / time and simultaneously analyze magnitude and phase 

data. 

To display a single cursor overlay: 

 With a mag / phase plot displayed, select the View menu’s Plot / Plot Overlays / 

Single Cursor option, or use the single cursor toolbar button. 

Feedback Area – Displays POINT name, date / time, amplitude, and phase. 

Information Area – Specific information displays on the Mag/Phase tab.  Tab 

information includes POINT name, date / time, amplitude, and phase. 
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Right-Click Context Menu - Right-click on the single cursor overlay anchor to reveal its 

context menu.  Available options include: 

Next Trace - Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from the plot. 

Keyboard Support – Press Enter to toggle to next POINT.  Press Delete to remove.   

Available Preferences 

Color – Cursor is the color of the next available cursor (as configured in 

Cursors / Color Preferences in the Preferences dialog. 

Display Status – Display status (on or off) is configured in the Single Cursor – 

Mag-Phase Trend / Plot Preferences in the Preferences dialog. 

 The default status is on. 

Time / Single Cursor 

Use a single cursor to analyze a time waveform’s amplitude and time data. 

To display a single cursor overlay: 

 With a time plot displayed, select the View menu’s Plot / Plot Overlays / Single 

Cursor option, or use the single cursor toolbar button. 

Feedback Area – Displays amplitude and time data for cursor’s location on the plot. 

Information Area – Specific information displays on the Time tab.  Tab information 

includes POINT name, amplitude, and time.  

Right-Click Context Menu - Right-click on the single cursor overlay anchor to reveal its 

context menu.  Available options include: 

Next Trace - Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from the plot. 

Keyboard Support – Press Enter to toggle to next POINT.  Press Delete to remove.   

Available Preferences 

Color – Cursor is the color of the next available cursor (as configured in 

Cursors / Color Preferences in the Preferences dialog. 

Display Status – Display status (on or off) is configured in the Single Cursor – 

Time / Plot Preferences in the Preferences dialog. 

 The default status is on. 
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Time / Harmonic Cursor 

Use a harmonic cursor to create and view a time interval’s harmonics. 

To display a harmonic cursor overlay: 

 With a time plot displayed, select the View menu’s Plot / Plot Overlays / Harmonic 

Cursor option, or use the harmonic cursor toolbar button.  

Feedback Area – Displays amplitude and time of fundamental left line and right line of 

cursor.  Displays interval in time and interval as a frequency. 

Information Area – Specific information displays on the Harmonic Cursor tab.  Tab 

information includes POINT name, left and right fundamental lines' amplitude and time, 

interval, frequency, and all visible harmonic labels.  

Right-Click Context Menu - Right- click on the harmonic cursor overlay anchor to 

reveal its context menu.  Available options include: 

Next Trace - Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from the plot. 

Keyboard Support – Press Enter to toggle to next POINT.  Press Delete to remove.  

The cursor is made up of three parts.  The fundamental left line, fundamental right line, 

and the entire cursor.  The active line is indicated by the cursor line focus icon.  This 

icon displays as a triangle on the active part of the cursor.  Use the left and right arrow 

keys to move the entire cursor or either individual line (depending on which is active) 

left or right.  The Page Up and Page Down keys toggle between selections of left line, 

right line, and entire cursor. 

 The individual fundamental lines and the entire cursor move in 

small increments (one line at a time).  Use the Shift and left and 

right arrow keys to move all or part of the cursor in larger 

increments (15 lines at a time). 

Available Preferences 

Color – Cursor is the color of the next available cursor (as configured in 

Cursors / Color Preferences in the Preferences dialog. 

Display Status – Display status (on or off) is configured in the Harmonic 

Cursor – Time / Plot Preferences in the Preferences dialog. 

 The default status is off. 

 The Time – Harmonic cursor's fill pattern lines slope downward 

from left to right to distinguish it from a Band cursor.  A Band 

cursor’s fill pattern lines slope upward left to right. 

 The default number of harmonics is 50. 
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Time / Band Cursor 

Use a band cursor to identify the time interval and amplitude delta. 

To display a band cursor overlay: 

 With a time plot displayed, select the View menu’s Plot / Plot Overlays / Band 

Cursor option, or use the band cursor toolbar button.  

Feedback Area – Displays amplitude and time of left and right fundamental lines and 

the delta (in time). 

Information Area – Specific information displays on the Time Band tab.  Tab 

information includes current position, amplitude, time, delta (frequency and time), 

positive and negative peak, RMS and time domain statistics for the time data shown 

within the band, including: 

Standard Deviation – A basic measure of the spread of values within a set 

around their average value. 

Skew – A measure of the asymmetry of the time domain values when plotted 

around their average.  Whereas the Standard Deviation suggests that values 

are homogeneously distributed left and right of their average, the Skew 

indicates whether this assumption is true. 

Kurtosis – A measure of the general extent of peaks.  A high value means that 

more of the variance is due to infrequent, extreme deviations as opposed to 

frequent, modest deviations. 

Crest Factor – A calculation of the highest absolute Peak / RMS value of the 

signal.  The Crest Factor is a measure of the general extent of peaks as 

compared to a pure sinusoid.  The crest factor for pure sinusoid is 1.41 (square 

root of 2). 

Right-Click Context Menu - Right-click on the band cursor overlay anchor to reveal its 

context menu.  Available options include: 

Next Trace - Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from the plot. 

Keyboard Support – Press Enter to toggle to next POINT.  Press Delete to remove.  

The band cursor is made up of three parts.  The fundamental left line, fundamental 

right line, and the entire band.  The active line is indicated by the cursor line focus icon.  

This icon displays as a triangle on the active part of the cursor.  Use left and right arrow 

keys to move the entire band or an individual line (depending on which is active) left or 

right.  The Page Up and Page Down keys toggle between the left line, right line, and 

entire band. 

 The individual fundamental lines and the entire band move in 

small increments (one line at a time).  Use the Shift and the left 

or right arrow key to move part or all of the band in larger 

increments (15 lines at a time). 
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Available Preferences 

Color – Cursor is the color of the next available cursor (as configured in 

Cursors / Color Preferences in the Preferences dialog.  Cursor line focus icon 

color appears as configured in Cursor Line Focus in Color Preferences in the 

Preferences dialog. 

Display Status – Display status (on or off) is configured in the Band Cursor – 

Time / Plot Preferences in the Preferences dialog. 

 The default status is off. 

Cursor Cross Hashing – Cross-hashing (on or off) is configured in the Cursor 

Cross-Hashing – Time / Plot Preferences in the Preferences dialog.  

Determines whether the band is shaded with a single diagonal line or a cross-

hash.  

 The Time – Band cursor’s fill pattern lines slope upward from left 

to right to distinguish it from a harmonic cursor.  A harmonic 

cursor’s fill pattern lines slope downward from left to right.  Cross 

hashing can be useful to help further distinguish a time band 

cursor from a harmonic band cursor.   

Time / Peak Cursor 

Use a peak cursor overlay to label all peaks above a set amplitude value. 

To display a peak cursor overlay: 

 With a time plot displayed, select the View menu’s Plot / Plot Overlays / Peak 

Cursor option, or use the peak cursor toolbar button. 

Feedback Area – Displays the line's current amplitude, total number of peaks displayed, 

and the peak number, amplitude, and time for as many displayed peaks as space allows. 

Information Area – Specific information displays on the Peak tab.  Tab information 

includes POINT name, line amplitude, and each peak number's time and amplitude.   

Right-Click Context Menu - Right-click on the peak cursor overlay anchor to reveal its 

context menu.  Available options include: 

Next Trace - Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from the plot. 

Keyboard Support – Press Enter to toggle to next POINT.  Press Delete to remove.   

Use the up and down arrow keys to increase / decrease the amplitude range in small 

increments (1% at a time).  Use the Shift and up and down arrow keys to increase / 

decrease the amplitude range in larger increments (10% at a time). 

Available Preferences 

Color – Cursor is the color of the next available cursor (as configured in 

Cursors / Color Preferences in the Preferences dialog. 
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Display Status – Display status (on or off) is configured in the Peak Cursor – 

Time / Plot Preferences in the Preferences dialog. 

 The default status is off. 

Time / Linear Speed 

Use a linear speed overlay to graphically display the value of the linear factor multiplied 

by the running speed. 

To display linear speed overlay: 

 With a time plot displayed, select the View menu’s Plot / Plot Overlays / All 

Overlays option.  The All Overlays dialog displays. 

 Select Linear Speed and click OK. 

Feedback Area – Displays amplitude, frequency, orders, and linear speed. 

Information Area - No tabs display for this overlay. 

Right-Click Context Menu - Right-click on the linear speed overlay anchor to reveal its 

context menu.   

Available options include: 

Next trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from plot. 

Keyboard Support – Press Enter to toggle to next trace.  Press Delete to remove. 

Available Preferences 

Display Status – Display status (on or off) is configured in the Time / Linear 

Speed / Plot Preferences in the Preferences dialog.  

The default status is off. 

Time / CTA  

Use a CTA cursor to create and view a time interval’s average waveform. 

To display a CTA cursor overlay: 

 With a time plot displayed, select the View menu’s Plot / Plot Overlays / CTA 

Cursor option, or use the CTA cursor toolbar button.  

Feedback Area – Displays amplitude and time of fundamental left line and right line of 

cursor.  Displays interval in time and interval as a frequency. 

Information Area – Specific information displays on the CTA Cursor tab.  Tab 

information includes POINT name, left and right fundamental lines' amplitude and time, 

interval, frequency, and all visible harmonic labels.  

Right-Click Context Menu - Right- click on the CTA cursor overlay anchor to reveal its 

context menu.  Available options include: 

Next Trace - Toggles between traces when the plot is displaying more than 

one trace. 



Displaying Graphic Plots 

Live Data Displays 

5 - 86 SKF @ptitude Analyst and SKF Multilog On-line Systems 

 User Manual 

Remove – Removes overlay from the plot. 

Keyboard Support – Press Enter to toggle to next POINT.  Press Delete to remove.  

Use the plus (+) and minus (-) keys to select the next or previous frequency. 

The cursor is made up of three parts.  The fundamental left line, fundamental right line, 

and the entire cursor.  The active line is indicated by the cursor line focus icon.  This 

icon displays as a triangle on the active part of the cursor.  Use the left and right arrow 

keys to move the entire cursor or either individual line (depending on which is active) 

left or right.  The Page Up and Page Down keys toggle between selections of left line, 

right line, and entire cursor. 

 The individual fundamental lines and the entire cursor move in 

small increments (one line at a time).  Use the Shift and left and 

right arrow keys to move all or part of the cursor in larger 

increments (15 lines at a time). 

Available Preferences 

Color – Cursor is the color of the next available cursor (as configured in 

Cursors / Color Preferences in the Preferences dialog. 

Display Status – Display status (on or off) is configured in the Harmonic 

Cursor – Time / Plot Preferences in the Preferences dialog. 

 The default status is off. 

 The Time – CTA cursor displays differently from the Time – 

Harmonic cursor.  Instead of a cross hatch between two markers, 

the CTA cursor displays the averaged waveform (per CTA 

calculation), allowing you to isoloate the various sources 

contributing to the signal. 

 The default number of harmonics is 50. 

Live Data Displays 

@ptitude Analyst’s Live Data Displays allow you to view a POINT's live data in various 

graphical formats.  When Live Data mode is enabled, the active display updates as new 

data is collected by its on-line device. 

 Live data display is only available when a single POINT is selected. 

When live data mode is enabled, displayed measurements automatically update on a 

continuous basis.  Previous spectra and time waveform plots are overwritten by 

updated spectra / time waveforms.  

To display live data: 

 Select a POINT from the hierarchy list. 

 Display the desired plot type using the View menu's Plot options, or the plot type 

toolbar buttons.  The selected plot displays in its plot window. 

 Click the Live Data toolbar button to initiate live data mode, or select the View 

menu’s Plot / Live Data option. 
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The plot window initially displays * WAITING LIVE * in the upper corners and displays 

"Waiting for live data for the plot" in the center.   

Once live data is available, the plot window displays  

* LIVE * in its upper corners and the live data appears in the selected graphical format. 

 

Figure 5 - 67. 

A Spectrum Plot Window Displaying Live Data. 

Spectrum and Time Waveform Plots 

As the POINT's DAD collects new data, the new data overwrites the existing data on the 

spectrum and time plots. 

Trend Plot 

The trend plot in live data mode “grows” from the bottom of the overall trend plot with 

each new DAD data collection.  When the overall Trend plot fills the overall trend plot, a 

First In First Out process begins, in which the oldest data moves off the display to make 

room for the most recent data.Spectrum Waterfall Plot 

Instead of overwriting previous FFT spectra with each update, live data waterfall plots' 

previous spectra scroll up the spectrum display window with each update, creating a 

waterfall spectra display.  

Polar Vector Plots 

An on-line polar vector display can also go “live”.  However, unlike non-live polar vector 

displays, with live displays, only the POINT's current value is displayed and updated 

every few seconds, no historical data appears.   

Alarm criteria remains assigned to the displayed POINT.  The line segment (vector) that 

includes the hollow circle as its endpoint shows the selected harmonic's current 

magnitude and phase.  This vector’s magnitude and direction (phase) update every few 

seconds. 
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Saving Live Data 

Live data may be saved either to the POINT or to a live data set in your hierarchy. 

To save live data: 

 Right-click in the live data plot window to display the plot’s context menu. 

 Select Save Live Data.  The Save Live Data dialog displays. 

The Save Live Data dialog allows you to specify which measurements to save and 

where you'd like to save their live data. 

Measurements 

 Click to select Save last measurement or Save all measurements. 

Location 

 Save data to POINT – Select this option to save the live data to the POINT.  Live 

data is saved to the POINT itself and may be viewed when the POINT is selected in 

the hierarchy. 

 Save data to live data location – Select this option to save the live data to a LIVE 

DATA SET in the hierarchy.  The first time this option is selected, a new SET named 

LIVE DATA is created in the hierarchy.  When this option is selected, the live data, 

along with the machine name, date / time stamp, and a copy of the POINT are 

stored in the LIVE DATA SET.  The live data is not saved directly to the original 

source POINT. 

Live Bar Display 

@ptitude Analyst’s Live Bar Display allows you to display live overall values in bar graph 

format for DMx POINTs.  

Live bar data is useful when checking or replacing a sensor.  If a sensor is faulty, it 

produces an out of range voltage value.  By observing the live bar data, you can quickly 

tell if a sensor is functioning properly. 

To display live bars: 

 Select the Hierarchy, ROUTE, or Workspace containing POINTs that have been 

downloaded to the online device. 

 Click the Live Bars toolbar button, or select the View menu’s Plot / Live Bars 

option. 

A Live Bars window displays with two panels.  The left panel displays the current 

Hierarchy, ROUTE, or Workspace, containing only POINTs that have been downloaded 

to the online device(s).   

 Click a POINT’s checkbox to display its live bar data in the window’s right panel. 
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Figure 5 - 68. 

The Live Bars Display. 

Each selected POINT’s overall data displays in bar graph format.  The Customize / 

Preferences dialog’s Plot tab allows you to select the scaling for the graph using the 

Live Bar Axis value.  Available options include: 

POINT Full Scale (default value) 

Alarm Limit – Alert 

Alarm Limit – Danger 

Autoscale 

For positive values, the graph is scaled from zero to the live bar axis value.  For negative 

values, the scaling varies, depending on the selected Live Bar Axis value: 

If Autoscale is selected with a negative value, the scale will change to negative with the 

zero setting on right-hand side. 

If POINT Full Scale or an Alarm Limit is selected with a negative value, the scale 

changes to bipolar with zero in the middle of the graph, and +/- the full scale value on 

either side.   

 The graph remains bipolar, even if the value returns to positive. 

The bar graphs display the POINTs’ overall alarm levels.  By default, red icons 

graphically indicate the POINT’s danger alarm value, and yellow indicates the alert 

alarm value.  Arrows within these icons indicate if the alert or danger area is to the right 

or left.  The arrow positions depend on the POINT’s overall alarm properties.  If the 

POINT’s overall alarm is a Level alarm, the live bar graph’s arrows point to the right 

because the value is considered “clear” if is it to the left of the alert and danger alarm 

values, as indicated by the yellow and red icons.  If the POINT’s overall alarm is In 

Window, the arrows point from the outside toward the inside.  If the POINT’s alarm is 

Out of Window, the live bar graph’s arrows point from the inside to the outside.  The 

actual bars on the graph also display according to alarm values.  By default, the POINT’s 

alarm value displays green when “clear”, yellow for “alert,” and red for “danger.” 

 The Preferences dialog’s Colors tab allows you to change colors 

of items appearing in graphic display plots and in the colors of 

alarm indicators (on hierarchy lists and in graphic displays). 
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Live Bar Messages 

If no new data has been collected for a POINT for more than a specified number of 

minutes, the displayed data is considered “aged data,” and the POINT’s name and 

overall value display in light blue text within the POINT’s bar graph.  By default, this 

value is thirty minutes, and the text displays in light blue.  You can customize the Data 

Aged Time (Minutes) in the Preferences / Plot tab, and change the text color in the 

Preferences / Colors tab. 

An error message displays if no live data is available for the selected POINT(s).   

An “(OV)” displays in a POINT’s bar graph if the device has an overloaded signal. 

The word “(LATEST)” displays in the bar graph with the most recent data.  In most 

cases, data is collected in sequence, but if you have POINTs from multiple IMx / DMx 

selected, data may be collected out of order.   
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Generating and Printing SKF @ptitude Analyst Reports 

Overview 

 The File menu's Print option or the toolbar's Print button may be 

used at any time to print the contents of the “active” @ptitude 

Analyst window (including graphic display windows). 

 Microsoft Internet Explorer version 4.X or newer is required to 

view reports. 

@ptitude Analyst’s Reports feature provides options for controlling the generation and 

printing of hard copy reports showing database and measurement information.   

Exception - Produces a report of POINTs in violation of specified exception 

criteria. 

History - Produces a report of machine notes. 

Last Measurement - Reports POINTs’ last measurement values. 

Overdue - Produces a report of all POINTs that are overdue for measurement. 

ROUTE Statistics - Produces a report of statistics for one or more ROUTEs.  

Statistics include when due, last downloaded, total number of POINTs in the 

ROUTE.   

ROUTE History Report - Produces a report of ROUTE history for the selected 

ROUTEs.  ROUTE History reports include ROUTE collection time duration, and 

start and stop times.  The amount of reported ROUTE historical information is 

determined using the ROUTE Properties / General tab.  

SET Statistics - Produces a report of statistics for the selected data source.  

The statistics include total number of POINTs, POINTs in alarm, POINTs 

disabled, and POINTs overdue. 

Transient – Produces a report of start-up or coast down data for the selected 

transient events.  

Upload Statistics – Produces a report of the statistics for information last 

uploaded from the DAD. 

 Each of @ptitude Analyst’s report types may be customized.  

Report setup is discussed later in this chapter. 
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Reports Window 

 Select the File menu’s Reports option.  The Reports window displays. 

The Reports window allows you to select, configure, manage, and generate reports.  

Each report type is available for use and may also be used as a starting point to 

customize reports to fit your particular application. 

 Reports may also be generated automatically using the Scheduler 

feature.  Refer to Chapter 3, Working With Your SKF @ptitude 

Analyst Hierarchy for more information on scheduling automatic 

reports. 

Use the Reports window to work with existing reports and to create new report 

templates.  The top area provides options for new and current reports.  The bottom 

area provides options for preserved (archived) reports. 

 

Figure 6 - 1. 

The Reports Window. 

Select report area - Displays all existing report definitions. 

 Click a report’s name to select it.   
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Reports options include: 

Generate – Generates a report to the computer display based on the selected report 

definition. 

View – Displays the latest generated version of the selected report. 

Add – Defines a new report based on a pre-defined @ptitude Analyst template. 

Copy – Defines a new report using the selected custom report as a template. 

Edit – Launches the Report Editor window to edit the selected report. 

Remove – Deletes the selected report definition.  When you delete a report from the 

window's top area, you are asked if you also want to delete all preserved historical 

reports for the selected report definition. 

 When a report is removed, its corresponding subdirectory and all 

included files are also removed from your computer’s hard drive.  

If you wish to delete a report, but save previous copies, copy the 

report’s files from its subdirectory to a new location on your hard 

drive before removing the report. 

History area – Displays all existing preserved reports for the selected report definition. 

 Refer to the Report Editor / General section later in this chapter 

for more information on preserving historical reports. 

 Click a preserved report's name to select it. 

View – Displays the preserved version of the selected report, identified by its date and 

time. 

Send – Launches the Recipient Selection dialog and allows you to send the report in 

an email message to one or more selected contacts or groups of contacts.  The report is 

sent in HTML and PDF format to the selected email recipients.  

 Refer to the SKF @ptitude Analyst Introduction and Global 

Features User Manual, Chapter 2, Getting Around in @ptitude 

Analyst / Contact Information section for details on how to set up 

contacts and groups. 

Rename – Allows you to rename the selected preserved report.  The Enter Name 

dialog displays, prompting you to enter the new report name.  Click OK to rename the 

selected report. 

Remove – Removes the selected preserved report. 

Close – Closes the window. 

To generate a @ptitude Analyst Report: 

 Open the Hierarchy window whose data you wish to report.  If necessary, open or 

select hierarchy items within the window to limit the report’s content. 

 Select the File menu’s Reports option.  The Reports window displays. 

 Select a report from the Reports window’s Select report area. 

 Click the Generate button.  The report is rendered and when complete, displays in 

a report window for viewing or printing. 
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 Report generation progress displays in the progress bar in the 

screen’s lower right corner. 

 When setting up a report, there is an option to select the data 

source at the time the report is generated.  If this has been 

selected, the Select Data Source dialog displays.  Refer to the 

Selecting the Data Source section, later in this chapter, for 

details. 

 If your report is based on transient data and there is more than 

one transient data set available, the Select Transient Data 

Source dialog displays.  Select the desired transient event from 

the list. 

 The Plot Preferences Channel Number option determines how 

you specify which channel(s) to include when viewing plots with 

multi-channel data.  This option also applies to plots in reports.  

Be aware that if this preference is set to Ask and there are 

multiple plots in your report, you will receive a channel prompt for 

each plot, but the prompts do not indicate to which plots they 

correspond.  If you have a large number of plots in your reports, 

consider selecting the All channels option for this preference to 

avoid multiple prompts.  If you do have this set to Ask, it is 

recommended you make the same selection for all plots in the 

report to avoid confusion. 

 Press your keyboard’s End key to go to the end of the report. 

 Press your keyboard’s Home key to go to the top of the report. 

To print a generated report: 

 With the generated report on the computer’s display, use the Print toolbar button 

or select the File menu’s Print option.   

To view an existing report:  

 In the Reports window, select the desired report. 

 Click the View button.  The report displays in a Report window and is available for 

viewing and/or printing. 

Use the Reports window to “add” a customized report type.  Customized reports are 

based on pre-defined report types, then modified to suit your particular application.  

Once your new report type is defined, it is available for selection from the Reports 

window, and may be generated as needed. 

To add a new report: 

 Click the Report window’s Add button.  The Select Report Template dialog 

displays. 

The Select Report Template dialog displays all pre-defined @ptitude Analyst report 

templates.  These templates may be used to generate reports without further 

modification, or as a starting point for creating custom reports. 

 Select the template to use as a basis for your new report. 
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 If you wish to use the selected report “as is,” (no modifications are 

required) assign the report a unique name, verify the path 

settings, and click the OK button to accept all default settings. 

 Click OK.  The Report Editor window displays. 

Report Editor 

The Report Editor window contains three tabs: 

General – Defines the new report’s identity and processing parameters. 

Definition – Defines the new report’s criteria, criteria settings, and content. 

Assign – Allows you to configure default report configurations for both public and 

hierarchy-specific reports. 

Report Editor / General 

Report Editor / General tab fields include: 

Name – Using standard file naming conventions, assign the new report a unique name.  

Do not use the pound sign (#) in your report name as it can cause errors when printing.  

The assigned name identifies the most recently generated report and is used to name 

the disk directory (folder) where the report and all its supporting files are stored.  If you 

maintain historical reports, a separate directory is created beneath the report's directory 

identified by the historical report's name. 

The assigned name identifies the report and is used to name the disk directory where 

the report and all its supporting files are stored. 

If you change a report’s name, all data for the previously generated report remains in 

the subdirectory with the original report’s name.  The original report subdirectory 

cannot be deleted using @ptitude Analyst. 

Title – Enter a descriptive title for the report.  This text appears at the top of the 

generated report. 

Description – Enter descriptive text for the report.  This text appears as the title at the 

top of the generated report. 

Header – Enter text to display in the printed report’s header area. 

Footer – Enter text to display in the printed report’s footer area. 

Preserve Reports – Click to enable report preservation.  When enabled, newly 

generated reports are archived, organized by report definition and date / time. 

Report is Available for all users – Click to enable and define the report as a public 

report, available to all @ptitude Analyst users.  If you do not check this option, the 

report is defined as a private report, available only to the report creator. 

Report is Available for all hierarchies – Click to enable and make the report available 

for use with all @ptitude Analyst hierarchies.  If you do not check this option, the report 

will only be available to the current hierarchy. 

Report can specify data sources from multiple hierarchies – Click to enable and 

make the report available for use with all @ptitude Analyst hierarchies, as well, as 
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enable the ability to select multiple data sources from multiple hierarchies.  If you do not 

check this option, the report will only be available using a single hierarchy source. 

Report Editor / Definition 

The Report Editor / Definition tab is divided into two main areas, the Select report 

criteria area in the tab's left panel and the criteria setup panel on the right.  Click an 

item to expand and view any sub-items available for configuration.   

 

Figure 6 - 2. 

The Report Editor / Definition Tab. 

Select report criteria – Select attributes to appear in the report.   

Criteria setup (contents change depending upon item selected in left panel) – 

Allows you to configure the selected report criteria to determine report content.  

To select an element to include in the report: 

 Highlight the item and click the item’s checkbox to include it in your report.  Once 

selected, the item's input fields (if any) display in the tab’s right panel.  Available 

report elements are detailed in the Report Criteria section later in this chapter. 

 Click the item's + icon to expand the item in the hierarchy list and view its additional 

configuration options. 
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 Click an additional configuration item to select it.  When selected, the additional 

item's set up fields display in the Criteria Setup area, allowing you to further 

customize the report.  Available setup fields are detailed in the Criteria Setup 

Fields section later in this chapter. 

Report Criteria 

The following items display in the Select report criteria area as top-level items.   

Alarms - Select individual alarm conditions and types to include in the report. 

Last Measurement - Select to include all POINTs in the report with a last 

measurement. 

Overdue/Noncompliant – Specify the amount of overdue POINTs to include in 

the report. 

Priority – Includes any Machine with a set priority matching your selection(s). 

Inspection / Upload Statistics – Select one or more alarm conditions (Clear, 

In alert, In danger); select the columns, date range and type of notes to include. 

Check Upload Statistics to include a summary of the last data upload from the 

DAD. 

Work Notification – Select to include all work notifications, a fixed number of 

them, or select a date or date range. Specific ROUTEs and work request 

statuses can be selected for the report.  

SET Statistics – Select to include a summary of the hierarchy item and all its 

children. 

ROUTE Statistics – Select to include a summary of ROUTE data collection 

status for each ROUTE included in the report. 

History – Select to include all machine notes and images for any machine in 

the selected data source. 

Measurement Statistics – Select to include a summary of statistical 

information for a selected measurement type (selected by the Full Scale Units 

setting) and alarm threshold (selected by the Threshold Level setting).  This 

setting includes the average amplitude for last measurement data of the 

specified measurement type, and indicates all POINTs with an amplitude above 

the specified alarm threshold in the report. 

Collection Status - Select to include a summary of the ROUTE activities and 

its POINTs’ status. Include all collection activities, a fixed number of them, or 

select a date or date range. You can choose to show only missed or uncollected 

POINTs. 

Route History – Specify the amount of historical ROUTE information to include 

in the report. 

 The Include records by comparing options under Route History are 

only applicable to the date range settings.  They further filter the 

range based on start time, end time, or both. 

Compliance – Select ROUTEs on which you wish to report a summary of 

compliance status, and specify to report status for either the previous collection 
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interval (previous compliance) or the current collection interval (current 

compliance).  You may also specify to list all missed or out of compliance 

POINTs for the specified ROUTEs and to exclude interval-based POINTs. 

Transient – Select to include transient data and specify the phase order (1 – 

4). 

Criteria setup (right panel setup fields, dependent upon item select in left panel) 

Columns – Use the Columns input area to specify which columns appear in report 

tables, to specify column order, and select column sort criteria. 

Available columns – Displays all available columns for the selected report 

element.  

Included columns – Displays all included columns for the selected report 

element. 

To include / exclude columns: 

 Click the column type to select it. 

 Use the Include / Exclude buttons to move the selected column to the 

Included columns area to include in the report, or move the selected 

column to the Available columns area to exclude it from the report. 

To specify column order: 

 Click the column type in the Included columns area. 

 Use the Up and Down buttons to place the column into the desired 

position. 

To specify sort criteria: 

 Select a column type from the Sort on drop down list box. 

 Click the desired sort method button, Ascending or Descending. 

 Click the Set All button to use the current column settings for all matching 

column types in other report element setup fields.  For example, the same 

column settings are available for various report elements.  The Set All 

feature allows you to configure this information once and then use the 

same settings for all applicable report elements. 

 Click OK to save changes, or Cancel to undo settings. 

Date Range – Use the date range fields to specify a date interval.  This date interval is 

used to retrieve only POINTs with a last measurement that falls within the indicated 

date interval. 

Only include enabled POINTs – Select (check) to have the applicable report 

criterion retrieve data from enabled POINTs only. This checkbox can be 

selected or not selected (checked or not checked) by default and may or may 

not be editable depending on the selected report criterion. 

 For Alarms and Overdue/Non-compliant criteria – This checkbox 

is selected (checked) by default and is read-only. Thus, these 

criteria will always retrieve data from enabled POINTs only for 

reporting. 
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 For Last Measurement, Inspection, and Measurement 

Statistics criteria – This checkbox is not selected (not checked) by 

default and is editable. Thus, by default these criteria will retrieve 

data from all POINTs for reporting, but you can select (check) this 

checkbox to have them retrieve data from enabled POINTs only. 

No date range restriction – Select to remove date range restrictions. 

Absolute date – Enter “absolute” (calendar) dates for date range restriction. 

Relative date – Enter number of days (from / to) for date range restriction. 

 Click the Set All button to use the current date range settings for all date 

range settings in other report element setup fields.  The Set All feature 

allows you to configure this information once and then use the same 

settings for all applicable report elements. 

General – Use the General fields to configure general report element information. 

Include image – Click to enable and include any images associated with the 

selected report element. 

Grouped by machine – Click to enable and display included report items 

grouped by machine. 

Plots – Use the Plots fields to specify which plot types are to be included with the 

report table for the selected report item. 
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Figure 6 - 3. 

The Report Editor Screen. 

Include plot information tables – Click to enable and include plot content 

details and overlay information in table format on the report. 

Plots area - Displays all available plots.  Click a plot type to include it in the 

report. 

 Selected plots are created only if there is associated data. 

Overlays area – Displays overlays associated with the selected plot type (if 

applicable). 

 Click the Set All button to use the current plot and overlay settings for all 

matching plot and overlay types in other report element setup fields.  For 

example, the same plot settings are available for various report elements.  

The Set All feature allows you to configure this information once and then 

use the same settings for all applicable report elements. 

Measurement History – Use the Measurement History fields to specify which 

measurements to include in the report. 

Last fixed number of measurements – Select this option and type in or use 

the arrow buttons to specify the fixed number of measurements to include in 

the report. 
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Measurements in this date range – Select this option to include all 

measurements occurring between your entered date interval in the report.  

Type in a start date in the From field and an end date in the To field, or use 

the arrow buttons to display a pop-up calendar to select start and end dates. 

Measurements from the last fixed number of days – Select this option to 

include measurements occurring within a specific number of days in the report.  

Type in or use the arrow buttons to specify the fixed number of days. 

All measurements – Select this option to include all measurements in the 

report. 

Notes – Use the Notes fields to specify which notes to include in the report. 

Note Categories – Click to enable and include one or more note categories for 

the selected report item in the report.  Note categories include ACK Alarm 

Note, Coded Note, General Note, Non-Collection, Oil Analysis Note, and 

Operating Time Reset.  

Settings area – Use the settings area to define which notes to include in the 

report. 

Last fixed number of notes – Select this option and type in or use 

the arrow buttons to specify the fixed number of notes to include in 

the report. 

Notes in this date range – Select this option to include all notes 

occurring between your entered date interval in the report.  Type in a 

start date in the From field and an end date in the To field, or use the 

arrow buttons to display a pop-up calendar to select start and end 

dates. 

Notes from the last fixed number of days – Select this option to 

include notes occurring within a specific number of days in the report.  

Type in or use the arrow buttons to specify the fixed number of days. 

All notes – Select this option to include all notes in the report. 

Routes – Use the ROUTEs  fields to specify which ROUTEs to include in the report. 

Routes – All available ROUTEs display in the ROUTEs area.  Click to select one 

or more ROUTE.   

 Click Check All to select all available ROUTEs.  Click Clear All to clear your 

selections. 

 Click the Set All button to use the current ROUTE selections in other 

report element setup fields.  The Set All feature allows you to configure 

this information once and then use the same settings for all applicable 

report elements. 

Overdue Forecast – Use the Overdue Forecast option to forecast which POINTs will be 

overdue for collection if data for the POINTs does not come in by a specified date.   

Absolute date in the future – Select this option to forecast based on a fixed 

date.  This is useful if the report will be run over the course of several days 

leading up to a fixed deadline.  Select the date from the pop-up calendar. 
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Number of days from today – Select this option to forecast based on a 

specified number of days from the date the report is run.  Enter a number in 

the text field or use the up and down arrows to indicate the number of days 

from now for use with the forecast. 

Report Editor / Assign 

Use the Report Editor window's Assign tab to configure default report settings, and to 

override defaults when the report is generated from the current Hierarchy. 

The Assign tab varies, depending on whether Report is available for all hierarchies or 

Report can specify data sources from multiple hierarchies is enabled on this 

window’s General tab. 

 

Figure 6 - 4. 

The Report Editor / Assign Tab with Report is available for all hierarchies Disabled. 
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Figure 6 - 5. 

The Report Editor / Assign Tab with Report is available for all hierarchies Enabled. 
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Figure 6 - 6. 

The Report Editor / Assign Tab with Report can specify data sources from multiple hierarchies 

Enabled. 

The tab provides fields to configure default report settings.  Options include: 

Report Location – Specify the path for the disk directory for report storage.  The report 

is stored in a subdirectory (using the report’s name) beneath this indicated directory.  

For example, specify E:\SKF @ptitude Analyst\Reports to place all reports in their 

unique directories branching from a “reports” directory. 

 Click the Browse button to specify a new path. 

 Reports are stored in HTML format and are available for copying, 

moving, and sharing over intranet, world wide web, etc. 

Data Source – Select the source of the data to include in the report.  Use the plus and 

minus icons to expand the hierarchy as needed to display sub-items. If Report can 

specify data sources from multiple hierarchies is disabled, options include: 

Selected Node – Select to include data from the node that is selected in the 

hierarchy at the time the report is generated, including all sub items. For 

example, if a SET is selected in the hierarchy when the report is generated, all 

POINTs from all Machines under that SET are included. 

 Use this option when including Transient data in your report. 

Current Hierarchy – Select to include all data from the hierarchy that is open 

when the report is generated. 
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Primary Hierarchy - Select to us the currently selected primary hierarchy as 

the report's data source. 

Last Uploaded – Select to include the most recently uploaded data. 

ROUTEs / Workspace – These options appear in the upper section’s Data 

source list if the report is only available for this hierarchy (i.e., Report is 

available for all hierarchies is disabled).  Select a previously defined ROUTE 

or Workspace to use with the report. 

 ROUTE based reports, such as ROUTE Statistics, ROUTE History, 

Compliance, and Collection Status, use data from the ROUTEs 

specified on the Definition tab, rather than the source data 

specified on the Assign tab.  

If Report can specify data sources from multiple hierarchies is enabled, options 

include: 

Selected Node – Select to include data from the node that is selected in the 

hierarchy at the time the report is generated, including all sub items. 

 Use this option when including Transient data in your report. 

Select Data Source - Select multiple hierarchies, groups, and POINTs to 

include in your report. 

Define title, data source, and/or history name at time of generation – Enable to 

receive an option to override the Data source selection at the time the report is run.  If 

this is enabled, you must manually specify this report information each time the report 

is generated.  Before report generation occurs, the Select Data Source dialog displays, 

prompting you to enter report information and select the report’s data source.  (See 

Selecting the Data Source below for details.) 

If the Report is available for all hierarchies check box is enabled on the Report 

Editor’s General tab, the tab's bottom area allows you to configure reports specifically 

for use with the current Hierarchy only.  If you do not use the bottom area's 

configuration options, the default configuration from the tab's top section is used. 

 You must edit the report in each hierarchy where you wish to 

override the default options.   
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The top line of this section displays the current hierarchy name and indicates whether 

the default settings are used, or if custom overrides have been established in the fields 

below. 

 

Figure 6 - 7. 

The Report Editor / Assign Tab’s Default / Custom Line. 

 hierarchy name 

 default / custom 

The remaining fields function as previously described.  These settings will be used to 

generate the selected report type for the current Hierarchy only. 

 Click the Use Defaults button to clear your custom configuration and return to all 

default settings. 

Selecting the Data Source 

If Define title, data source, and/or history name at time of generation is enabled on 

the Report Editor’s Assign tab, the Select Data Source dialog appears when the 

report is generated. 

The Select Data Source dialog varies, depending on whether Report can specify data 

sources from multiple hierarchies is enabled on the Report Editor’s General tab. 
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Figure 6 - 8. 

The Select Data Source Dialog. 

 

Figure 6 - 9. 

The Select Data Source Dialog when Report can specify data sources from multiple hierarchies is 

Enabled on the Report Editor’s General Tab. 
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This dialog lets you configure the report title, specify whether to preserve a copy of the 

generated report, and specify the data source for this instance of the report.   

 The data source defaults to the Data source setting on the 

Report Editor’s Assign tab. 

 In the Report title field, enter the report title. 

 Click the Preserve report checkbox to enable report preservation.  When enabled, 

newly generated reports are archived, organized (by default) by report definition 

and date / time. 

If Preserve report is enabled, you can also manually enter a History name to use 

when organizing your preserved reports, instead of the default date / time naming 

method.  The History name determines how the reports are organized, and how they 

display in both the Report Editor / General’s History window, and in the separate 

preserved reports directory created in the disk directory (folder) designated as the 

report storage location.  The History name field displays “[Date] [Time]” until you type 

in the field.  If you do not type within the History name field, the preserved report is 

named and organized by its date / time. 

To assign a manual history name: 

 In the History name field, enter text to identify and organize your preserved 

reports, overriding the default date / time history name.   

To select the report’s data source: 

 From the Select data source for report window, click to select the appropriate 

data source from the displayed hierarchy list.   

 Use the plus and minus icons to expand the hierarchy as needed 

to display sub-items. 
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Multilog DMx Machine Monitoring Module 

Overview 

The Intrinsically Safe SKF Multilog DMx Machine Monitoring module is designed to 

provide machine monitoring and protection in safe and hazardous areas.  Data that is 

collected by DMx modules deployed in the plant can be brought into @ptitude Analyst 

for analysis and alarming purposes. 

Most standard @ptitude Analyst features and functionality also apply to the DMx.  

(Refer to the appropriate sections, earlier in this manual, for details.)  This chapter 

describes setup and functionality that is specific to the DMx.  

 Where possible, DMx information is included in the related 

manual sections.  For help locating specific information, refer to 

the index. 

 DMx transient data setup and collection is documented in 

Chapter 8, Transient Data Analysis.  Because transient data 

collection impacts standard DMx data collection, it is 

recommended that you read both chapters.   

Hardware Configuration 

One important difference when using the SKF Multilog DMx Machine Monitoring system 

as opposed to conventional Machine Protection systems is that an RS485 field bus, 

rather than individual signal wires, is used to transmit data.  From the module, a single 

or dual field bus cable is used to transfer data to the safe area.  Up to 31 DMx modules 

can be connected together to share a single field bus cable.  
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Figure 7 - 1. 

Sample DMx System Configuration. 

The SKF Multilog DMx module has two independent RS485 communication channels.  

Each of the channels can be used for the connection to @ptitude Analyst or to the DMx 

Manager software.   

@ptitude Analyst Monitor is used to acquire data from the DMx devices and bring that 

data into @ptitude Analyst.  Using the field bus cable, multiple DMx modules can share 

a connection to the computer running Monitor.  

 If the connection to the computer running Monitor is via a serial port using an 

RS485 -PC interface module (which converts the RS485 signal to USB), and both 

@ptitude Analyst Monitor and DMx Manager are installed on the same computer, 

the following two configuration options are available: 

1. If both RS485 communication channels are available for monitoring, one link 

can be used for configuration using DMx Manager and the other for monitoring 

using @ptitude Analyst Monitor. 

2. If only one link is available, then only one application may be active and occupy 

the available communication port at a time.  In this case, you must ensure DMx 

Manager is shut down when using @ptitude Analyst Monitor, and vice versa. 

 If the connection is via Ethernet access to a gateway, the two applications may 

reside on different systems.   

 Refer to your SKF Multilog DMx hardware manual for more 

information on installing your hardware. 
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Configuring DMx Settings 

DMx settings allow you to configure communication between @ptitude Analyst Monitor 

and the DMx devices.  

To access DMx Settings: 

 Select DMx Settings from the Transfer menu’s DMx sub-menu. 

The DMx Settings dialog displays. 

 Select the Hosts tab to specify the Monitor hosts used to acquire data from DMx 

devices.  The Host settings display.  

DMx Settings Host Tab 

It is possible to have @ptitude Analyst Monitor running on more than one computer.  

This tab allows users to ensure that all Monitor host installation(s) being used for 

monitoring DMx devices are included and appropriately configured. 

Options on this tab include: 

Hosts – This list automatically populates with the machine names of any Monitor 

installations that have communicated with the @ptitude Analyst database.  Select the 

host whose settings you would like to configure from the list. 

Host name – This field displays the machine name for the selected host.  Typically, you 

do not need to modify this setting.  If the machine name for a computer running 

@ptitude Analyst Monitor has changed, enter the new name in this field. 

Live data mode – You are able to view a live trace of data collected from DMx devices 

in @ptitude Analyst.  In addition to scheduled data collection, Monitor keeps a buffer of 

overall measurements that is used in the event of an alarm.  (Refer to Buffer update 

rate, below, for details.)  Typically, Monitor buffers data as it comes in, however, this 

process can result in a speed impact on the live data display.  This field allows you to 

specify whether you would like to continue buffering overall measurements from the 

DMx modules, or temporarily suspend the buffer while viewing live data.  Options are: 

Dedicated – This option instructs the Monitor program to suspend buffer data 

collection and dedicate resources to updating the live trace. 

Interleaved – This option instructs the Monitor program to continue buffering 

data while in the live display. 

Live Data Resolution – Specify the percentage of the total waveform data captured by 

DMx modules that should be transferred to @ptitude Analyst for live data display.  A 

lower percentage improves the update rate, but offers a lower resolution on the display.  

Buffer update rate – When setting up your @ptitude Analyst hierarchy, you are able to 

set a data collection schedule for your DMx POINTs.  In addition to this scheduled data 

collection, Monitor keeps a buffer of overall readings that may be written to the 

database as “unscheduled” data in the event of an alarm condition.  In the event of an 

alarm, the full buffer is written to the @ptitude Analyst hierarchy for the POINT in 

alarm, and a single overall value from the buffer is stored for all additional POINTs on 

the same DMx device.  Specify how often Monitor should buffer data collected from the 

DMx modules.  Enter an update rate between 2 and 999 seconds. 
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Buffer samples – Specify how many measurements should be buffered from each DMx 

device.  Once the buffer sample limit is met, new data overwrites older data in the 

buffer.   

Trend mode – The DMx supports two types of measurements: Trend and Transient 

(i.e., variable speed) data.  (Refer to Chapter 8, Transient Data Analysis for more 

information on Transient data POINTs.)  This option defines which measurement type(s) 

are available for live data display and included in the buffer.  Options are: 

Interleaved – Both transient and trend data are used. 

Transient – Only transient data is used.  You will not be able to include normal 

trend POINTs (i.e., DMx Processed measurements) in live data display.  In the 

event of an alarm condition, overall measurements will only be available for 

transient POINTs.  

Normal – Only trend data is used.  You will not be able to include transient 

POINTs in live data display.  In the event of an alarm condition, overall 

measurements will not be available for transient POINTs. 

 The Trend Mode setting only impacts live data display and the 

buffer used for unscheduled data in the event of an alarm.  The 

non-selected option will continue to be collected according to the 

normal data acquisition schedule. 

 If the Trend Mode is set to Interleaved, a buffer update rate of 2 

seconds might be too short to collect both Transient and Trend 

data, depending on the number of DMx modules per connection.  

In this case, consider increasing the update interval. 

Normal data resolution – This setting is similar to Live Data Resolution, but it defines 

the waveform/FFT resolution used for scheduled data acquisition.  

 To speed data collection, if time waveform data is available, FFT is 

post-processed from the waveform rather than collected directly 

from the DMx.  This setting specifies the resolution of the 

waveform, and by extension, the FFT.  If FFT Data Collection 

mode is enabled on the DMx and @ptitude Analyst’s POINT 

Properties Save Data field is set to FFT only, FFT is collected 

directly from the DMx.  In this case, 1000 lines of resolution is 

used, regardless of this setting. 

Synchronize date/time – Enable to automatically set the time on the DMx devices to 

the time on the @ptitude Analyst Monitor computer.   

Interval – If Synchronize date/time is enabled, this setting controls how often the time 

from the Monitor computer is synchronized to the DMx devices. 

Add – If the @ptitude Analyst Monitor host you wish to configure is not in the Hosts list, 

click this button to add a new host and enter the machine name where Monitor is 

installed in the Host name field. 

Save – When changes are made to any of the Properties fields, the Add button toggles 

to a Save button. Click to save your changes. 

Remove –Click to remove the Monitor host currently selected in the Hosts list. 
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 If the selected host has been assigned to a connection on the 

Connections tab, you must clear the assignment (as well as any 

related devices and POINTs) before deleting the host.   

Undo – When changes are made to any of the Properties fields, the Remove button 

toggles to an Undo button. Click to cancel your changes. 

 When you have set up your host, click the Connections tab.  The Connections 

settings display. 

DMx Settings Connections Tab 

A connection group is a group of DMx devices that are connected together and share 

the same field bus cable.  This tab is used to define the communication protocols for 

each connection group communicating with the Monitor hosts.   

 It is possible to have more than one connection group of DMx 

devices communicating with the same Monitor host.   

 Click the Add button to add a new connection group and enter the appropriate 

settings in the Properties section.   

Options include: 

Connections – This list displays all connection groups that have been added. 

Connection name – Enter a unique name for the new connection group. 

Host – This list displays all Monitor hosts that have been configured on the Hosts tab.  

Select the host to use for this connection. 

Communication type – Select the communication protocol used for this connection 

group.  Options include: 

Serial port – Select this option if you are connecting through a serial cable.  

 This can be direct serial ports or emulated serial ports (i.e., USB-

Serial converters). 

TCP/IP – Select this option if you are connecting through a network cable.  

 TCP/IP operation with the DMx Protection System is only possible 

when using TCP/IP to RS485 terminal servers to establish the 

required physical serial connection between network and DMx 

connection. 

Config – Click to access configuration settings for either the serial port or TCP/IP 

protocol, depending on your Communication type selection.  Refer to the appropriate 

Configuration section below for details. 

Save – When changes are made to any of the Properties fields, the Add button toggles 

to a Save button.  Click to save your changes. 

Remove – Click to remove the connection group currently selected in the Connections 

list. 

 If the selected connection group has been assigned to a device on 

the Devices tab, you must clear the assignment (as well as any 

related POINTs) before deleting the connection group. 
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Undo – When changes are made to any of the Properties fields, the Remove button 

toggles to an Undo button.  Click this button to cancel your changes. 

DMx Settings - Serial Port Configuration 

If the Communication type on the DMx Settings dialog’s Connections tab is set to 

Serial port, click the Config button to display the Configure Serial Port dialog. 

This dialog lets you specify settings for serial communication from DMx modules to the 

@ptitude Analyst Monitor installation. 

Options include: 

RS485 settings – These settings should reflect how the converter between the serial 

port of the host computer and the DMx modules has been configured to handle 

communication.   

Tx/Rx switching (Auto / RTS) – This setting is used to control how the RS485 

connection switches between listen mode and send mode.  If you are using a 

latest generation USB to RS485 converter, set this Auto.  If you are using an 

old style converter, you may need to set this to RTS. 

Tx message echo (Off / On) – Echo is used as a communication check to verify 

that data from the converter is received. With the two-wire, bidirectional 

communication system recommended by SKF, echo is not necessary. If you are 

using a latest generation USB to RS485 converter, set this to Off.  For older 

models, Echo may need to be set On. 

Serial Port settings 

COM port – Enter the COM port on the host machine to which the serial cable 

is attached. 

Baud rate – Enter the baud rate for the DMx modules, as configured in the 

DMx Manager’s Serial Communications settings. 

 The default baud rate for DMx modules is 38.4 K. 

The Stop bits, Data bits, and Flow control settings are fixed within the DMx 

modules and provided for reference purposes only. 

 Click OK to return to the DMx Settings dialog. 

DMx Settings TCP/IP Configuration  

If the Communication type on the DMx Settings dialog’s Connections tab is set to 

TCP/IP, click the Config button to display the Configure TCP/IP dialog. 

This dialog lets you specify the TCP/IP parameters of the Ethernet to serial converter 

used to connect the DMx system to the Ethernet connection. 

Options include: 

IP Address – Enter the IP address of the Ethernet to serial converter. 

Port no. – Enter the port number used by the converter. 

 Click OK to return to the DMx Settings dialog. 
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DMx Settings Devices Tab 

 When you have set up your communications groups, click the Devices tab.  The 

Devices settings display. 

This tab defines the individual DMx devices.  Each definition provides information to 

uniquely identify a device within a connection group.  Typically, devices are added 

automatically when new DMx POINTs are created from the New DMx POINTs option on 

the Transfer menu’s DMx sub menu. (See the Creating DMx POINTs section below for 

details.)   In this case, this screen is informational and no configuration is required.   

 You must select the New DMx POINTs dialog’s Create from 

Monitor Host option to automatically create a device. 

In the event a DMx module is added after initial POINT setup, it can be manually 

configured here. 

 Click the Add button to add a new device and enter the appropriate settings in the 

Properties section.   

Options include: 

Devices – Lists any devices that have already been configured.   

Device name – Enter a unique name to help identify this device.  

Connection – This list contains the connection groups that were created on the 

Connections tab.  Select the appropriate group from the list.  The communication 

settings for the selected connection group are used for this device. 

DAD # – This corresponds to the module address that has been configured on the DMx.  

Within each connection, all devices must have a unique address.  If you are adding a 

new device, obtain the Module Address from DMx Manager software and enter it here. 

Add – Click this button to add a new device.   

Save – When changes are made to any of the Properties fields, the Add button toggles 

to a Save button.  Click this button to save your changes. 

Remove – Click this button to remove the device. 

 If any POINTs have been added for this device, they must be 

deleted before you can remove the device. 

Undo – When changes are made to any of the Properties fields, the Remove button 

toggles to an Undo button.  Click this button to cancel your changes. 
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Creating DMx POINTs 

Once connections settings have been configured, @ptitude Analyst POINTs can be 

created based on the configuration of the DMx devices.  Within DMx Manager, you are 

able to set up measurements under Process Channels in the hierarchy and on the 

Transient Data tab in Module Properties.  (Refer to your DMx Manager documentation 

for more information.)  A POINT is created in the @ptitude Analyst hierarchy for each of 

these measurements that has been configured. 

 Only Processed Channel and Transient Data measurements are 

included.  Any other measurement types are not imported into 

@ptitude Analyst.   

To create DMx POINTs: 

 Select New DMx POINTs from the Transfer menu’s DMx sub-menu. 

The New DMx POINTs wizard displays. 

 

Figure 7 - 2. 

The New DMx POINTs Wizard. 

This dialog offers two options for creating @ptitude Analyst POINTs:  

Create from host – This option is used for first time setup of devices on a Monitor host.  

Configured connections on the specified Monitor host are scanned for connected 

devices.  A machine is created in the hierarchy for each device, along with the applicable 

measurement POINTs. 
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Host name – This list displays all of the hosts configured on the Hosts tab of 

the DMx Settings dialog.  Select the Monitor host that should be scanned. 

Create from device – This option is used to add additional devices to an existing DMx 

hierarchy.  This is useful if a DMx device has been added to an existing connection.  

Rather than re-creating POINTs for all devices associated with a Monitor host, it enables 

you to append a machine and the related POINTs to the existing configuration. 

Device name – This list displays all of the devices configured on the Devices 

tab of the DMx Settings dialog. 

Subsequent New DMx POINTs wizard screens vary, depending on which option is 

selected.  Refer to the appropriate section, below. 

Creating New DMx POINTs from a Monitor Host 

To create New DMx POINTs from a host: 

 Select the Create from host option button and select the appropriate Monitor host 

from the Host name list.   

 Click Next to access the next screen, where you can specify the DMx module 

address range to scan. 

 Monitor must be running to proceed. 

This screen lets you limit the DMx device addresses that are scanned.  This can be used 

to speed up the setup by instructing the system to only scan addresses that are in use.  

POINTs are only created for devices that fall within the specified range of addresses. 

Scan from address – If desired, enter the starting and ending addresses of the DMx 

modules that should be scanned.  Modules with addresses falling outside of this range 

are ignored. 

 Refer to the DMx Manager user manual for more information on 

module addresses on the DMx. 

 Click Next to proceed to a communication status screen. 

 Click Next to begin adding DMx POINTs.   

A SET level item is added to the Primary hierarchy with the name of the selected 

Monitor host.  Beneath the SET, a machine is added for each DMx device, with related 

POINTs branching from the machine.  The first measurement value for each POINT is 

collected and stored to the database.   

The status window updates to list the names of the hierarchy items that are created, 

and the total number of POINTs added. 

 When the POINT creation is complete, the Next button toggles with a Finish 

button. Click Finish to exit this wizard. 
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Creating New DMx POINTs from a DMx Device 

To create New DMx POINTs from a DMx device: 

 Select New DMx POINTs from the Transfer menu’s DMx sub-menu to access the 

New DMx POINTs Wizard. 

 Select the Create from device option button and select the appropriate DMx device 

from the Device name list.   

 Click Next to access the next screen, where you can specify the location in the 

hierarchy to add the new DMx machine and related POINTs. 

 Monitor must be running and the hierarchy selected in Monitor 

must match the Primary hierarchy in @ptitude Analyst to 

proceed. 

 

Figure 7 - 3. 

The New DMx POINTs Wizard’s Select Element Screen. 

The Select element hierarchy displays all SET level hierarchy items in the currently 

selected Primary hierarchy.  The new DMx machine can be placed in the root of the 

hierarchy, or beneath an existing SET.   

 If DMx POINTs have already been created from the Monitor host, 

it is recommended that you add the additional device under the 

host SET. 

 Select the desired hierarchy item and click Next to proceed to a communication 

status screen. 

 Click Next to begin adding DMx POINTs.  A new machine and related POINTs are 

created under the specified hierarchy location.  The first measurement value for 

each POINT is collected and stored to the database.  The status window updates to 
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list the names of the hierarchy items that are created, and the total number of 

POINTs added. 

 When the POINT creation is complete, the Next button toggles with a Finish 

button.  Click Finish to exit this wizard. 

Viewing DMx Hierarchy Items 

DMx POINTs appear in the @ptitude Analyst hierarchy.  

 

Figure 7 - 4. 

@ptitude Analyst Hierarchy with DMx POINTs. 

 Monitor host 

 machine for each DMx device 

 DMx POINTs 
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In the hierarchy, the Monitor host appears as the SET.  Beneath the set, a machine 

appears for each DMx device. Branching from the machines are the measurement 

POINTs that were created based on the device settings.  The POINT types that may be 

created from the DMx include:  

 Single channel measurements.  The POINT name includes the channel name and 

the type of measurement (e.g., Channel 1.PktoPk). 

 Dual channel Orbit measurements.  DMx device setup allows for pairing channels 1 

and 2 or channels 3 and 4.  This POINT type is created from two single 

measurements on the DMx if both channels in a pair have the transducer type set 

to Displacement, there is a probe mounting angle difference between 85 and 95 

degrees, and they share the same measurement type.  An Orbit POINT is also 

created if DMx Manager’s TSI Application field for both channels in a pair is set to 

Smax.  Orbit POINT names include the channel numbers of the channel paring and 

the type of measurement (e.g., Ch1.2.PktoPk). 

 Order measurements.  This POINT type groups all available order measurements 

(magnitude and/or phase) defined for a single channel.  The POINT names include 

the channel name and Orders (e.g., Channel 1.Orders).  

 Order measurements are only created if no dual channel Orbit 

measurement POINT exists for the channel pair.  If Orbit POINTs 

are present for the processed channels, the order measurements 

will be integrated into the Orbit POINTs. 

 Transient measurement POINTs.  This measurement type is configured specifically 

for use with @ptitude Analyst’s transient data analysis feature.  (Refer to Chapter 8 

for details.)  The POINT names display the channel name, followed by the letter T 

(to signify transient data), and the type of measurement (e.g., Channel1T.RPM).  

 Transient measurement POINTs may include any of the types 

described above. 

DMx Machine Properties 

Group Properties for machines created from a DMx device provide the ability to check 

the device’s alarm status and setup parameters from within @ptitude Analyst. 

 For a full discussion of Group Properties, refer to this manual’s 

Working With Your SKF @ptitude Analyst Hierarchy chapter. 

To Check DMx Device Status:  

 From the @ptitude Analyst Hierarchy, right click on a DMx machine and select 

Properties.  The Group Properties screen displays. 

 Select the DMx Status tab.  The DMx Status tab displays. 
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Figure 7 - 5. 

The Group Properties Screen’s DMx Status Tab. 

 Click Get Status to collect status for the DMx device.  The tab updates with 

information from the device. 
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Figure 7 - 6. 

The Group Properties Screen’s DMx Status Results. 

Alarm status – The DMx offers up to five alarm configuration containers that are used 

to create alarms.  The alarm status displays green for each container that is not in 

alarm, and red for containers that are in alarm. 

Channel – Select which channel’s configuration to display in the Device configuration 

area. 

Device configuration – This box displays detailed information on the configuration of 

the selected channel. 

DMx POINT Properties 

Properties for POINTs created from DMx devices provide information about the POINT 

configuration on the DMx and allow configuration of some settings for use with 

@ptitude Analyst.  

 Changes to POINT Properties are internal to @ptitude Analyst.  

They are not transferred to the DMx device. 

 This section only discusses POINT properties that specifically 

relate to the DMx.  It does not cover properties that operate the 

same for DMx POINTs as other POINT types.  For a full discussion 

of POINT Properties, refer to this manual’s Working With Your 

SKF @ptitude Analyst Hierarchy chapter. 
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To Access POINT Properties: 

 From the @ptitude Analyst Hierarchy, right click on a DMx POINT and select 

Properties.  The POINT Properties screen displays. 

 

Figure 7 - 7. 

The POINT Properties Screen’s General Tab. 

The Application, Sensor type, and Units display information about this measurement 

POINT.  
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DMx POINT Properties – Setup Tab 

 Click on the Setup tab to view further information related to the POINT settings. 

 

Figure 7 - 8. 

The POINT Properties Screen’s Setup Tab. 

 The options on this tab vary, depending on the type of POINT 

selected.  

 The DMx Hamming window function is not supported in @ptitude 

Analyst.  The Hanning window function is used instead. 

 The DMx Average detection type is not supported in @ptitude 

Analyst.  RMS detection is used instead. 

This tab provides read-only information concerning the measurement settings.  In 

addition, some POINT types offer the following editable options: 

Speed – Enter the nominal shaft speed in CPM or Hz.   

Save data – Specify whether data is stored as FFT data, Time data, FFT and Time, 

FFT and Phase, or FFT, Time and Phase.  (Options vary depending on the Freq. type.) 
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 Changes made to POINT Properties do not impact the 

configuration on the DMx device. 

Low freq. cutoff - Enter a low frequency cutoff filter value for FFT enabled 

measurement POINTs.  Although values are allowed from 0.0 CPM to 1200 kCPM, the 

range for normal measurements is from approximately 200 CPM to 600 CPM, or the 

equivalent in Hz.  The default value for DMx measurement POINTs is 120 CPM (or 2 

Hz). 

DMx POINT Properties – Schedule Tab 

 Click the Schedule tab to configure the collection schedule for this POINT.  The 

Schedule tab displays. 

 

Figure 7 - 9. 

The POINT Properties Screen’s Schedule Tab. 

@ptitude Analyst Monitor reads and buffers overall measurement readings using the 

schedule established on the Hosts tab of the DMx Settings dialog.  These readings are 

used for alarming, but the measurements are not stored in @ptitude Analyst unless an 

alarm is detected. 
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In addition, more complete measurements, including FFT spectrum, if applicable, are 

taken and stored to the @ptitude Analyst database using the schedule specified in the 

Take Data Every field on this tab.   

 The default schedule is every 24 hours. 

Take data every – Enter a numerical value to indicate how often data should be 

collected and select the appropriate units from list box options (Second(s), Minute(s), 

Hour(s), Day(s)).   

DMx POINT Properties – Band and Envelop Alarms 

If the DMx POINT is a Displacement, Velocity, or Acceleration type POINT, the Band 

Alarm and Envelope Alarm tabs are available.  Band alarm configuration is imported 

from the DMx module and can use up to four bands per POINT.  They can be modified 

in POINT Properties without affecting the configuration on the DMx. Refer to this 

manual’s Working With Your SKF @ptitude Analyst Hierarchy chapter for more 

information.  

DMx POINT Properties - Orbit/SCL Tab 

DMx device setup allows for pairing channels 1 and 2 or channels 3 and 4.  If both 

channels in a pair have the transducer type set to Displacement, there is a probe 

mounting angle difference between 85 and 95 degrees, and they share the same 

measurement type, a dual channel Orbit POINT is created and the Orbit/SCL tab is 

available in POINT Properties. 
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Figure 7 - 10. 

The POINT Properties Screen’s Orbit/SCL Tab. 

POINT Properties / Orbit/SCL fields may include: 

Channel X and Y Settings  

 For DMx orbit POINTs that pair channels 1 and 2, channel X on 

this screen corresponds to channel 1 and channel Y corresponds 

to channel 2.  For DMx orbit POINTs that pair channels 3 and 4, 

channel X corresponds to channel 3 and channel Y corresponds to 

channel 4. 

X-Input mv/EU – Enter a number to define the sensitivity of the pickup to be 

used in taking measurements for channel X. 

X-Sensor angle - Specify the angle that defines the X sensors’ physical 

location. 

Y-Input mv/EU - Enter a number to define the sensitivity of the pickup to be 

used in taking measurements for channel Y. 
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Y-Sensor angle - Specify the angle that defines the Y sensors’ physical 

location. 

 The orbit axis may use Scientific or Standard mode for the 0 

degree reference point, depending on your Angular axis view 

preference setting.  This setting should be taken into account 

when entering your sensor angles. 

 

Figure 7 - 11. 

Diagram Showing Scientific vs. Standard. 

Orbit Settings 

Top dead center – Specify the label to display at the top of the Orbit/SCL plot. 

Display tacho angle – Enable to allow the tacho angle to display on the 

Orbit/SCL plot. 

Shaft rotation – Specify the shaft rotation direction as either Bidirectional, 

Clockwise, or Counter clockwise for reference on the Orbit/SCL plot. 

Tacho angle – Specify the angle that defines the tachometer’s physical location 

(0 to 359 degrees). 

Shaft Centerline Settings 

X-Cold gap – Specify the X probe’s cold gap value.  Together the X and Y probe 

cold gap values define the distance between the displacement probe and the 

shaft’s position in the bearing when the machine is at rest. 

Y-Cold gap – Specify the Y probe’s cold gap value. 

Cold gap position – Define the cold gap position in the bearing clearance circle 

when viewing the shaft centerline plot.  Choices are Bottom, Center, Left, 

Right, and Top. 

Bearing clearance – Specify the bearing’s clearance value (typically supplied 

by the manufacturer).  The expected clearance value is the diametric clearance 

between the shaft and bearing.   
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Waveform Tab 

When analyzing orbit data, it is desirable to exclude runout of the shaft.  This can be 

accomplished by capturing a waveform measurement when the shaft is rotating very 

slowly (1 – 400 RPM).  This “slow roll” waveform highlights the normal variances in the 

rotation of the shaft, which can then be factored out when viewing orbit plots.  

The Waveform tab in POINT Properties lets you select the desired waveform 

measurement. 

 The POINT Properties / Waveform tab is available only when the 

current POINT has stored data.  If there is no collected data, or 

the POINT type is not Orbit / SCL, the Waveform tab does not 

appear. 

 

Figure 7 - 12. 

The POINT Properties Screen’s Waveform Tab. 
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To specify a POINT’s waveform measurement: 

 Select the POINT in the hierarchy list. 

 Right-click to display the POINT’s context menu and select the Properties option.  

The POINT Properties screen displays. 

 Select the Waveform tab. 

Current Waveform 

The Current Waveform field lists measurement record timestamps for the POINT’s 

stored measurements.  Click to specify the measurement to use as the slow roll 

waveform.  The specified measurement’s time waveforms display graphically in the tab’s 

lower area.   

 A <No waveform> option appears in the drop down list as the 

default, and to clear the current waveform selection. 

DMx POINT Properties - Vector Tab  

Vector compensation allows you to specify known magnitude and phase angle values 

that represent shaft runout.  This may be used to correct data for Orbit, Bode, and 

Nyquist plots.   

The Vector tab in POINT Properties lets you enter the magnitude and angle that 

should be used to compensate Orbit, Bode, and Nyquist plots for Channel X and 

Channel Y at 1X, 2X, and 3X machine running speed. 

 In DMx Manager’s Measurement Channel Properties, you are able 

to Allow free orders.  If this is selected, rather than assuming the 

first three orders of running speed for a measurement, you may 

specify any order (from 1 to 31).  In this case, the 1X, 2X, and 3X 

settings in Vector Compensation correspond to the first three 

defined orders in DMx Manager.  The Allow free orders setting 

also provides the option to specify a non-integer order (for 

example, you may wish to track speed related vibration at 1.5X 

running speed).  Non-integer orders do not have an associated 

phase measurement.  If a non-integer order is entered in one of 

the first three order fields in DMx Manager, vector compensation 

in @ptitude Analyst will not be accurate.  It is strongly 

recommended that you use the forth order field in DMx Manager 

for any non-integer order you wish to track. 

 The Vector tab only appears if the POINT type is Orbit / SCL or 

Order (i.e., Freq. type set to Order Track). 
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Figure 7 - 13. 

The POINT Properties Screen’s Vector Tab. 

Enable vector compensation – Mark this check box to enable the fields on this tab. If 

this is unmarked, no vector compensation is performed for the POINT. 

 Vector compensation is applied to the measurement as it is stored 

to the database.  Marking this check box only affects new 

measurements.  Vector compensation will not be available for any 

measurements that were taken with this check box unmarked. 

Channel X and Y compensation – The vector compensation settings that should be 

used in plots for Channel X and Channel Y data, respectively.   

Magnitude (1X, 2X, and 3X Speed) – The magnitude of the vector that should be 

factored out of plots at 1X, 2X, and 3X orders.  (The magnitude corresponds to the peak 

value, using the units defined for the POINT.) 

Angle (1X, 2x, and 3X Speed) – The phase angle, in degrees, of the vector that should 

be factored out of plots at 1X, 2X, and 3X the machine running speed. 

 The General Preferences Angular Axis View setting specifies 

whether to use Scientific or Standard mode when determining the 
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0 reference point to define probe placement.  This setting should 

be taken into account when entering your compensation angles. 

 The magnitude and angle settings together define the vector. 

DMx POINT Properties – Gating Setup  

Gating is a method of controlling data collection for one POINT, called a dependent 

POINT, based on the current state of a second POINT, called the control POINT. 

If the control POINT's conditions are met, the dependent POINT's measurement is 

performed.  If the control POINT's conditions are not met, the dependent POINT's 

measurement is not performed. 

 Reference Appendix C, Data Collection Gating for more 

information about gating. 

The Gating Setup tab in Point Properties lets you assign speed and process reference 

POINTs to the selected POINT for gating purposes.   

 

Figure 7 - 14. 

The POINT Properties Screen’s Gating Setup Tab. 



 Multilog DMx Machine Monitoring Module 

 Viewing DMx Hierarchy Items 

SKF @ptitude Analyst and SKF Multilog On-line Systems 7 - 25 

User Manual 

Fields include:  

Speed Collection – Enter speed collection information in the fields below: 

 If the selected POINT is a speed POINT, you can enable speed 

gating on itself.  

Speed reference - To assign a POINT for speed tag reference, click the 

Select… button to browse POINTs.   

 For troubleshooting purposes, it is recommended that you do not 

gate the reference POINT. 

 It is recommended that the reference POINT collects at a faster 

schedule than its gated POINTs. 

Speed Ratio – Enter a numerical value for the desired multiple in the Ratio 

field.   

Enable Speed Gating – Click to discard data outside of the specified range. 

 When you disable speed gating, also clear the reference point 

selection to ensure the reference point does not continue to be 

flagged as in use. 

Min / Max - Enter the Min / Max range at which data collection occurs.  Max 

range must be less than or equal to the reference POINT’s full scale value. The 

max range is automatically adjusted if the Speed Ratio field is modified (for 

example, if the max range is 100 RPM, and the speed ratio is changed from 1 

to 2, the max range automatically updates to 200 RPM.) 

Units – The reference POINT’s units of measurement automatically display. If 

the selected POINT is a speed POINT and no reference POINT is specified (self-

gating), the selected POINT’s units display.  

Process Collection – Enter process collection information in the fields below: 

 If the selected POINT is a process POINT, you can enable process 

gating on itself. 

Process reference – To assign a POINT for process reference, click the 

Select… button to browse POINTs.   

 For troubleshooting purposes, it is recommended that you do not 

gate the reference POINT. 

 It is recommended that the reference POINT collects at a faster 

schedule than its gated POINTs. 

Enable Process Gating – Click to discard data outside of the specified range. 

 When you disable process gating, also clear the reference point 

selection to ensure the reference point does not continue to be 

flagged as in use. 

Min / Max - Enter the Min / Max range at which data collection occurs.  Max 

range must be less than or equal to the reference POINT’s full scale value.   
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Units – The reference POINT’s units of measurement automatically display. If 

the selected POINT is a process POINT and no reference POINT is specified, the 

selected POINT’s units display. 

Working with DMx Data 

As soon as DMx POINTs are created, a measurement is captured and stored to the 

@ptitude Analyst database.  @ptitude Analyst Monitor continues to take overall readings 

on the schedule specified on the DMx Settings dialog’s Hosts tab.  Monitor stores these 

readings in a buffer.  Readings in the buffer are retained until they are overwritten with 

new readings when the buffer sample limit is met.  Buffered readings are only used in 

the event of an alarm condition.  (Refer to the DMx Alarms section, below, for details.) 

On the schedule specified in POINT Properties, @ptitude Analyst Monitor takes a more 

complete reading, including spectral data if applicable, and writes it to the @ptitude 

Analyst database.   

The status bar at the bottom of the @ptitude Analyst screen provides color-coded 

status information.  If you are collecting data for the DMx, two Monitor status indicators 

appear, one for the DMx, and one for all other online devices.  They can be identified by 

the icon to the left of the Monitor ID. 

 

 

Figure 7 - 15. 

DMx Monitor Status. 

 Monitor for DMx 

 Monitor for other online systems 

 DMx Monitor right-click menu 

The operation of the two status indicators is similar, with the exception of the options 

available on the right-click menu.   

 For more on general operation of the status indicators, refer to 

Automatic Data Retrieval in Chapter 4. 

The DMx Monitor status indicator’s right-click menu includes a Refresh Monitor option.  

This option refreshes Monitor with changes to DMx configuration, without requiring a 

restart. 
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DMx Alarms 

Most alarms for DMx POINTs are configured in DMx Manager.  The Monitor program 

automatically matches the POINT in @ptitude Analyst to the measurement on the DMx 

and captures the alarm status during data collection.   

Unlike @ptitude Analyst, alarms in DMx Manager are not configured for each 

measurement POINT.  Instead, DMx Manager allows up to five Alarm Channels that 

provide a logical alarming scheme based on combining multiple measurements, 

potentially from different measurement channels. 

Because of this, the same measurement POINT may be represented in more than one 

Alarm Channel with different alert and danger values.  Consequently, the same POINT 

may be in alarm in one channel, and not in another.  Additionally, a single measurement 

within an Alarm Channel may go into alarm without triggering the Alarm Channel.  (For 

example, the logic may specify that at least two measurements must be in alarm for the 

channel to trigger.)   

Monitor keeps track of the alarm status for both the five alarm channels, and the 

individual measurements used in the alarm logic. 

 This only applies to General Alarms on the DMx.  If you are using 

Advanced alarms in DMx Manager, the alarm channel status is 

reported but individual measurement alarm status is not 

supported in @ptitude Analyst. 

If an alarm channel goes into alarm, it is noted in the Event Log and in the DMx 

machine’s Group Properties status indicators. 

If an individual measurement goes into alarm on any Alarm Channel, the corresponding 

POINT in the @ptitude Analyst hierarchy is also placed in alarm, whether or not the 

related Alarm Channel is triggered.   

 Because a POINT in @ptitude Analyst may be in alarm without 

triggering the Alarm Channel, @ptitude Analyst POINT status is 

not a reliable indicator of DMx Protection System status. 

When a POINT goes into alarm, the following occurs: 

 The hierarchy’s status indicators update to reflect the alarm level (alert or danger) 

and details of the alarm are made available in the Alarm Details view. 

 A time and/or spectrum measurement is taken for the POINT in alarm, when 

applicable.    

 All data in the buffer for the POINT in alarm is immediately written to the @ptitude 

Analyst hierarchy.   

 A single overall measurement from the buffer is stored for all other POINTs on the 

same DMx machine.  

These unscheduled measurements from the buffer provide a “snapshot” reference of 

the overall machine condition.  
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 If a DMx POINT is a Displacement, Velocity, or Acceleration type 

POINT, it is also possible to configure Band and Envelope alarms 

in @ptitude Analyst.  These alarms are treated as standard 

@ptitude Analyst alarms and do not result in additional buffer 

measurements being written to the hierarchy.  They are also 

internal to @ptitude Analyst and do not impact the DMx device 

(i.e., they are not used by the Protection System) or display in 

DMx Manager. 

DMx Hierarchy Maintenance 

DMx module configuration is performed in DMx Manager.  If a change is made to a 

measurement in DMx Manager, @ptitude Analyst automatically updates the 

corresponding POINT in its hierarchy using the following rules:  

 If the source channel (channel 1-4) and measurement output (detection type: Pk, 

RMS, DC, ect.) have not changed, the existing POINT is updated with the changes. 

 If the source channel and measurement output combination exists in @ptitude 

Analyst, but the POINT is disabled, it will be enabled again and changes will be 

applied. 

 If the source channel and measurement output combination on the DMx does not 

exist in @ptitude Analyst, a new POINT is created. 

 If the source channel and measurement output specified in @ptitude Analyst does 

not exist anymore in the new setup on the DMx, the measurement POINT is 

disabled in @ptitude Analyst. 

 Updates use the same rules followed for creating single @ptitude Analyst POINTs 

from multiple DMx channel measurements (i.e., order measurement and dual 

channel measurement POINT merging). 

Automatic changes to @ptitude Analyst POINTs are noted in the Event Log. 

 Rather than using the automatic update, you may also delete your 

@ptitude Analyst hierarchy and use the New DMx POINTs wizard 

to recreate it from the DMx.  If you would like to retain past 

measurement data for the machine, first export the data using 

the File menu’s Export option.  Once the machine is recreated, 

the data can be imported back into @ptitude Analyst by using the 

File menu’s Import option and selecting to Merge 

Measurements on the Introduction screen. 
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Viewing DMx Data in Plots 

Data from DMx POINTs can be viewed in graphical plots in @ptitude Analyst in the 

same manner as other POINTs.  In addition, live data can be viewed from the following 

plots:  

 Trend plot 

 Spectrum plot 

 Time plot 

 Trend/Spectrum plot 

 Trend/Time plot 

 Trend/Spectrum/Time plot 

 Orbit plot 

 Shaft Centerline plot 

 Bode 

 Nyquist 

 Cascade 

 Topology 

 Depending on the Live data mode selected on the Hosts tab of 

the DMx Settings dialog, data collection may be temporarily 

suspended while the live data screen is open. 

Refer to the Displaying Graphic Plots chapter for general information on working with 

plots and viewing live data. 

 Bode, Nyquist, Cascade, and Topology plots primarily apply to 

transient data.  They are documented Chapter 8, Transient Data 

Analysis. 

In addition, DMx device setup allows for pairing channels 1 and 2 or channels 3 and 4.  

If both channels in a pair have the transducer type set to Displacement, there is a probe 

mounting angle difference between 85 and 95 degrees, and they share the same 

measurement type, a dual channel Orbit POINT is created.  Data from Orbit POINTs can 

be displayed in Orbit and Shaft Centerline plots. 
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Orbit Plot 

 

 

 

Figure 7 - 16. 

Orbit Plot. 

 directional arrows 

 flash blank 

 X channel sensor location 

 Y channel sensor location 

 tachometer’s physical location 

 X Channel Time Plot 

 Y Channel Time Plot 

The Orbit plot displays the shaft’s most recent orbit data for the two input channels (X 

and Y).  Orbit plots can be used to show the movement of the shaft within the bearing. 

 The sensor and tachometer angles are adjusted based on your 

Angular Axis View preference setting. 

Orbit plot labels include: 

 - Indicates the direction the shaft is rotating.   indicates the shaft is rotating 

counterclockwise,  indicates the shaft is rotating clockwise, and  indicates the 

shaft is rotating bi-directional. 

T – Indicates the physical location of the tachometer sensor. 

X – Indicates the physical location of the channel X sensor. 

Y – Indicates the physical location of the channel Y sensor. 

Flash blank – Indicates the starting point of the rotation of the shaft.  A blank on the 

orbit plot precedes the dot for easier identification of the starting point. 
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Orbit Plot Settings 

To access the Orbit Plot Settings dialog: 

 With an orbit plot displayed, select the View menu’s Plot/Settings option, or use 

the settings toolbar button. 

 The Settings dialog is also available from the orbit plot’s right-

click context menu. 

Orbit Plot Settings fields include: 

Autoscale - Enabling autoscale automatically scales the initial orbit axis so it is 

approximately 120% of the largest orbit.  Disabling autoscale displays the orbit on the 

same full scale axis used when it was recorded. 

Mag. Min. / Mag. Max. - Enter the minimum and maximum magnitude scale values in 

the designated text boxes. 

Orbit settings 

Slow roll compensation – Slow roll compensation uses a measurement taken at low 

speed when there should be negligible shaft vibration to quantify shaft runnout.  Enable 

the Slow roll compensation checkbox to allow the plot to compensate based on either 

the vector compensation or waveform compensation settings in POINT Properties 

(depending on the Filtering settings, below). 

 Press F2 on your keyboard when viewing the plot to toggle vector 

compensation on or off. 

 Vector compensation must be enabled in POINT Properties prior 

to data collection to be used in a plot. 

Filtering – Allows you to display the orbit data for a specific frequency.  Choices are 

Raw, 1x, 2x, 3x.  If 1x, 2x, or 3x is selected with Slow roll compensation, the 

corresponding 1X, 2X, or 3X vector compensation settings on the Vector tab in POINT 

Properties are applied.  If Raw is selected along with Slow roll compensation, it uses 

the waveform measurement selected in POINT Properties.   

 Press F3 on your keyboard when viewing the plot to scroll 

through the filtering options.   

Revolutions – Specify the number of revolutions to display on the orbit plot.  Choices 

are 1 revolution, 2 revolutions, 3 revolutions, 4 revolutions, 5 revolutions, or All 

revolutions. 

 Press F4 on your keyboard when viewing the plot to scroll 

through the revolution options. 
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Shaft Centerline Plot 

 

 Figure 7 - 17. 

Example of a Shaft Centerline Plot. 

The Shaft Centerline plot displays a trend of the shaft’s average centerline for Orbit 

POINTs.  Shaft centerline plots can be used to show the movement of the shaft within 

the bearing. 

Shaft Centerline Plot Settings 

To access the SCL Plot Settings dialog: 

 With a Shaft Centerline plot displayed, select the View menu’s Plot/Settings 

option, or use the settings toolbar button. 

 The Settings dialog is also available from the shaft centerline 

plot’s right-click context menu. 

SCL Plot Settings fields include: 

Autoscale - Enabling autoscale automatically scales the initial amplitude axis so it is 

approximately 120% of the largest amplitude.  Disabling autoscale displays the 

spectrum on the same full scale vertical axis used when it was recorded. 

Mag. Min. / Mag. Max. - Enter the minimum and maximum magnitude scale values in 

the designated text boxes. 

Date / Time Scale- Enter the minimum and maximum date / time scale values in the 

designated text boxes. 

Tag – Allows you to display RPM tags on the plot.  Select either No Tag or RPM. 
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Transient Data Analysis 

Overview 

The Transient Data feature is used to collect and analyze run up / coast down data, 

intermittent events, and transient vibration signals from non steady state machinery. 

 At the time of this writing, only the IMx and DMx DADs support 

transient data collection. 

 IMx setup is documented in Chapter 3, Working With Your SKF 

@ptitude Analyst Hierarchy.  DMx setup is documented in 

Chapter 7, Multilog DMx Machine Monitoring Module.  

Because transient data collection impacts standard data 

collection, it is recommended that you read each section. 

 

For the IMx, configuring @ptitude Analyst to collect transient data is a two step 

process:  

 First, create transient POINTs for the device via @ptitude Analyst. These POINTs 

can be the same as those used for normal condition monitoring. 

 Next, set up your transient data hierarchy in @ptitude Analyst  and add the 

transient POINTs. 

Once setup is complete, the IMx will monitor for transient events and send transient 

data to the IMx Service. For this to happen, the transient data must be transferred 

along with the normal condition monitoring POINT data. 

 

For the DMx, configuring @ptitude Analyst to collect transient data is a different 

two step process. 

 First, set up transient POINTs for the device via @ptitude Analyst’s Transfer > DMx 

> DMx Transient or in the DMx Manager’s Module Properties. 

 Next, set up your transient data hierarchy in @ptitude Analyst  and add the 

transient POINTs created by @ptitude Analyst Monitor. 

Once setup is complete, the DMx will monitor for transient events and send transient 

data to @ptitude Analyst Monitor. Transient data may be analyzed using specialized 

plots and/or included in reports. 
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Setting up DMx Transient POINTs 

Transient data collection provides multiple “snapshots” of your machinery as the speed 

changes.  Transient data generally uses Order type POINTs (i.e., magnitude and phase 

pairings on the same channel, potentially integrated in dual channel Orbit POINTs) 

configured for fast data collection to allow the DMx to rapidly take multiple 

measurements during the transient event.  A separate setup is provided specifically for 

transient data so you can configure transient POINTs without impacting normal data 

collection.  

Transient POINTs may be configured from within DMx Manager using the Module 

Properties Transient Data tab.  These POINTs are added to your @ptitude Analyst 

hierarchy during normal DMx POINT creation.  (Refer to Chapter 7’s Creating DMx 

POINTs section for details.)  You may also create transient POINTs from within 

@ptitude Analyst and transfer them to the DMx device. 

To add transient measurements in @ptitude Analyst: 

 Select DMx Transient from the Transfer menu’s DMx sub-menu.  The DMx 

Transient screen displays. 

 Select the Device Setup tab. 

 

Figure 8 - 1. 

The DMx Transient Screen’s Device Setup Tab. 

This tab allows you to display transient POINTs that already exist on the DMx device, as 

well as configure new transient POINTs. 
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DMx Manager allows up to 48 transient measurements, of which 11 are reserved for 

alarming, speed, and status information.  This leaves 37 measurements available for 

user defined configuration.  This allows configuration of up to all four orders (requiring 

eight measurements to describe both amplitude and phase) on all four measurement 

channels, with an additional five spaces available for other measurement types. 

Before you can add new transient measurements, you must retrieve the existing setup 

from the DMx device. 

To retrieve transient data configuration: 

 Select the DMx device you would like to use from the DMx device list. 

 Select Get Setup.  A progress bar displays as the data is retrieved, then the DMx 

channels section updates with information from the selected DMx device.  

Options on this tab include: 

DMx device – Displays all DMx devices configured on the DMx Settings dialog’s Devices 

tab.  

DMx Channels – Displays a list of the existing transient measurements on the selected 

DMx device.  Available information includes the measurement Channel, measurement 

Type, the Full Scale limit (i.e., the measurement’s maximum value), and the 

measurement Units. 

Channel Properties section – Allows you to modify the highlighted transient 

measurement.  Options include: 

Channel – Select the measurement channel (Channel 1 through 4) 

corresponding to one of the four sensor inputs on the DMx. 

Type – Select the measurement type from the list.  Options that are not 

configured in DMx Manager for use with the selected channel appear dimmed. 

 FFT processing is disabled during transient data collection, 

therefore, FFT band options are not available for transient 

POINTs. 

 The Units are automatically derived from the Type. 

Full Scale – Enter the measurement’s maximum value. 

Get Setup – Retrieves transient measurement setup from the selected DMx device. 

Add – Click to add a new transient measurement with default settings.  The new 

measurement is added to the bottom of the list. 

Remove – Deletes the highlighted transient measurement. 

Download – Saves and transfers the configuration to the DMx device. 
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To add a new transient measurement: 

 Select a DMx device and click Get Setup.  The Add button enables. 

 Click Add.  A new measurement is added at the bottom of the list.  The 

measurement settings default to: 

Channel = Channel 1 

Type = True peak 

Full scale = 32767 

 Scroll to the bottom of the list and highlight the new measurement.  

 Modify the settings in the Channel properties section.   

To remove a transient measurement: 

 Highlight the transient measurement you would like to delete and click Remove.  

The measurement is removed from the list. 

 This option removes the measurement from the DMx.  If the 

corresponding POINT already exists in @ptitude Analyst, it is 

disabled. 

To save and transfer configuration to the DMx: 

 When you are satisfied with your configuration, click Download.  The 

measurements are saved and a progress bar appears as the configuration is 

transferred to the DMx device. 

WARNING! 

The DMx device may be unresponsive for several seconds while configuration is 

downloaded.  This results in a temporary interruption in the protection system. 

Changes are reflected on the Transient Data tab in DMx Manager’s Module Properties.  

If you have added new transient measurements or modified existing measurements, the 

next time @ptitude Analyst is updated with changes from the DMx, the new POINTs are 

added to the hierarchy and existing POINTs are updated. 

 If a POINT already exists in the @ptitude Analyst hierarchy, only 

changes to the Full Scale setting are updated.  Changes to the 

channel number or measurement type result in a new POINT 

being created and the existing POINT being disabled. 

 If you exit this tab without downloading, you are prompted to save 

your configuration.  Saving also downloads the changes to the 

DMx. 
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Transient Hierarchy Configuration 

The transient hierarchy and captured transient data records are organized in a separate 

transient hierarchy window (similar to a ROUTE or workspace window).   

The transient window lets you create special groups that define transient data 

collection.  All of the data collected during a transient event is stored in one 

measurement record in the transient window so data is grouped and readily available 

for analysis. 

 Scheduled data collection of POINTs is separate from transient 

data collection.  Scheduled data continues to be collected and 

displayed in the standard Hierarchy window. 

How to Create a New Transient Window 

Transient windows are added and maintained from the Transient dialog. 

To open the Transient dialog: 

 Select View / Transient.  The Transient dialog displays a list of any previously 

created transient windows. 

Options include: 

Open – Opens the highlighted transient window. 

Add – Opens the Transient Properties dialog and adds a new transient window. 

Remove – Removes the highlighted transient window. 

Properties – Opens the Transient Properties dialog where you may edit the name and 

description of the highlighted transient window. 

To create a new Transient window:  

 Click Add.  The Transient Properties dialog displays. 

 Enter a Name for the new transient view and provide a Description if desired. 

 Click OK.  A new, empty transient window displays. 

 

Figure 8 - 2. 

A New Transient Window. 

 Transient Hierarchy root level – displays the name of the Transient window. 

Unlike other hierarchies in @ptitude Analyst, the transient window adds an additional 

hierarchy level for the transient group.  All SETs, machines, and POINTs are added 

beneath this transient group.  This window can contain one or more transient groups 

that define transient data collection. 
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Important 

Although @ptitude Analyst is capable of handling multiple transient groups, keep in 

mind that the communication speed of the DMx is restricted for IS compliance.  If 

you are configuring more than one transient group for the DMx, use the guidelines 

below to carefully evaluate your group settings to minimize the data capture 

requirements.  (For example, consider only capturing overall data rather than 

waveform data, or capturing data at greater intervals.)  If transient data collection 

is initiated for more than one group simultaneously, Monitor may be busy 

processing another group and some data may be missed. 

How to Create a New Transient Group 

To add a transient group:  

 Highlight the root level of the Transient window hierarchy. 

 Select Insert / New Group.  The Group Properties screen displays.   

Options include: 

Name – Enter a unique name to identify the new group. 

Description – (optional) Enter a description to further identify the new group. 

Type – Select IMx Transient or DMx Transient. 

Enable Data Collection – Enable or disable transient data collection for this group. 

 Select the Transient tab. 

The Group Properties DMx Transient Tab 

 

Figure 8 - 3. 

The Group Properties Screen’s DMx Transient Tab. 
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Options include: 

Low / High Speed – Defines the transient event window.  Transient data is only 

collected if the running speed of the machine falls within the specified range.   

Start-up events are initiated when the machine speed increases above the low 

speed threshold and stopped when the speed exceeds the high speed 

threshold.   

Coast down events are initiated when the machine speed drops below the high 

speed threshold and stopped when the speed reaches the low speed threshold.  

Important 

If data collection times out on the DMx before the speed limit is reached, a new 

transient event will not be triggered until the running speed falls below the low 

speed limit or above the high speed limit.  If the high speed limit is set higher than 

the maximum machine speed, it effectively turns off transient data collection for 

the DMx.  If this happens, either select the Refresh Monitor option on the DMx 

Monitor status indicator, or stop and restart @ptitude Analyst Monitor to reset the 

system. 

Overall data sample – Allows definition of data acquisition triggers for overall data, 

based on changes in speed and/or time. 

Delta speed – Enable to trigger data acquisition at the speed interval specified 

in the adjacent RPM field.   

Delta time – Enable to trigger data acquisition at the specified time interval.  

Enter the time interval in Second(s), Minute(s), or Hour(s). 

 When data collection is triggered by either one of the options, 

both triggers reset and are initialized to current speed and 

timestamp values. 

Dynamic data sample - Allows definition of data acquisition triggers for dynamic data 

(waveform), based on changes in speed and/or time. 

Delta speed - Enable to trigger data acquisition at the speed interval specified 

in the adjacent RPM field.   

Delta time - Enable to trigger data acquisition at the specified time interval.  

Enter the time interval in Second(s), Minute(s), or Hour(s). 

 When data collection is triggered by either one of the options, 

both triggers reset and are initialized to current speed and 

timestamp values. 

 Dynamic data acquisition takes considerably more time than 

overall data collection.  Be aware that during this time, no overall 

measurement data is collected. 

Data resolution - Allows definition of the approximate resolution for dynamic data 

collection by specifying the percentage of the total captured data that should be 

transferred to @ptitude Analyst.  This allows you to minimize data acquisition and 

transfer time.   

Maximum duration - Specifies a transient data collection timeout.  Transient data 

collection will terminate when either the machine speed reaches the defined Low or 
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High speed limit, or the timeout is reached.  Enter a timeout between 1 and 60 

Second(s), Minute(s), or Hour(s). 

Extra startup sample time (optional) – Allows additional time to be added onto data 

collection for a startup event.  Once the High speed limit has been met, data collection 

will continue for the specified amount of time.  Enter a time between 0 and 60 

Second(s), Minute(s), or Hour(s).  If 0 is entered, data collection terminates as soon as 

the high speed limit is reached. 

 The Maximum duration timer is disabled as soon as the Extra 

startup sample time is started, allowing the full additional 

sample to be collected. 

The Group Properties IMx Transient Tab (IMx) 

 

Figure 8 - 4. 

The Group Properties Screen’s IMx Transient Tab. 
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Options include: 

Transient ranges area - Defines the transient event window.  Transient data is only 

collected if the running speed of the machine falls within the specified range.  The fields 

on the right are read-only, and automatically update when the fields on the left are 

modified.  A graphical display of the speed ranges displays with different colors 

representing each of the transient ranges currently enabled: 

Red – overspeed 

Green - normal operation 

Orange – transient 

Pale blue - slow roll event 

Blue - machine stopped 

Overspeed – Specify the speed at which Overspeed events are initiated.  These occur 

when the machine speed exceeds the Overspeed threshold.  The machine is then shut 

down normally by a control system.  When this occurs, a transient event collects the 

coast down to stopped data.  

Normal operation (N.O.) – Specify the speed at which the machine is no longer in a 

transient state and normal operation (steady state) data collection begins.   

Transient – Click to enable transient data collection.  Enter the starting speed at which 

transient data collection begins in a run up event, or finishes in a coast down or 

overspeed trip event. 

Slow roll – Specify the starting speed at which Slow roll measurements are captured.  

Transient events are initiated when the machine speed increases into the Transient 

speed range.  Slow roll measurements are captured using the Normal Operation data 

collection schedule. 

Stopped – (read-only) Specifies the speed at which the machine is considered to be 

stopped.  Dynamic measurements in this range are discarded, but static measurements 

are saved. 

N.O. transient capture timeout – Specifies a transient capture timout after the 

machine has reached a steady state.  Transient data collection will terminate when the 

specified time after the steady state is reached.   

Maximum transient event time – Specifies a transient data collection timeout.  

Transient data collection will terminate when either the machine speed reaches the 

defined Low or High speed limit, or the timeout is reached.  Enter a timeout between 1 

and 60 Second(s), Minute(s), or Hour(s). 

Important 

If data collection times out on the IMx before the speed limit is reached, a new 

transient event will not be triggered until the running speed falls below the low 

speed limit (into slow roll or stopped) or above the high speed limit (into Normal 

Operation State).  Further transient readings are discarded until machine speed 

returns to either transient or overspeed, and  a new transient event is captured. 

Static measurement area - Allows definition of data acquisition triggers for overall 

data, gap and amplitude + phase data, based on changes in speed and/or time. 

Delta RPM - Enable to trigger data acquisition at the speed interval specified in the 

adjacent RPM field.   
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Delta Time – Enable to trigger data acquisition at the specified time interval.  Enter the 

time interval in Second(s), Minute(s), or Hour(s). 

Dynamic measurement area - Allows definition of data acquisition triggers for dynamic 

data (waveform or FFT), based on changes in speed and/or time. 

Delta RPM – Enable to trigger data acquisition at the speed interval specified in the 

adjacent RPM field. 

Delta time - Enable to trigger data acquisition at the specified time interval.  Enter the 

time interval in Second(s), Minute(s), or Hour(s). 

 Dynamic data acquisition takes considerably more time than 

overall data collection.  Be aware that during this time, no overall 

measurement data is collected. 

Building the Transient Hierarchy 

Once the transient group has been created, you can use drag and drop or copy and 

paste operations to copy Groups and POINTs from a Hierarchy or Workspace window 

into the new transient window to create the new hierarchy list.  

DMX Transient Hierarchy Considerations 

The following should be kept in mind when building a transient hierarchy: 

 Transient POINTs are identified in the hierarchy with a T following the channel 

name (e.g., Channel1T.RMS or Channel1T.Order). 

 Transient data POINTs are processed separately b from trend POINTs (i.e., 

Processed Channel POINTs).  Using both trend and transient data in your hierarchy 

requires both processing loops to be considered during data collection, impacting 

data acquisition speed.  It is highly recommended for fast transient events to only 

use transient measurement POINTs.  If you require a particular trend 

measurement in your transient analysis, consider duplicating the configuration in 

Transient POINT setup.  This provides the same data, without slowing down data 

collection. 

 FFT processing on the DMx is suspended during a transient event.  If you do include 

trend data in your transient hierarchy, it is not recommended that you include 

POINTs set to save data as FFT.  (If you select POINTs set to save FFT and Time, 

the FFT will be processed using the time waveform data.) 

 You may not assign POINTs from a single IMx / DMx machine to multiple transient 

groups. 

 DMx hardware setup allows the speed channel of one DMx module to be physically 

connected to another DMx module using an assigned opto-output (speed out) and 

Logic input (speed input) on the other module.  (i.e., You may “daisy chain” multiple 

DMx modules on one physical machine.)  Since separate “DMx machines” in 

@ptitude Analyst are not necessarily on separate physical machines, you may 

assign POINTs from multiple DMx machines to the same transient group.  This 

should only be done if the DMx devices share the same speed reference.   
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IMx Transient Hierarchy Considerations 

The following should be kept in mind when building a transient hierarchy: 

 It is possible to define multiple transient groups on a single IMx.  Each transient 

must have its own tachometer, and each channel must only be used in a single 

transient group. 

 It is not possible to define a transient group that spans multiple IMx units.  If this is 

required, create multiple transients, each containing channels from a single IMx. 

 It is possible to mix dynamic channels and IMx-M protection channels in a single 

IMx transient group. 

Transferring DMx Transient Groups to @ptitude Analyst Monitor 

Once transient groups have been completely configured (including building the 

hierarchy), you must transfer them to SKF @ptitude Analyst Monitor.  You must also 

retransfer a group if changes have been made to an existing transient hierarchy, such 

as modifying the group settings or adding or removing POINTs.  

 If you disable a group, it is automatically communicated to 

Monitor. You do not need to transfer the change. 

Transferring DMx Transient Groups 

 Select DMx Transient from the Transfer menu’s DMx sub-menu.  The DMx 

Transient screen displays. 

 

Figure 8 - 5. 

The DMx Transient Screen. 
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 Highlight the group you would like to download to Monitor and click Download. 

 Click OK at the download confirmation message. 

 If you have multiple transient groups, repeat these steps for each group. 

 Only enabled Transient Groups are displayed in the DMx 

Transient Screen. 

Transient Data Collection 

Once the hierarchy setup is complete and transient groups have been downloaded, 

Monitor starts monitoring your machine for transient events, based on the machine 

speed range established for the group.  

 For DMx transient data, the machine running speed is checked 

using the schedule specified in the Buffer Update Rate setting on 

the DMx Settings screen’s Host tab. 

When a change in machine speed triggers a transient event, normal data collection for 

all POINTs under any machine included in the affected transient hierarchy is temporarily 

suspended.  (This does not impact data collection for POINTs on other machines.)  In its 

place, data collection commences using the transient group parameters.   

 During this time, measurements are written to the transient 

hierarchy, rather than the main @ptitude Analyst hierarchy. 

Monitor creates a measurement record in the transient window hierarchy for each 

POINT under the transient group that triggered the event.  As the transient event 

proceeds, measurements are captured at the specified delta speed and/or delta time, 

based on your transient group settings.   

The entire data set for the transient event is included in the single transient data record 

under each POINT.  While the transient event is still active (i.e., transient data collection 

is still occurring), the start and end times of the transient data set record are equal. 

During the transient event, you are able to view a Live Data display of the transient data 

as it is collected.  Data is updated in the display using the transient data collection 

schedule.  Live Data display is temporarily suspended for any POINTs that are not in the 

affected transient hierarchy.   

When the transient event is complete, the end time of the transient data set record 

updates to reflect the actual stop date and time of the event.  The transient data set 

record is also updated to indicate whether the event was a start-up or a coast-down.  
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Figure 8 - 6. 

Sample Transient Start-up Record. 

 Transient data set for a start-up event. 

Additional information about the transient data set is available on the Transient 

Measurement Properties dialog. 

To view transient measurement properties:  

 In the transient window, navigate to the desired transient data POINT. 

 Highlight the transient data set in the right-hand pane. 

 Select Edit / Properties, or click the Properties icon on the toolbar.  The Transient 

Measurement Properties dialog displays. 
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Figure 8 - 7. 

The Transient Measurement Properties Dialog. 

This dialog displays details concerning the transient data record, an overview of the 

settings that were used in data collection, and provides an option to use this event as a 

baseline measurement.   

Options include: 

Type – Whether it was a start up or coast down event. 

# measurements – The number of individual measurements captured during the 

event. 

Start and End date/time – The time range when the transient event occurred. 

Data Range, Overall data sample, Dynamic data sample – These sections display the 

transient group properties that were set at the time the data was captured. 

Current baseline – Sets the current data set as the baseline for the corresponding type 

of event (start-up or coast down).  
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 The baseline applies to this POINT only.  If the same transient 

event is recorded under multiple POINTs in the transient 

hierarchy, you will need to set the baseline for each POINT. 

 The baseline is used in reports to provide the percentage of 

change between the selected transient data set and the baseline.   

Viewing Transient Data Plots 

Depending on the type of POINT selected in the transient hierarchy, one or more of the 

following standard plot types are available when viewing a transient data set:  

Trend 

Spectrum 

Time  

Spectrum Waterfall 

Polar Vector 

Mag/Phase 

Orbit 

Shaft Centerline 

Mag/Speed 

 Plots that display a single measurement (e.g., spectrum, time, 

orbit) use the measurement with the highest amplitude peak in 

the transient data set. 

In addition, there is a selection of plots that specifically apply to transient data. 

 Although these plots are also available for non-transient data, 

they are primarily designed to reflect impact on vibration signal 

caused by changes in speed during a transient event. 

Bode - Plots signal magnitude and phase as a function of running speed. 

Nyquist - Plots the movement of the machine shaft within the (sleeve) bearing housing 

during the start-up or coast-down of the machine. 

Cascade – Plots collected spectra against running speed. 

Topology - A top-down view of a cascade or waterfall plot, where color intensity is used 

to visualize the spectral peaks. 

Bode/Nyquist – A combined Bode and Nyquist plot. 

Speed/Bode/Spectrum – Combines a speed trend, Bode, and spectrum plot. 

Speed/Bode/Orbit/Spectrum – Combines a speed trend, Bode, orbit, and spectrum 

plot. 
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Bode Plot 

 

 

Figure 8 - 8. 

Bode Plot. 

 phase angle  

 signal magnitude 

 X-axis = machine running speed 

 right click menu toggles the order being viewed 

 vector compensation status 

The Bode graph plots signal magnitude and phase as a function of running speed.  Bode 

plots are available for order channel (i.e., Freq. type = Order Track in POINT 

Properties) and dual channel POINTs with phase enabled.   

You may toggle the order being displayed using the right click menu. 

 The phase angle scale is adjusted based on your Angular Axis 

View preference setting. 

Bode Plot Settings 

To access the Bode Plot Settings dialog: 

 With a Bode plot displayed, select the View menu’s Plot / Settings option, or use 

the settings toolbar button. 

 The Settings dialog is also available from the Bode plot’s right-

click context menu. 

Bode Plot Settings fields include: 

Speed Scale – Specify the speed range that should be represented on the X-axis of the 

plot. 

Magnitude scale – Specify the scaling for the Y-axis of the magnitude plot (bottom 

section). 
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Autoscale - Enabling Autoscale automatically scales the initial amplitude axis 

so it is approximately 120% of the largest amplitude.  Disabling Autoscale 

displays the same full scale vertical axis used when data was recorded. 

% Full scale - When enabled, the amplitude axis displays as a % value of the 

POINT’s full scale value.  Use % Full Scale to compare measurements that do 

not have the same units or the same Full Scale value. 

 If you do not select Autoscale or % Full Scale, you must enter 

values to determine the plot’s magnitude scale (Y-axis scaling). 

Mag min / max - Enter the minimum and maximum magnitude scale values in 

the designated text boxes. 

Linear / Logarithmic - Select Linear scaling to space out data equally.  Select 

Logarithmic scaling to emphasize lower values. 

Phase scale - Specify the scaling for the Y-axis of the phase plot (top section). 

View (Wrapping or Rolling) – If the phase angle exceeds 360, determines 

whether the data should wrap (return to 0) or roll (continue past 360).  Choose 

Wrapping to have the data line beyond the phase axis range wrap around.  

Choose Rolling to have the phase axis scale extend to keep the data line 

continuous. 

Phase min / max – Specify the phase angle range that should be represented 

on the plot.  Enter a value between -180 and 360. 

Vector compensation - Allows you to filter out known magnitude and phase angle 

values that represent inherent impurities in the shaft.  Enable to allow the plot to 

compensate based on the vector compensation settings in POINT Properties.  

 Press F2 on your keyboard when viewing the plot to toggle vector 

compensation on or off. 

Order – Specify the order that is displayed on the plot (1 – 4). 

Damping Cursor 

Use a damping cursor on a Bode plot to display side bands of three decibels to the left 

and right of the cursor position, and the calculated Q-factor (i.e., the rate of energy 

dissipation relative to the oscillation frequency; a higher Q factor indicates a lower rate 

of dissipation). 

To display a damping cursor overlay: 

 With a Bode plot displayed, select the View menu’s Plot / Plot Overlays / Damping 

Cursor option, or use the damping cursor toolbar button. 

Feedback Area - Displays amplitude, speed, Q-factor, and date/time. 

Information Area - Specific information displays on the Bode Damping tab.  Tab 

information includes POINT name, cursor color, date/time, amplitude, speed, and Q-

factor.  

Right-Click Context Menu - Right-click on the damping cursor overlay anchor to reveal 

its context menu.  Available options include: 
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Next trace – Toggles between traces when the plot is displaying more than 

one trace. 

Remove – Removes overlay from the plot. 

Keyboard Support – Press Enter to toggle to next trace.  Press Delete to remove.  Left 

and right arrow keys move one measurement in the transient data set at a time. 

Available Preferences 

Color - Cursor is the color of the next available cursor (as configured in Cursor 

/ Color Preferences in the Preferences dialog). 

Display Status – Display status (on or off) is configured in the Damping 

Cursor / Plot Preferences in the Preferences dialog. 

 The default status is on. 

Nyquist Plot 

 

Figure 8 - 9. 

Nyquist Plot. 
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A Nyquist plot is a Polar plot showing the “path” of the vector against speed.  This plot is 

a good way of observing the change in amplitude and phase angle during a transient 

event.  When a critical speed is traversed, there is a 180˚ shift in phase angle.  A major 

change in the Nyquist “profile” from a normal baseline may indicate a change in the 

resonant frequency (critical speed), which is an indicator of a potential structural 

problem.  Nyquist plots are available for order channel POINTs (i.e., Freq. type = Order 

Track in POINT Properties) and dual channel POINTs with phase enabled.   

The plot’s right click menu allows you to toggle the order being displayed and turn 

speed labels on or off using the Show Amp Labels option. 

 The phase angle is adjusted based on your Angular Axis View 

preference setting. 

Nyquist Plot Settings 

To access the Nyquist Plot Settings dialog: 

 With a Nyquist plot displayed, select the View menu’s Plot / Settings option, or use 

the settings toolbar button. 

 The Settings dialog is also available from the Nyquist plot’s right-

click context menu. 

Nyquist Plot Settings fields include: 

Magnitude scale 

Autoscale - Enabling Autoscale automatically scales the initial amplitude so it 

is approximately 120% of the largest amplitude.  Disabling Autoscale allows 

you to specify the plot’s maximum magnitude scale. 

Mag. Max – If Autoscale is disabled, enter the maximum amplitude that 

should be displayed in the plot.   

Vector compensation - Allows you to filter out known magnitude and phase angle 

values that represent inherent impurities in the shaft.  Enable to allow the plot to 

compensate based on the vector compensation settings in POINT Properties.  

 Press F2 on your keyboard when viewing the plot to toggle vector 

compensation on or off. 

Order – Specify the order that is displayed on the plot (1 – 4). 

Tag – Turn speed labels on (Speed) or off (<None>). 
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Cascade Plot 

 

Figure 8 - 10. 

Cascade Plot. 

 amplitude   

 frequency 

 machine running speed 

The Cascade plot is similar to the Waterfall plot, but instead of plotting collected spectra 

against time, the data is plotted against running speed on the Z-axis.   

Cascade Plot Settings 

To access the Cascade Plot Settings dialog: 

 With a Cascade plot displayed, select the View menu’s Plot / Settings option, or 

use the settings toolbar button. 

 The Settings dialog is also available from the Cascade plot’s 

right-click context menu. 

Cascade Plot Settings fields include: 

Speed scale - Specify the scaling for the plot’s Z-axis (speed). 

Min / Max – Enter the minimum and maximum machine speed that should be 

represented on the plot. 

Limit measurement of the same speed – Specify how many measurements 

should be represented at each speed interval.  This is useful if data was 

captured using Delta Time, potentially resulting in multiple measurements at 

the same speed.  
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Amplitude scale - Specify the scaling for the plot’s Y-axis (amplitude). 

Min / Max – Enter the minimum and maximum amplitude scale values in the 

designated text boxes.   

Linear / Logarithmic - Select Linear scaling to space out data equally on the 

Y-axis.  Select Logarithmic scaling to emphasize lower values. 

Frequency scale - Specify the scaling for the plot’s X-axis (frequency). 

 The X-axis may display frequencies or orders, depends on your 

Plot Preferences X-Axis units setting. 

Min / Max - Enter the minimum and maximum frequency scale values in the 

designated text boxes. 

Linear / Logarithmic - Select Linear scaling to space out data equally on the 

X-axis.  Select Logarithmic scaling to emphasize lower values. 

Topology Plot 

 

Figure 8 - 11. 

Topology Plot. 

 highest amplitude and associated color indication   

 lowest amplitude and associated color indication 

The Topology plot is similar to a Cascade or Waterfall plot, but provides a top-down 

view of the data using color intensity to visualize the spectral peaks. 
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Topology Plot Settings 

To access the Topology Plot Settings dialog: 

 With a Topology plot displayed, select the View menu’s Plot / Settings option, or 

use the settings toolbar button. 

 The Settings dialog is also available from the Topology plot’s 

right-click context menu. 

Topology Plot Settings fields include: 

X-scale - Specify the scaling for the plot’s X-axis. 

 The X-axis may display frequencies or orders, depends on your 

Plot Preferences X-Axis units setting. 

Scale min / max - Enter the minimum and maximum frequency or order  

scale values in the designated text boxes. 

Linear / Logarithmic - Select Linear scaling to space out data equally on the 

X-axis.  Select Logarithmic scaling to emphasize lower values. 

Y-Scale - Specify the scaling for the plot’s Y-axis. 

Axis – Specify whether to show the plot over Speed (Cascade plot) or Time 

(Waterfall plot).  

Date min / max – If Time is selected for the axis, enter the minimum and 

maximum date range that should be reflected on the plot. 

 This setting primarily applies to non-transient data. 

Scale min / max – If the axis is set to Speed, enter the minimum and 

maximum machine speed that should be represented on the plot.   

If the axis is set to Time, enter the time range that should be included. 

Limit measurement of the same speed – If the axis is set to Speed, specify 

how many measurements should be represented at each speed interval.  This 

is useful if data was captured using Delta Time, potentially resulting in multiple 

measurements at the same speed.  

Magnitude scale – Specify the scaling and display settings for the spectral peaks. 

Mag min / max – Specify the colors that should represent the minimum and 

maximum amplitudes for spectral peaks on the plot. 

Linear / Logarithmic - Select Linear scaling to space out data equally on the 

Y-axis.  Select Logarithmic scaling to emphasize lower values. 
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Bode/Nyquist Plot 

 

Figure 8 - 12. 

Bode/Nyquist Combined Plot. 

This plot combines a Bode plot and a Nyquist plot in one view.  You may toggle between 

the plots by clicking on them or using the Tab key on your keyboard.  The non-selected 

plot’s title information area appears dimmed.  When you move your cursor on the Bode 

plot, the cursor on the Nyquist plot automatically moves to the corresponding 

measurement. 

Settings for each plot type may be configured individually and are identical to the single 

plot options. 

 This plot is not available for live data display. 
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Speed/Bode/Spectrum Plot 

 

Figure 8 - 13. 

Speed/Bode/Spectrum Combined Plot. 

This plot combines a Speed Trend, Bode, and Spectrum plot.  It is available for order 

channel POINTs (i.e., Freq. type = Order Track in POINT Properties) and dual channel 

POINTs with phase enabled. When you move your single cursor overlay on the Speed 

Trend plot, the cursor on the Bode plot automatically moves to the corresponding 

measurement and the Spectrum plot updates to display the corresponding spectrum. 

If you are viewing multiple channels on the plot, the plots default to Channel X.  For help 

with viewing data from other channels, refer to Multiple Measurements and Channels 

in Plots in Chapter 5, Displaying Graphic Plots.   

You may toggle between the plots by clicking on them.  The non-selected plots’ title 

information areas appear dimmed.  Cursor movement impacts the active plot.   

Settings for each plot type may be configured individually and are identical to the single 

plot options. 

 This plot is not available for live data display. 
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Speed/Bode/Orbit/Spectrum Plot 

 

Figure 8 - 14. 

Speed/Bode/Orbit/Spectrum Combined Plot. 

This plot combines a Speed Trend, Bode, Orbit, and Spectrum plot.  It is available for 

dual-channel POINTs with FFT, Time, and Phase enabled.  When you move your single 

cursor overlay on the Speed Trend plot, the Bode, Orbit, and Spectrum plots update to 

display the corresponding data. 

If you are viewing multiple channels on the plot, the plots default to Channel X.  For help 

with viewing data from other channels, refer to Multiple Measurements and Channels 

in Plots in Chapter 5, Displaying Graphic Plots.    

You may toggle between the plots by clicking on them.  The non-selected plots’ title 

information areas appear dimmed.  Cursor movement impacts the active plot.   

Settings for each plot type may be configured individually and are identical to the single 

plot options. 

 This plot is not available for live data display. 
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Appendix A 

SKF @ptitude Analyst Toolbars 

Toolbar Tools 

@ptitude Analyst’s toolbars and toolbar button assignments are described below.  You 

can enable any or all of the available buttons by using the Custom Toolbar dialog 

discussed later in this chapter. 

Primary Toolbar 

Hierarchy Window – open Hierarchy window. Organizes your monitored machinery 

measurements into a hierarchy structure consisting of Groups (which may be 

organizational SETs, machines, or custom groups) and measurement POINTs. 

ROUTE Manager – open ROUTE dialog. A ROUTE is a measurement POINT collection 

sequence that is downloaded to a data acquisition device (DAD).  

Workspace Manager – open Workspace dialog. A workspace organizes specific Groups 

into one location for easy comparison and analysis. 

WMx Device – open WMx Device dialog. 

Transient Manager – open Transient dialog to manage transient windows and data. The 

Transient Data feature is used to collect and analyze run up / coast down data, 

intermittent events, and transient vibration signals from non steady state (variable 

speed) machinery. Note: Only the IMx and DMx DADs support transient data collection.  

Alarm Window – open Alarms window which displays all POINTs in alarm in the selected 

view. 

Report Setup – open Reports dialog. 

System Information – open System Information view to see the Event Log and Online 

Data 

Microlog Inspector Status – open Microlog Inspector Device Status window. 

Properties – open Properties dialog for the active hierarchy item (could be Group 

Properties or POINT Properties) 

Print – print window contents (also print to file). 

Exit – exit the application. A confirmation message displays before exiting. 

Hierarchy View Toolbar 

Alarm Details – open the Alarm Details view.  

Apply Filter – open Apply Filter dialog. When a filter is applied, the resulting items 

display in a new Workspace window. 

Apply Template – open the Apply Template dialog to select a template to apply to the 

hierarchy.  
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Navigation Toolbar 

Auto Link – link any open Hierarchy, Workspace, ROUTE, Transient, Template, or 

Alarms window (source windows) to any open Alarm Details or Plot window (target 

windows). With Auto Link enabled, selections in one of the source type windows 

automatically affect all open target type windows.  

For example, suppose you have a Hierarchy window open (source type window), select a 

POINT, and display its spectrum (target type window). With Auto Link enabled, when 

you select a different POINT in the Hierarchy window, the plot window automatically 

updates to display the newly selected POINT's spectrum. 

Previous POINT – move focus to the previous POINT in the hierarchy. 

Next POINT – move focus to the next POINT in the hierarchy. 

Previous Measurement - move focus to the previous measurement. 

Next Measurement - move focus to the next measurement. 

View Icons Toolbar 

Large Icons – display measurements as large icons. 

Small Icons – display measurements as small icons. 

Simple List Icons – display measurements as a simple list. 

Detailed List Icons – display measurements as a detailed list. 

Plots Toolbar 

Trend Plot – view a POINT’s most recent reading in comparison with its previous 

readings and its alarm set up. See how the POINT is “trending” over time to detect 

gradual changes in process conditions.  

Spectrum Plot – view measured vibration signals with respect to frequency. An FFT 

spectrum plot displays vibration amplitudes at various component frequencies. [stacked 

or combined] 

Time Plot – view a short time sample of a raw vibration signal with vibration amplitude 

plotted over the time scale.  Current time plots are compared to past time plots to 

analyze changes in vibration amplitude or frequency. 

Spectrum Waterfall Plot – view three-dimensional waterfall plots of POINT’s historical 

spectra collected over time. 

Cascade Plot – view plots of collected spectra against running speed on the Z-axis.  

The Cascade plot is similar to the Waterfall plot, but instead of plotting collected spectra 

against time, the data is plotted against running speed on the Z-axis. 

Topology Plot – view a top-down view of a cascade or waterfall plot using color intensity 

to visualize the spectral peaks. 

Polar Vector Plot – shows vibration amplitude and phase.  The phase angle is the angle 

the shaft travels from the start of a triggering event to when the point at which the 

sensor experiences maximum positive force.  This relationship provides valuable 
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information on shaft orbit and shaft position and is used for analysis, balancing, and 

shaft orbital analysis. 

Mag/Phase Plot – view trends plotting the amplitude (top) and phase / angle (bottom) 

aligned by the measurement date.  Mag / Phase trends may be used to determine if a 

machine’s mechanics are changing by analyzing the shifting in phase. 

Orbit Plot – view the dynamic motion of the center of a rotating shaft with signals from 

two perpendicularly mounted transducers. 

MCD Plot – view stacked trend plots for the three values of an MCD measurement: 

velocity, enveloped acceleration, and temperature. 

SCL Plot – view a trend of the shaft’s average centerline for Orbit POINTs.  Shaft 

centerline plots can be used to show the movement of the shaft within the bearing. 

Inspection Plot – view inspection measurement results for up to six points 

simultaneously.  Enables viewing inspection history over time. 

BOV or Gap Trend – view the trend of a sensor’s bias output voltage value for IMx 

POINTs that have channels with the Check sensor ok status option enabled. The BOV 

limit overlay (blue horizontal lines) indicate the specified BOV limits. 

Mag/Speed Plot – view trends plotting the amplitude (top) and speed (bottom) aligned 

by the measurement date. 

Bode Plot – plots signal magnitude and phase as a function of running speed. 

Nyquist Plot – plots the movement of the machine shaft within the (sleeve) bearing 

housing during the start-up or coast-down of the machine. 

Live Bars – displays live overall values in bar graph format for IMx and DMx POINTs. 

Live bar data is useful when checking or replacing a sensor. 

All Plots – open the All Plots dialog to select the plot type to display from all available 

plots, including combination plots, in addition to the plot types commonly represented 

with toolbar buttons. 

HAL Trend Plot – view the trend for a POINT that has a defined Frequency set plus FFT 

data measurements. 

Combination Plots 

Spectrum/HAL Trend –view the Spectrum and HAL Trend plots together for a POINT 

with associated frequencies. 

Contribution/Profile – displays an overview of different frequencies’ contributions to 

overall vibration within a POINT. 

Band Trend - combine the spectrum and available band trends for the selected POINT.  

Analyze the energy within the band to closely monitor that particular frequency range. 

Bode/Nyquist – view a Bode and Nyquist plot together. (For transient data analysis.)  

Extracted Band – display a waterfall and extracted band plot.  The energy of the 

frequency within the band across the spectrum displays.  
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Extracted Trend – display a trend plot of spectrum amplitudes at a frequency.  A 

waterfall plot shows which spectra are to be used.  The single cursor in the waterfall 

controls which frequency to plot in the trend.  The waterfall plot is the primary plot. 

Mag/Speed/Spectrum – view a POINT’s mag / speed trend plot and a spectrum plot.  

The two plots display in two different panels with the mag / speed panel as the primary 

panel.  

Mag/Speed/Spectrum/Time – view a POINT’s mag / speed plot, spectrum plot and time 

plot.  The three plots display in three different panels. 

Mag/Speed/Time – view a POINT’s mag / speed trend plot and a time plot.  The two 

plots display in two different panels with the mag / speed panel as the primary panel. 

Speed/Bode/Orbit/Spectrum – combines a speed trend, Bode, orbit and spectrum plot. 

It is available for dual-channel POINTs with FFT, Time, and Phase enabled. (For 

transient data analysis.) 

Speed/Bode/Spectrum – combines a speed trend, Bode and spectrum plot. It is 

available for order channel POINTs (that is, Freq. type = Order Track in POINT 

Properties) and dual channel POINTs with phase enabled. (For transient data analysis.) 

Trend/Spectrum – view both a trend plot and a spectrum plot for a trend record 

indicated by the single cursor position. 

Trend/Spectrum/Time – display a POINT’s trend plot, spectrum plot, and time 

waveform plot. The three plots display in three different panels with the trend plot as 

the primary panel. 

Trend/Time – view both a trend plot and a time waveform plot for a trend record 

indicated by the single cursor (if available). 

Plot Tools Toolbar 

Plot Settings – open Plot Settings dialog for the active plot. 

Information Area – open information area beneath the active plot. 

Set Speed – set the cursor position to correspond with the spectrum’s running speed.  

Set Speed (Multiple) – set the same measurement speed for multiple FFT 

measurements 

Activate Zoom – Click to activate the zoom feature, then click and drag across the area 

of the plot which you would like to zoom. The plot will redraw to display the selected 

area. When using a mouse scroll wheel, position your cursor over the area of the plot 

which you would like to zoom. While holding the Ctrl key, roll the mouse scroll wheel up 

or down.  Rolling up causes the plot to zoom in, while rolling down causes the plot to 

zoom out. 

Zoom Out – zoom out one level. 

Live Data – initiates live data mode when a single POINT is selected. The active display 

updates as new data is collected by its on-line device. Previous spectra and time 

waveform plots are overwritten by updated spectra / time waveforms. 

Play Sound Byte – launches the utility providing various playback options to listen to 

sound data waveform through your computer's speakers or connected earphones. 
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Overlays Toolbar 

Overlay Settings – open the Overlay Settings dialog for the selected overlay. 

Single Cursor – display single cursor. Use a single cursor to view individual 

measurement data on the trend plot by moving the cursor to various measurement 

records. Use a single cursor on a spectrum plot to display the amplitude for the 

frequency of the cursor’s current placement. 

Harmonic Cursor – display harmonic cursor to view multiples of the current frequency. 

Opens Harmonic Cursor tab in the plot information area to show details on potential 

harmonics using SKF’s Harmonic Activity Index (HAI). 

Band Cursor – display band cursor to view the frequency / time and amplitude 

difference (delta) between two cursor positions. Opens Spectrum Band tab in the plot 

information area to show details of the left and right cursor positions. 

Sideband Cursor – display sideband cursor reference position with an array of five pairs 

of sideband markers evenly spaced on both sides. Sideband markers to the left of the 

center cursor are referenced with negative numbers; their associated markers to the 

right of the cursor are referenced with positive numbers. Opens Sideband tab in the plot 

information area to show details of the marker positions. 

Peak Cursor – display peak cursor and label all peaks above a user-determined 

amplitude. Opens Peak tab in the plot information area to show details of peak position 

(index), amplitude, frequency, and orders. 

Previous Frequency – display the previous frequency. 

Frequencies – display all frequencies associated with the active plot. 

Next Frequency – display the next frequency. 

Display indicators for notes – active if notes are related to the plot. 

Text Annotation – open Text Annotation Settings dialog. 

Diagnostics – compute and display all relevant harmonic series of the current spectrum, 

and rank all series found according to probability. The results are shown on the 

Diagnostics tab in the info area below the spectrum plot.  The probability is expressed 

as an activity index, whereby values of 1.5 and higher indicate an increasing probability 

of a significant harmonic pattern. [This option is only available with @ptitude Analyst 

CMSW 7400.] 

In addition, the fundamental frequency of each series is compared to any frequency 

associated with the POINT (for example, bearing defect frequencies). If a match is found, 

the name of this frequency is displayed next to the related harmonic pattern. 

Damping Cursor – display damping cursor on a Bode plot to display side bands of three 

decibels to the left and right of the cursor position, and the calculated Q-factor (that is, 

the rate of energy dissipation relative to the oscillation frequency; a higher Q factor 

indicates a lower rate of dissipation). 

CTA Cursor – display CTA cursor on a time plot and view a time interval’s average 

waveform. Opens CTA Cursor tab in the plot information area to show details of label, 

interval, frequency, magnitude, and contribution (%). 
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MCD Cursor – display MCD cursor to view individual measurement values on the MCD 

plot. Opens the MCD Cursor tab in the information area to show: the POINT the cursor 

is currently positioned on, cursor color, acceleration / velocity / temperature values, and 

date / time. 

MCD Alarm – display MCD alarm levels on the plot.  

MCD Curve Fit – project the linear direction a trend is heading based on current data. 

Inspection Cursor – display inspection cursor to view individual measurement data on 

the inspection plot by moving the cursor to various measurement values. Specific 

information displays on the Inspection tab: the POINT on which the cursor is currently 

positioned, cursor color, date / time, operator name, and inspection result. 

Band Alarm – display band alarm levels on the plot. Band Alarms provide alert and 

danger alarms on both peak and spectral values within a defined frequency band. 

Envelope Alarm – display a "total spectrum" envelope alarm for the POINT.  You can 

select from a list of previously created envelope alarms or edit a private (unique) alarm 

for the current POINT.  

HAL Alarm – display HAL (harmonic activity locator) alarm levels on the plot for a 

dynamic measurement POINT.  

Overall Alarm – display the alert and danger levels designated for detection of 

machinery faults. The overall alarm levels are based on the measurement’s “baseline” 

vibration level. 

Phase Alarm – display alarm levels for phase data on a polar vector plot.  Normal levels 

display inside small enclosed areas.  Alert levels are contained within a larger enclosed 

area.  Danger levels appear outside the enclosed area.  

Bearing Clearance – display the bearing’s clearance value (typically supplied by the 

manufacturer).  The clearance value assumes the shaft is centered in the bearing and 

defines the physical distance between the shaft and the bearing, multiplied by 2. 

BOV Limit – display the BOV limit overlay (blue horizontal lines).  If a sensor’s BOV value 

exceeds its limits, it indicates a bad sensor, and a zero overall value is stored for its 

vibration measurements.  

Curve Fit – display a curve fit overlay to graphically display the projected linear direction 

a trend is heading based on current data.  

Exponential Curve Fit – display a curve fit overlay to graphically represent the projected 

nonlinear trend based on current data. 

Linear Speed – display the value of the linear factor multiplied by the running speed.  

Oil Analysis –display the Oil Analysis overlay on a trend plot. 

All Overlays – open the All Overlays dialog and select the overlays to display. 

Protection Threshold Limits – display the threshold limits on a trend plot to graphically 

display the protection levels for IMx-M protection POINTs.  The protection threshold 

limits display as red (danger) and/or yellow (alert) dashed lines.  

Online Tools 

Reset Indicators – resets the status indicators in the status bar. 
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Custom Toolbars 

Toolbar buttons are available for each menu item and available function.  By default, 

only toolbar buttons for commonly utilized features are active.  Buttons are arranged by 

related functionality in separate sections of the toolbar area.  You can enable any or all 

of the available buttons using the Custom Toolbar dialog. 

To open the Custom Toolbar dialog: 

 Select the Customize menu’s Toolbars option.  The Custom Toolbar dialog 

displays. 

 

Figure A - 1. 

The Toolbars Dialog. 

The Custom Toolbars dialog has two main areas.  The Toolbars area displays all 

available toolbars, sorted by name.  All available buttons (active and non-active) for the 

selected toolbar display in the dialog’s second area, Buttons. 

You can configure each toolbar to display the buttons you frequently use.  You may 

activate buttons that are inactive by default, or inactivate buttons that are active by 

default.   
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By default, the Hierarchy View, Navigation, Overlays, Plot Views, Plots, Primary, 

and View Icons toolbars are activated. 

 Click the checkbox next to the toolbar to activate the toolbar. 

 Click the checkbox next to the individual available buttons to activate the buttons for 

the selected toolbar. 

 Click Display toolbar titles to display the toolbar’s descriptive name on the toolbar 

itself for easy identification. 

 Click OK to rebuild all toolbars incorporating your selections. 

 Custom toolbar selections are stored with your user name and 

automatically display for you after initial log in. 
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Appendix B 

Event Log Redirection 

Overview 

Event Log redirection allows you to automatically capture or print alarm or system 

event information by directing the information to either a serial communications port or 

to a parallel printer port.  Communication parameters (port, baud rate, etc.) are user 

selected. 

When an alarm(s) is uploaded from an on-line device, or when a system event occurs 

(e.g., bad sensor, on-line device LAN communication failure, etc.), @ptitude Analyst 

formats each event as it occurs and immediately redirects the formatted output through 

the selected port to the connected device or printer.  Printed events are formatted 

differently than the COM port redirected events. 

Example 

Following is an example of an Event Log redirected to a printer.  Each line was printed 

as the alarm or system event occurred. 

 

Figure B - 1. 

Example Event Log Redirection to a Printer. 

The following are the categories in each redirected event.  The same data is included, 

regardless of whether it is redirected to a printer or a COM port. 

Date / Time Setup (DTS)  - 19 characters - MM / DD / YYYY  HH:MM:SS 

Event type – 20 characters maximum 

Alarm Message (MSG)  - 240 characters maximum 

Machine name – 20 characters maximum 

POINT name – 20 characters maximum 

Device name – 250 characters maximum (contains  / ch#nn at end if there is channel 

for the event) 

Host name – 15 characters maximum 

User name – 30 characters maximum 
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Printed events have labels for each item of data.  The labels are defined in the language 

file.  The channel abbreviation that may be included with the device name also comes 

from the language file.  Printed lines are wrapped if they exceed 80 characters. 

The format for events redirected to COM (serial) ports is as follows: 

 Character 

Location 

Character 

Width 

DTS 1-19 19 

Machine Name 21-40 20 

POINT Name 42-61 20 

Event Message 63-302 240 

Event Type 304-323 20 

Device 325-574 250 

Host Name 576-590 15 

User Name 592-621 30 

\r 622  

\n 623  
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Appendix C 

Data Collection Gating 

Overview 

Gating is a method of controlling data collection for one POINT, called a dependent 

POINT, based on the current state of a second POINT, called the control POINT. 

If the control POINT's conditions are met, the dependent POINT's measurement is 

performed.  If the control POINT's conditions are not met, the dependent POINT's 

measurement is not performed. 

 All data collection gating is performed within an on-line device.  

Therefore a control POINT and its dependent POINT do not need 

to be in the same on-line device, but must be in the same 

Hierarchy. 

There are five types of gating: 

Parametric Gating  

Gating 

Sensor Bias-Output-Voltage Gating 

Tachometer Gating 

Parametric Gating 

Parametric gating is based on a measured value.  Parametric gating was developed to 

monitor vibration under consistent running conditions.  If a machine being monitored 

changes speed or load, its vibration level could change dramatically.  This change in 

vibration has little correlation to machinery health.  Data collected with the machine 

running at a consistent speed and load, however, is useful for determining the machine 

condition. 

Parametric gating allows you to configure the data collection process so that data is 

collected on vibration POINTs only when the machine is in a predetermined speed and 

load range. 

 Parametric gating works best with processes that change less 

frequently than once in 10 minutes.  Do not use it where levels 

are actively varying. 

Example - A winder in a steel mill operates at varying speeds.  Starting from a 

standstill, the winder accelerates to 900 RPM, then decelerates as the rolled up product 

grows in diameter, and finally decelerates to a standstill.  The user wants to collect 

vibration data at both 900 and 500 RPM.  Vibration data at other speeds is not desired.   

To accomplish this, the user creates two RPM POINTs.  These RPM POINTs act as 

control POINTs.  They monitor the machine speed via one of the tachometer inputs.  
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One RPM POINT, 900 LINE SPEED, is set to alarm if the speed is in a window between 

850 and 950 RPM.  The other, 500 LINE SPEED, is set to alarm between 450 and 550 

RPM.  The alarm window parameters define the control POINTs' criteria.  Only if the 

control POINTs' values are within these alarm windows are the conditions met (and the 

dependent POINTs' measurements performed). 

The user then creates the vibration POINTs (dependent POINTs).  These POINTs are 

linked to the control POINT by selecting the appropriate RPM POINT in the parametric 

gating setup.  This guarantees that vibration data can be trended over consistent speed 

conditions. 

 

Figure C - 1. 

Spectrum Envelope for a Control POINT. 

The figure above shows another way to perform parametric speed gating.  This method 

uses a spectrum envelope for a control POINT.  This spectrum envelope creates an 

alarm as long as the running speed does not change significantly and the peak value 

does not become too low.  While the control (RPM) POINT remains in its alarm window, 

conditions are considered “true” and the dependent POINT is measured and collected.  

If the machine is not running or not running at the correct frequency, the control POINT 

does not produce a spectrum alarm and the dependent POINT's measurement is not 

performed. 

Logic Gating 

Logic gating is a type of parametric gating, therefore it can be used in the same 

applications.  In logic gating, the control POINT is a logic POINT.  A logic POINT allows 

signals from external control circuitry, such as programmable logic controller outputs, 

to make the gating decisions.   

When a logic POINT takes data, it checks the state of a TTL logic input (0 to 5 volts).  A 

value of one (HIGH) or zero (LOW) is saved.  If the logic POINT is used to control 

another POINT, the logic POINT's input value (HIGH or LOW) determines if data is 

collected on the dependent POINT.  You can specify which state, high or low, will be the 

triggering or Active State. 
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Figure C - 2. 

POINT Setup Fields for Logic Control POINT Setup. 

Example - A grinder in an automotive manufacturing plant operates in three modes, 

grinding, idle, and stop.  In the grinding mode there is so much vibration from the 

grinding wheel that vibration data, indicative of the condition of the spindle and its 

bearings, is drowned out.  During idle mode, the useful machinery condition vibration 

signals can easily be detected.   

The process is controlled via a programmable logic controller (PLC) in the 

manufacturing cell.  The PLC has programmable logic outputs.  One of these outputs 

can be used as a logic input to the on-line device (the control POINT).  The control 

computer's logic output can be programmed to be high during idle mode and low in 

grinding mode. 

The user creates a logic control POINT that monitors the appropriate logic input.  Since 

the signal from the controller is high during idle mode, the logic POINT's Active State 

should be set to high.  The user then creates vibration monitoring POINTs (dependent 

POINTs) and links them to the logic (control) POINT.  This allows the collection of 

consistent vibration data during the idle mode of operation. 
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Sensor Bias-Output-Voltage Gating 

This gating method verifies proper sensor operation and may be used for any channel 

using a sensor with a dynamic signal riding on a DC bias voltage.  Examples are an 

accelerometer with internal electronics or an eddy current displacement probe.  The 

sensor's bias output voltage value is indicative of its operating condition. 

Sensor Bias Output Voltage (BOV) is a DC voltage on which the AC signal rides.  The 

on-line device can monitor the bias output voltage as well as the AC signal.  If the bias 

output voltage is outside the sensor manufacturer's specified operating range, the 

signal coming from the sensor should probably be disregarded. 

Example - Two accelerometers are installed at key points on a motor drive.  The 

accelerometers are cabled to the first two IMx / WMx sensor inputs.  The user has 

created one dynamic POINT for each of these channels and has enabled sensor BOV 

gating for both POINTs.  The lower BOV for each is set to +2 VDC and the upper BOV to 

+22 VDC; BOVs outside this window are indicative of failures in the sensor or in its 

cabling.  The figure below shows the BOV Gating Setup of the Sensor Setup Tab for 

one of these dynamic POINTs.) 

 

Figure C - 3. 

Sensor Setup Tab. 
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Three months later during routine maintenance of the turbine, one of the sensor cables 

is accidentally cut.  The sensor BOV rises up to +24V DC (the open circuit voltage).  The 

IMx / WMx will not collect data for the POINT that uses the channel with the cut cable, 

but will continue to collect data on the other dynamic POINT.  A non-collection event is 

logged for the bad BOV event. 

Tachometer Gating 

Tachometer gating is used to disable data collection for a POINT when its machine 

stops.  

Example - In the sensor BOV motor drive example, a tachometer is permanently 

mounted on the motor.  The output of the tachometer is cabled to the TACH 1 input on 

the IMx motherboard.  The tachometer outputs a pulse for each revolution of the 

motor.  

The user has enabled TACH 1 for all POINTs downloaded to the IMx.  The IMx waits for 

a pulse from the tachometer prior to collecting data on each of the points.  If no pulse is 

registered after ten seconds (6 RPM), the motor is assumed to have stopped.  

This provides consistently trendable vibration data by turning off data logging when the 

machine is stopped. 
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Glossary of Terms 

Acceleration - The time rate of change of 

velocity.  Acceleration measurements are 

usually made with accelerometers. 

Accelerometer - A sensor whose output is 

directly proportional to acceleration. 

Alignment - A condition whereby the axes of 

machine components are either coincident, 

parallel, or perpendicular, according to design 

requirements. 

Amplitude - The magnitude of dynamic motion 

or vibration.  Expressed in terms of 

peak-to-peak, zero-to-peak, or RMS. 

Asynchronous - Vibration components that are 

not related to rotating speed. 

Averaging - In a dynamic signal analyzer, 

digitally averaging several measurements to 

improve statistical accuracy or to reduce the 

level of random asynchronous components. 

Axial - In the same direction as the shaft 

centerline. 

Axial Vibration - Vibration which is in line with 

a shaft centerline. 

Axis - The reference plane used in plotting 

routines.  The X-axis is the frequency plane.  

The Y-axis is the amplitude plane. 

Balancing - A procedure for adjusting the radial 

mass distribution of a rotor so that the 

centerline of the mass approaches the 

geometric centerline of the rotor.  

Band-Pass Filter - A filter with a single 

transmission band extending from lower to 

upper cutoff frequencies.  The width of the band 

is determined by the separation of frequencies 

at which amplitude is attenuated by 3 dB 

(0.707). 

Bandwidth - The spacing between frequencies 

at which a band-pass filter attenuates the signal 

by 3 dB. 

Baseline Spectrum - A vibration spectrum 

taken when a machine is in good operating 

condition; used as a reference for monitoring 

and analysis. 

Baud Rate - Adjustable serial communication 

transfer rate.  Measured in bits per second. 

Bit - Smallest unit of computer information 

storage. Equivalent to a choice of a one or a 

zero. 

Byte - A unit of computer information storage 

usually equal to eight bits or one character. 

Center Frequency - For a bandpass filter, the 

center of the transmission band. 

Centerline Position - The average location, 

relative to the radial bearing centerline, of the 

shaft dynamic motion. 

Channel - A sensor and the instrumentation 

hardware and related software required to 

display its output signal. 

Condition Monitoring - Determining the 

condition of a machine by interpretation of 

measurements taken either periodically or 

continuously while the machine is running. 

CPM - Cycles per minute. 

CPS - Cycles per second.  Also referred to as 

Hertz (Hz). 

Critical Speeds - In general, any rotating speed 

which is associated with high vibration 

amplitude.  Often the rotor speeds which 

correspond to natural frequencies of the 

system. 

Cycle - One complete sequence of values of a 

periodic quantity. 

Displacement - The change in distance or 

position of an object relative to a reference. 

Download - Transferring information to the 

measurement device  from the host computer. 

Enable - To activate. 

Engineering Units - Physical units in which a 

measurement is expressed, such as in/sec, 

micrometers, or mils.  Selected by the user. 

EU - See ENGINEERING UNITS. 

External Sampling - In a DSA refers to control 

of data sampling by a multiplied tachometer 

signal.  Provides a stationary display of vibration 

with changing speed. 

Fast Fourier Transform - A calculation method 

of converting a time waveform to a frequency 

display that shows the relationship of discrete 

frequencies and their amplitudes. 

Field - One data item.  Examples of fields are 

POINT Type, Description, etc. 

Filter - An electronic device designed to pass or 

reject a specific frequency band. 

FFT - See Fast Fourier Transform. 

Flat Top Window - DSA window function which 

provides the best amplitude accuracy for 

measuring discrete frequency components. 
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Frequency - The repetition rate of a periodic 

event, usually expressed in cycles per second 

(Hz), cycles per minute (CPM), revolutions per 

minute (RPM), or multiples of running speed 

(orders).  Orders are commonly referred to as 

1X for running speed, 2X for twice running 

speed, and so on. 

Frequency Domain - An FFT graph (amplitude 

vs. frequency). 

Free Running - A term used to describe the 

operation of an analyzer or processor which 

operates continuously at a fixed rate, not in 

synchronism with some external reference 

event. 

Frequency Range - The frequency range 

(bandwidth) over which a measurement is 

considered valid.  Usually refers to upper 

frequency limit of analysis, considering zero as 

the lower analysis limit. 

Gap - (See Probe Gap.) 

Global Bearing Defect - Relatively large 

damage on a bearing element. 

Hanning Window - DSA window function that 

provides better frequency resolution than the 

flat top window, but with reduced amplitude 

accuracy. 

Hertz (Hz) - Cycles per second.  CPM/60. 

Hierarchy - A method of organizing equipment 

into logical groups or physical areas for ease of 

access in the PRISM4 database.  This format 

consists of Main SETs, Sub-SETs, machines, 

and POINTs. 

High Pass Filter - A filter with a transmission 

band starting at a lower cutoff frequency and 

extending to (theoretically) infinite frequency. 

Imbalance - A condition such that the mass of a 

shaft and its geometric centerlines do not 

coincide. 

Keyphasor Phase Reference Sensor - A signal 

used in rotating machinery measurements, 

generated by a sensor observing a 

once-per-revolution event.  (Keyphasor is a 

Bently-Nevada trade name.) 

Linear Averaging - In a DSA, averaging of time 

records that results in reduction of 

asynchronous components. 

Lines - Common term used to describe the 

filters of a DSA (e.g. 400 line analyzer). 

Low Pass Filter - A filter whose transmission 

band extends from an upper cutoff frequency 

down to DC. 

Multi-Parameter Monitoring - A condition 

monitoring method that uses various 

monitoring technologies to best monitor 

machine condition. 

Natural Frequency - The frequency of free 

vibration of a system.  The frequency at which 

an undamped system with a single degree of 

freedom will oscillate upon momentary 

displacement from its rest position. 

Orbit - The path of shaft centerline motion 

during rotation. 

Overlap Processing - The concept of 

performing a new analysis on a segment of data 

in which only a portion of the signal has been 

updated (some old data, some new data). 

Peak Spectra - A frequency domain 

measurement where, in a series of spectral 

measurements, the one spectrum with the 

highest magnitude at a specified frequency is 

retained. 

Phase - A measurement of the timing 

relationship between two signals, or between a 

specific vibration event and a keyphasor pulse. 

Phase Reference - A signal used in rotating 

machinery measurements, generated by a 

sensor observing a once-per-revolution event. 

Phase Response - The phase difference (in 

degrees) between the filter input and output 

signals as frequency varies; usually expressed 

as lead and lag referenced to the input. 

Phase Spectrum - Phase frequency diagram 

obtained as part of the results of a Fournier 

transform. 

POINT - Defines a machinery location at which 

measurement data is collected and the 

measurement type.  

Probe - An eddy-current sensor, although 

sometimes used to describe any vibration 

sensor. 

Probe Gap - The physical distance between the 

face of an eddy probe tip and the observed 

surface.  The distance can be expressed in 

terms of displacement (mils, micrometers) or in 

terms of voltage (millivolts), which is the value of 

the (negative) dc output signal and is an 

electronic representation of the physical gap 

distance.  Standard polarity convention dictates 
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that a decreasing gap results in an increasing 

(less negative) output signal; increasing gap 

produces a decreasing (more negative) output 

signal. 

Radial - Direction perpendicular to the shaft 

centerline. 

Radial Position -The average location, relative 

to the radial bearing centerline, of the shaft 

dynamic motion. 

Radial Vibration - Vibration which is 

perpendicular to a shaft's centerline. 

Resonance - The condition of vibration 

amplitude and phase change response caused 

by a corresponding system sensitivity to a 

particular forcing frequency.  A resonance is 

typically identified by a substantial amplitude 

increase, and related phase shift. 

RMS - The square root of the sum of a set of 

squared instantaneous values. 

ROUTE - A measurement POINT collection 

sequence.  

Run Up/Run Down - The monitoring of 

machinery conditions during a start up or shut 

down process. 

Sensitivity - The ratio of magnitude of an 

output to the magnitude of a quantity 

measured.  Also the smallest input signal to 

which an instrument can respond. 

Sensor - A transducer which senses and 

converts a physical phenomenon to an analog 

electrical signal. 

Signal Analysis - Process of extracting 

information about a signal's behavior in the time 

domain and/or frequency domain.  Describes 

the entire process of filtering, sampling, 

digitizing, computation, and display of results in 

a meaningful format. 

Spectrum - A display of discrete frequencies 

and their amplitudes. 

Spectrum Analyzer - An instrument which 

displays the frequency spectrum of an input 

signal. 

Thermocouple - A temperature sensing device 

comprised of two dissimilar metal wires which, 

when thermally affected (heated or cooled), 

produce a change in electrical potential. 

Time Domain - A dynamic amplitude vs. time 

graph. 

Time Waveform - (See Waveform.) 

Transducer - A device which translates a 

physical quantity into an electrical output.   

Trend - The measurement of a variable vs. 

time. 

Trigger - Any event which can be used as a 

timing reference. 

Upload - Transferring data from the measuring 

device to the host computer. 

Vibration - The behavior of a machine's 

mechanical components as they react to 

internal or external forces.  Magnitude of cyclic 

motion; may be expressed as acceleration, 

velocity, or displacement.  Defined by frequency 

and timebased components. 

Waveform - A presentation or display of the 

instantaneous amplitude of a signal as a 

function of time.





 

SKF @ptitude Analyst and SKF Multilog Online Systems Index - 1 

User Manual 

Index 

A 

activity index 

diagnostic cursor 5-76 

frequency overlay 5-74 

harmonic cursor 5-67 

add notes 5-54 

alarm 

DMx alarms 7-27 

DMx band 7-18 

alarm database 

band 3-154 

envelope 3-158 

overall 3-152 

alarm settings 3-150 

alarm group 3-160 

speed 3-156 

anchor symbol 5-6, 5-8 

apply template wizard 3-181 

asset name 3-5 

assign 

report editor 6-12 

autorange 3-33 

averaging 3-19, 3-26 

B 

band alarm 

load band alarms 3-80, 3-93 

band alarm settings 5-71 

band trend 5-32 

baseline 3-99 

set baseline screen 3-99 

bearing editor 3-118 

bode 

damping cursor 8-17 

plots 8-16 

Bode/Nyquist plot 8-23 

BOV 

gating 4-7, C-1, C-4 

limits overlay 5-14 

trend plot 5-14 

C 

canary lab settings 3-201 

cascade plots 8-20 

channel 3-18, 3-24, 3-28, 3-33 

check size 4-6 

clear all devices 4-6 

coast down 8-7 

columns 

report definition 6-8 

configure DMx 7-3 

Contribution tab 3-68 

contribution/profile plot 5-43 

control POINT 3-84, 7-24, C-1 

control POINT setup 3-27 

crest factor 5-83 

CTA, cyclic time averaging 5-43 

custom toolbars A-7 

cyclic time averaging (CTA) 5-43 

D 

DAD / POINT type selection 3-11 

DAD status 4-7 

damping cursor 8-17 

date range 

report definition 6-8 

DC point 3-32 

dependent POINT 7-24, C-1 

derived point 3-33, 3-198 

calculate 3-104 

data input display 3-33 

expressions 3-36 

functions 3-38 

variables 3-36 

details 3-10 

detection 3-18, 3-24 

device activity 4-9 

devices 

clearing 4-6 

DMx 

@ptitude Analyst Monitor 7-2 

adding POINTs 7-8 

alarms 7-27 

buffer 7-3 

collection schedule 7-17 

connections setup 7-5 

data collection 7-26 

device setup 7-7 

device status 7-12 

gating setup properties 7-24 

hardware configuration 7-1 

hierarchy 7-11 

hosts 7-3 
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live data resolution 7-3 

machine properties 7-12 

normal data resolution 7-4 

orbit plot 7-30 

orbit POINTs 7-12 

orbit properties 7-18 

overview 7-1 

plots 7-29 

POINT properties 7-14 

POINT types 7-12 

SCL plot 7-32 

serial connection 7-6 

settings 7-3 

TCP/IP connection 7-6 

transient groups 8-6 

transient hierarchy 8-10 

transient points 8-2 

transient window 8-5 

updates from Manager 7-28 

vector properties 7-22 

waveform properties 7-21 

download 4-5 

check size 4-6 

E 

event 

add 3-106 

copy 3-106 

edit 3-106 

remove 3-106 

select user 3-108 

transaction server 3-108 

event log 

redirection B-1 

event scheduler wizard 3-106 

exception report 6-1 

extracted band plot 5-35 

extracted trend plot 5-34 

F 

FAM 

activity index 5-74 

filter keys 3-7, 3-55, 3-89 

filter notes 5-55, 6-11 

filters 3-183 

apply filter 3-185 

copy filter 3-184 

edit filter 3-185 

filter attributes 3-187 

filter editor 3-183 

managing filters 3-183 

new filter 3-183 

remove filter 3-185 

shared filter 3-186 

freq. type 3-18, 3-24 

frequency formula 3-69 

frequency overlay 

activity index 5-74 

frequency sets 3-116 

frequency sets editor 

bearings 3-118 

general 3-117 

other 3-120 

frequency settings dialog 5-75 

full scale 3-33 

G 

gating C-1 

BOV C-1, C-4 

DMx 7-24 

logic C-1, C-2 

parametric C-1 

POINT configutration rules 3-84 

rules 3-84 

tachometer C-1, C-5 

graphic plot display 5-1 

group 

insert group 3-5 

new group 3-5 

group properties 3-5 

details 3-10 

DMx device status 7-12 

DMx transient 8-6 

filter keys 3-7, 3-55, 3-89 

general 3-5 

images 3-9 

IMx transient 8-8 

messages 3-7 

notes 3-9 

group types 

creating group types 3-112 

H 

HAI 5-66 

HAL Alarms tab 3-66 

HAL trend plot with spectrum 5-41 
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harmonic cursor 

activity index 5-67 

HAI 5-66 

hierarchy 

building 3-1 

close hierarchy 3-3 

multiple 3-4 

new hierarchy 3-2, 3-4 

open hierarchy 3-3 

paper copy 3-1 

primary 3-4 

transient 8-10 

history report 6-1 

host computer 1-4 

I 

images 3-9, 3-74 

report definition 6-9 

IMx 

alarm group 3-160 

alarm group 3-46 

analog 3-124 

attributes 3-97 

channel 3-24, 3-28, 3-124 

Communication 3-134 

digital 3-126 

download 4-5 

download band alarm 3-79 

IMx Setup tab 3-46 

modbus export 3-141 

modbus import 3-140 

Modbus RTU 3-134, 3-137 

Modbus TCP 3-134, 3-136, 3-139 

modify by attribute 3-97 

online settings 3-122 

Online transfer 4-4 

post-processing 3-79, 3-80, 3-157 

process reference 7-25 

protection analog 3-128 

protection BOV 3-130 

protection digital 3-132 

Service 1-8, 1-9, 3-123 

setup system 1-9 

Setup tab 3-23 

speed alarm settings 3-156 

speed reference 7-25 

status 4-7 

system 1-6 

Transaction Service 1-9 

upload 4-10 

IMx-8 1-6 

modbus 3-140, 3-141 

IMx-M 1-6 

protection channels 3-127 

IMx-P 1-7 

IMx-S 1-7 

modbus 3-140, 3-141 

IMx-T 1-7 

modbus 3-140, 3-141 

K 

kurtosis 5-83 

L 

last measurement report 6-1 

linear speed overlay settings 5-53 

linear speed settings 5-59 

live data 

saving 5-88 

live data displays 5-86 

local data collection 4-8 

lock trace 5-9 

logic gating C-1, C-2 

low frequency cutoff 3-18, 3-26 

M 

machine priority 3-6 

Mag / Speed / Spectrum / Time 5-30 

mag / speed / spectrum trend plot 5-29 

Mag / Speed / Time 5-31 

mag / speed trend plot 5-28 

mag/phase / single cursor 5-80 

mag/phase settings 5-27, 5-28 

mag/phase trend plot 5-27 

manual archive 3-105 

manual entry 4-12 

measurement history 

report definition 6-10 

measurement properties 3-98 

messages 

public 3-161 

shared 3-8, 3-63 

modify by attribute 3-96 

Monitor 

DMx buffer 7-3 

DMx hosts 7-3 

transient groups 8-11 
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multi-channel 

plots 5-10 

select channel number 5-10 

multi-measurement plots 5-10 

multiple point properties 3-88 

envelope tab 3-94 

N 

new DMx POINTs 7-8 

notes 

report definition 6-11 

Nyquist plots 8-18 

O 

offset calculator 2-21, 3-125 

Online 

transfer overview 4-4 

orbit 

plots 7-30 

shaft centerline plot 7-32 

orbit POINTs 7-12 

orbit properties 7-18 

vector 7-22 

waveform 7-21 

overdue report 6-1 

overlays 5-8 

all overlays 5-51 

bode/damping cursor 8-17 

mag/phase / single cursor 5-80 

polar vector/phase alarm 5-80 

polar vector/single cursor 5-79 

spectrum/band alarm 5-70 

spectrum/band cursor 5-65 

spectrum/diagnostic cursor 5-76 

spectrum/envelope alarm 5-72 

spectrum/frequency 5-73 

spectrum/harmonic cursor 5-66 

spectrum/linear speed 5-73 

spectrum/peak 5-69 

spectrum/running speed 5-64 

spectrum/sideband 5-68 

spectrum/single cursor 5-61 

time/band 5-83 

time/harmonic 5-82, 5-85 

time/linear speed 5-85 

time/peak 5-84 

time/single cursor 5-81 

toolbar buttons 5-50 

trend/curve fit 5-60 

trend/linear speed See 

trend/notes 5-54 

trend/overall alarm 5-58 

trend/single cursor 5-57 

waterfall/band cursor 5-78 

waterfall/single cursor 5-77 

overspeed 8-9 

P 

paper copy hierarchy 3-1 

parametric gating C-1 

plots 

band trend plot 5-32 

Bode 8-16 

Bode/Nyquist 8-23 

cascade 8-20 

extracted band plot 5-35 

extracted trend plot 5-34 

live data displays 5-86 

Mag / Speed / Spectrum / Time trend plot 5-

30 

mag / speed / spectrum trend plot 5-29 

Mag / Speed / Time trend plot 5-31 

mag / speed trend plot 5-28 

mag/phase trend plot 5-27 

multi-measurements 5-10 

navigation 5-12 

Nyquist 8-18 

plot toolbar buttons 5-2, 5-50 

plot window 5-6 

plot window operations 5-7 

polar vector plot 5-26 

report definition 6-9 

select channel number 5-10 

spectrum plot 5-15 

speed/Bode/orbit/spectrum 8-25 

speed/Bode/spectrum 8-24 

time plot 5-20 

topology 8-21 

transient 8-15 

trend plot 5-13 

trend/spectrum plot 5-19 

trend/spectrum/time plot 5-23 

trend/time plot 5-22 

waterfall plot 5-24 

point 

graphic display 5-1 

insert point 3-11 
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new point 3-11 

point name 3-1 

point properties 

band 3-77, 3-92 

canary labs 3-35 

derived points 3-34 

envelope 3-80 

expressions 3-36 

frequency 3-64 

gating 3-50 

general 3-12 

manual points 3-31 

messages 3-62 

notes 3-65 

orbit/scl 3-29 

overall 3-58, 3-90 

phase 3-77 

protection threshold levels 3-48 

schedule 3-52 

threshold 3-47 

POINT Setup Validation 3-17, 3-24, 3-31, 3-

86 

polar vector plot 5-26 

polar vector settings 5-26 

polar vector/phase alarm 5-80 

polar vector/single cursor 5-79 

prefix 3-1 

primary hierarchy 3-4 

print 6-1 

priority 3-6 

process reference 3-48 

public messages 

creating 3-161 

R 

RAM 4-8 

report 6-1 

report definition 

columns 6-8 

date range 6-8 

images 6-9 

measurement history 6-10 

notes 6-11 

plots 6-9 

routes 6-11 

report editor 

assign 6-12 

assign for ROUTE report 6-15 

reports 

exception report 6-1 

history report 6-1 

last measurement report 6-1 

overdue report 6-1 

report editor 6-5 

route history 6-1 

ROUTE Statistics report 6-1 

set statistics 6-1 

transaction server 3-108 

transient 6-1 

upload statistics report 6-1 

route 

creating 4-1 

new route items 4-3 

paper copy 4-1 

report definition 6-11 

structured 4-3 

route history 

report 6-1 

route statistics report 6-1 

running speed 5-62, 5-67, C-2 

S 

saving live data 5-88 

schedule DMx data collection 7-17 

scheduled event 

add 3-106 

copy 3-106 

edit 3-106 

remove 3-106 

select user 3-108 

transaction server 3-108 

scheduler 3-106 

actions 3-110 

current scheduled events 3-106 

events 3-109 

segment name 3-5 

select channel in plots 5-10 

self collection 3-48 

send message 3-111, 6-3 

sensor setup 3-15 

sensors 

shared 3-16 

serial connection for DMx 7-6 

set baseline 3-99 

set statistics report 6-1 

shaft centerline plot 7-32 

share alarm 3-59, 3-62, 3-91 

share gating 3-51 
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share message 3-8, 3-63 

shared sensors 3-16 

skew 5-83 

sound byte 5-21 

spectrum 

combined 5-18 

multi channel 5-17 

stacked 5-17 

spectrum settings 5-16 

combined/stacked 5-16 

spectrum/band alarm 5-70 

spectrum/band cursor 5-65 

spectrum/diagnostic cursor 5-76 

spectrum/envelope alarm 5-72 

spectrum/frequency 5-73 

spectrum/HAL trend plot 5-41 
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